How can we help you?
Use the links below to find instructions, software training, one-on-one
support, technical specifications, or other resources to get Sage ERP
Accpac working smoothly for your business! Your Sage Business
Partner is also an excellent resource to consult when you have
questions about Sage ERP Accpac.
I'm setting up Sage ERP Accpac and need information or assistance
I'm looking for instructions to complete a task within Sage ERP Accpac
I think something is broken, or I'm getting error messages
I’m looking for downloads, updates, or technical specifications
I want to become a more skilled user of Sage ERP Accpac
I want to share knowledge with other Sage ERP Accpac users
I want to contact a Sage ERP Accpac representative

What's New in Order Entry 6.0
Order Entry 6.0 includes the following new features and improvements:

In Product Update 1:
You can now return serialized and lotted items to a location other than
the location from which the items were shipped. (Previously, if you
shipped and invoiced an order that included serialized or lotted items,
and then selected the invoice in Credit Note Entry and tried to change
the ship-to location, serial and lot numbers for the items were
cleared.)
Changes to Support Payment Processing
Order Entry supports Payment Processing, a Sage ERP Accpac
program that lets you process credit card payments from your
customers. You use it with Sage Exchange, a secure paymentprocessing application that integrates Sage ERP Accpac with Sage
Payment Solutions.
After you install Payment Processing and Sage ERP Accpac 6.0
Product Update 1, the following features are added to Order Entry:
In Accounts Receivable, a new payment type ("SPS Credit Card")
is added to the list of available selections on the Payment Codes
setup form. In Order Entry, when you select a payment code that
uses this payment type, you can pre-authorize or process a credit
card prepayment for an order, shipment, or invoice.
On the Order Entry, Shipment Entry, and Invoice Entry forms, you
can click the Prepayment button to process or void a credit card
prepayment. On the Prepayment form, when you select a payment
code that uses the SPS Credit Card payment type and add a
prepayment, Charge and Void buttons become available and allow
you to process or void a credit card prepayment for an order,
shipment, or invoice.
On the Order Entry form, three new buttons — Pre-authorize,
Capture, and Void — allow you to pre-authorize, capture, or void a
credit card prepayment.
On the Shipment Entry form, a Capture button allows you to
capture a pre-authorized credit card payment. If no pre-authorized
credit card payment exists, a Prepayment button appears instead

and allows you to process a prepayment.
On Order Entry forms where you can pre-authorize or process a
credit card prepayment, a Processing Code field allows you to
select a processing code, which specifies the bank, currency, and
Sage Payment Solutions merchant account that will be used to
process the transaction. (You set up processing codes in Common
Services, under Payment Processing.)

In the 6.0 Release:
Changes in Processing to Respect New Fiscal Period Locks
Order Entry version 6.0 supports changes to Common Services'
Fiscal Calendar.
Fiscal periods are now locked separately for each Sage ERP Accpac
program, including Order Entry. Although this change does not affect
the way you enter transactions, you should note the following points:
The program checks the status of a fiscal period when you enter
certain dates in Order Entry documents.
Day End Processing (in Inventory Control) is not affected by
locked fiscal periods.
If the period is locked for Bank Services and the Locked Fiscal
Period option is set to Error, you receive an error message when
you add a receipt or print a refund cheque. (Otherwise, no warning
or error appears.)
Day End Processing creates transactions for General Ledger,
Accounts Receivable, and Project and Job Costing (depending on
your system and settings) and updates costs, as usual. However, if a
fiscal period is locked for a ledger receiving these transactions from
Inventory Control, the transactions may fail to post in that other
ledger.

Upgrading from an Earlier Version?
If you are upgrading from version 5.5, see Changes in Order Entry 5.6.
If you are upgrading from version 5.4, also see Changes in Order Entry 5.5.
If you are upgrading from version 5.3, also see Changes in Order Entry 5.4.

Steps for Setting Up Order Entry
This topic lists the steps for setting up a new Order Entry system.
To print this topic, right-click on the help page, and select Print... from the
popup menu that appears.
Step 1:Gather your existing Order Entry data.
Step 2:Add order entry accounts to your Chart of Accounts.
Step 3:Add security information.
Step 4:Choose Order Entry options.
Step 5:Add setup records.
Step 6:Enter outstanding orders (optional).
Step 7:Enter sales statistics.
Step 8:Design order entry forms.
See also
Setting Up Multicurrency Accounting in Order Entry

Setting Up Multicurrency Accounting in Order Entry
If you use multicurrency accounting, you set up the currency information
for your Order Entry system in Common Services and Accounts
Receivable. When setting up Order Entry, you need only make sure the
currencies in which you bill your customers have been added to the
Currency forms in Common Services.
You need to add currency information only when:
Setting up a miscellaneous charge or entering a transaction for a
customer who is not yet defined in Accounts Receivable. You
specify the currency for the charge record or transaction by the tax
group you select.
Changing the default exchange rate on a transaction. Order Entry
displays the exchange rate that is entered in Common Services for
the transaction date, but you can change to a rate that is specified in
Common Services for another date or rate type.
Recording a prepayment. You can add prepayments in any currency
you have defined for your Sage ERP Accpac system.
Some Order Entry reports can also include source and functionalcurrency (home-currency) information.
See also
Steps for setting up Order Entry

Customize Order Entry with Unlimited Optional
Fields
Order Entry supports Sage ERP Accpac Transaction Analysis and
Optional Field Creator, a separately licensed package that you can
purchase and use with any edition of Sage ERP Accpac.
Sage ERP Accpac lets you customize your accounting system by adding
any number of fields to accounting records, accounting transactions, and
transaction details. You can choose whether transaction fields flow
through to other subledgers or to the general ledger.
Within Order Entry, you can specify unlimited optional fields for
Miscellaneous Charges, Orders (header and detail), Shipments (header
and detail), Invoices (header and detail), and for Credit/Debit Notes
(header and detail).
The Copy Orders function also supports optional fields since it creates
transactions.
Because several Order Entry reports let you select records by optional
fields, you can easily analyze your data in ways that are especially
relevant to your business.
Optional field information can be transferred to G/L
When you create general ledger transactions in Order Entry, the program
passes the optional field values used in a transaction to General Ledger
if:
The optional fields are the same as the optional fields assigned to the
affected account in General Ledger.
The optional field settings specify that optional field information be
passed to the type of account used in the transaction.
The values then appear in the General Ledger journal entry for the
account, as well as in the Optional Fields report.
Optional field settings
To see the accounts that are affected when you post a certain kind of
transaction, select an optional field you created for that type, then click

the Settings button. Note that different accounts are affected by
transaction documents and transaction details.

Using the Optional Fields Setup Form
Before adding optional fields for Order Entry, you must first define
optional fields for Sage ERP Accpac using the Optional Fields form in
Common Services.
Once you set up system-wide optional fields, you use the Optional Fields
form in the O/E Setup folder to define optional fields for the following
records and transactions:
Miscellaneous Charges.
Orders and order details. (You define optional fields separately for the
complete transaction and for transaction details.)
Shipments and shipment details. (You define optional fields separately
for the complete transaction and for transaction details.)
Invoices and invoice details. (You define optional fields separately for
the complete transaction and for transaction details.)
Credit/debit notes and credit/debit note details. (You define optional
fields separately for the complete transaction and for transaction
details.)
The Copy Orders processing function also supports optional fields, since
this function creates transactions.
For each optional field, you can specify a default value and indicate
whether the optional field will be automatically inserted, depending on the
type of field.

Security for Optional Fields
If you use security with Order Entry, you need permission to add or
change optional fields, as follows:
Setup Maintenance.This authorization lets you add or delete optional
field setup records in the Optional Fields form.
Transaction Optional Fields. This authorization lets you add or

delete default optional fields for Orders, Shipments, Invoices, and
Credit/Debit Notes.
Contact your administrator for security permission changes.

Global Locking for Optional Fields
The Optional Fields setup form is globally locked. This means that while
the O/E Optional Fields form is open, you cannot run other processes in
Order Entry.
If other Order Entry forms are open, you cannot save changes in the
O/E Optional Fields setup form. You can modify optional fields setup
records only when all other users have left Order Entry, and all other
Order Entry forms are closed.

Validated Optional Fields
If an optional field requires validation, you can select only a value that is
assigned to the optional field in Common Services. (If the optional field
allows blanks, you can leave the default value field blank.)
If the optional field does not use validation, you can select a value from
Common Services, leave the field blank, or enter any value that is
consistent with the type of field (yes/no, text, number, date, amount, and
so on) and does not exceed the maximum number of characters
permitted for the optional field.
Optional field values are restricted to the lengths that were defined in
Common Services.

Auto Insert Option
When you add optional fields to Order Entry (in the O/E Optional Fields
setup form), you can choose to have them inserted automatically into the
O/E record. This option is available for all records and transactions.
Set to Yes If Auto Insert is set to Yes, the optional field and default field
value set for the field will automatically appear in the particular form to
which you are adding the optional field.
Set to No If Auto Insert is set to No, the optional field will not appear by

default in the form to which you added the optional field. You will have to
select it during data entry.
Note: You must have Transaction Optional Fields security access to add
optional fields that have the Auto Insert option set to No.

Optional Field Settings
If the optional fields specified for Order Entry transactions and transaction
details match optional fields in General Ledger transactions, the O/E
optional field data can automatically pass to General Ledger.
You can — and should — restrict the flow of information that is passed to
General Ledger when you post transactions that use optional fields. The
Optional Fields setup form lets you specify groups of accounts for which
values for an optional field can be passed to G/L.
When defining an optional field for use with transactions, click the
Settings button. A separate form opens, listing the groups of accounts
that are affected when you post transactions of the type for which you are
defining the optional field. Select from the list all the account groups for
which you want to pass values to General Ledger when you post
transactions that include the optional field.
Important!Note that while all account groups are initially selected for new
optional fields, you need to consider carefully the purpose of the optional
field you are defining. You should send values to General Ledger only for
optional fields that require financial analysis, and only to accounts where
they are required.
You do not need to send optional field information for analysis that is
performed only in Order Entry. If you routinely send all the optional fields
you use in Order Entry transactions, your General Ledger may become
unwieldy, and you may also slow down processing considerably.
Once you define optional fields for Order Entry, you can assign them to
particular records or use them in transactions.

Adding/Deleting Optional Fields
Adding Users with security access to Setup Maintenance can add or
delete optional fields in Optional Fields setup. The optional fields that can

be added are restricted to the optional fields defined in the Optional
Fields setup form in Common Services.
Deleting If you attempt to delete an optional field, Order Entry will check
the appropriate records and display an error message if the optional field
you are deleting is being used. You must first delete the optional field
from the appropriate records, or post the transactions.

Assigning Security Authorizations for Order Entry
Users
If your Sage ERP Accpac system requires user passwords and security
profiles, the system administrator must assign security authorizations to
users for Order Entry forms.
For information on activating security and setting up security groups,
refer to the System Manager online Help (choose the Help menu on the
Sage ERP Accpac desktop).

Changing Print Destination
To change the print destination, you must have Change Print Destination
security authorization, which is assigned from the permissions list in
Administrative Services' Security Groups form.

Assigning Order Entry security
The Security Groups form, in the Administrative Services folder, provides
security assignments to perform Order Entry tasks, as follows:
Common Inquiry — Print setup reports and view/print setup forms.
Setup Maintenance — Print setup reports, modify setup options.
Setup Maintenance — Print setup reports, modify setup options.
Setup Maintenance and Transaction Inquiry — View statistics, print
setup reports, modify setup options.
Setup Maintenance — Print setup reports, modify setup options.
Setup Maintenance and Day End Processing (I/C) — Print reports,
modify setup options, view sales history and salesperson statistics.
Import Processing and Setup Maintenance — Print setup reports,
import setup options.
Transaction Inquiry — View orders, print reports, view statistics.
Import Processing and Invoice Entry — Import and add orders,
view posted invoices.

Import Processing and Credit Note Entry — Import and add credit
notes, view posted credit notes.
Export Processing and Setup Maintenance — Print setup reports,
export setup options.
Export Processing and Invoice Entry — Export orders, view posted
invoices.
Export Processing, Setup Maintenance, and Transaction Inquiry
— Export orders, print setup reports, view, export and print setup
options, view posted invoices, view posted credit notes, view sales
history and statistics.
Invoice Entry — View and modify orders, view invoice statistics.
Note: If you use Payment Processing, you must have Invoice Entry
authorization in order to pre-authorize and process credit card
transactions in Order Entry.
Invoice Printing — Print invoices and salesperson commission rates
report.
Invoice Entry and Receipt Entry (A/R) — View statistics, modify
orders, invoices and prepayments.
Credit Note Entry — Enter credit notes, view credit note statistics.
Credit Note Printing — Print credit notes and salesperson
commission rates report.
History Clearing — Clear history.
History Clearing and Day End Processing (I/C) — Clear history,
print reports, view, print, and edit sales statistics. Note: You can edit
statistics only if the option, Allow Edit of Statistics, is selected in the
O/E Options form
Order Confirmation Printing — Print order confirmations,
salesperson commission rates report.
Shipping Label Printing — Print shipping labels.
Picking Slip Printing — Print picking slips.
Quote Printing — Print quotes.

Unit Price Override — Change the unit price on orders, shipments,
and invoices.
Dashboard — View Order Entry dashboard.
See also
Steps for Setting Up Order Entry

E-Mail Messages Form
The E-Mail Messages form is located in the O/E Setup folder. You can
create messages to send with e-mailed order confirmations, quotes,
invoices, and credit notes. You can use replacement symbols from your
company database so that the e-mailed message will include customeror company-specific information.
Each message is identified with a unique 16-character message ID code.
When you select Customer as the Delivery Method on the order
Confirmation/Quote/Invoice/Credit Note forms, you can select the correct
Message ID for the message you are sending.

To create e-mail messages
1.Double-click the E-Mail Messages icon in the O/E Setup folder.
2.In the Message Type field, select Order Confirmation, Quote, Credit
Note, or Invoice on the drop-down list. (The description appears
automatically when you choose a type.)
3.In the Message ID field, enter a code, using up to 16 characters.
4.Enter a subject in the E-Mail Subject field. Note that you can use email replacement symbols (variable names) in this field. They will be
replaced by data from your database when you send an e-mail
message using this message ID.
5.Type your message, using replacement symbols if you wish.
6.Click Add or Save when you are satisfied with your message.
See also
Replacement symbols for e-mail messages

Using the G/L Integration Form
Use the G/L Integration form to:
Specify whether to add general ledger transactions to the G/L batch
during posting or each time you run Day End Processing, or to create
the transactions at a later date.
Note: This choice can have a large impact on the speed of
processing transactions in Order Entry, especially if you are costing
inventory during posting (in which case, you may want to create
transactions at a later date).
Choose whether to create a separate G/L batch each time you create
the G/L batch (and optionally automatically post the batch) or add new
transactions to the existing batch. (This option applies only if you use
Sage Accpac General Ledger with Order Entry at the same location.)
Choose whether to consolidate the G/L batch when you post, or
always enter full transaction details in the batch.
Assign different source codes to general ledger transactions created
by Order Entry and added to G/L batches. (New source codes are
automatically added to G/L, but you will have to update G/L source
journal profiles to include transactions on source journals.)
Select the information to appear in the Entry Description, Detail
Description, and Detail Reference and Comment fields in G/L
transactions arising from invoices and shipments. (This information
appears for transactions in the G/L Transactions report.)
Look up the last Day End Number for which you have created general
ledger batches.
Click the field list button or the link below for more information on
selecting G/L integration options.
Transactions tab

Changing Settings
You can change any of your choices on the G/L Integration page at any
time. However, you should be aware that any changes you make will

apply only to general ledger transactions created after the change, and
will not affect existing general ledger batches.
If you want to change from using the Create Batch form to produce your
general ledger transactions to creating them during day-end processing,
be sure to run Create Batch to process any outstanding transactions first,
to avoid accidentally omitting transactions from your general ledger
batches.

Before Using the G/L Integration Form
Before changing any of the settings or other information in the G/L
Integration form, make sure you understand the impact the options have
on processing within Order Entry.
Note: You cannot change settings on the Integration tab of the G/L
Integration form if other Order Entry forms are open, or other users are
working with the Inventory Control database.
Make sure that no one else is using the Order Entry data and that no
other Order Entry forms are open for the company before you save
changes to the G/L Integration form.

A/R integration option is set in the O/E Options
form
Order Entry also lets you choose when to post Accounts Receivable
batches arising from invoices posted in Order Entry.
To specify when to post A/R batches generated from Order Entry
Invoices, credit notes and debit notes, use the option Post A/R Batches During Posting
or Day End Processing/On Request Using Create Batch Icon.
See also
O/E Options form
Miscellaneous Charges
Ship-Via Codes
Steps for setting up Order Entry
Templates

Miscellaneous Charges Form — Overview
Use this form to:
Add records to identify the miscellaneous charges (such as service
charges) used in your Order Entry system.
Edit and delete existing miscellaneous charge records.

Multicurrency ledgers
If you use multicurrency accounting, you need to specify a currency code
for each miscellaneous charge. You can use the same miscellaneous
charge code for charges in different currencies.
After adding or changing miscellaneous charge codes:
Print the Miscellaneous Charges report to check the new record information and
to update your printed records.
Print the Transaction list for orders (including the order details) to check that
no orders use miscellaneous charges that you have deleted. Edit the
orders if necessary.

Integration with Project and Job Costing
Miscellaneous charges can have two different functions on job-related
orders:
Let you add additional charges to customer orders for invoicing
external charges such as freight (UPS or FedEx).
Let you record internal non-material transactions such as equipment,
subcontractors, labor, etc.
To create miscellaneous charges for job-related orders, you must select
the Allow For Jobs option on the Miscellaneous Charges form, and then
specify:
An extended cost.
For each project in PJC, you can choose to use this cost by default or
use the contract cost.
A miscellaneous charge expense account.

A miscellaneous charge clearing account.
You can also choose by project in PJC whether to use the amount
specified here for the miscellaneous charge or use a default billing rate
for the contract.
Click here for tips on using forms in Order Entry.

See also
Adding miscellaneous charges
Options form - overview
Ship-Via Codes form
Templates - form
Using Order Entry with Project and Job Costing
Steps for setting up Order Entry

Optional Fields Setup
You must install Sage ERP Accpac Transaction Analysis and Optional
Field Creator before you can add optional fields for Order Entry
transactions.
Optional fields must be added first in Common Services, and then
assigned to Order Entry transactions and forms.
You assign optional fields to Order Entry transactions and forms using
the Order Entry Optional Fields setup form.
To assign optional fields:
1.Open the Optional Fields setup form located in the O/E Setup folder.
2.

.

Select a type from the Optional Fields For list

3.Click the Finder in the Optional Fields column. The Finder searches
for optional fields created in Common Services.
4.Select an optional field, and click Select.
5.Using the Finder in the Default Value column, select a value that has
been defined in Common Services for that optional field, or enter a
value.
6.Switch the Auto Insert column to Yes if you want the optional field and
value to appear automatically in the transaction form. (Note that, for
users with security access, they can add optional fields to
transactions even when this option is set to No.)
7.Click the Settings button to select the G/L accounts and other subledgers that
this optional field will be passed to.
8.Click Add. (Click Save if you added more optional fields and values to
a type for which you had already assigned an optional field and
value.)
9.Repeat for all the types for which you want optional fields.
When you open a transaction form, you see the optional field information
if you chose Auto Insert. If you chose No in the Auto Insert field, you can
still select an optional field in the transaction by adding them in the

Optional Fields tab. You can also add optional fields for details in the
Optional Field column in detail grids.
See also
Adding optional fields to orders
Adding optional fields to shipments
Adding optional fields to invoices
Adding optional fields to credit/debit notes
Assigning Optional Fields in the Copy Orders Form
Adding/Deleting Optional Fields

Options Form — Overview
You select options when you create your Order Entry ledger. Once you
have set up your ledger, use this form when you need to change your
selections.
Use this form to:
Specify the contact name, telephone number, and fax number for your
Order Entry ledger. (Use the Company tab.)
Look up your choice for the Multicurrency option and select other
options that determine how your Order Entry system operates. (Use
the Processing tab.)
Specify the prefixes and next numbers to use when you let Order
Entry automatically assign document numbers for orders, invoices,
and credit notes.
For information on the settings for integrating Order Entry with the
General Ledger program, see G/L Integration.
You choose the Options form from the O/E Setup folder.

Before using
Before changing any of the settings or other information in the Options
form, make sure you understand the impact the options have on
processing within Order Entry.
Before saving changes to the Options form, make sure that no other
Order Entry forms are open for your database on your computer or on
any other computer on a network. You cannot change most of your
choices in the Options form if other Order Entry forms are open, or other
users are working with the Order Entry data.

Changing settings
After setup, you can change any of the selections and information you
entered on the Options form, with the following exception and restrictions:
You cannot change the choice for the Multicurrency option. You make
the selection for this option in the Accounts Receivable Options form,
and can change your choice only in Accounts Receivable. (Note that
you cannot turn off the Multicurrency option once you have selected it
and saved your changes to the Accounts Receivable Options form.)
You can change the type of year (fiscal or calendar) and period by
which you accumulate item statistics (in the Enterprise and Corporate
Editions), but you should do so only at fiscal or calendar year end.
If you change either method part way through a year, the statistics
already accumulated will be incorrect or in the wrong period.
Click the links below for help using the corresponding tabs:
Company

Processing

Documents

Click here for tips on using forms in Order Entry.

See also
G/L Integration
Miscellaneous Charges
Ship-Via Codes
Templates
Steps for setting up Order Entry

Ship-Via Codes Form — Overview
Use this form to:
Add ship-via codes to identify the shipping methods or carriers you
use to deliver goods to customers (for example, courier, air mail,
parcel post).
Edit and delete existing codes.
Click here for tips on using forms in Order Entry.

After changing ship-via codes
Print the Ship-Via Codes report to check the new information and to
update your printed records.
Print the Templates report to check that no Order Entry templates use
ship-via codes that you deleted. Edit templates if necessary.
Print the Transaction list for orders (including the order information) to
check that no orders use ship-via codes that you deleted. Edit the
orders if necessary.
See also
Adding ship-via codes
Deleting ship-via codes
Editing ship-via codes
Miscellaneous Charges
Options
Templates
Steps for setting up Order Entry

Templates Form — Overview
Use this tab to:
Speed up and simplify order entry by setting up templates to provide
default settings which appear when you add a new order or credit
note.
For each template, you must specify the order type and customer type.
The other information in a template is optional.
Click here for tips on using forms in Order Entry.

Click the links below for help on using the corresponding tabs:
Order

Customer

After adding or changing templates
Print the Templates report to check the new information and to update
your printed records.
See also
Adding templates
Deleting templates
Editing templates
Miscellaneous Charges
Options
Ship-Via Codes
Steps for setting up Order Entry

Order Entry Folders
The following list includes the name of each Order Entry icon that you
can select from the Sage ERP Accpac Company desktop. Select one of
the keywords below for more information on these icons.
Forms folder
Credit/Debit Notes
Invoices
Order Confirmations
Picking Slips
Quotes
Shipping Labels

Periodic Processing folder
Clear History
Create Batch

Reports folder
Aged Orders
E-mail Messages
G/L Integration
G/L Transactions
Invoice Action
Miscellaneous Charges
Optional Fields
Options
Order Action
Posting Journals
Sales History
Sales Statistics
Salesperson Commission Rates
Salesperson Commissions
Ship-Via Codes
Templates
Transaction List

Setup Folder
E-Mail Messages
G/L Integration
Miscellaneous Charges
Optional Fields
Options
Ship-Via Codes
Templates

Statistics and Inquiries Folder
Current Orders Inquiry
Pending Shipments Inquiry
Sales History
Sales Statistics
Salesperson Inquiry

Transactions Folder
Copy Orders
Credit/Debit Note Entry — Overview

Order Entry — Overview
Invoice Entry — Overview
Shipment Entry — Overview

See also
Order Entry menu commands

Changing Column Order in Data Entry forms
You can permanently or temporarily change the order in which columns
appear on many Sage ERP Accpac forms.
For example, you can change the order of the Payment Entry detail
columns to match the field order of a document from which you are
entering data.

To move a column
1.Point at the column heading.
2.Hold down the left mouse button
3.Move the column to its new location
4.Release the button.

To restore your original settings
From the Sage ERP Accpac Desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.
The columns will be in the original order the next time you open the form.
See also
Order Entry Folders
Order Entry menu commands

Changing Column Widths in Data Entry Forms
Double clicking on the division between columns resizes the column on
the left to its minimum size based on the data it contains.

To change the width of columns
1.Position the mouse pointer on the vertical line separating a column
heading from the next heading to the right.
2.Drag the column to the right (to make the column wider) or to the left
(to make it narrower).
3.When you reach the width you want, release the mouse button.

To restore your original settings
From the Sage ERP Accpac Desktop menu bar, select the icon for the
form you changed, then click Object, Restore Defaults, then All Other
Settings.
The columns will be in the original order the next time you open the form.
See also
Order Entry Folders
Order Entry menu commands

Data Entry Tools and Shortcuts
Order Entry data entry forms contain many aids to data entry which you
can activate by selecting a menu command, pressing a function key, or
clicking an icon.
Select the icon or command listed below for which you want information:
Finder

New

Previous/
Next

Drill Down

or

or

Go

Zoom

See also
Order Entry Folders
Order Entry menu commands

File Menu
The File menu appears in most Order Entry forms. The File menu in each
form contains some or all of the following commands:
Print

Prints the current report, list, or form.

Print Setup

Selects a printer and sets printing options.

Customize

Lets you hide or display fields depending on the user.

Import

Imports the data records you specify from other Sage ERP
Accpac databases and from non-Sage ERP Accpac
programs to Order Entry.

Export

Exports the data records you specify from Order Entry to
other Sage ERP Accpac databases and non-Sage Accpac
programs.

Close

Closes the current form.

Save

Saves the entries or changes you have made to the
current form.

See also
Order Entry Folders
Order Entry menu commands

Help Menu
The Help menu contains the following commands.
Contents
Starts Help and displays the topics in Order Entry Help.
Using Help
Describes how to use Help.
About...
Displays version, mode, and copyright information about Order Entry.
See also
Order Entry Folders
Order Entry menu commands

Settings menu
A Settings menu appears on all transaction entry forms and on several
report forms. For report settings, see O/E Form and Report Settings.

Transaction Entry Settings
The Settings menu provides the following options on transaction entry
forms:
Auto Clear
The Auto Clear option helps you to streamline data entry in transaction
entry forms.
Select the Auto Clear option to start a new entry automatically when you
add a transaction.
If this option is turned on, the program automatically clears all fields
each time you post a transaction, and returns the cursor to the NEW
field to let you start a new transaction.
If this option is turned off, the program leaves the transaction
information on the screen after posting. Click the New button to start a
new transaction.

O/E Form and Report Settings
Save Settings As Defaults / Clear Saved Settings
This setting lets you save the current report settings as personal defaults
or restore the program's original settings. It appears in the menu for
Order Entry forms and for several Order Entry reports, including the
Transaction List, Order Action Report, Aged Orders, Invoice Action, and
Sales History.
To save the current settings as your personal defaults for the form, select
the Save Settings As Defaults option.
To revert to the program's original settings, select the Clear Saved
Settings option.
See also
Order Entry Folders
Order Entry menu commands

Processing Orders, Shipments, and Invoices
Order Entry matches your company's order processing needs by
providing three separate transaction entry forms for entering orders,
shipments, and invoices.
For example:
You can separate your order processing, shipping, and invoicing
functions.
Or
You can enter quotes, orders, shipments, and backorders on the
Order Entry form and automatically create invoices for shipped
quantities.
Or
You can directly enter shipments and print invoices on the spot —
without entering orders first .
See the following topics on this page:
Processing Orders and Quotes
Processing Shipments
Processing Invoices
Job-Related Orders and Invoices

The information used in orders, shipments, and invoices is very similar,
with the following exceptions:
Shipments and invoices contain only the items that you have shipped
on an order or miscellaneous charges.
Payment details appear on the invoice, so if you specify a multiple
payment schedule, you will confirm all of the payment details when
you invoice the customer (such as the due dates).
If you use Payment Processing, you can process (and void) credit
card prepayments from the Order Entry, Shipment Entry, and Invoice
Entry forms. However, you can pre-authorize credit card transactions
(and void pre-authorized credit card transactions) only from the Order
Entry form.
When you select a shipment for invoicing in the Invoice Entry form, the
details from the shipment are copied to the invoice you are entering.

Processing Orders and Quotes
You enter orders and quotes using the Order Entry form. To save time, you can
also use the Copy Orders form to copy the details of existing orders for a
selected customer to a new order.
To add an order or a quote, you enter:
.

Order and customer information

Detail information for inventory items and miscellaneous charges.
.

Optional field information

.

Sales split information
Exchange rates

.

.

Tax information

.

Prepayment information

If you use Payment Processing, you can pre-authorize or process a credit
card prepayment for an order. For more information, see Enter a Prepayment.
For information on verifying order totals, see:
Verifying order totals
Return to Top

Processing Shipments
If you process shipments after entering orders, you record the shipment
using the Shipment Entry form. You can enter any number of shipments for an
order, until the order is fully shipped.
If you process shipments while entering orders, you can enter shipped
quantities directly on the order.
Order Entry lets you process a single shipment document for one order
number or for multiple orders, but you can ship items only until an order is fully
shipped. (Details that are fully shipped are not available for future
shipments.)
When you select an order for shipment on the Shipment Entry form, the
details from the order are copied to the shipment transaction you are

entering.
If you use Payment Processing, you can process a credit card
prepayment for a shipment, or capture a pre-authorized credit card
payment for an order.
Note: If you use Payment Processing, you must capture or void all
outstanding credit card pre-authorizations for any orders that are
included in the shipment before you can post the shipment.
Shipment Entry lets you edit shipment transactions until the order is fully
shipped. You can delete details, and you can edit most of the detail
information for a shipment, except the item numbers and the quantities
committed to the order. You can also enter a negative quantity on a
shipment transaction. You cannot enter new detail lines, however.
To create an invoice automatically when you post a shipment, select the
Create Invoice option on the Totals tab of the Shipment Entry form. Then,
in the Invoice Number field that appears, either type an invoice number or
accept the ***New*** entry to have the program assign the next
sequential invoice number.
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Processing Invoices
You can create invoices automatically when you ship goods — either with
the Order Entry form or the Shipment Entry form. You create the invoice
by selecting the "Create Invoice" option on the Shipment tab or on the
Totals tab when you create a shipment. You can print the invoice when
you post the shipment.
You use the Invoice Entry form to process invoices for shipped items or
miscellaneous charges if you create invoices as that separate function
from shipping goods.
If you use Payment Processing, you can process a credit card
prepayment for an invoice.
Order Entry lets you process a single invoice for one shipment or for multiple
shipments, but only until the shipment is fully invoiced. (Details that are fully
invoiced are not available for future invoices.)

For information on producing invoices, see:
Invoice an order
Verifying invoice totals
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Job-Related Orders, Shipments, and Invoices
If you use Sage ERP Accpac Project and Job Costing, you can create
and process job-related orders that allocate inventory items, labor costs,
and miscellaneous charges to particular contracts, projects, and
categories that are tracked in the Project and Job Costing program.
Quotes and new contracts
Order Entry lets you create new contracts in PJC when you enter a new
quote. New contracts can be based on existing contracts, so you can
create template contracts containing standard items and costs. Amounts
entered on quote detail lines will appear as original estimates in the
Contract Maintenance form in Project and Job Costing.
When you change the order from Quote to Active, Order Entry will update
Project and Job Costing line-by-line to change the status of each
referenced project from Estimate to Open.
Service orders for existing contracts
You can also process orders and invoices in Order Entry for long-term
contracts and let Project and Job Costing track all of the costs and
revenues.
For example, you may have year-long service contracts but invoice
clients for each service call. For each service call, you could activate a
standing order with standard call details, change it as required, and then
issue the invoice.
Project Invoicing
The Project invoicing option lets you invoice job-related orders in Order
Entry or from Project and Job Costing.
If you select the project invoicing option, all of the billing for this order
will be handled by the Project and Job Costing program.

Order Entry will not create an invoice for this order, but will debit the
Work in Progress account when you ship the order and pass all
information to Project and Job Costing for it to process billings using
the Create Billing Worksheet form.
Negative shipments as credit notes: Order Entry allows negative
shipments if you are using project invoicing because you cannot post
a credit note for job-related, project invoicing documents. Negative
shipments provide credit note functionality for job-related project
invoicing.
If you do not select project invoicing, Order Entry invoices go to
Accounts Receivable, where the cost of sales and revenues are
posted together from A/R. Typically, service companies would invoice
from Order Entry, and close the jobs when they post the invoices.
Click here to see which projects can be invoiced in Order Entry.

Item details
You cannot mix job-related and non-job-related order details on the same
order.
For job-related orders, you must specify the quantity purchased, as well
as the contract, project, and category to which each item applies. The
contract, project, category and resource (if applicable) must exist in
Project and Job Costing.
More...

Miscellaneous charges
Miscellaneous charges perform two functions on job-related orders:
Allow you to invoice external charges, such as freight.
Record internal, non-material transactions, such as equipment use,
subcontractors, or labor.
You must select the Allow For Jobs option on the Miscellaneous Charge
setup form to use a miscellaneous charge on a job-related order.
More...

Multicurrency
If you are invoicing in Order Entry, O/E will pass functional cost amounts

and functional and source revenue amounts to Accounts Receivable.
If you are invoicing in Project and Job Costing (Project Invoicing is
selected), Order Entry will pass both functional and source cost amounts
and source revenue amounts to PJC. (Order Entry will calculate the
source cost by using the document currency and date for exchange.)
Taxes
Although Project and Job Costing allows tax groups to be specified by
project, if you are producing the invoice in Order Entry, the tax group
specified for the order applies to all contracts and projects listed in the
O/E document details. If you require different tax groups for different
contracts and projects, they will have to be entered on separate orders.
Note that this doesn't apply if the document is set for Project Invoicing —
the tax group of the project will be used to calculate the tax because the
invoice will be generated in Project and Job Costing.
Return to Top

See
Using Order Entry with Project and Job Costing
Setting Up Miscellaneous Charges
Entering Item Details
Entering Miscellaneous Charge Details
Journal Entries Generated by Posted Transactions

See also
Invoice Entry form — overview
Order Entry form — overview
Shipment Entry form — overview
Using Order Entry templates

Entering Prepayments
You can enter as many prepayments as you wish to active orders, future
orders, and shipments. You can also enter one prepayment for each
invoice you produce. The prepayment information is printed on the
transaction lists and the posting journals.
If you use Payment Processing, you can process a credit card
prepayment for an order, shipment, or invoice. You can also preauthorize a credit card payment for an order, and then capture the
payment when you ship the order. For more information, see Entering a
Prepayment.
You can see the total prepayment amount on the Totals tab, and you can
print prepayment details on the order, shipment, and invoice transaction
lists and on the Invoice Posting Journal.
Once you enter and post a prepayment, you cannot change it in Order
Entry. If you need to change the amount of the prepayment (or other
information), you must adjust the receipt in Accounts Receivable.

Choosing the Accounts Receivable batch
When you enter a prepayment, you can choose an existing Accounts
Receivable receipt batch, or you create a new receipt batch to include the
prepayment. If you choose an existing batch, Order Entry checks the
batch status. If the batch is not available (for example, if it has been
deleted or posted), Order Entry displays an error message.
If you create a new batch, Accounts Receivable assigns the batch
number. You enter the description, date, and bank code.

Choosing the deposit number
When you create a new receipt batch, you assign a deposit number to
the batch. You cannot edit the number once you add the first receipt to a
batch.
You can:
Assign a new deposit number to the receipt batch. Click the New

button beside the Deposit Number field to let the program assign the
next deposit number.
Assign an existing deposit number to the batch. Use the Finder to
select an existing deposit number (for example, to consolidate a
number of receipt batches into one bank deposit).
If you leave the field blank, the program assigns the next deposit number
when you add the first receipt to the batch.

Prepayments on invoices
If you enter a prepayment for an invoice, the amount of the prepayment is
displayed in the Totals tab before you post the invoice. The amount of the
prepayment is included in the credit limit check for the customer, and it
immediately reduces the amount due on the invoice you print from Order
Entry. Note, however, that the amount is not added to the order
prepayment amount kept with the order.
If you use Payment Processing, you can process a credit card
prepayment for an invoice. For more information, see Process a Credit Card
Prepayment.

Prepayments on orders and shipments
If you are not invoicing the order or shipment, the prepayment total for
the document is displayed on the Totals tab. The prepayment total is
included in the credit limit check for the customer, but it does not reduce
the amount of the next invoice you create. You can see the total
prepayments to date on the Totals tab.
Prepayments on orders and shipments are matched to invoices in
Accounts Receivable using the order number.
If you use Payment Processing, you can use Order Entry forms to preauthorize, capture, and process credit card payments as follows:
Use Order Entry to pre-authorize or process a credit card
prepayment, or to capture a pre-authorized prepayment for an order.
Use Shipment Entry to capture a pre-authorized credit card payment,
or to process a new credit card prepayment for a shipment.

Use Invoice Entry to process a credit card prepayment for an invoice.
For more information, see Process a Credit Card Prepayment and Pre-authorize a Credit Card
Payment.

Prepayments on job-related orders and invoices
If you are entering a prepayment for a job-related order, shipment, or
invoice, you must also distribute the prepayment to individual
order/invoice detail lines.
Click the Jobs button on the Prepayments form to display the
Prepayment Details form for job-related orders, shipments, and invoices.
You can manually distribute the payment amount to job details, or you
can let the program prorate payment amounts to details or allocate the
payment starting with the first detail (top-down method).
See also
Enter a prepayment
Process a credit card prepayment
Pre-authorize a credit card payment
Information entered with prepayments
Multicurrency prepayments

Pre-authorizing, Capturing, and Forcing Credit
Card Payments
If you use Payment Processing, you pre-authorize a credit card payment
when you want to verify that sufficient credit exists on a customer's credit
card before processing a sale. When you create a pre-authorization, the
cardholder's credit limit is reduced by the amount of the pre-authorization
until the pre-authorization is captured or expires.
After pre-authorizing a payment, you can capture (process) the payment
or void the pre-authorization. If the pre-authorization has expired recently
(typically within 30 days), you may also be able to force a payment for the
pre-authorized amount.

Pre-authorizing Payments
On the O/E Order Entry form, you can click the Pre-authorize button to
pre-authorize a credit card payment. For more information, see Pre-authorize a
Credit Card Payment.
The amount of a pre-authorization does not need to match the amount
captured in the final sale. The captured amount may be more (as when a
restaurant customer adds a tip) or less (as when a service station
customer swipes a credit card, and then purchases fuel that costs less
than the amount pre-authorized for a fill-up).
Important! If it is likely that more than seven days will pass before an
order is shipped, you should not pre-authorize a credit card payment for
the order. If you do, the pre-authorization may expire, in which case your
merchant service provider will charge a fee. (Credit card preauthorization in Sage Payment Solutions expires after approximately
seven days.)

Capturing Pre-authorized Payments
You capture a pre-authorized credit card payment when you are ready to
process payment for goods that you have shipped, or for goods or
services that a customer has received.
On the O/E Order Entry and O/E Shipment Entry forms, you can click the
Capture button to capture (process) a pre-authorized credit card
payment. For more information, see Capture a Pre-authorized Credit Card Payment.
You can capture a pre-authorization only once. After you capture it, the
pre-authorization is released in full, regardless of whether the amount
captured matches the amount that was pre-authorized.

Forcing Payment for Expired Pre-authorizations
If a pre-authorization has expired, you may be able to force a payment for
the pre-authorized amount.
Note: Forced transactions may be subject to higher fees than regular
transactions, depending on the terms of your agreement with your
merchant service provider.
You can force a payment only if the pre-authorization has expired
recently (typically within 30 days), and if you used a saved credit card for
the pre-authorization (that is, you did not select the Enter A Card For
One-Time Use option when processing the pre-authorization).
When you attempt to capture an expired pre-authorization, if the preauthorization meets the above criteria and can be forced, a message
appears and gives you the option to force payment. If you cannot force
payment, a message informs you that you must create a new preauthorization or prepayment.

Voiding Existing Pre-authorizations
On the O/E Order Entry form, you can click the Void button to open the
Pre-authorization form, and then click Void to void an existing preauthorization. For more information, see Void a Credit Card Pre-authorization.
Merchant service providers charge a fee for voiding a credit card preauthorization. However, this fee is lower than the fee that is charged if
you do not void or capture a pre-authorization and allow it to expire. For
this reason, we recommend that you void any pre-authorization that will
not be captured.
See also
Enter a prepayment
Process a credit card prepayment
Pre-authorize a credit card payment
Capture a pre-authorized credit card payment
Void a credit card pre-authorization

Processing Credit/Debit Notes
Use the Credit/Debit Note Entry form to enter credit notes and debit notes.
You can enter credit notes to credit a customer's account for returned
merchandise, damaged items, or price reductions, to correct an error on
an invoice, or to post a debit or a credit for a miscellaneous charge.
All Order Entry credit notes and debit notes affect sales amounts. If you
do not want to affect any Order Entry or Inventory Control amounts or
statistics, enter the credit note in Accounts Receivable.
You can credit an entire invoice, part of an invoice, create a debit note or a credit note for a nonexistent or cleared invoice, or for an existing invoice.
Note: You cannot post a credit note for job-related, project invoicing
documents. Because of this, Order Entry lets you enter negative
shipments to provide credit note functionality for job-related project
invoicing.
For each detail line to be credited on the invoice, you select the credit
type:
Items returned to inventory
Damaged items
Price adjustment (increases or decreases)

For more information on producing credit notes, see:
See also
Assign Lot Numbers or Serial Numbers to an O/E Debit Note
Assign Lot Numbers or Serial Numbers to an OE Credit Note
Credit/Debit Note Entry - Overview
Day End Processing

Using Order Entry with Project and Job Costing
Order Entry provides sales order integration with Project and Job
Costing.
You can create an order and specify the job (contract, project, category,
and resource, if applicable) to which each order detail applies.
If an order is job-related, all detail lines on the order must be jobrelated.
Orders can list material details—items from inventory used on the job
—and they can list miscellaneous charges, which can be labor,
subcontracting charges, or charges such as shipping and handling.
This topic discusses the following aspects of Project and Job Costing
integration:
Project Invoicing
Quotes and estimates
Order detail lines
Miscellaneous charges
Taxes
Prepayments
Accounts Receivable integration
Purchase orders created from job-related sales orders
Double-recording item costs or miscellaneous charges
Determining prices
Cost of kitting items in job-related orders
Doing project invoicing with non-existing customers
See also

Project invoicing
Order Entry lets you handle the complete order processing cycle in Order
Entry, or create the order in Order Entry and manage the billing and
invoicing in Project and Job Costing (called Project Invoicing).
Service providers normally invoice directly from Order Entry.
A series of service calls can apply to a single project, or you can
create new projects for each call. Order Entry lets you create new
contracts on-the-fly when you create new quotes. The details for each
new contract can be copied from an existing template.
Click here to see which contract/project types can be invoiced in Order Entry.

Companies with more lengthy or complex projects, such as
construction companies, normally use project invoicing, and will likely
process additional costs through the Accounts Payable program.
Posting the shipment in Order Entry completes the transactions for
O/E. The transaction is sent to Project and Job Costing, where it
calculates the extended billing amount and the cost portion of the
order.
You can then process the billings for the transaction using Project and
Job Costing's Create Billing Worksheet.
One of the most important processing decisions is how you are going to
invoice orders/jobs.
Also note:
If the invoice needs to be created in Project and Job Costing, Order
Entry will complete the order when you post the shipment, and
prevent you from invoicing in Order Entry.
If you delay invoicing in Order Entry, the transaction will be sent to
Project and Job Costing as unbilled, and you will have to create the
invoice in Project and Job Costing or bill from Accounts Receivable.
Retainage accounting
You can choose retainage accounting if you are creating the invoice in
Order Entry. If you creating the invoice in Project and Job Costing, you

cannot select retainage accounting in O/E, because you will be
determining invoice amounts in PJC.
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Quotes and estimates
Contracts created from Order Entry quotes start as estimates in Project
and Job Costing, and all Order Entry detail line amounts that you add will
update contract estimate amounts when you post the quote in Order
Entry. (The contract can have an Open status, but the project status
must be Estimate.)
When you change the order type to Active and post the order, Order
Entry changes the project status to Open for each project to which you
posted a detail.
Return to Top

Order detail lines
Each detail line on a job-related order must be applied to an existing cost
category in an open contract and project.
Item details assign inventory items to jobs, so the category cost type to
which they apply must have a material cost class.
Miscellaneous charge detail lines let you assign costs for all other cost
classes — labor, equipment, subcontractor, overhead, and miscellaneous
cost.
Setting up the Project and Job Costing side includes:
Deciding how you are going to invoice customers—in Order Entry or
in Job Costing.
Click here to see which contract/project types can be invoiced in Order Entry.

Set up contracts and projects.
You can set up template jobs that you can copy for each new order
using the New Contract Wizard in Order Entry. (See Using the New Contract
Wizard.)
Or
You can set up jobs that are used by groups of orders.
For each project:
Choose whether the default cost for miscellaneous charges
comes from the miscellaneous charge record or from the
contract.
For accrual-basis or billings and costs projects, choose
whether the billing rate comes from the contract billing rate,
from the customer price list, or from a price list specified for
the project.
Adding the cost categories and the employee resources, equipment,
subcontractors, overhead, miscellaneous costs, and materials.
Setting up Order Entry includes:
Adding miscellaneous charges for employee resources, equipment,

subcontractors, and miscellaneous costs that you want to include on
job-related orders.
Selecting the Allow For Jobs option on job-related miscellaneous
charges.
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Miscellaneous charges
Miscellaneous charges perform several functions on job-related orders:
They let you record internal non-material transactions such as
equipment, subcontractors, labor, etc.
They let you add charges to customer orders for invoicing external
charges such as freight (UPS or FedEx).
To create miscellaneous charges for job-related orders, you must select
the Allow For Jobs option on the Miscellaneous Charges form in Order
Entry, and then specify:
An extended cost.
For each project in PJC, you can choose to use this cost by default or
use the contract cost.
A miscellaneous charge expense account.
A miscellaneous charge clearing account.
Miscellaneous charges can be assigned to categories with any cost type
except material. You must use item detail lines on orders for material cost
types.
Note that you can choose by project in Project and Job Costing whether
to use the amount specified in Order Entry for the miscellaneous charge
or use a default billing rate specified for the contract in PJC.
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Taxes
Although Project and Job Costing allows tax groups to be specified by
project, if you are producing the invoice in Order Entry, the tax group
specified for the order applies to all contracts and projects listed in the
O/E document details. If you require different tax groups for different
contracts and projects, they will have to be entered on separate orders.
Note that this doesn't apply if the document is set for Project Invoicing —
the tax group of the project will be used to calculate the tax because the
invoice will be generated in Project and Job Costing.
Return to Top

Prepayments
When you record job-related prepayments, you also distribute the
payment amount to the details on the order.
Order Entry lets you automatically prorate payment amounts to individual
details or do a "top-down" distribution, starting at the first job-related
detail, or you can edit the payment distribution amounts yourself.
Return to Top

Accounts Receivable integration
If you are invoicing orders in Order Entry, Day End Processing will send
Order Entry invoices to Accounts Receivable, where the costs and
revenue are posted together in Accounts Receivable.
When Order Entry creates the invoice, it does not use the Work in
Progress account and Billings accounts to post the costs and revenue;
instead, it uses the Cost of Sales and Revenue accounts defined in the
project or the category.
The Order Entry invoices posted in Accounts Receivable are treated like
a billing worksheet in PJC, where the cost transactions are marked as
billed and will not appear on the Aged WIP Report.
See Journal Entries Generated by Posted Transactions.
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Purchase orders created from job-related sales
orders
If you are creating Purchase Orders from orders entered in the Order
Entry program and the details are job-related, Purchase Orders will
remove the job-related fields when it creates the PO. It does this to
prevent Receipt Entry from using the Work In Progress account and
overstating WIP, which has already been debited with the order.
The entry for the receipt posted by Purchase Orders looks like this:
G/L Account
Debit
Credit
Inventory Control
Payables Control
Return to Top

X
X

Double-counting item costs or miscellaneous
charges
Processing errors can arise when you bill customers for external charges
— services or goods that are actually provided by a third party and that
you receive in Purchase Orders or record in Accounts Payable.
If you are processing goods or services for a job through several
accounting programs, you must decide which programs are going to
record the costs and assign them to jobs.
For example, if you enter a job-related PO in Purchase Orders, and
assign items to a specific contract, project, category, and resource (if
applicable), and then create a customer order in Order Entry and assign
the same items to the same contract, project, category, and resource, the
work in progress account will be overstated, (costs recorded twice) and
so will Contract Maintenance.
Similarly, if you enter a job-related order in Order Entry that includes a
shipping miscellaneous charge, and then process an A/P invoice for the
same charge and treat it as a job-related invoice, you will record charges
twice for the job.
If you are invoicing in Project and Job Costing, it might make more sense
to omit the miscellaneous charge on the order in Order Entry and record
the transaction in Accounts Payable. The shipping charge for the job will
then be picked up on the billing worksheet and included on the invoice
created in Accounts Receivable.
In any case, you have to decide when and how you want to transfer costs
to jobs, and then set up the procedures for processing those costs.
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Determining prices
How the price is determined depends on the project style, project type
and accounting method.
For the following projects and accounting methods:
> Time and Materials projects using the Billings and Costs or
Accrual-Basis accounting methods
> Time and Materials projects using the Completed Project
accounting method
> Fixed Price projects using the Billings and Costs or AccrualBasis accounting methods
You set the default source for the price using the Default Billing Rate field
on the Project tab in Contract Maintenance.
Select Use Customer Price List to use the price list assigned to the
customer.
Select Use Specified Price List to use a price list assigned to the
project.
Select Billing Rate to use the price specified in the contract:
If the project is a standard project, the billing rate assigned to the
item (material) resource (and customer) will be used as the default
unit price.
If the project is a basic project, the billing rate assigned to the
material category (and customer) will be used as the default unit
price.
If you are entering job-related orders or shipments where:
The Default Order UOM = Pricing Unit (set in the O/E Options
form).
and
The Default Billing Rate = Billing Rate (set for the project in
Project and Job Costing).
Order Entry will default the unit of measure from the current price
list, and then re-calculate the unit price based on the billing rate

specified in PJC Contract Maintenance.
Also note:
For Time and Materials projects using the Billings and Costs or
Accrual-Basis accounting methods
The project is billed at the category and resource level for standard
projects and the category level for basic projects, and you can create
the invoice in Order Entry or in Project and Job Costing.
For Time and Materials projects using the Completed Project
accounting method
You cannot invoice from Order Entry. Posting the shipment in Order
Entry completes the transactions for O/E, and the transaction is sent
to Project and Job Costing.
For Fixed Price projects using the Billings and Costs or Accrual-Basis
accounting methods
Invoices may be created in Order Entry or billing may be deferred to
Project and Job Costing to process using the Create Billing
Worksheet.
For all other Fixed Price and Cost Plus projects:
Posting the shipment completes the transactions for Order Entry and
sends the transaction to Project and Job Costing. once the project is
set to Complete, the PJC Billing Worksheet will process all the
transactions and create an invoice for the accumulated costs.
You can process the billings for the transaction using Project and Job
Costing's Create Billing Worksheet, or you can manually enter
invoices in Accounts Receivable.
The unit price is set to zero and only the costs are processed.
With Fixed Price because the price is set to a fixed price amount
for the project.
With Cost Plus because the cost is calculated when you post a
shipment and perform inventory costing using the costing method
assigned to the inventory items in Inventory Control.
> Fixed Price projects using the Completed Project accounting

method
Once the project is set to Complete, the PJC Billing Worksheet can
process all the transactions and create an invoice for the accumulated
costs up to the Fixed Price Amount.
> Fixed Price projects using the Project Percentage Complete
accounting method
Billing is determined on a project completion basis using the current
estimated costs and the actual costs and not on the purchase of
individual items.
> Cost Plus projects using Billings and Costs or Accrual-Basis
accounting method
The unit price is set to zero and only the cost portion of the order is
processed. The price is determined for billing in PJC using the actual
cost of items according to the costing methods assigned in Inventory
Control (and calculated by shipping and Day End Processing).
> Cost Plus projects using Total Cost Percentage Complete and
Category Percentage Complete accounting methods
The percentage of completion calculation is done during the Create
Billing Worksheet process in Project and Job Costing. The amount to
be billed is determined on a project or category percentage
completion basis using the current estimated costs and the actual
costs and not on the purchase of individual items.
> Cost Plus projects using Labor Hours Percentage Complete
accounting methods
The customer is billed at the project level. The percentage complete is
determined using the current estimated and actual quantity (labor
hours) for each category within the project as well as the cost plus
percentage for the category.
> Cost Plus projects using Completed Project accounting methods
Billing occurs when the project status is set to Completed and is
calculated using the Create Billing Worksheet in Project and Job
Costing.
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Cost of kitting items in job-related orders
Kitting items are treated differently in Project and Job Costing than they
are in Order Entry.
In Order Entry, a kitting item is a collection of separate items, where
revenue is recognized at the master level, but costs are recognized for
each item in the kit.
In Project and Job Costing, however, a kitting item is treated as a
single item for both revenues and costs.
This means that for job-related orders:
Order entry adds the cost of all kit components to create a single cost
for Project and Job Costing, so PJC can recognize one revenue
amount and one cost amount.
If you match transactions from Inventory Control with those from
Project and Job Costing, I/C will provide G/L with a string of
component cost entries, whereas PJC will provide G/L with a single
master cost.
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Doing project invoicing with non-existing
customers
If you create an order or shipment for a non-existing customer and you
select the project invoicing option, you will not be able to add order or
shipment details unless the default template includes a tax group. (The
tax group is not editable if you choose project invoicing, and it will be
blank unless it is specified in the template.)
Return to Top

See also
Journal Entries Generated by Posted Transactions
Setting Up Miscellaneous Charges
Setting Up Project and Job Costing Integration
Transaction Processing
Using the New Contract Wizard
G/L Accounts Used by Order Entry

Serial/Lot Numbers Allocation / Generation
Form
If you have a license to use Serialized Inventory and Lot Tracking, you
can allocate serial numbers and lot numbers to items that you sell and to
items that you return to inventory.
While serial numbers and lot numbers are maintained in Inventory
Control, you can use the O/E Order Entry, O/E Shipment Entry, Invoice
Entry, and O/E Debit/Credit Note Entry forms to allocate these numbers
to items. Also, when invoicing for a quantity that is different from the
quantity you shipped, you can allocate numbers using the Invoice Entry
form.
The Serial/Lot Numbers Allocation form appears when you enter a
quantity for a serialized or lotted item in the Order Entry, Shipment Entry,
Invoice Entry, and Credit/Debit Note Entry forms, and then press the Tab
key or click the Zoom ( ) button. It lets you assign serial numbers and lot
numbers to items that you sell in Order Entry.
Qty. Shipped is the default field for opening the allocation form. If you want to
open the form from the Qty. Ordered field, you need to select the options to do so in Inventory Control . (If your
system uses security, you must have Inventory Control Setup
Maintenance authorization to change these options.)
The Serial/Lot Numbers Generation form appears when you enter a
quantity in a credit note for a serialized or lotted item. It lets you identify
existing serial numbers and lot numbers, or generate new numbers, for
an item that you are returning to inventory. (You cannot assign lot
numbers or serial numbers for Damaged Item or Price Adjustment credit
types.)
The forms can display one or both of the following tabs, depending on
whether the item is serialized or lotted, or both. For information on these
tabs, click the following links:
Serial/Lot Numbers Allocation / Generation - Serials Tab
Serial/Lot Numbers Allocation / Generation - Lots Tab

See also

Assign Lot Numbers or Serial Numbers to an O/E Credit Note
Assign Lot Numbers or Serial Numbers to an O/E Debit Note
Assign Lot Numbers or Serial Numbers to an O/E Order
Assign Lot Numbers or Serial Numbers to an O/E Invoice
Assign Lot Numbers or Serial Numbers to an O/E Shipment
Understanding Serialized Inventory and Lot Tracking

Order Entry Form — Overview
Before you start

Use the Order Entry form to:
Enter, edit, and post orders, including active, standing, and future
orders, and quotes.
Enter prepayments for orders.
Enter quantities shipped, and create an invoice for shipped quantities.
Print quotes, order confirmations, receipts (for prepayments), and
invoices (if created for shipped quantities) immediately after posting.
Import and export orders.
Assign serial numbers and/or lot numbers if you have a license to use
Sage ERP Accpac Serialized Inventory and Lot Tracking.
If you use Payment Processing, pre-authorize credit card payments,
and process credit card prepayments.
You can also use the Shipment Entry form to ship posted orders and the
Invoice Entry form to invoice shipments if you separate the order entry, shipping,
and invoicing tasks.
For information about a tab, click the corresponding link, below:
Order

Customer

Taxes

Retainage

Optional Fields

Sales Split

Rates

Totals

For help on particular tasks, choose one of the following topics:
Change an order
Change payment terms
Change tax information
Create a new order
Create and activate a quote
Create a New Contract for a Quote
Edit currency exchange rates
Edit sales splits
Enter a prepayment
Pre-authorize a credit card payment
Capture a pre-authorized credit card payment
Void a credit card pre-authorization
Process a credit card prepayment
Void a credit card prepayment

Create a standing or future order
Enter taxes manually
Import orders
Print order confirmationsAssign serial or lot numbers to an order

Double-click the Order Entry icon in the O/E Transactions folder to add or
edit orders.
Use the buttons on the form to:
Post

the displayed order or invoice.

View history for the order.
Enter a prepayment for the order.
If you use Payment Processing, pre-authorize, capture, or void a credit card
prepayment.
Delete the displayed order.
Open the detail Items/Taxes form.
Close

the Order Entry form or a “zoomed” form.

To get help on fields in the Order Entry form, click the Field List button at
the top of this Help page.
To find out about other forms you can open from Order Entry, choose
from the following:
Customer Bill-To Address
Customer Ship-To Address
Item Detail Form
Serial/Lot Numbers Allocation
Pre-authorization form

See also
Credit/Debit Note Entry — overview
Printing Order Entry forms
Using the New Contract Wizard

Credit/Debit Note Entry — Overview
Use the Credit/Debit Note Entry form to:
Credit customer accounts for returned merchandise, damaged items,
and price adjustments.
Debit customer accounts for price adjustments and for additional
merchandise sent to the customer, if it was not included on an invoice.
Post a debit or credit for a miscellaneous charge.
Import and export debit notes and credit notes you created in another
Sage ERP Accpac Order Entry database or in a non-Sage ERP
Accpac program.
Assign serial numbers and/or lot numbers to items you remove from
or return to inventory, if you have a license to use Serialized Inventory and Lot
Tracking.
Note:
You can process credit note transactions for items that have been set
as Inactive in Inventory Control only if you are referencing an existing
invoice.
You cannot post a credit note for job-related, project invoicing
documents. Because of this, Order Entry lets you enter negative
shipments to provide credit note functionality for job-related project
invoicing.
To get help on any field in the Credit/Debit Note Entry form, choose the
Field List button (above).
For help on particular tasks, click here, and choose from the list that appears
Before you start

To start entering a credit note or a debit note:
1.Click the New button.
2.Enter or select the Customer Number.
3.Enter or select the invoice that you are adjusting.
Use the buttons at the bottom of the form to:

Post the displayed credit note or debit note.
View sales history for a customer or for an item.
Close the Credit/Debit Note Entry form, the “zoomed” detail form, or a
popup form.
Click here for tips on using forms in Order Entry.

Click the following links for information about tabs in the Credit/Debit
Note Entry form:
Credit Note/Debit Note
Optional Fields

Customer

Taxes

Retainage

Sales Split

Rates

Totals

See also
Order/Invoice Entry form — overview
Printing invoices

Shipment Entry Form — Overview
Use the Shipment Entry form to:
Enter and post shipments — for existing orders or without entering
orders first.
Add miscellaneous charges to existing orders.
Create invoices automatically for posted shipments.
Print picking slips and invoices (if you created an invoice) immediately
after posting shipments.
Import and export shipments.
Assign serial numbers and/or lot numbers if you have installed and
activated Sage ERP Accpac Serialized Inventory and Lot Tracking.
If you use Payment Processing, capture or void credit card
prepayments for orders.
Note:
You can skip the order process and enter items directly on a shipment
and automatically create the invoice. On a new shipment, enter the
customer number, and then add the item details. (Do not specify an
order number.)
You can recall and edit a shipment until you invoice it or until the order
is fully shipped.
For information about a tab, click the corresponding link, below:
Shipment

Customer

Taxes

Retainage

Optional Fields

Sales Split

Rates

Totals

For help on the History and Prepayment buttons that appear on the
Shipment Entry form, click the following links:
History... Prepayment...

For help on particular tasks, choose one of the following topics:
Assign Lot Numbers or Serial Numbers to an O/E Shipment
Change payment terms
Change tax information

Edit currency exchange rates
Edit sales splits
Enter taxes manually
Import shipments
Invoice a shipment
Print invoices
Ship an Order

If you use Payment Processing, process, capture, or void a credit card
prepayment.
Double-click the Shipment Entry icon in the O/E Transactions folder to
add or edit shipments.
For help on the Shipment Entry popup forms, choose from the following:
Customer Bill-To Address
Customer Ship-To Address
Item Detail Form

Use the buttons on the form to:
Post the displayed order or invoice.
Open the detail form (Item/Tax...).
Close the Invoice Entry form or a “zoomed” form.
Process or void a credit card prepayment, or capture a pre-authorized
credit card payment.
For help on fields and buttons in the Invoice Entry form, click the Field
List button at the top of this Help page.
See also
Credit/Debit Note Entry — overview

Invoice Entry Form — Overview
Use the Invoice Entry form to:
Enter and post invoices.
Enter prepayments for invoices.
Export invoices.
Print receipts (for prepayments) and invoices immediately after
posting.
If you use Payment Processing, process or void a credit card
prepayment for an invoice.
For information about a tab, click the corresponding link, below:
Invoice

Customer

Taxes

Retainage

Optional Fields

Sales Split

Rates

Totals

For help on the buttons that appear on the Invoice Entry form, click the
following links:
History... Prepayment...

For help on particular tasks, choose one of the following topics:
Assign Lot Numbers or Serial Numbers to an O/E Invoice
Change payment terms
Change tax information
Edit currency exchange rates
Edit sales splits
Enter a prepayment
Enter taxes manually
Export invoices
Invoice a shipment
Print invoices

Process a credit card prepayment
Void a credit card prepayment

Double-click the Invoice Entry icon in the O/E Transactions folder to add
or edit orders and to create invoices.
For help on the Invoice Entry popup forms (not the Serialized Inventory popups),
choose from the following:
Customer Bill-To Address
Customer Ship-To Address
Item / Taxes Form

Use the buttons on the form to:
Post

the displayed order or invoice.

Open the detail form (Item/Tax...).
Close the Invoice Entry form or a “zoomed” form.
To get help on fields and buttons in the Invoice Entry form, click the Field
List button at the top of this Help page.
See also
Credit/Debit Note Entry — overview
Viewing Posted Invoices

Copy Orders
The Copy Orders form lets you select an existing order, or a range of
orders, on which to base a new order. The details from the existing
orders, including item numbers, quantities ordered, pricing, and other
information, appear as defaults for the new order.
You can select the details you want to use in the new order, and you can
change the price list, location, ship date, quantity ordered, unit of
measure, and unit price for any detail line.
Note:
You cannot add new detail lines to an order.
You cannot create a new order with items that required price approval
on an original order. If any item on an original order required price
approval during processing, Order Entry displays an error message
when you click the Go button.
Price checks are set in Inventory Control price lists for particular
items, price lists, and Sage ERP Accpac user IDs.
If you change item prices after copying items, the Price Approval
field displays "Yes" if price checks are in effect for the item, and
the price you enter is outside the boundaries allowed.
You cannot select different item codes for the detail lines.
If you are copying job-related orders:
You cannot change the contract, project, or category.
You cannot create a job-related order from a job-related quote.
You cannot copy details from other order types to a quote if there
are open job details. Normally, to create new job-related quotes,
you set up a template quote and copy it each time you create a
quote.
You can:
Decide whether to copy or not copy a detail line.
Change the location, quantity, and price for an item/miscellaneous

charge.
Unit cost and costing unit
To create an order from an existing order, or orders.

View Posted Transactions
Overview
To look up posted transactions using the transaction entry forms:
To look up current orders by customer using the Current Orders Inquiry form:
To look up pending shipments by customer, item, and/or location using the Pending Shipments Inquiry form:
To look up invoices and credit notes by salesperson using the Salesperson Inquiry form:
Drilling down to O/E transactions from Accounts Receivable and General Ledger
Related topics

Current Orders Inquiry
This form lets you view all the posted sales orders for a selected
customer, and view orders based on order date, order type, and order
status.

To inquire on sales orders
1.Choose Current Orders Inquiry from the O/E Statistics and Inquiries
folder.
2.In the Customer Number field, enter the number for the customer
whose orders you want to review.
3.To limit the display to orders that meet certain criteria, specify a range
of order numbers, order dates, and expected ship dates.
4.Select the type of orders (Active, Future, Standing, or Quote) you are
inquiring on. You can also choose All if you wish to include all the
types of orders in the display.
5.Select the status of orders you are inquiring on (Posted,
Quote/Confirmation Printed, Picking Slip Printed, Never Invoiced,
Partially Invoiced, Never Shipped, Partially Shipped, Complete, or On
Hold). You can also choose All.
Note that if you shipped goods from an order and printed the picking
slip after posting from the Order Entry form, the print status of the
shipment will be set to “Picking Slip Printed,” but the print status of the
order will not be changed.
To update the status for orders, post the order but do not print the
picking slip. Instead, go to the O/E Forms folder, choose Picking Slips,
select the form you want, and change the Select By field to Order
Number. Print the picking slip, and the status will be correctly
updated.
6.Click the Go button ( ).
The program fills in the detail grid with information from the selected
orders.
7.To view all the details of one of the orders, select the order line and

click the Details button, or double-click the order line on the detail
grid.
The program displays the original order in the Order Entry form.
You can view all the order information in the Order Entry form,
including sales history for a selected item, but you cannot change the
order.

Pending Shipments Inquiry
This form lets you review items that are expected to ship within a given
time period (for example, in the next 7 days) and whether sufficient stock
is available for the shipments.
The inquiry ignores orders that are on hold, and you can limit the inquiry
to specific order types and to specific locations.
The inquiry also shows if open purchase orders exist for each item on
order, and allows you to zoom into existing POs to check the quantities
on order and the expected arrival dates.

To inquire on pending shipments
1.Choose Pending Shipments Inquiry from the O/E Statistics and
Inquiries folder.
2.In the Expected Shipment Date fields, leave the From field blank to
include all orders with outstanding items, and enter the end date for
the inquiry in the To field.
3.To view orders for a specific customer, enter the customer number in
the From and To fields.
4.To view orders for a range of one or more items, enter the starting and
ending item numbers in the From and To Item Number fields.
5.Select a range of locations, or skip the Location fields to display all
locations.
6.Select the types of orders that you want to review (All, Active, Future,
or Standing).
7.Click the Go button ( ).
The program fills in the detail grid with information from the selected
orders.
8.To view all the details of one of the orders, double-click the order line
on the detail grid, or select the line and click the Details button.
The program displays the unshipped order details from the original
order.

9.To check POs for the items on order, highlight the item detail line, and,
if the On PO field says "Yes", double-click the On PO field or click the
column heading Drilldown button.
The program displays purchase order information for the item,
including the PO number, quantity ordered, and expected arrival date.

Sales History Form — Overview
If your Order Entry system uses the Keep Sales History option, you can use this
form to:
Review all sales and returns of items for the fiscal or calendar years
and periods for which you keep history.
Print the Sales History report.
To open this form from the Sage ERP Accpac desktop, you choose the
Sales History icon from the O/E Statistics and Inquiries folder.
To check sales history for a selected item or customer while using the
Order Entry, Shipment Entry, Credit Note/Debit Note Entry, or Invoice
Entry forms, click the History button on the transaction entry form.
Before using
Select the Keep Sales History option in the O/E Options form. (Note
that you will be able to view sales history for transactions entered
after you select this option.)
Specify the type of year and period by which to accumulate sales
history.
To review sales history

To print sales history for a range of item numbers, customer
numbers, and reporting periods, print the Sales History report.
See also
Clear History form
Keep Transaction History option
Sales Statistics form
Saving sales information for reporting
Saving transaction history for reporting

Sales Statistics Form — Overview
Use this form to:
Look up sales statistics for the invoices, debit notes, and credit notes
that have been posted in your Order Entry system during the year and
period you specify.
Enter or edit sales, invoice, debit note, and credit note statistics from
your previous order entry system during setup of Sage ERP Accpac
Order Entry.
Print the Sales Statistics report.
If your Order Entry system uses the option to keep statistics, the program
keeps sales statistics from your posted orders, invoices, debit notes, and
credit notes. You can review the statistics as far back as the oldest year
for which you keep this information by printing the Sales Statistics report.
Before adding or editing sales statistics
Select the options to Keep Statistics and Allow Edit Of Statistics in the O/E Options
form.
Select the type of year and period to accumulate statistics by in the
O/E Options form.
To add statistics
To review sales statistics

To print sales statistics for a range of item numbers, customer
numbers, and reporting periods, print the Sales Statistics report.
See also
Accumulating sales statistics for reporting
Keep Sales Statistics option
Sales History form
Saving transaction history for reporting

Salesperson Inquiry — Overview
Use the Salesperson Inquiry form to review sales data (invoices and
credit notes) according to salesperson and customer. Sales data is
available if you choose the Keep Sales History option.
After you select a salesperson and customer number, then click Go, you
can double-click a detail line or click the Details button to view and print a
copy of the document.
To get help on any field in the Salesperson Inquiry form, click the Field
List button (above).
Click here for tips on using forms in Order Entry.

Clear History Form — Overview
The Clear History form removes obsolete data from your Order Entry
system. You can clear the following information:
Transaction history (all the information from completed orders,
invoices, credit notes, and debit notes).
Sales history (item and customer sales by period).
Sales statistics (totals and high and low amounts by period).
Salesperson commission data (commissions accumulated since the
last time data was cleared).
Printed posting journals (transactions from invoices and credit notes
which will be posted by Accounts Receivable to general ledger
accounts, listed by day end number).
You can clear one or more types of data at the same time.
To use the Clear History form
1.Select the types of records you wish to clear.
2.Specify the ranges for each type of record.
3.Type the dates or fiscal year and period for which to clear.
4.Click Process.
See also
Sales History form
Sales Statistics form
Saving transaction information for reporting

Day End Processing
When you post Order Entry transactions, the program immediately:
Updates item quantities in Sage ERP Accpac Inventory Control.
Adds any prepayments to an Accounts Receivable receipt batch.

Additional Tasks During Posting or Day End
Processing
Costing options specified in Inventory Control determine whether the
following additional tasks take place in "real time" (during posting) or
during Day End Processing:
Update of item costs in Inventory Control.
Creation of audit records or general ledger transactions.
Update of sales statistics and customer accounts in Accounts
Receivable.
Warning! The time required to complete day-end processing varies
according to your computer and the number of transactions you entered
since the last time you ran Day End Processing. We recommend that you
run Day End Processing overnight, or when you do not need to use your
computer for other tasks.

If You Cost Items During Day End Processing . . .
If Inventory Control uses the options Cost Items During Day End
Processing or Create Subledger Transactions And Audit Info During Day
End Processing, you must run Day End Processing in Inventory Control
to finish updating Order Entry, General Ledger, Inventory Control, and
Accounts Receivable.
To keep your audit trail and reports up to date, you should run Day End
Processing as part of your daily routine.
You can run Day End Processing as many times a day as you want. Day
End Processing processes all transactions posted since the last time you
ran Day End Processing.

Locked Fiscal Periods
Note that if a fiscal period is locked for General Ledger but not for Order
Entry, you can create batches for General Ledger during posting, during
Day End Processing, or using the Create G/L Batch icon (depending on
Order Entry's G/L Integration settings). When you try to post transactions
to a locked period in General Ledger, however, the transactions will be
placed in an error batch. You can avoid this situation if you create and
post General Ledger batches for outstanding Order Entry transactions
before locking the period for General Ledger.
Similarly, you can create transactions for Accounts Receivable from
Order Entry transactions, but you cannot post them to a period that is
locked for Accounts Receivable.
See also
After running Day End Processing
Before running Day End Processing
Tasks performed by Day End Processing

Create Batch Form — Overview
Use the Create Batch form to:
Produce a batch of general ledger transactions from posted
shipments (or append to an existing general ledger batch) and
optionally post them automatically.
You can use this form to produce G/L batches only if you selected On
Request Using Create G/L Batch Icon for the Create G/L Transactions option in
the G/L Integration form.
Post a batch of invoices in Accounts Receivable from invoices or
credit/debit notes posted in Order Entry.
You can use this form to post A/R invoices created by Order Entry
only if you selected On Request Using Create Batch Icon for the Post A/R
Batches option on the Processing tab of the O/E Options form.

Locked Fiscal Periods
Note that if a fiscal period is locked for General Ledger but not for Order
Entry, you can create batches for General Ledger during posting, during
Day End Processing, or using the Create G/L Batch icon (depending on
Order Entry's G/L Integration settings). When you try to post transactions
to a locked period in General Ledger, however, the transactions will be
placed in an error batch. You can avoid this situation if you create and
post General Ledger batches for outstanding Order Entry transactions
before locking the period for General Ledger.
Similarly, you can create transactions for Accounts Receivable from
Order Entry transactions, but you cannot post them to a period that is
locked for Accounts Receivable.
If you do not use Sage ERP Accpac General Ledger, or if your Sage
ERP Accpac General Ledger system is at another location, Order Entry
appends its general ledger transactions to a file called oegltran.csv,
which can be imported by a Sage ERP Accpac General Ledger at
another site, or transferred to another general ledger that you use. The
file is in a Comma Separated Values (CSV) format, and is created in the
same directory as your company database.

Note that if you do not use Sage ERP Accpac General Ledger in the
same database as Order Entry, all general ledger transactions are placed
in the same CSV file, and that each time Order Entry creates transactions
it asks whether to add to the file, or replace it.
Before you begin
Select the On Request Using The Create G/L Batch Icon and other
general ledger options on the Integration tab of the Options form.
Run Day End Processing in to update the company’s Order Entry data.
Print the G/L Transactions report, then file it with your audit trail reports. (You
must print the report before using the Create G/L Batch form. When
you create general ledger transactions, the data for the G/L
Transactions report is deleted from Order Entry.)
To create the general ledger batch
1.Choose the Create Batch icon from the Periodic Processing folder.
2.Specify the day-end number up to which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
3.Click Process.
After using
Post the batches in Sage Accpac General Ledger, if you use it.
Order Entry will automatically post the batch in the General Ledger
program if you selected "Creating and Posting a New Batch" for the
Create G/L Transactions option in the G/L Integration form.
If you use a different general ledger, import the CSV batch file into
your general ledger, then delete the file.
Or,
Using the G/L Transactions report, transfer the entries to your general
ledger manually, then delete the CSV batch file.
See also
Clear history
Periodic processing

Reporting Order Entry Data
Order Entry prints a variety of reports to help you manage your sales
orders. Printed reports also serve as a source of backup information in
case any of the data gets damaged on your computer.
This topic contains an overview of Order Entry's reports. For more
information refer to the online help for each report.

Printing Reports
There are several ways to print reports in Order Entry. You can:
, to obtain permanent copies of the

Print directly from the program to the printer

information.
, for quick review.

Print the information on your screen

for printing later, importing into another program, or
transferring to a diskette.
Print to a file

Print to an e-mail

to send a report to an electronic mail recipient.

Order Entry reports can be printed on laser printers with 8½" x 11" paper,
A4-sized paper, or dot matrix printers. (The Posting Journal can also be
printed on 8½"x14" paper.)

Setup reports
You can print reports showing the information entered to define each
of the records you create when setting up or updating your Order Entry
system.
Options
G/L Integration
Optional fields
Miscellaneous charges
Ship-via codes
E-mail messages
Templates

Any time you add, delete, or change any of these records, you should
print and file the corresponding reports, to keep your printed records up
to date.

Sales analysis and transaction reports
Order Entry provides reports you can use to analyze sales orders. There
are also reports about the Order Entry transactions you post (invoices
and credit notes), and the journal entries created for the general ledger
from these transactions.
Transaction lists
G/L Transactions
Sales history
Order action
Invoice action
Sales statistics
Aged orders
Salesperson commissions
Posting journals

Printing Forms
Finally, Order Entry provides you with the standard forms you need to
process sales orders and invoice customers:
Order confirmations
Invoices
Receipts
Picking slips
Credit notes
Shipping labels
Quotes

See also
Order Entry reports

Order Entry Reports
Order Entry Reports are divided into two categories:
Reports provide you with orde
Forms include quotes, order confirmations, invoices, picking slips,
credit notes, and shipping labels.
If you have a multicurrency ledger, some of these reports can also
include source and functional-currency information.

Reports
Aged Orders
E-mail Messages
G/L Integration
G/L Transactions
Invoice Action
Miscellaneous Charges
Optional Fields
Options
Order Action
Posting Journals
Sales History
Sales Statistics
Salesperson Commissions
Ship-Via Codes
Templates
Transaction List

Forms
Credit/Debit Notes
Invoices
Order Confirmations
Picking Slips
Quotes
Receipts
Shipping Labels

See also
Including Optional Field Information on Reports
Reporting Order Entry Data
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Printing When Preview is the Print Destination
To print to the screen (display a report on your monitor), choose Print
Destination from the File menu on the company desktop. Choose
Preview.
When you print to any destination, a report’s status is updated to Printed.
See also
Order Entry reports
Printing when Printer is the print destination
Printing when File is the print destination
Printing when E-mail is the print destination

Printing When Printer is the Print Destination
To print to a printer, choose Print Destination from the File menu on the
company desktop. Choose Printer, then choose Save.
When you print to any destination, a report’s status is updated to Printed.
See also
Order Entry reports
Printing when Preview is the print destination
Printing when File is the print destination
Printing when E-mail is the print destination

Printing When File is the Print Destination
To print to a file, choose Print Destination from the File menu on the
company desktop.
Choose File, then enter the drive, directory, and filename, or use the
Browse button to scroll through the list of directories and files to select
the file you want to use.
You can enter the name of a non-existent file or directory to be created
by the system when you print.
When you print to any destination, a report’s status is updated to Printed.
See also
Order Entry reports
Printing when Printer is the print destination
Printing when Preview is the print destination
Printing when E-mail is the print destination

Printing When E-Mail is the Print Destination
To print to an e-mail message, choose Print Destination from the File
menu on the company desktop. Choose E-mail, then choose OK.
When you print to any destination, a report’s status is updated to Printed.
See also
Order Entry reports
Printing when Printer is the print destination
Printing when Preview is the print destination
Printing when File is the print destination
Printing when Schedule is the print destination

Credit/Debit Notes — Printing
Sage ERP Accpac Order Entry lets you print copies of the details of sales
returns and other credits and debits posted to customer accounts using
the Credit/Debit Notes report form.
Order Entry comes with two sample formats for printing credit notes and
debit notes: one for preprinted forms, and another that prints the entire
credit note or debit note on blank paper. You can use the sample formats
or change them to suit your company's requirements.

Keeping Transaction History
If you do not use the option to keep transaction history, Order Entry
deletes information for printed credit notes when you run Day End
Processing in Inventory Control — so you must print the credit notes and
debit notes you need before running Day End Processing.

How to print credit notes or debit notes
1.Open Order Entry > O/E Forms > Credit/Debit Notes.
Or
Print the credit note or debit note from the Credit/Debit Note Entry
form immediately after posting. (Order Entry asks whether you want to
print when it displays the "Posting completed" message.)
2.From the Document Type list, select Credit Note or Debit Note.
3.In the Use Credit (or Debit) Note field, select the report format you
want to use:
OECRN01.RPT— Credit/debit note for laser printers (plain
paper version)
OECRN02.RPT— Credit/debit note (for preprinted forms)
4.Select all or a range of credit notes or debit notes using the From
[Credit/Debit] Note No. and To [Credit/Debit] Note No. fields.
5.Choose the Delivery Method.
Select Print Destination to print to your usual print destination.

Select Customer to use the delivery method specified in each
customer record (such as e-mail).
If you choose Customer as the delivery method, select the ID for
the e-mail message you want to send with credit/debit notes for
customers that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for credit/debit notes, click the Zoom button for the
Message ID field.
6.Select Include Credit/Debit Notes Already Printed to print all credit or
debit notes in the range, or leave the option clear to print only those
credit or debit notes that have not been printed.
7.Select Print Serial/Lot Numbers to print the serial numbers or lot numbers that
have been assigned to the items on the Credit/Debit Notes. (You can
select this option only if you have a license for Serialized Inventory
and Lot Tracking.)
8.Do not select the Custom Form option unless you are using a
customized credit/debit note form that requires it. (This option is for
custom forms that do not use the report selection criteria sent by this
print form.)
9.Select Print Kit Component Items if you want to print all of the
components in kit assemblies on the credit/debit note.
10.Select Print Bills of Material Component Items if you want to print all
of the components in assemblies that are manufactured from bills of
material on the credit/debit note.
11. Select Retainage to include retainage amounts on the printed credit
notes or debit notes. (This option is available only if you use Sage
ERP Accpac Project and Job Costing and if Accounts Receivable
uses retainage accounting.)
12.Click Print.
You can also choose the Align button when printing to a printer. Use
this button to print a sample copy of the credit note to check that
preprinted forms are correctly inserted in the printer so that the credit
note information will be printed in the right places.

For more information on the contents of this report, see Credit/Debit notes —
features.
See also
Order Entry reports
Printing to a file
Printing to a printer
Printing to the screen
Printing to an e-mail

Invoices — Printing
An invoice is a detailed bill for all items purchased and shipped by Order
Entry.
Sage ERP Accpac Order Entry comes with two sample 8½" x 11"
datapiped formats for invoices: one for preprinted forms, and one that
prints the entire credit note or debit note on blank paper. Two nondatapiped formats are also available. You can use the sample formats or
change them to suit your company's requirement.
Note: An additional invoice form, OEINV03.RPT, is used for Internet
inquiries using iConnect Sales Orders - Order Inquiry.

Keeping Transaction History
If you do not use the option to keep transaction history, Order Entry
deletes information for printed invoices when you run Day End
Processing in Inventory Control — so you will not be able to reprint
invoices.

How to print invoices
You can use the Invoices icon to print a range of invoices, or you can
print an invoice from the Order/Invoice Entry form immediately after
posting it.
1.If you are printing a single invoice from Invoice Entry, Order Entry
asks if you want to print the invoice when it displays the "Posting
completed" message. Click Yes.
To print a range of invoices, choose the Invoices icon from the O/E
Forms folder.
2.In the Use Invoice field, select the invoice format you want to use.
OEINV01.RPTInvoice for laser printer (plain paper version)
OEINV02.RPTInvoice (for preprinted forms)
OEINV04.RPT Invoice for laser printer plain paper version (nondatapiped)

OEINV05.RPT Invoice for preprinted forms (non-datapiped).
3.If you are using the Invoices icon, use the From Invoice and To
Invoice fields to specify a range of invoices, or accept the default
entries to print all of them..
4.Select the delivery method from the list.
Select Print Destination to print to your usual print destination.
Select Customer to use the delivery method specified in each
customer record (such as e-mail).
If you choose Customer as the delivery method, select the ID for
the e-mail message you want to send with invoices for customers
that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for invoices, click the Zoom button for the Message
ID field.
5.If you are using the Invoices icon, select Include Invoices Already
Printed to print all invoices in the range, or leave the option
unchecked to print only those invoices that have not been printed.
6.Select Print Serial/Lot Numbers to print the serial numbers or lot numbers that
have been assigned to the items on the invoices.
7.Specify whether you need shipping labels for the invoices.
8.Specify whether to include backordered items on invoices.
9.Do not select the Custom Form option unless you are using a
customized invoice that requires it. (This option is for custom forms
that do not use the report selection criteria sent by this print form.)
10.Select Print Kit Component Items if you want to print all of the
components in kit assemblies on the invoice.
11. Select Print Bills of Material Component Items if you want to print all
of the components in assemblies that are manufactured from bills of
material on the invoice.
12.Select Retainage to include retainage amounts on the printed
invoices. (This option is available only if you use Sage ERP Accpac
Project and Job Costing and if Accounts Receivable uses retainage

accounting.)
13.Click the Print button.
You can also click the Align button when printing to a printer. Use this
button to print a sample copy of the invoice to check that preprinted
forms are correctly inserted in the printer so that the invoice
information will be printed in the right places.
Note that you must print invoices before they can be cleared.

Unit Price column may not match data entry
screen
The Unit Price column printed on invoices is calculated by dividing the
extended price by the quantity shipped — whether pricing by quantity or
by weight. When pricing by weight (and when the order unit of measure is
not the pricing unit of measure), the printed unit price may not match the
unit price on the transaction entry forms.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Order Confirmations — Printing
Before completing and invoicing an order, you can print and send
customers an order confirmation which acknowledges receipt of the order
and confirms the contents.
You can print confirmations for all orders or for a range of order numbers.
For the selected orders, you can:
Print only the order confirmations that have not been printed yet, or
also print new copies of those that were printed previously.
Print serial numbers and lot numbers for serialized and lotted items, if
you use Serialized Inventory and Lot Tracking (separately licensed).
For each detail line, the order confirmation lists the serial and/or lot
number for each of the items ordered.
Indicate whether shipping labels are required for the order.
Sage ERP Accpac Order Entry includes two sample forms for order
confirmations: OECONF01.RPT for printing on blank paper and
OECONF02.RPT for preprinted forms. You should set up and test these
forms before you begin entering transactions.
Note: An additional form, OECONF03.RPT, is used for Internet orders
entered through iConnect Sales Orders – Order Entry.

How to print a range of order confirmations
1.Choose Order Confirmations from the Forms folder.
2.Select the report format you want to use to print the report:
OECONF01.RPT Order confirmation for laser printers (plain paper
version).
OECONF02.RPT Order confirmation (for preprinted forms).
3.Use the From and To Order Number fields to specify a range of
orders, or accept the default range (all orders).
4.Select the Delivery method.
Select Print Destination to print to your usual print destination

Select Customer to use the delivery method specified in the
customer record (for example, the customer’s e-mail address).
5.If you selected Customer as the delivery method, select the ID for the
e-mail message to send to customers whose delivery method is email, or accept the default ID.
6.Specify print options for the order confirmations. You can select:
Include Confirmations Already Printed if you want to print new
copies of order confirmations that you printed before.
Print Serial/Lot Numbers to print the serial numbers or lot numbers
assigned to serialized or lotted items. (You can select this option if
you have a license to use Serialized Inventory and Lot Tracking.)
Require Shipping Labels if you want to print shipping labels for
marked order confirmations only. (When you print shipping labels,
you can print labels for the order confirmations that were marked
as requiring them.)
Note that you can print shipping labels only if you entered a
number on the Totals tab for each order.
Custom Form only if you have a special order confirmation form
that does not use the report selection criteria sent by this print
form.
Print Kit Component Items to print all of the components in kit
assemblies on the order confirmation.
Print Bills of Material Component Items to print all of the
components in assemblies that are manufactured from bills of
material on the order confirmation.
Print On Hold Orders to print all orders, whether or not they are on
hold.
7.Click the Print button.
If you are printing the order confirmation on a printer (and not sending
the form by e-mail), you can click the Align button to print a sample
copy of the confirmation to check whether the order information prints
in the right places on preprinted forms. If the sample form does not

line up correctly, ensure that you have correctly inserted the forms in
the printer.

Printing a single order confirmation from Order
Entry
You can also print an order confirmation from the Order Entry form
immediately after posting. (Order Entry asks whether you want to print
the order confirmation when it displays the "Posting completed"
message.)
For more information on the contents of this report, see Order confirmations —
features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Picking Slips — Printing
You can print picking slips to send to the warehouse or shipping
department. Warehouse staff use picking slips to locate items and check
the availability of inventory.
You can:
Sort items on picking slips by picking sequence (user-defined), item
number, or order line number.
Select all or a range of orders for which to print picking slips.
Select a range of locations for which to print picking slips.
Limit printing to those that have not been printed, or print all picking
slips in the range you selected.
Print serial numbers and lot numbers, for items that use these
numbers and have had serial/lot numbers assigned to them. For each
detail line, the picking slip lists the serial/lot number for each of the
items ordered.
Sage ERP Accpac Order Entry includes sample forms you may be able
to use to print picking slips. You should set up and test these forms
before you begin entering transactions.
You can also print picking slips immediately after posting shipments by
choosing Yes when asked if you want to print on the Posting Completed
confirmation form.
For more information on the contents of this report, see Picking slips — features.

How to print picking slips
1.Choose Picking Slips in the Forms folder.
2.In the Use Slip field, select the report that corresponds to the picking
slip you want to print. The report file last used appears by default.
If you are going to select one or more orders for picking, choose
one of the following reports:
OEPICKORDER1 — A picking slip for laser printers (plain
paper version).

OEPICKORDER2 — A picking slip (for preprinted forms).
If you are going to select one or more shipments for picking,
choose one of the following reports:
OEPICKSHIPMENT1 — A picking slip for laser printers (plain
paper version).
OEPICKSHIPMENT2 — A picking slip (for preprinted forms).
3.In the Sort By field, specify whether to list item details by picking
sequence, item number, or order or shipment line number.
4.Use the From and To [Order or Shipment] Number fields to specify the
range of orders or shipments for which to print picking slips.
5.In the Print By field, specify whether to print picking slips for the
location specified in the document header or for the locations
specified for the item details.
If you print by header locations, the program will print one picking slip
for each order or shipment when the location specified in the header
is within the From Location/To Location range.
If you print by detail locations, the program will print a separate
picking slip for each location listed in the item details of each order or
shipment, provided that the location falls within the From Location/To
Location range that you specify next.
6.Specify the range of locations for which you want to print picking slips.
7.Select additional options, as follows:
Select Include Picking Slips Already Printed if you want to reprint
some picking slips that you printed before.
Select Print Serial/Lot Numbers to include serial numbers or lot
numbers assigned to serialized or lotted items. (You can select this
option if you have a license for Serialized Inventory and Lot
Tracking.)
Select Require Shipping Labels,

.

if the picking slips require shipping labels

Specify whether to print components for kits and/or for bills of
material.

8.Click the Print button.
When printing to a printer, you can first click the Align button to print a
sample copy of the picking slip. Check the sample to ensure that
preprinted forms are correctly inserted in the printer, so that
information for the picking slip will be printed in the right places.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Quotes — Printing
If you wish to provide a quote for a customer, you can enter an order,
select Quote as the order type, then enter the details for the quote and
print a copy of the information for the customer.
You can print a single quote Immediately after posting the quote, or you
can print one or more quotes using the Quotes form in the O/E Forms
folder.
Select all or a range of orders for which to print quotes (orders with Quote
selected as the order type). You can print all quotes from the orders in
the range you selected by selecting Include Quotes Already Printed, or
limit printing to those that have not been printed by not checking this
option.
Sage ERP Accpac Order Entry includes two sample forms you may be
able to use to print quotes:
OEQUOT01.RPT — A quote for laser printers (plain paper version).
OEQUOT02.RPT — A quote for preprinted forms.
You should set up and test these forms before you begin entering
transactions.

How to print a range of quotes
1.Choose Quotes from the Forms folder.
2.Select a range of orders.
3.Choose the Delivery method.
Select Print Destination to print to your usual print destination
Choose Customer to use the delivery method specified in the
customer record (for example, the customer’s e-mail address).
4.If you are e-mailing the quote to a customer whose delivery method is
e-mail, select the ID for the message to send with the quote, or accept
the default ID.
5.Select the print options for the quotes.

Select Custom Form only if you have a special quote form that
does not use the report selection criteria sent by this print form.
Select Print Kit Component Items to print all of the components in
kit assemblies on the quote form.
Select Print Bills of Material Component Items to print all of the
components in assemblies that are manufactured from bills of
material on the quote form.
6.Click the Print button.
If you are printing the quote on a printer (rather than sending the form
by e-mail), you can also click the Align button to print a sample copy
of the quote to check that the order information prints in the right
places on preprinted forms. If the information does not line up
correctly, ensure that you have inserted the forms correctly in the
printer.

Printing a single quote from the Order/Invoice
Entry form
You can print each quote separately from the Order/Invoice Entry form
immediately after posting it. (Order Entry asks whether you want to print
the quotes when it displays the "Posting completed" message.)
For more information on the contents of this report, see Quotes — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Receipts — Printing
Order Entry lets you print receipts to let you confirm your receipt of a
customer prepayment at the time you post an order or an invoice in Order
Entry.
You can print one or more receipt confirmations for receipts after posting
an order or invoice, or you can go to the Accounts Receivable Receipts
form in the A/R Transaction Reports folder to print receipts. For example,
if you always print receipts after posting, you may just have to make sure
that you aren't reprinting receipts to print a receipt for the prepayment
that you just entered.
Note: Receipts are saved in Receipt batches in the Accounts Receivable
program. Order Entry and Invoice Entry use the Receipt printing program
in the Accounts Receivable program to print the prepayment receipt
confirmation.
Accounts Receivable comes with a sample form for laser printers that
you can use to print receipts on plain paper: ARRCPT.RPT. You can use
this sample form as is, or change it to suit your company’s requirements.
For information on the contents of this report, see Receipts — Features.

How to print receipts
1.To print a single receipt for a prepayment when you post an order or
invoice, select the Prepayment Receipt Confirmation checkbox on the
posting confirmation form.
2.Make selections in the following fields:
Detail or Summary. Select a detail or summary receipt depending on
the amount of information that you want to include with receipts.
Reprint Previously Printed Receipts. Select this option to reprint
receipts you printed before. Do not select this option if you want to
print only receipts that you have not yet printed.
Delivery Method. Select Print Destination (to print the invoices to the
current print destination) or Customer (to use the delivery method
specified in each customer record).

E-mail Message ID/Fax Message ID. These fields appear when you
select Customer as the print destination. Select the code for the
receipt message you want to accompany e-mailed or faxed receipts.
Select By. Choose how you want to select the receipt that you are
printing:
Batch/Entry Number. Select a range of receipt batch numbers for
which to print invoices. The number of the current batch is
displayed by default when you print from the Receipt Entry form.
Customer/Document Number. Select a range of customers and
document numbers for which to print receipt confirmations.
Customer/Check/Receipt Number. Select a range of customers
and check /receipt numbers for which to print receipt
confirmations.
If you do not select a range of document or check/receipt numbers,
the program prints receipt confirmation for all the documents or
check/receipts for the customer or A/R Receipt batch numbers you
specify.
If you print several document types at once, the program first sorts the
document numbers alphabetically, then numerically, to determine
which documents belong in the range you specify.
3.Click

Print.

See also
Order Entry reports

Shipping Labels — Printing
You can print shipping labels to attach to shipments and invoices sent
from your warehouse or shipping department.
The number of labels printed for each shipment or invoice is the number
specified for the shipment or invoice on the Totals tab of the Shipment
Entry or Invoice Entry form.
You can print labels for all or a range of shipments or invoices, printing
labels for every shipment or invoice in the range, or limiting printing to
labels you have not printed already. You can also print labels for all
shipments or invoices, or only for shipments or invoices you marked as
requiring shipping labels when you printed order confirmations, picking
slips, and invoices.

When to print
Print labels when assembling orders for shipping.

How to print
1.Choose Shipping Labels in the Forms folder.
2.Choose the type of label you want to use. Order Entry comes with two
label formats that you may be able to use:
OELABEL.RPT Shipping label: 1½" x 4" sheet labels for a laser
printer (14 labels on a page)
OELABELD.RPT Shipping label: 1½" x 3¾" tractor feed labels
3.Choose whether to print labels for a range of invoices, orders, or
shipments.
4.Specify the range of invoices, orders, or shipments.
5.Choose whether you want to reprint previously printed labels.
6.Choose whether you want to print labels for all shipments or invoices
or print labels only for those invoices, orders, or shipments that you
marked as requiring labels.
7.Click Print.

For more information on the contents of this report, see Shipping labels — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Aged Orders Report — Printing
Print the Aged Orders report to list all incomplete orders and their relative
ages in the system.
You can list all or a range of orders by order number, customer number,
or currency (in a multicurrency system). You can select three aging
categories. A fourth column prints orders that have been outstanding for
more than the number of days in the last aging category.
Note: You need Transaction Inquiry security authorization to view this
report.

When to print
Print the report periodically to identify orders which have not been filled.

How to print
Choose Aged Orders in the Reports folder, then specify the following
information:
The date as of which you want orders aged.
All orders older than the Aged As Of date fall into one of the aging
periods. Orders which are more recent than the Aged As Of date (and
up to the Cutoff Date) appear in the Current column.
The Cutoff Date (the date of the most recent order you want listed).
The report does not list orders with a document date later than this
date. If you do not want to list any current orders, enter the same date
in the Aged As Of and Cutoff Date fields.
The sorting order for the report: by order number, customer number,
or currency code.
Ranges of order numbers, customer numbers, and currencies to
include on the report.
Number of days in each report aging period. The default aging
periods are defined in the Options form.
Whether to print amounts in the customer currency or in the functional

currency (multicurrency ledgers).
Extra information to include: contact name and phone number, invoice
information, or space for comments.
For more information on the contents of this report, see Aged Orders report —
features.
See also
Order Entry reports
Printing to a file
Printing to a printer
Printing to the screen
Printing to an e-mail

E-Mail Messages Report — Printing
Print the E-Mail Messages report to see a list of all the e-mail messages
you have set up for your Order Entry system.

When to print
Print and file the report when you send an e-mail message.

How to print
Double-click the E-Mail Messages icon in the O/E Reports folder, or
choose File, Print from the E-Mail Messages setup form, then choose the
Print button.
For more information on the contents of this report, see E-Mail report — features.
See also
Order Entry reports
Printing to an e-mail
Printing to a file
Printing to a printer
Printing to the screen

G/L Integration Report — Printing
The G/L Integration report lists the G/L transaction and batch creation
options and other information you entered in the G/L Integration form to
specify how your Order Entry system sends transactions to General
Ledger.
For more information on the contents of this report, see G/L Intregration — Features.

When to print
Print the report before and after changing options.

To print the G/L Integration report
1.Double-click the G/L Integration icon in the Setup Reports folder, or
choose File, Print from the G/L Integration form.
2.To begin printing, click the Print button.
If you are printing to a printer, Order Entry displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Order Entry displays the name of the file,
so you can change it or cancel printing.
If you are printing to the screen (preview), Order Entry displays the
report. You can then export it to a file or send it to the printer.
See also
Order Entry Reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

G/L Transactions Report — Printing
Print the G/L Transactions report to obtain a list of the general ledger
journal entries created from shipments posted in Order Entry since the
last time you created a general ledger batch.
Remember to run Day End Processing before you create the general
ledger batch if you want to include the latest information in the report.
For information on the contents of this report, see G/L Transactions Report — Features.

When to print
The option you selected for creating G/L entries (on the Integration tab of
the G/L Integration form) determines whether and when you can print this
report in Order Entry:
During Posting or Day End Processing. With this option, you can
only view general ledger transactions from the General Ledger
Program.
On Request Using Create Batch Icon. With this option, you can
print the report in Order Entry after you post transactions or run Day
End Processing (depending on when you cost inventory) but before
you create G/L batches using the icon.

To print the report
1.Choose the G/L Transactions icon from the O/E Reports folder.
2.Make selections in the following fields:
Through Posting Sequence. Enter a number in the Through Posting
Sequence box. The latest posting sequence number is displayed, but
you enter an earlier number, if you wish. The report lists all
transactions for posting sequences up to and including the number
you specify.
Report Format. Select Detail or Summary.
Sort By. If you choose the detailed report format, specify the order in
which to list the transactions on the report. The choices are by
general ledger Account Number, by Year/Period, and by Batch/Entry

Number.
Currency. If you use multicurrency accounting, specify whether to
print amounts in each customer's currency or in the functional
currency.
3.Click Print.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Invoice Action Report — Printing
Print the Invoice Action report to find out whether orders have been
partially or fully invoiced, and to print the current amounts remaining to be
invoiced.
Note: You need Transaction Inquiry security authorization to view this
report.
For more information on the contents of this report, see Invoice Action report —
features.

When to print
When you need to review active orders to see what has been invoiced, or
needs to be invoiced.

How to print
1.Choose Invoice Action from the O/E Reports folder.
2.Specify whether to print a detail report or a summary report.
3.Specify the main selection method and sorting order for the report —
by order number or shipment number — and the range of order
numbers or shipment numbers to include on the report.
If you select by shipment, you choose the range of shipments and,
optionally, a range of customers or a range of salespeople.
If you select by order, you choose the range of orders and,
optionally, a range of customers or a range of salespeople.
However, you can also choose the status of the orders printed,
which involves choosing from a variety of shipment statuses and
invoicing statuses.
4.Specify the secondary sorting order — by customer number or
primary salesperson — and the range of customer numbers or
primary salespeople.
5.Select the range of order dates or shipment dates to include on the
report (depending on whether you are selecting orders or shipments).

6.If you are selecting by order number, specify the Shipped and
Invoiced statuses of the orders to include on the report.
You use the options in the Include Orders section to restrict the report
to orders that are partially shipped or fully shipped, and that are not
invoiced, partially invoiced, or fully invoiced. You can include any
combination of statuses, but you must select at least one Shipped
status and one Invoiced status to print the report.
7.If you have a multicurrency system, choose whether to print amounts
in the customer currency or your functional currency.
8.If you are printing a detail report and you use Sage ERP Accpac
Project and Job Costing, select the Include Job Details option if you
want to print the contract, project, and category information for each
detail.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Miscellaneous Charges Report — Printing
Print the Miscellaneous Charges report to obtain a list of the
miscellaneous charges such as postage, shipping, handling, and
restocking charges, that you use in your Order Entry system.

When to print
Print the report when you add new miscellaneous charges or change
existing charges information.

How to print
Choose Miscellaneous Charges in the Reports folder, or choose File,
Print from the Miscellaneous Charges form, then select:
The order in which you want the report printed (by miscellaneous
charge or currency, if you have a multicurrency system).
The range of miscellaneous charge codes.
The range of currency codes, if you have a multicurrency system.
Whether you want to include the extended cost and job-related
expense and clearing accounts for job-related miscellaneous charges.
Whether to include optional field information.
For more information on the contents of this report, see Miscellaneous Charges
report — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Optional Fields Report
Print the Optional Fields report when you want to check your optional
fields records.

How to print
1.Double-click the Optional Fields icon in the O/E Reports folder, or
choose File, Print from the Optional Fields setup form.
2.Choose the Show Settings option to print the settings for each
optional field on the report. (The settings specify the accounts to
which optional fields will be passed and whether optional fields will be
passed to Project and Job Costing.)
3.Click Print.

Information printed on the report
The Optional Field report displays the optional field code and description,
as well as the default value and whether or not you want the value to be
automatically inserted in a record.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Options Report — Printing
Print the Options report to list the information and options you entered
when you set up your Order Entry system, or when you changed the
information using the Options form.

When to print
Print and file the report when you change company options for the order
entry system.

How to print
Choose Options in the Reports folder, or choose File, Print from the
Options form, then click the Print button.
For more information on the contents of this report, see Options report — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Order Action Report — Printing
Print the Order Action report to obtain a list of your current orders, sorted
by the order you require.
Note: You need Transaction Inquiry security authorization to view this
report.

When to print
When you need to review active orders to see what has been done with
them, or needs to be done.

How to print
Choose Order Action from the O/E Reports folder, then specify the
following information:
The range of expected ship dates (for orders) to include on the report.
Whether to print a detail report or a summary report.
The source of orders: all, entered directly, or entered through the
Internet
The types of orders to include: all orders, orders never invoiced,
orders partially invoiced, orders never or partially invoiced, or orders
on hold.
The print status of orders to include: all statuses, entered (nothing
printed), confirmation printed, or picking slip printed.
Note that if you ship goods from an order and print the picking slip
after posting from the Order Entry form, only the shipment will have
the print status set to “Picking Slip Printed,” not the order.
The item status of orders to include: completed with no shipments,
incomplete, some items available for shipment, all items available for
shipment, or items out of stock.
The sorting order for the report: by order number, customer number,
or primary salesperson number.
Ranges of order numbers, customer numbers, or primary salesperson

numbers to include on the report.
Whether to print prices and total order amounts in the customer
currency or in the functional currency (for detail reports in
multicurrency ledgers only).
Whether to include job details (if you use the Project and Job Costing
program).
For more information on the contents of this report, see Order Action report —
features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Posting Journals Report — Printing
Print the posting journals at the end of each day, as part of your day-end
procedure and audit trail documentation. You can clear the posting file
after printing the report to any destination.

When to print
Print regularly (daily or weekly). This is the detailed record of all
transactions arising from particular invoices and credit notes that will be
posted to the general ledger from Accounts Receivable.

How to print
1.Choose Posting Journals in the Reports folder.
2.Select Shipments, Invoices, or Credit/Debit Notes.
3.Specify the range of day-end numbers for which you are printing the
report.
4.Use the Sort By field to specify the order in which you want the
transactions to appear.
5.Choose whether to include:
Salesperson splits,
Tax summary from posted transactions,
A/R audit information for invoices and credit/debit notes (showing
the G/L transactions arising from the invoices and credit/debit
notes),
Tax reporting information if you also report taxes in another
currency,
Journals that have already been printed,
Optional fields
Job details
Serial and lot numbers for serialized or lotted items, if you have a
license for Serialized Inventory and Lot Tracking.

6.Choose the paper size — 8½ x 11”, A4, or 8 ½ x 14” (except with
credit/debit notes).
7.Click Print.
For more information on the contents of this report, see Posting journals — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Sales History Report — Printing
Print the Sales History report for use as a sales journal, to record sales
staff performance by territory or location, and to indicate the strengths
and weaknesses in company sales.
You can clear the sales history (using the Clear History form) after
printing the report to any destination.
To be able to print the report, you must choose the Keep Sales History
option on the Options form prior to running Day End Processing.

When to print
Print the report after running Day End Processing, at the end of an
accounting cycle, or any time you want to check on your sales
performance.

How to print
1.Choose Sales History from the Reports folder.
Or
On the Sales History form, click File, and then click Print.
2.From the Report Type list, select the type of report you want to print.
You can select:
Detail
Summary
Totals

3.If you are printing a Detail report by item or customer and you want to
include invoice details, serial and lot numbers, or kit components,
select the Include Invoice Details option. Once you select the Include
Invoice Details option, you can select the following additional options:
Print Kit Components. (This option is located near the bottom of
the form.)
Include Serial/Lot Numbers. (This option is available if you use
Serialized Inventory and Lot Tracking.)

4.Specify selection criteria, as follows:
Select By. Use the Select By field, and the From and To fields that follow the Select By field, to
specify the time period for which to print sales history.
Sort By.

Specify the order in which to print sales history

.

From / To ranges. Depending on your choice for the Sort By field,
additional fields may appear that let you specify ranges of customers,
territories, salespersons, items, account sets, categories, and
currencies (in a multicurrency system). If you use Serialized Inventory
and Lot Tracking and you selected the option to include serial and lot
numbers, you can also specify ranges of serial and lot numbers.
Specify ranges to restrict sales history to these ranges, or accept the
default ranges to print sales history for all salespersons, customers,
and items.
5.If you use multicurrency accounting, specify whether to print amounts
in the customer's currency or your functional currency.
6.If you sorted the report by Primary Salesperson, you can select the
option to print kit component items.
7.Click Print.
For more information on the contents of this report, see Sales History report —
features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Sales Statistics Report — Printing
Print the Sales Statistics report to list order entry statistics accumulated
since you last cleared the sales statistics data for the period you specify.
The report can help you understand and analyze the level of processing
in your Order Entry system.
Note that to print this report, you must choose the Keep Sales Statistics
option on the Options form before you run Day End Processing.

When to print
Print the report when you want to check on the volume of orders,
invoices, and credit notes you processed during a period.

How to print
1.Choose Sales Statistics in the Reports folder, or choose File, Print
from the Sales Statistics form.
2.Specify the range of years and periods for which to print the report.
3.If you use multicurrency accounting, specify whether to print amounts
in customer currency or functional currency, choose the range of
currency codes to include, and select whether to consolidate statistics
for the range of currencies you specify.
4.Click Print.
For more information on the contents of this report, see Sales Statistics report —
features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Salesperson Commissions Report — Printing
Print the Salesperson Commissions report when you need a list of the
sales commission earned since you last cleared commission data for
each salesperson for whom you track commissions. You can print a detail
or summary version of the report.

Before Printing the Salesperson Commissions
Report
For each salesperson whose commissions you want to track, the Paid
Commissions option must be selected in the salesperson record (in
Accounts Receivable) .
To be able to print this report, you must select the Track Commissions
option on the Options form before you run Day End Processing.
After printing the report, you can clear the salesperson commission data
to start a new commission period.

When to print
After running Day End Processing, or any time you want to review
commission data.

How to print
1.Choose Salesperson Commissions from the O/E Reports folder.
2.In the Print field, specify whether to print a detail or summary report.
3.If you want to include a column that indicates the type of commission
paid, select the Include Commission Type option.
4.In the Select By field, specify whether to select commissions by date
or by year and fiscal period, and then use the From and To fields that
follow to specify a range of dates or years and fiscal periods to
include on the report.
5.Specify the range of salesperson codes you want to include on the
report.

6.If you are printing a detail report, specify whether to sort the details by
document number, document date, or customer number.
If you are sorting by customer number and you want to print subtotals
for each customer, select the option Display Subtotals.
For more information on the contents of this report, see Salesperson Commissions
report — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Ship-Via Codes Report — Printing
Print the Ship-Via Codes report to list the information entered to define
the shipping methods used in your Order Entry system (for example,
courier, air mail, parcel post).

When to print
Print the report when you change ship-via information.

How to print
1.Choose Ship-Via Codes in the Reports folder, or choose File, Print
from the Ship-Via Codes form.
2.Specify the range of ship-via codes.
3.Click Print.
For more information on the contents of this report, see Ship-Via Codes report —
features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Templates Report — Printing
The Templates report lists the information entered to define the templates
that are used in your Order Entry system. You can speed up and simplify
order entry by setting up templates. Templates provide default
information and settings when you add a new order or invoice.

When to print
Print the report when you add or change templates.

How to print
1.Choose Templates in the Reports folder, or choose File, Print from the
Templates form.
2.Specify the range of template codes.
3.Click Print.
For more information on the contents of this report, see Templates report — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Transaction List Report — Printing
The order, invoice, shipment, and credit/debit note lists let you print
detailed or summary listings of all current Order Entry transactions. You
print a separate report for each type of transaction.
You can sort the reports by transaction number or customer number, and
you can specify a range of transaction numbers, customer numbers, and
currency codes (if you have a multicurrency system) to include in the
report.
If you are printing orders, you can select active orders, future orders,
standing orders, or quotes, and you can include orders which have only
been entered, orders for which a confirmation has been printed, orders
for which a picking slip has been printed, orders never invoiced, orders
partially invoiced, completed orders, and orders on hold.
Note: You need Transaction Inquiry security authorization to view this
report.

When to print
Print these reports for full or partial information on current or past
transactions (if you keep transaction history).
Keep Transaction History option. If you do not keep transaction history,
Order Entry deletes transaction information when you run Day End
Processing in Inventory Control.
Day End Processing deletes order information when orders are
completed and deletes invoice and credit note information after you have
printed invoices and credit notes.

How to print
1.Double-click the Transaction List icon in the Reports folder.
2.In the Print field, select the type of transaction (orders, shipments,
invoices, credit/debit notes).
3.Select the report type (detail or summary).
4.Select sort order (by transaction number or customer number).

5.Select the range of transaction numbers, customer numbers, and
currencies (if you have a multicurrency system).
6.Select the information you want to include in the report. For example,
if you selected Order in the Print field, you can choose to include
some or all of the following information:
Order information
Order details
Addresses
Tax reporting information
Salespersons
Prepayments
Optional fields
Job details
Retainage details (if you are including job details)
Serial and lot numbers (if you have a license to use Serialized
Inventory and Lot Tracking).
Order type (active, standing, future, quote)
Status (posted, never shipped, on hold, etc.)
Source (entered, Internet)
7.Click Print.
For more information on the contents of this report, see Transaction List — features.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail

Create and Activate a Quote
Overview

To create a quote:
1.Open Order Entry > O/E Transactions > Order Entry.
Click here for help on Order Entry fields.

2.Press the Tab key to accept *** NEW *** as the quote number (in the
Order No. field).
Order Entry will assign a number when you post the quote. (If you do
not want Order Entry to assign the order number, type the new
number yourself.)
3.Type the customer number or select it from the Finder.
4.Select Quote as the order type.
5.Enter the expiration date. Order Entry displays a default expiration
date based on the default number of days specified in the O/E
Options form.
Note: If you do not change the quote to an order before the expiration
date, Order Entry automatically removes the quote when you run Day
End Processing. If you selected the option to Clear Expired Quotes
and specified a number of days on the O/E Options form, Order Entry
deletes the expired quote from the system the next time you run Day
End Processing after the specified delay. If you do not select the
option to Clear Expired Quotes, expired quotes will not be deleted.
6.Enter the details and other information for the quote.
See Create a New Order for full instructions on entering orders.
7.Click Post.
Changing quotes to orders

Note: You can also change a quote into a standing or future order.
Related topics

Create a New Contract in PJC for a Quote
If you are creating a job-related quote in Order Entry, you can use the
New Contract wizard to create a new contract in the Project and Job
Costing program by copying an existing one.
Overview

To create a contract using the New Contract Wizard:
1.Start a new order in the Order Entry form.
2.Choose Quote as the Order Type.
3.Click the Contracts button at the bottom of the Order Entry form.
The Contracts button appears after you choose Quote as the Order
Type.
4.Enter a new contract number (you can use the Contract Number tab
to help you do this), and specify the number of the contract that you
are copying to create this new contract.
5.Click the Contract Style tab, and choose whether you want to create a
basic contract or a standard contract.
6.Click the Optional Fields tab and choose whether you want to copy
the optional fields from the template contract, use the PJC default
optional fields, or use no optional fields for this contract.
7.Click the Finish button to create the contract.
Related topics

Create a Standing or Future Order
Overview

To create a standing order:
1.Open Order Entry > O/E Transactions > Order Entry.
Click here for help on Order Entry fields.

2.Press the Tab key to accept *** NEW *** as the order number (Order
Entry will assign the order number when you post the order), or
assign the number yourself.
3.Enter the customer number.
4.Select Standing as the order type.
5.Enter the details and other information for the order.
See Create a New Order for full instructions on entering orders.
6.Click Post.
To create a future order:
1.Open Order Entry > O/E Transactions > Order Entry.
Click here for help on Order Entry fields.

2.Press the Tab key to accept *** NEW *** as the order number (Order
Entry will assign the order number when you post the order), or
assign the number yourself.
3.Enter the customer number or select it from the Finder.
4.As the order date, type the date on which to activate the order.
Note: If you usually run Day End Processing at the end of the work
day, future orders set to be activated on a certain day will not become
active until the end of the day. To be sure a future order is ready to be
processed on the correct date, assign a date earlier than the desired
date for the order.
5.Select Future as the order type.
6.Enter the details and other information for the order.
See Create a New Order for full instructions on entering orders.

7.Click Post.
To create an active or future order from a standing order
To activate a future order
Related topics

Create a New Order
You can also use the Copy Orders form to create an order by copying the
details from an existing order, or a range of orders, to a new order.
Before entering orders

To create a new order:
1.Open Order Entry > O/E Transactions > Order Entry.
Click here for help on Order Entry fields.

2.Press the Tab key to accept *** NEW *** in the Order No. field, and let
Order Entry assign an order number when you post the order.
If you do not want Order Entry to assign the number automatically,
you can type the new number yourself, and then press the Tab key.
3.Type the customer number or select it from the Finder.
You can also click:
The New button to add a new customer record in Accounts
Receivable.
The Credit Check button to see whether you should continue with
the order.
The Zoom button to check address and contact information.
To change customer information such as the tax code, price list, and
payment terms, click the Customer tab, and then return to the Order
tab.
4.

Fill in the general order information fields on the Order tab.

5.Tab into the detail entry grid (or click the grid) to start entering order
details.
a.

If you need to start a new line, press the Insert key.

b.

If you need to change the detail type, double-click the Type field to
switch to Item or Miscellaneous.

c.

Double-click the Item Number field, and then type the item number
or select it using the Finder.

Note: If you are using a scanner, click in the Item Number field
before scanning the bar code.
d.

Use the Tab key to move through the columns on the form. (Some
columns may not appear. Order Entry lets you hide columns and
change the column order.)
Or
Click the Item/Tax button (or press F9) to display a separate detail
entry form that lets you view all the fields for a detail without
scrolling.
Note the following points when entering detail information:
The Price List is determined by the customer account. You
can change it.
The Location defaults from the order header.
You must enter a Quantity Ordered.
If you are also shipping goods, enter the quantity being
shipped. (If you are shipping the entire order immediately, you
can use the Ship All button after entering item quantities.)
If the item entered is serialized and/or lotted, when you enter
the quantity ordered or the quantity shipped, and then press the Tab key,
the Serial/Lot Numbers Allocation form appears. Use this form to assign serial
and/or lot numbers to the item.
For information on other detail fields, see Order Entry fields.

e.

If you need to add another detail, repeat this procedure.

6.Use the remaining tabs to finish entering order information, as follows:
To assign or credit a salesperson for this order, use the Sales Split
tab.
To add optional field information for the order, use the Optional
Fields tab.
To change currency exchange rates in a multicurrency system, use
the Rates tab.
To add a prepayment to this order, use the Prepayment button.

To check the totals for the order, click the Totals tab.
Tip: If you are shipping any goods, select the Create Invoice option
on the Totals tab to create an invoice for the shipped quantities
automatically.
7.If you use Payment Processing, you can pre-authorize or process a credit card
prepayment for the order before posting it.
8.Click Post to post the order, as well as any shipment, prepayment, or
invoice information.
After posting an order
Related topics

Copy Orders
Overview

To create a new order from one or more existing orders:
1.Open Order Entry > O/E Transactions > Copy Orders.
.

Click here for help on all Copy Orders fields

2.In the From Customer Number field, type the code for the customer
whose order details you want to copy for the new sales order.
3.In the To Customer Number field, type the code for the customer for
whom you are creating the new order, or use the Finder or the
navigation buttons to select it.
4.In the From Order Number and To Order Number fields, enter the
range of existing "From Customer" orders to use as the basis for the
new order.
5.If the customers are different and have different tax groups, enter or
select the tax group for the To customer.
6.Specify the type of order that you are copying (Active, Future,
Standing, or Quote).
7.If you use Project and Job Costing, choose whether you are copying
job-related orders.
If job-related, specify whether you want to copy orders that use
project invoicing.
Note: The program will select from the type of orders that you
choose. For example, if you select job-related, but do not select
project invoicing, the program will search for all orders within the
customer and order ranges which are job-related but do not use
project invoicing.
8.If the customers and the customer currencies are different, enter or
select the price list for the To customer. (If the From and To customer
is the same, the program copies the prices directly from the previous
orders.)
Note: If the original order uses a currency with more decimal places

than the new order, the program will display an error message if the
order contains miscellaneous charges.
9.Click the Go button ( ) to add the details from the existing orders to
the new order.
10.In the Order Number field, type an order number if you wish to assign
a number manually, or accept the ***New*** entry to let the program
assign the next number in the order number sequence.
11. In the Order Date field, enter or choose the date for the order. The
program automatically displays the session date as the order date.
12.If you need to put the order on hold for some reason, select the On
Hold option.
13.Choose the type of order that you are creating (Active, Future,
Standing, or Quote).
14.Enter a description and a reference for the order.
15.Use the detail grid on the Copy Orders form to edit the details as you
require.
To delete a detail line, you simply click the detail line, then press the
Delete key on your keyboard.
If Inventory Control permits the allocation of serial numbers or lot
numbers using the Qty. Ordered field, and the detail is for a serialized
or lotted item, you can optionally allocate serial numbers and/or lot numbers for the order quantity you
enter.
16.When you have finished entering information for the order, click the
Create button to generate the order.
After copying an order, or orders
Related topics

Change an Existing Sales Order
Overview

To change an existing sales order:
1.Use the Order Entry form to display the order that you want to edit.
a.

Open Order Entry > O/E Transactions > Order Entry.

b.

Type the number of the order you want to edit, or select it from the
Finder.
Click here for help on Order Entry fields.

2.Enter the changes you need to make. You can change everything you
entered originally, but the order number, customer number, and
whether the order is job-related.
For example, you can add lines, delete lines (unless you have
shipped quantities), change item quantities, change prices, add
comments or instructions, etc.
3.Click Post to post the changes.
Note that if you by increase the quantity backordered on a shipment for a
fully shipped order, the program then treats the order as incomplete.
Related topics

Change Payment Terms
Overview

To change payment terms for a sales order, shipment, or invoice:
1.Display the order, shipment, or invoice whose terms you want to
change.
a.

Open Order Entry > O/E Transactions > Order Entry, Shipment
Entry, or Invoice Entry.

b.

Type the number of the transaction that you want to edit, or select
it from the Finder.
Note: You cannot change the terms for a completed order, or for an
invoiced shipment, or for a posted invoice.
Click here for help on Order Entry fields.
Click here for help on Shipment Entry fields.
Click here for help on Invoice Entry fields.

2.Click the Customer tab, then change the terms code, discount, or
other payment terms as necessary.
3.Click Post.
Related topics

Change Customer or Detail Tax Information on
Documents
Overview

To change the customer tax group or tax class for a sales order,
shipment, or invoice:
1.Display the order or shipment whose tax information you want to
change.
You cannot change the tax information on a posted invoice. You must
change it before posting.
a.

Open Order Entry > O/E Transactions > Order Entry or Shipment
Entry.

b.

Type the number of the transaction that you want to edit, or select
it from the Finder.
Note: You cannot change information for a completed order, or for an
invoiced shipment, or for a posted invoice.
Click here for help on Order Entry fields.
Click here for help on Shipment Entry fields.
Click here for help on Invoice Entry fields.

2.To change the customer tax group (tax jurisdictions):
a.

Click the Customer tab.

b.

In the Tax Group field, type the new tax group code or select it
using the Finder.

3.To change the customer tax class (whether the customer is subject
to taxes):
a.

Click the taxes tab.

b.

In the Customer Tax Class field for each tax authority, enter the
correct tax class for the customer.

c.

Enter a tax registration number if necessary.

4.To change the tax class for a detail item or miscellaneous charge
(whether the item is taxable):

a.

Click the first tab for the document. (Depending on the type of
document, this is the Order, Shipment, or Invoice tab.)

b.

Select the detail line for which you want to edit tax information (on
the detail grid on the Document tab).

c.

Click the Item/Tax... button or press F9.

d.

In the tax grid at the bottom of the zoomed detail form, enter a
different tax class, if a different one applies.

e.

Change the Tax Included setting, if necessary.
You can only change this setting if "Tax Included" is allowed by the
Tax Authority in Tax Services.

f.

Click Save, then Close.
For information about sales tax calculation, see Calculating sales taxes.
For information about entering taxes manually, see Enter taxes manually.

5.When finished entering or editing the document, click Post.
Related topics

Change Tax Amounts on Order Entry
Documents
Overview

To change the total tax amount for a document:
1.Click the Taxes tab on the Order Entry, Shipment Entry, Invoice Entry,
or Credit/Debit Note Entry form.
2.Edit the tax class if necessary, then click the Calculate Tax button to
see the results of the change.
3.To enter taxes manually, clear the Calculate Taxes option (in the topleft corner of the tab), and then enter new tax amounts. You can also
change the tax base if applicable.
Note: You cannot edit taxes or see the Distribute Taxes button if the
Calculate Taxes option is selected.
4.Click the Distribute Taxes button to automatically distribute the new
tax total to the items on the order (you can also use the Distribute
Taxes button on the first document tab).
To change tax information for single items:
1.Click the Item/Tax... button on the first tab of the Order Entry,
Shipment Entry, Invoice Entry, or Credit/Debit Note Entry form.
2.Change the tax class for an authority, or the tax included option, if
necessary.
Note:
You cannot change the Tax Included setting unless the tax
authority allows it. (Tax authorities are defined in Tax Services.)
The tax amount will not be automatically recalculated until you
close this window and move to another document tab.
The tax amount will not be recalculated if you did not select the
Calculate Tax option. If you want to recalculate the tax, you will
have to select Calculate Tax, or use the Calculate Tax button on
the Taxes tab.

To enter item tax amounts manually:
1.Clear the Calculate Taxes option, select the line for which you want to
change tax amounts, and then click the Item/Taxes button to open the
zoomed form to change tax amounts.
Note: You must uncheck the Calculate Taxes option before you click
the Item/Tax... button. You can find the Calculate Taxes checkbox just
above the detail entry grid on the first tab, or on the Taxes tab.
2.Enter the new tax base and tax amount for the detail line.
3.When you are finished, click Close.
4.To check tax amounts for the document, click the Taxes tab or click
the Totals tab.
Related topics

Entering a Prepayment in Order Entry, Shipment
Entry, or Invoice Entry
Overview
Before you start

To add a prepayment:
1.Click the Prepayment button to open the Prepayments form.
The Prepayment button appears on the Order Entry, Shipment Entry,
and Invoice Entry forms.
Click here for more help on Order / Shipment Prepayment fields.
Click here for more help on Invoice Prepayment fields.

2.In the Batch field, type the number of the receipt batch to which you
want to add the prepayment, or use the Finder to select the receipt
batch.
If creating a new batch, select the bank code and the currency (for a
multicurrency system).
3.Select a deposit number, or click the New button if you are creating a
new deposit.
4.If you use Payment Processing and want to process a credit card
prepayment:
a.Select a payment code that uses the payment type SPS Credit
Card.
Tip: Click the Finder ( ) to see a list of payment codes and
associated payment types.
The Processing Code field appears.
b.Select a processing code that will be used to process the credit
card transaction.
Note: The bank and currency for the processing code you select
must match the bank and currency for the current transaction.
5.Enter a number for the receipt — this could be a check number or it
could be a confirmation or reference number for a credit card.

6.Use the calendar icon to choose the date of the receipt.
7.Enter the amount of the prepayment in the Receipt Amount field.
8.Click Add to add the prepayment.
If you use Payment Processing and you selected a payment code that
uses the payment type SPS Credit Card, the Charge button becomes
available.
9.If you want to process a credit card prepayment, click Charge and use
the Process Credit Card form to process the credit card prepayment.
10.Post the prepayment.
Note: To cancel a prepayment before you have added it, click Close
without first clicking Add.
Related topics

Process a Credit Card Prepayment
Overview
Before you start

To process a credit card prepayment:
1.In Order Entry, Shipment Entry, or Invoice Entry, enter and add a prepayment.
Note: You must select a payment code that uses the payment type
SPS Credit Card, and you must select a processing code for the
transaction.
After you add the prepayment, the Charge button becomes available.
2.Click Charge.
The Process Credit Card form appears.
3.Select a saved credit card or enter details for a new credit card:
To select a saved credit card, use the Finder ( ).
To enter details for a new card and save the card in the customer
record, click New ( ) and then add the card details in the Credit
Card Information form.
To enter details for a new credit card that will not be saved in the
customer record, select Enter a Card for One-Time Use.
4.Enter or review billing details. These may be different from the
information in the Sage ERP Accpac customer record. For example,
the customer may be using a company credit card, or may be
authorized to use a card on behalf of the primary cardholder.
5.Review totals. For some transactions, you can edit the amount in the
Subtotal and Taxes fields. When you edit one of these fields, the
amount in the other field is calculated automatically by subtracting the
amount you entered from the total.
6.Click Process Payment.
The Sage Payment Solutions browser form appears.
7.Enter credit card details.
Tips for entering credit card details

8.Click Submit.
Sage Payment Solutions processes the payment. The browser form
closes, and transaction details and a status message appear on the
Process Credit Card form.
9.On the Process Credit Card form, review transaction details and
status.
10.Close the Process Credit Card form.
Related topics

Void a Credit Card Prepayment
Overview
Before you start

To void a credit card prepayment:
1.On the Order Entry, Shipment Entry, or Invoice Entry form, select a
document for which a Sage Payment Solutions credit card
prepayment has been processed.
Note: You can void a prepayment in Order Entry only if the document
has not been posted. If the document has been posted, you must void
the prepayment in A/R Receipt Entry.
2.Click Prepayment to open the Prepayments form.
3.Click Void.
The Process Credit Card form appears and displays details for the
transaction.
4.Click Void Sale.
If the payment has not been settled in Sage Payment Solutions,
it is voided.
If the payment has been settled in Sage Payment Solutions, an
error message informs you that it cannot be voided. If you want
to refund the payment, you can process a refund on the A/R
Refund Entry form.
5.Close the Process Credit Card form.
Related topics

Pre-authorize a Credit Card Payment
Overview
Before you start

To pre-authorize a credit card payment:
1.Open Order Entry > Transactions > Order Entry.
2.Create or select an order for which you want to pre-authorize a credit
card payment.
3.Click the Pre-authorize button.
The O/E Pre-authorization form appears. The Pre-authorization
Amount field displays the order total (including taxes).
4.Verify that the Payment Code field displays the correct payment code,
or select a payment code that uses the payment type SPS Credit
Card.
Tip: Click the Finder ( ) to see a list of payment codes and
associated payment types.
5.Verify that the Processing Code field displays the correct processing
code, or select a processing code.
The bank code associated with the processing code appears in the
Bank Code field..
Note: The bank and currency for the processing code you select must
match the bank and currency for the transaction.
6.Enter remaining pre-authorization details, and then click Pre-authorize
to open the Process Credit Card form.
The Process Credit Card form appears.
7.Select a saved credit card or enter details for a new credit card:
To select a saved credit card, use the Finder ( ).
To enter details for a new card and save the card in the customer
record, click New ( ) and then add the card details in the Credit
Card Information form.

To enter details for a new credit card that will not be saved in the
customer record, select Enter a Card for One-Time Use.
8.Enter or review billing details. These may be different from the
information in the Sage ERP Accpac customer record. For example,
the customer may be using a company credit card, or may be
authorized to use a card on behalf of the primary cardholder.
9.Review totals. For some transactions, you can edit the amount in the
Subtotal and Taxes fields. When you edit one of these fields, the
amount in the other field is calculated automatically by subtracting the
amount you entered from the total.
10.Click Process Pre-authorization.
The Sage Payment Solutions browser form appears.
11. On the Sage Payment Solutions browser form, enter credit card
details.
Tips for entering credit card details

12.Click Submit.
Sage Payment Solutions processes the pre-authorization. The
browser form closes, and transaction details and a status message
appear on the Process Credit Card form.
13.On the Process Credit Card form, review pre-authorization details and
status.
14.Close the Process Credit Card form.
After pre-authorizing the credit card payment, you can post the order, and
then use the Shipment Entry form to capture the pre-authorization when
the order is shipped.
Related topics

Capture a Pre-authorized Credit Card Payment
Overview
Before you start

To capture a previously pre-authorized credit card prepayment:
1.Open O/E Order Entry or Shipment Entry and select an order for
which a credit card payment has been pre-authorized.
Note: On the O/E Shipment Entry form, the Create Invoice option is
selected by default. You must create an invoice when capturing a preauthorized credit card payment from this form.
2.For each item that you are shipping, enter the quantity shipped in the
Qty. Shipped field.
3.Click Capture.
The O/E Prepayments form appears.
Note: If you are using Shipment Entry, the receipt amount displays
the invoice amount, rather than the pre-authorized amount.
4.Select a batch or create a new one.
Note: The bank code for the batch must match the bank code
specified in the processing code used for the transaction.
5.Verify that the selected payment code matches the payment code for
the pre-authorized credit card, and that the receipt amount is correct.
Note: When you capture a pre-authorized credit card payment, the
amount captured can be different than the amount that was preauthorized. For example, if a customer at a restaurant adds a tip, the
amount captured will be greater than the amount that was preauthorized.
6.Click Add.
The Charge button becomes available.
7.Click Charge.
The Process Credit Card form appears.

8.Review billing details and totals. For some transactions, you can edit
the amount in the Taxes field in order to comply with Level 2
processing requirements. When you edit this amount, the amount in
the Subtotal field is calculated automatically by subtracting the taxes
you entered from the transaction total.
9.Click Process Payment.
Sage Payment Solutions processes the payment, and transaction
details and a status message appear on the Process Credit Card
form.
10.Close the Process Credit Card form.
11. Post the document.
Related topics

Void a Credit Card Pre-authorization
Overview
Before you start

To void a credit card pre-authorization:
1.Open Order Entry > Transactions > Order Entry and select an order
for which a credit card pre-authorization exists.
2.Click Void button.
The O/E Pre-authorization form appears.
3.Click Void.
The Process Credit Card form appears.
4.Click Void Pre-authorization.
Sage Payment Solutions voids the pre-authorization, and a time
stamp and status message appear on the Process Credit Card form
to confirm that the pre-authorization has been voided.
5.Close the Process Credit Card form.
Related topics

Cancel Backordered Quantities on a Sales Order
Overview

To cancel backordered quantities:
1.Use the Order Entry form to display the order that you want to edit.
a.

Open Order Entry > O/E Transactions > Order Entry.

b.

Type the number of the order you want to edit, or select it from the
Finder.
Click here for help on Order Entry fields.

2.Choose the line that you want to cancel.
3.Set the Quantity Backordered to zero to mark the line as complete.
Order Entry will add the line amount (the Quantity Ordered) to the
Sales Lost field on the Sales Statistics report.
4.Click Post to post the changes.
Note that if you by increase the quantity backordered on a shipment for a
fully shipped order, the program then treats the order as incomplete.
Related topics

Ship Orders and Items
Overview

Choose the appropriate set of steps from the following choices. See the
Overview above for more information.
To enter shipped quantities on the Order Entry form
To ship items for one or more orders using the Shipment Entry form
To ship items using the Shipment Entry form without creating an order first
Related topics

Invoice Shipments
Overview
To invoice shipped goods automatically on the Order Entry or Shipment Entry form:

To invoice one or more shipments using the Invoice Entry form:
1.Open Order Entry > O/E Transactions > Invoice Entry.
Click here for help on Invoice Entry fields.

2.Press the Tab key to accept *** NEW *** as the invoice number (in the
Invoice No. field).
Order Entry will assign an invoice number when you post the invoice.
If you do not want Order Entry to assign the number automatically,
you can type the new number yourself, and then press the Tab key.
3.Type the customer number or select it from the Finder.
4.If you are invoicing only one shipment, type the number of the
shipment, or select the number using the Finder.
If you are invoicing several shipments, select the From Multiple
Shipments option, then click the zoom ( ) button beside the option.
On the Create Invoice From Shipments form that appears select the
shipment numbers using the Finder, then click the Invoice button.
The program will display all of the information from the shipments that
you selected, allowing you to edit the existing information or post the
default invoice.
5.Check the

header information for the invoice

to make sure that it is correct.

6.You can edit invoice details right on the detail entry grid, or on the Items/Taxes form.
7.Click the Customer tab to check the payment terms, and to adjust any
discounts or scheduled payments associated with the terms code.
8.If you are invoicing several shipments, click the Sales Split tab to
check the allocation of the sale. If the shipments used various sales
splits, you will have to change the allocation manually.
9.Click the Taxes tab to check the tax class and the tax registration
number for the customer. If you are entering taxes manually, you can

adjust the tax base and tax amount, if necessary.
If the tax currency differs from the customer currency, you can enter a
reporting tax amount or let the program calculate it automatically.
9.Click the Totals tab to check the totals for the invoice.
10.Click Post to post the invoice and assign the invoice number, if you let
Order Entry assign your invoice numbers.
When posting is finished, the program will let you print the invoice.
Related topics

Enter a Return or Credit Note for an Existing
Invoice
Overview

Crediting existing invoices
1.Open Order Entry > O/E Transactions > Credit/Debit Note Entry.
Click here for help on Credit/Debit Note Entry fields.

2.Press the Tab key to accept *** NEW *** as the credit note number (in
the Document No. field). The default document type is Credit Note.
If you do not want Order Entry to assign the number automatically,
you can type the new number yourself, and then press the Tab key.
3.Type the customer number or select it from the Finder.
4.Type the invoice number or select it from the Finder. The invoice
information is automatically displayed.
Verify that the invoice information is correct. You can change the
entries in any fields other than the order number, invoice date, and
job-related checkbox.
If you want, you can click the Drilldown button beside the Invoice
Number field to view the invoice, and drill down from there to the
shipment and original order.
5.Check and edit the Actual Return Date and Credit Note Date (if they
differ from today's date).
6.Choose the action you want to take:
If all items on the invoice have been returned to inventory:
Check the quantities on the item details to make sure that the
number of items returned match the number on the invoice.
Check the Totals tab before posting the return.
If this is a partial return or price adjustment, or if items are damaged,
or if you need to add detail lines for the credit note, you will need to
change detail lines in the detail grid on the Credit Note tab.
a.

Tab into the detail entry grid (or click the grid) to start entering

credit note details. You may have to press the Insert key to start a
new line.
b.

Double-click the Type field to switch between entering items or
miscellaneous charges.

c.

If you are entering an Item detail, double-click the credit type field
and choose whether:
Items are being returned to inventory.
Items are damaged (and not being returned to inventory).
The price is being adjusted.

d.

Double-click the Item Number field and enter an item number or a
miscellaneous charge code. (If this is a job-related credit note, you
have to enter the contract and job information before you can
choose the item.)
You can also click the Item Number column heading to look up
item numbers.
If you are using a scanner, click in the Item Number field before
scanning the bar code.

e.

Use the tab key to move through the columns on the form. Or, you
can click the Item/Tax... button or press F9 to display an entry form
for adding items.
Some columns may not be displayed. Order Entry lets you
hide columns and change the column order.
The Price List is determined by the customer account. You
can change it.
The Location defaults from the Location in the top part of the
tab.
For information on other detail fields, see Credit Note Entry fields.

7.Once you are finished editing the credit note detail lines, you should
check the information on the remaining credit note tabs:
To assign or credit a salesperson for this credit note, click the
Sales Split tab.

To add optional field information to this credit note, click the
Optional Fields tab.
To change currency exchange rates in a multicurrency system,
click the Rates tab.
To check the totals for the credit note, or to add an extended
comment, click the Totals tab.
8.Click Post to post the credit note.
Order Entry asks if you want to print the credit note after posting it.
You can also print the credit note separately, from the O/E Forms
folder.
Related topics

Edit Credit Note Details
1.In the detail grid on the Credit Note tab, select the line to be credited.
If you are not crediting an invoice in Order Entry, the first line is
already selected. Also, if the invoice number does not exist in Order
Entry, the program displays a unit cost for each item you specify,
based on the item's costing method.
2.Select the type of credit:
Items Returned to Inventory
Damaged Items
Price Adjustment

If you do not want to affect any Order Entry or Inventory Control
statistics, you should enter the credit note in Accounts Receivable.
3.If you need to check or change tax information for the items, see Change
tax information.
4.Repeat steps 1 through 3 for each line to be credited.
5.Delete all lines that are not to be credited. To delete a line, select it
and press Delete. If you are prompted to confirm the deletion, choose
Yes.
6.Enter additional lines if needed. You can add lines for items or
miscellaneous charges.
7.When you are satisfied with the information, follow the steps in the
Verifying credit note totals topic.
Related topics

Enter a Return for a Cleared or Missing Invoice
Overview

To credit an invoice that no longer exists in Order Entry:
1.Open Order Entry > O/E Transactions > Credit/Debit Note Entry.
Click here for help on Credit/Debit Note Entry fields.

2.Press the Tab key to accept *** NEW *** as the credit note number (in
the Document No. field). The default document type is Credit Note.
If you do not want Order Entry to assign the number automatically,
you can type the new number yourself, and then press the Tab key.
3.Type the customer number or select it from the Finder.
You can also click:
The Zoom button to check address and contact information.
To change customer information such as the tax code or price list,
click the Customer tab, and then return to the Credit Note tab.
4.Type the number of the invoice. If you do not know the number, leave
the Invoice Number field blank.
If the invoice still exists in Accounts Receivable, you must use the
correct invoice number to properly credit the invoice. If you enter an
invoice number that does not currently exist in Order Entry, the
program uses the entries in the default template.
5.

Fill in the general credit note information fields on the Credit Note tab.

6.Tab into the detail entry grid (or click the grid) to start entering credit
note details. You may have to press the Insert key to start a new line.
7.Double-click the Type field to switch between entering items or
miscellaneous charges.
8.If you are entering an Item detail, double-click the credit type field and
choose whether:
Items are being returned to inventory.
Items are damaged (and not being returned to inventory).

The price is being adjusted.
9.Double-click the Item Number field and enter an item number or a
miscellaneous charge code. (If this is a job-related credit note, you
have to enter the contract and job information before you can choose
the item.)
You can also click the Item Number column heading to look up item
numbers.
If you are using a scanner, click in the Item Number field before
scanning the bar code.
10.Use the tab key to move through the columns on the form. Or, you
can click the Item/Tax... button or press F9 to display an entry form for
adding items.
Some columns may not be displayed. Order Entry lets you hide
columns and change the column order.
The Price List is determined by the customer account. You can
change it.
The Location defaults from the Location in the top part of the tab.
For information on other detail fields, see Credit Note Entry fields.
11. To assign or credit a salesperson for this credit note, click the Sales
Split tab.
12.To add optional field information to this credit note, click the Optional
Fields tab.
13.To change currency exchange rates in a multicurrency system, click
the Rates tab.
14.To check the totals for the credit note, or to add an extended
comment, click the Totals tab.
15.Click Post to post the credit note.
Order Entry asks if you want to print the credit note after posting it.
You can also print the credit note separately, from the O/E Forms
folder.
Related topics

Enter or Verify Credit Note (Debit Note) Totals
Before you post a credit note or a debit note, you should verify the
document total. You can also change the debit note and credit note
dates, if necessary, and specify whether the credit note or debit note
includes the invoice discount (if one applied)
To enter or verify document totals:
1.Choose the Credit Note or Debit Note Totals tab.
Click here for help on Credit Note (Debit Note) Entry fields.

2.Use the Totals tab to:
Specify whether miscellaneous charges were discounted on the
invoice, in addition to items.
Enter a credit note discount percentage or fixed amount. This is
the discount from the invoice which has to be subtracted from the
amount of the credit note. The amount you enter is prorated to all
the items on the credit note. If you discounted miscellaneous
charges as well, the discount is also prorated to the miscellaneous
charges.
The program displays the following information:
Estimated weight for all items on the credit note (using the unit
weights from Inventory Control item records).
Number of detail lines on the credit note.
Subtotal of all shipped items and miscellaneous charges on the
credit note.
Credit note amount, which is calculated as:
Credit note subtotal (shipped items + misc. charges)
- Discount
+ Tax (if it is not included in item prices)
If item prices include tax, the amount of the included tax is
displayed on the right side of the form. It does not affect the
calculation of the credit note amount.

3.If you need to change tax information for the customer, see Change tax
information.
4.When you are satisfied with the document and totals information, click
Post to post the credit note or debit note.
5.Print the credit note or debit note.
Related topics

Assign Lot Numbers or Serial Numbers to a
Debit Note
Overview

To assign serial numbers or lot numbers to a debit note:
1.Open Order Entry > O/E Transactions > Credit/Debit Note Entry.
2.Select Debit Note as the document type.
3.Select

Items Removed From Inventory

as the debit type.

4.Select an invoice number, if necessary.
The program automatically fills in other fields with information from the
invoice.
5.For items that are not kitting items:
a.

Enter a quantity in the Quantity column, and then click the Quantity
column heading.
If you are editing an existing document, and you only want to
change a serial number or lot number already assigned, select the
item line, and then click the Quantity column heading.
includes a Serials tab if the item is
serialized and/or a Lots tab if the item is lotted.
The Serial/Lot Numbers form that appears

Click here for help on the fields on the Serial/Lot Numbers form.

b.

Use the Serials tab to assign serial numbers

.

c.

Use the Lots tab to assign lot numbers

.

The quantity of serial numbers or lot numbers you require appears in
the Serial (or Lot) Number list. The quantity remaining to be allocated
is reduced as you allocate numbers.
For kitting items,

.

click here for instructions on assigning numbers

6.When the quantity of serial numbers and/or lot numbers remaining is
zero, click Close to return to the Credit /Debit Note Entry form.
7.Enter any additional information required for the document, and then
post the transaction, as usual.

Related topics

Assign Lot Numbers or Serial Numbers to a
Credit Note
Overview

To assign serial numbers or lot numbers to a credit note:
1.Open O/E Transactions > Credit/Debit Note Entry.
2.Select Credit Note as the document type.
3.Select

Items Returned To Inventory

as the credit type.

4.Select the invoice number, if necessary.
The program automatically fills in other fields with information from the
invoice.
Note: If the credit note refers to an invoice number, you cannot
allocate serial numbers or lot numbers to details that existed on the
invoice. However, you can allocate serial and lot numbers to new
details that you add to the credit note. You can also delete serial and
lot numbers from existing details.
5.Use the detail grid to enter item information, including the inventory
location to which you are returning the item.
For items that are not kitting items:
a.

Enter a quantity in the Quantity column, and then click the Quantity
column heading.
If you are editing an existing document, and you only want to
change a serial number or lot number already assigned, select the
item line, and then click the Quantity column heading.
includes a Serials tab if the item is
serialized and/or a Lots tab if the item is lotted.
The Serial/Lot Numbers form that appears

Click here for help on the fields on the Serial/Lot Numbers form.

b.

Use the Serials tab to assign serial numbers

.

c.

Use the Lots tab to assign lot numbers

.

The quantity of serial numbers or lot numbers you require appears in
the Serial (or Lot) Number list. The quantity remaining to be allocated

is reduced as you allocate numbers.
For kitting items,

.

click here for instructions on assigning numbers

6.When the quantity of serial numbers and/or lot numbers remaining is
zero, click Close in the Serial/Lot Numbers form.
7.Enter any additional information required for the credit note, and then
post the transaction, as usual.
Related topics

Assign Serial Numbers or Lot Numbers to an
Order
Overview

To assign serial numbers and/or lot numbers to an order:
1.Open Order Entry > O/E Transactions > Order Entry.
2.Start a new order that includes a detail for a serialized or lotted item,
or display an existing order.
3.Allocate serial numbers and lot numbers to the items.
For items that are not kitting items:
a.

Enter a quantity for the item in the Qty. Ordered field (or accept the
quantity, if it is correct), and then press Tab, or click the Zoom ( )
button, if it is available.
If Inventory Control uses the option to allocate serial numbers
and/or lot numbers using the order quantity, the Serial/Lot
Numbers Allocation form appears. (You must allocate serials
numbers and/or lot numbers using the Qty. Ordered field before
you can ship them using the Qty. Shipped field.)

b.

If the Serial/Lot Number Allocation form does not appear, enter a
quantity in the Qty. Shipped field, and then press the Tab key or
click the Zoom ( ) button to display the form.
The Serial/Lot Numbers form that appears includes a Serials tab if
the item is serialized and/or a Lots tab if the item is lotted.
Click here for help on the fields on the Serial/Lot Numbers form.

Use the Serial/Lot Numbers Allocation form to allocate serial
numbers and lot numbers, as follows:
.

Use the Serials tab to assign serial numbers
Use the Lots tab to assign lot numbers

.

The quantity of serial numbers or lot numbers you require appears
in the Serial (or Lot) Number list. The quantity remaining to be
allocated is reduced as you allocate numbers.

c.

When the quantity of serial numbers and/or lot numbers remaining
is zero, click Close to return to the Order Entry form.
For kitting items,

.

click here for instructions on assigning numbers

4.If you are shipping the items, now, and you have not already entered
a quantity shipped, enter a quantity in the Qty. Shipped field, and then
press Tab, or click the Zoom ( ) button.
5.On the Serials/Lot Numbers Allocation form that appears:
If Inventory Control does not use the option to allocate serial
numbers for the quantity ordered, you must allocate the
required serial numbers for the quantity shipped.
.

To identify serial numbers

If you allocated serial numbers to the quantity ordered, you can
view the serial numbers, but you cannot change them.
If Inventory Control does not use the option to allocate lot
numbers for the ordered quantity, allocate the required lot
numbers for the quantity shipped.
.

To identify lot numbers

If you allocated lot numbers to the quantity ordered, enter the
quantities that you are shipping for each lot.
6.Click Close to return to the Order Entry form.
7.Fill in any additional information required for the order, and then click
Post.
Related topics

Assign Lot Numbers or Serial Numbers to an
O/E Shipment
Overview

To assign serial numbers or lot numbers to a shipment:
1.Open Order Entry > O/E Transactions > Shipment Entry.
2.Enter information for the shipment, as usual.
3.If you specified an order number and you are shipping all of the
items on backorder:
a.

Click the Ship All button.

b.

For each serialized or lotted item (not kitting items):

a.
b.

Select the item, and then click the Zoom button ( ) for the Qty.
Shipped field.
Use the Serial/Lot Numbers Allocation form to assign serial numbers and lot numbers

, as

required.
If the item is a kitting item that contains serialized or lotted
components:
a.

Select the item.

b.

Click the Components button.

c.

On the Kitting Components form that appears, select a
serialized or lotted item, and then click the Zoom button for the
Qty. Shipped field.

d.

Use the Serial/Lot Numbers Allocation form to assign serial numbers and lot numbers

to each

component .
If you are not shipping all the items, or if you did not specify an
order number, for each serialized or lotted item:
a.

Specify an inventory location for each item detail. (Because serial
numbers and lot numbers are maintained by location, you must
specify a location before you enter a quantity.)

b.

In the Quantity Shipped field, enter the quantity you are shipping,

and then click the Zoom button ( ) for the Qt.y. Shipped field.
c.

Use the Serial/Lot Numbers Allocation form to assign serial numbers and lot numbers

, as required.

Click here for help on the fields on the Serial/Lot Numbers Allocation form.

4.Click Close to return to the transaction entry form. .
5.Finish entering information for the shipment, as needed, and then
click Post.
Related topics

Assign Lot Numbers or Serial Numbers to an
O/E Invoice
Overview

To assign serial numbers or lot numbers to an invoice:
1.Open Order Entry > O/E Transactions > Invoice Entry.
2.Enter information for the invoice, as usual.
3.For each serialized or lotted item (not kitting items):
a.
b.

Select the item, and then click the Zoom button ( ) for the Qty.
Invoiced field.
Use the Serial/Lot Numbers Allocation form to assign serial numbers and lot numbers

, as required.

If the item is a kitting item that contains serialized or lotted
components:
a.

Select the item.

b.

Click the Components button.

c.

On the Kitting Components form that appears, select a serialized
or lotted item, and then click the Zoom button for the Qty. invoiced
field.

d.

Use the Serial/Lot Numbers Allocation form to assign serial numbers and lot numbers

to each

component .
Click here for help on the fields on the Serial/Lot Numbers Allocation form.

4.Click Close to return to the transaction entry form. .
5.Finish entering information for the invoice, as needed, and then click
Post.
Related topics

Print Quotes, Order Confirmations, Picking
Slips, and Invoices
You can print Order Entry forms using the choices in the O/E Forms
folder, or you can print them immediately after posting the corresponding
transaction.
What business forms come with Order Entry?
Before you start

To print Order Entry reports:
1.Open Order Entry > O/E Forms.
2.Choose the form that you want to print.
3.Press F1 when the print form appears for detailed information on
report options.
4.To begin printing, click the Print button.
Related topics

Print an Order Confirmation Immediately After
Posting
Before you start

To print a confirmation for an order you have just posted:
1.With the order displayed in the Order Entry form, click the Post button
to post the order.
If you are shipping goods (and, optionally, producing an invoice) you
can also print a picking slip and an invoice.
When Order Entry is finished posting the order, it displays a form
which lists the order number and lets you choose which documents
you want to print.
2.Select the order confirmation check box (and any other documents
available documents that you want to print). Order Entry opens the
Order Confirmations form and selects the order you just posted.
3.Complete the information as follows:
Use Confirmation. Type the name of the order confirmation form
you want to use. If you are not sure of the name, choose Browse,
then select the form from the list that appears.
Delivery Method. Choose how you want to send the order
confirmation to your customer.
Select Print Destination to print to your usual print destination.
Select Customer to use the delivery method specified in each
customer record in the Accounts Receivable program (such
as e-mail).
If you choose Customer as the delivery method, select the ID for
the e-mail message that you want to send with order confirmations
for customers that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for invoices, click the Zoom button for the Message
ID field.

Print Serial/Lot Numbers. This option is available if you use
Serialized Inventory and Lot Tracking. You can select this option if
any order items are serialized or lotted, and you want to include
serial numbers and/or lot numbers on the order confirmation.
Require Shipping Labels. Select this option if you want to print
shipping labels for marked order confirmations only. (When you
print shipping labels, you can print labels for the order
confirmations that were marked as requiring them.)
Note that you can print shipping labels only if you entered a
number on the Totals tab for each order.
Use Custom Form. Do not select the Custom Form option unless
you are using a customized confirmation form that requires it. (This
option is for custom forms that do not use the report selection
criteria sent by this print form.)
Print Kit Component Items. Select Print Kit Component Items if
you want to print all of the components in kit assemblies on the
confirmation.
Print Bills of Material Component Items. Select Print Bills of
Material Component Items if you want to print all of the
components in assemblies that are manufactured from bills of
material on the confirmation.
Print On Hold Orders. Select this option if you want to print the
confirmation for orders which are on hold.
4.Click Print.
If you are printing the order confirmation on a printer (and not sending
the form by e-mail), you can click the Align button to print a sample
copy of the confirmation to check that the order information prints in
the right places on preprinted forms. If the sample form does not line
up correctly, ensure that you have correctly inserted the forms in the
printer.
What business forms come with Order Entry?
Related topics

Print a Receipt Immediately After Posting
Before you start

To print a receipt immediately after posting an order, shipment, or
invoice that included a prepayment:
1.Click the Post button on the order, shipment, or invoice.
When Order Entry is finished posting the transaction, select the
Prepayment Receipt Confirmation checkbox on the posting
confirmation form.
2.Order Entry opens the Receipt Printing form and selects the
prepayment that you just posted.
3.Complete the information as follows:
Detail or Summary. Select a detail or summary receipt depending on
the amount of information that you want to include with receipts.
Reprint Previously Printed Receipts. Select this option to reprint
receipts you printed before. Do not select this option if you want to
print only receipts that you have not yet printed.
Delivery Method. Select Print Destination (to print the invoices to the
current print destination) or Customer (to use the delivery method
specified in each customer record).
E-mail Message ID/Fax Message ID. These fields appear when you
select Customer as the print destination. Select the code for the
receipt message you want to accompany e-mailed or faxed receipts.
Select By. Choose how you want to select the receipt that you are
printing:
Batch/Entry Number. Select a range of receipt batch numbers for
which to print invoices. The number of the current batch is
displayed by default when you print from the Receipt Entry form.
Customer/Document Number. Select a range of customers and
document numbers for which to print receipt confirmations.
Customer/Check/Receipt Number. Select a range of customers
and check /receipt numbers for which to print receipt

confirmations.
If you do not select a range of document or check/receipt numbers,
the program prints receipt confirmation for all the documents or
check/receipts for the customer or A/R Receipt batch numbers you
specify.
If you print several document types at once, the program first sorts the
document numbers alphabetically, then numerically, to determine
which documents belong in the range you specify.
4.Click Print.
If you are printing the receipt on a printer (and not sending the form by
e-mail), you can click the Align button to print a sample copy of the
receipt to check that the order information prints in the right places on
preprinted forms. If the sample form does not line up correctly, ensure
that you have correctly inserted the forms in the printer.
What business forms come with Order Entry?
Related topics

Print an Invoice Immediately After Posting
Before you start

To print an invoice immediately after posting it:
1.Click the Post button while the invoice is displayed.
When Order Entry is finished posting the invoice, it displays a form
which it lists the invoice number and asks whether you want to print
the invoice.
2.Select the Invoice checkbox, and click Yes to print the invoice. Order
Entry opens the Invoice Printing form and selects the invoice you just
posted.
3.Complete the information as follows:
Use Invoice. Select the name of the invoice form to use. If you are
not sure of the name, choose Browse, then select the form from
the list that appears.
Delivery Method. Choose how you want to send the invoice to
your customer.
Select Print Destination to print to your usual print destination.
Select Customer to use the delivery method specified in each
customer record in the Accounts Receivable program (such
as e-mail).
If you choose Customer as the delivery method, select the ID for
the e-mail message you want to send with invoices for customers
that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for invoices, click the Zoom button for the Message
ID field.
Print Serial/Lot Numbers.
Require Shipping Labels. Select this option if you want to print
shipping labels for marked invoices only. (When you print shipping
labels, you can print labels for the invoices that were marked as
requiring them.)

Note that you can print shipping labels only if you entered a
number on the Totals tab for each invoice.
Include Backordered Items. Select this option if you want to
include backordered items on these invoices.
Use Custom Form. Do not select the Custom Form option unless
you are using a customized invoice that requires it. (This option is
for custom forms that do not use the report selection criteria sent
by this print form.)
Print Kit Component Items. Select Print Kit Component Items if
you want to print all of the components in kit assemblies on the
invoice.
Print Bills of Material Component Items. Select Print Bills of
Material Component Items if you want to print all of the
components in assemblies that are manufactured from bills of
material on the invoice.
Retainage.
4.Click Print.
If you are printing the invoice on a printer (and not sending the form
by e-mail), you can click the Align button to print a sample copy of the
invoice to check that the information prints in the right places on
preprinted forms. If the sample form does not line up correctly, ensure
that you have correctly inserted the forms in the printer.
What business forms come with Order Entry?
Related topics

Print Order Confirmations for a Range of Orders
Overview
Before you start

To print a range of confirmations:
1.Open Order Entry > O/E Forms > Order Confirmations.
2.Select the order confirmations to print as follows:
Use Confirmation. Type the name of the order confirmation form
you want to use. If you are not sure of the name, choose Browse,
then select the form from the list that appears.
From Order Number / To Order Number. Enter the first and last
order numbers for which you want to print confirmations, or use
the Finder to select a range of orders.
Delivery Method. Choose how you want to send the order
confirmation to your customer.
Select Print Destination to print to your usual print destination.
Select Customer to use the delivery method specified in each
customer record in the Accounts Receivable program (such
as e-mail).
If you choose Customer as the delivery method, select the ID for
the e-mail message you want to send with order confirmation for
customers that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for invoices, click the Zoom button for the Message
ID field.
Include Confirmations Already Printed. Select this option if you
want to print new copies of confirmations that you printed before.
Print Serial/Lot Numbers. This option is available if you use
Serialized Inventory and Lot Tracking. You can select this option if
any order items are serialized or lotted, and you want to include
serial numbers and/or lot numbers on the order confirmations.
Require Shipping Labels. Select this option if you want to print

shipping labels for marked order confirmations only. (When you
print shipping labels, you can print labels for the order
confirmations that were marked as requiring them.)
Note that you can print shipping labels only if you entered a
number on the Totals tab for each order.
Use Custom Form. Do not select the Custom Form option unless
you are using a customized confirmation form that requires it. (This
option is for custom forms that do not use the report selection
criteria sent by this print form.)
Print Kit Component Items. Select Print Kit Component Items if
you want to print all of the components in kit assemblies on the
confirmation.
Print Bills of Material Component Items. Select Print Bills of
Material Component Items if you want to print all of the
components in assemblies that are manufactured from bills of
material on the confirmation.
Print On Hold Orders. Select this option if you want to print the
confirmation for orders which are on hold.
3.Choose Print.
If you are printing the order confirmation on a printer (and not sending
the form by e-mail), you can click the Align button to print a sample
copy of the confirmation to check that the order information prints in
the right places on preprinted forms. If the sample form does not line
up correctly, ensure that you have correctly inserted the forms in the
printer.
What business forms come with Order Entry?
Related topics

Print a Range of Invoices
You can print a range of invoices after they are posted and before they
are cleared from Order Entry.
Before you start

To print a range of invoices:
1.Open Order Entry > O/E Forms > Invoices.
2.Select the invoices to print as follows:
Use Invoice. Select the name of the invoice form to use. If you are
not sure of the name, choose Browse, then select the form from
the list that appears.
From Invoice Number / To Invoice Number. Enter the first and
last invoice numbers you want to print, or use the Finder to select
the invoices.
Delivery Method. Choose how you want to send the invoice to
your customer.
Select Print Destination to print to your usual print destination.
Select Customer to use the delivery method specified in each
customer record in the Accounts Receivable program (such
as e-mail).
If you choose Customer as the delivery method, select the ID for
the e-mail message you want to send with invoices for customers
that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for invoices, click the Zoom button for the Message
ID field.
Include Invoices Already Printed. Select this option if you want
to print new copies of invoices you printed before.
Print Serial/Lot Numbers. This option is available if you use
Serialized Inventory and Lot Tracking. You can select this option if
any items on these invoices are serialized or lotted, and you want
to include serial numbers and/or lot numbers on the invoices.

Require Shipping Labels. Select this option if you want to print
shipping labels for marked invoices only. (When you print shipping
labels, you can print labels for the invoices that were marked as
requiring them.)
Note that you can print shipping labels only if you entered a
number on the Totals tab for each invoice.
Include Backordered Items. Select this option if you want to
include backordered items on these invoices.
Use Custom Form. Do not select the Custom Form option unless
you are using a customized invoice that requires it. (This option is
for custom forms that do not use the report selection criteria sent
by this print form.)
Print Kit Component Items. Select Print Kit Component Items if
you want to print all of the components in kit assemblies on the
invoice.
Print Bills of Material Component Items. Select Print Bills of
Material Component Items if you want to print all of the
components in assemblies that are manufactured from bills of
material on the invoice.
Retainage. The Retainage option is available if your Accounts
Receivable system uses Retainage accounting. Select the option
to include retainage information on the invoices.
3.Choose Print.
If you are printing the invoice on a printer (and not sending the form
by e-mail), you can click the Align button to print a sample copy of the
invoice to check that the information prints in the right places on
preprinted forms. If the sample form does not line up correctly, ensure
that you have correctly inserted the forms in the printer.
What business forms come with Order Entry?
Related topics

Print a Range of Credit Notes or Debit Notes
Overview

To print a range of credit notes or debit notes:
1.Open Order Entry > O/E Forms > Credit/Debit Notes.
2.Select the credit notes or debit notes to print as follows:
Document Type. Select the name of the invoice form to use. If
you are not sure of the name, choose Browse, then select the form
from the list that appears.
Use Credit/Debit Notes. Select the name of the credit or debit
note form to use. If you are not sure of the name, choose Browse,
then select the form from the list that appears.
From Credit/Debit Note Number / To Credit/Debit Note
Number. Enter the first and last credit or debit notes numbers you
want to print, or use the Finder to select the credit/debit notes.
Delivery Method. Choose how you want to send the credit or
debit note to your customer.
Select Print Destination to print to your usual print destination.
Select Customer to use the delivery method specified in each
customer record in the Accounts Receivable program (such
as e-mail).
If you choose Customer as the delivery method, select the ID for
the e-mail message you want to send with credit or debit notes for
customers that use e-mail as the delivery method.
To view or edit the message for the selected ID, or to add a new email message for invoices, click the Zoom button for the Message
ID field.
Include Credit/Debit Notes Already Printed. Select this option if
you want to print new copies of credit/debit notes that you printed
before.
Print Serial/Lot Numbers. This option is available if you use
Serialized Inventory and Lot Tracking. You can select this option if

any items used in document details are serialized or lotted, and
you want to include serial numbers and/or lot numbers on the
credit note or debit note.
Use Custom Form. Do not select the Custom Form option unless
you are using a customized credit or debit note form that requires
it. (This option is for custom forms that do not use the report
selection criteria sent by this print form.)
Print Kit Component Items. Select Print Kit Component Items if
you want to print all of the components in kit assemblies on the
credit or debit notes.
Print Bills of Material Component Items. Select Print Bills of
Material Component Items if you want to print all of the
components in assemblies that are manufactured from bills of
material on the credit or debit notes.
Retainage. The Retainage option is available if your Accounts
Receivable system uses Retainage accounting. Select the option
to include retainage information on the credit note or debit note.
3.Click Print.
If you are printing the credit/debit notes on a printer (and not sending
the form by e-mail), you can click the Align button to print a sample
copy of the credit/debit notes to check that the information prints in
the right places on preprinted forms. If the sample form does not line
up correctly, ensure that you have correctly inserted the forms in the
printer.
Related topics

Look Up Sales History for an Item or a Customer
Overview

To look up sales history for an item or a customer:
1.Open Order Entry > O/E Statistics and Inquiries > Sales History.
Click here for help on Sales History fields.

2.Specify the range of years and periods for which to display sales
history.
3.In the Select By field, select:
Customer Number — to view all of the items ordered or returned
by a particular customer.
Item Number — to view all of the customers who ordered or
returned a particular item.
4.Type the item number or customer number for which to display
history, or use the Finder to select the number.
5.If you use multicurrency accounting, specify whether to display
amounts in your functional currency or in the customer's currency.
6.Click the Go button ( ).
If you displayed history for a customer number, the program lists all of
the items used on invoices or returns for the customer for each year
and period.
If you displayed history for an item number, the program lists all of the
customers to which you sold item for each year and period.
7.To print a sales history report that uses your current selections:
a.

Click the Print button.

b.

On the Sales History Report form that appears, make any
additional selections that you want, and then click Print.

c.

Click Close to return to the Sales History form.

8.To view transactions processed for a particular item or customer in a
year and period, double-click the line for which you want more
information, or select the line and then click the Details button.

The transactions appears in the Sales History Detail form.
Click here for help on Sales History detail fields.

To drill down to a particular invoice or return, select the
transaction on the Sales History Detail grid, and then click the
Document button to display the document.
To view serial numbers or lot numbers allocated in a
transaction that included serialized or lotted items, select the
transaction line on the grid, and then click the Serial/Lot Numbers
button.
Related topics

Look Up Sales Statistics
Overview

To look up sales statistics:
1.Open Order Entry > O/E Statistics and Inquiries > Sales Statistics.
Click here for help on Sales Statistics fields.

2.Select the year, period, and currency for which you want to see sales
statistics.
3.To print a Sales Statistics report that uses your selections:
a.

From the File menu, click Print.

b.

Change any selections, as you need.

c.

Click Print.

d.

Click Close to return to the Sales Statistics inquiry form.

Related topics

Look Up Transaction History in Inventory
Control
The Inventory Control program lets you look up transactions created in
Sage ERP Accpac Order Entry, Purchase Orders or Inventory Control.
To look up transactions:
1.Open Inventory Control > I/C Statistics and Inquiries > Transaction
History Inquiry.
2.To change the fiscal year and period, select a new one from the dropdown list beside the As At Year/Period field.
3.Enter the beginning and ending item numbers, or select them using
the Finders.
4.Enter the beginning and ending account set numbers, or select them
using the Finders.
5.Enter the beginning and ending location numbers, or select them
using the Finders.
6.When you are satisfied with your inquiry criteria, click the Go button.
7.A list of items matching your criteria is displayed. To view a list of
recent transactions involving an item, select the item from the list and
click the Details button.
8.The list includes the document number and other information about
the transaction.
9.To drill down to the original document, highlight a transaction and click
the Details button.
Sage ERP Accpac will display the original transaction unless it has been
cleared from the database.
Related topics

Perform Day-End Processing
Run day-end processing as part of your daily routine, to keep your
Inventory Control audit trail and reports up to date. You can run day-end
processing as many times a day as you want.
What does Day-End Processing do?
Before you start

To perform day-end processing:
1.Open Inventory Control > I/C Periodic Processing > Day End
Processing.
2.Click Process.
3.When the message appears to indicate that processing is complete,
click the OK button or press Enter to close the message and the Day
End Processing form.
After using
Related topics

Create G/L Transaction Batch
Overview
Before you start

To create a batch of G/L transactions:
1.Open Order Entry > O/E Periodic Processing > Create Batch.
2.Specify the day-end number through which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
3.Optionally, select Post A/R Batch if you also want to post invoice
transactions created by Order Entry in the Accounts Receivable
program. (See the Overview notes.)
4.Click Process.
After using
Related topics

Post Accounts Receivable Invoice Batch
Overview
Before you start

To post a batch of invoices created by Order Entry in A/R:
1.Open Order Entry > O/E Periodic Processing > Create Batch.
2.Specify the day-end number through which to create general ledger
transactions. (You create the transactions for all outstanding day-end
numbers up to and including the number you specify.)
3.Select Post A/R Batch to post invoice transactions created by Order
Entry in the Accounts Receivable program. (See the Overview notes.)
4.Click Process.
After using
Related topics

Change Order Entry Processing Options
Overview
Before you start

To change O/E processing options:
1.Open Order Entry > O/E Setup > Options.
.

Click here for help on all Options fields

2.Click the Processing tab.
These are the options you can select or change on the Processing tab
in the O/E Options form.
Accumulate By
Allow Edit Of Statistics
Allow Non-Existent Customers
Apply Credit Note to Previously Credited Invoice
Calculate Backorder Quantities
Calculate Tax Reporting Amounts Automatically
Clear Expired Quotes
Commission By Sales/Margin
Credit Checks
Default Create Invoice Option To
Default Order Unit Of Measure
Default Order Weight Unit Of Measure
Default Quantity Committed
Default Quote Expiration Days
Default Rate Type
Default Template Code
Functional Currency
Include Other Pending Transactions in Credit Limit Check
Include Pending A/R Transactions in Credit Limit Check
Include Pending O/E Transactions in Credit Limit Check
Keep Sales History
Keep Sales Statistics
Keep Transaction History
Multicurrency
Period Type
Post A/R Batches During Posting.../On Request Using...
Track Commissions

Note:
Use the I/C Options form in Inventory Control to change whether
inventory is costed when posting Order Entry transactions or
during day end processing.
Costing items and creating subledger transactions and audit
information during posting will increase the time it takes to post
transactions in Inventory Control, Order Entry, and Purchase

Orders.
If you change from updating costs during day end processing to
updating costs during posting, you must first run day end to cost all
outstanding posted O/E, I/C, and P/O transactions.
3.Click the Save button to save any changes to processing options.
After changing O/E Options
Related topics

Change Posting and Day End Processing
Options
Note:
Day end processing options are set up in the Inventory Control
program. These options also affect when the Order Entry program can
post General Ledger and Accounts Receivable batches.
You cannot change day end processing options if any Inventory
Control forms are open, or other users are working with Order Entry.
Overview
Before you start

To change batch creation and posting options for A/R transactions
created by Order Entry:
1.Open Order Entry > O/E Setup > Options.
Click here for help on all O/E Options

.

2.Click the Processing tab.
3.Change the following option.
Post A/R Batches During Posting or Day End Processing/On Request Using Create Batch Icon

Note: If you choose to post A/R batches when you post O/E
transactions, and you cost inventory during transaction posting, Order
Entry will create and post an A/R batch each time you post an invoice.
4.Click the Save button when you are finished.
To change batch creation and posting options for G/L transactions
created by Order Entry:
If you are now using the Create Batch form to create transactions, print a
copy of the latest G/L Transactions report, then create any outstanding
transactions before changing your choice for this option.
1.Open Order Entry > O/E Setup > G/L Integration.
Click here for help on all G/L Integration fields

.

2.Change the appropriate option.
Create G/L Transactions
Create G/L Transactions by

Consolidate G/L Batches

3.Click the Save button when you are finished.
Make sure that no one else is using the Order Entry data and that no
other Order Entry forms are open for the company before you save
changes.
To change day end processing options in the Inventory Control
program:
1.Open Inventory Control > I/C Setup > Options.
2.Click the Costing tab.
3.Change the appropriate option.
Cost items during posting or Day End Processing
Create Subledger Transactions and Audit Info. During (Posting / Day End Processing)

4.Click the Save button when you are finished.
Make sure that no one else is using the Inventory Control data and
that no other Inventory Control forms are open for the company
before you save changes.
To change batch creation and posting options for G/L transactions
created by Inventory Control:
Note: Inventory Control generates G/L transactions from order shipments
and returns.
1.Open Inventory Control > I/C Setup > G/L Integration.
2.Change the appropriate option.
Consolidate G/L Batches
Create G/L Transactions
Create G/L Transactions by

3.Click the Save button when you are finished.
Make sure that no one else is using the Inventory Control data and
that no other Inventory Control forms are open for the company
before you save changes.
After changing Day End Procesing and posting options
Related topics

Change General Ledger Integration Options
You cannot change settings on the Integration tab of the G/L Integration
form if other Order Entry forms are open, or other users are working with
the Order Entry database.
Make sure that no other Order Entry forms are open for the company
before you save changes to the G/L Integration form.
Overview
Before you start

To change General Ledger integration options:
1.Open Order Entry > O/E Setup > G/L Integration.
2.The Integration tab lets you change these options:
Create G/L Transactions
Create G/L Transactions by
Consolidate G/L Batches
Transaction Type
Source Ledger
Source Type

3.Click the Transaction tab to change the information that appears with
G/L transactions for the G/L Detail Comment, G/L Detail Description, G/L Detail Reference, and
G/L Entry Description.
The Entry grid lists each of the transactions produced by Order Entry,
and displays the information that is currently included in G/L
transactions produced from these O/E transactions.
a.

Double-click the transaction description or transaction detail
information that you want to change.

b.

On the form that appears, highlight the information that you want
to add to the transaction field, and use the Include and Exclude
buttons to add or remove field information.
You can assign one or more pieces of information (segments) to
each G/L transaction field, provided that the combined length of
the segments and separators does not exceed 60 characters.
Fields exceeding this limit will be truncated when you post the
general ledger transactions.

c.

Click Save to save the contents of the G/L transaction field.

d.

Choose a different field to edit, or click Close to return to the
Transaction tab.

4.Click Save to save changes to the G/L Integration form.
After changing G/L Integration Options
Related topics

Change Customer Credit Check Options
Overview
Before you start

To change O/E processing options:
1.Open Order Entry > O/E Setup > Options.
.

Click here for help on all Options fields

2.Click the Processing tab.
These are the credit check options you can select or change on the
Processing tab in the O/E Options form.
Credit Checks
Include Other Pending Transactions in Credit Limit Check
Include Pending A/R Transactions in Credit Limit Check
Include Pending O/E Transactions in Credit Limit Check

3.Click the Save button to save any changes to processing options.
After changing O/E Options
Related topics

Add Miscellaneous Charges
Overview
Before adding

To add miscellaneous charges:
1.Open Order Entry > O/E Setup > Miscellaneous Charges.
Click here for help on Miscellaneous Charges fields.

2.If you do not use multicurrency accounting, type the code you
want to use in the Miscellaneous Charge Code field or select it using
the previous/next buttons (
).
If the field is not clear, click the New icon next to the Miscellaneous
Charges field, then type the code you want to use. (If you are
displaying an existing miscellaneous charge, you can “copy” it to a
new code by typing the new code over the displayed code, making
any changes you need to the information, and adding the record.)
If you use multicurrency accounting:
a.

Click the New icon in the button group on the right side of the form.

b.

Type the currency code or select it from the Finder.

c.

Type the code you want to use.

3.Type a description for the charge.
4.If the charge has a standard amount, type the amount.
5.Type the general ledger account number to use for the revenue account or
choose the account number from the Finder.
6.If you use Project and Job Costing, and you are also using this
charge for job-related orders:
a.

Select the Allow For Jobs option.

b.

Specify an account for recording the miscellaneous charge expense.

c.

Specify a clearing account for the miscellaneous charge.

7.If you use Optional Fields, click the Zoom button ( ), choose the
optional fields that apply to this charge, and (optionally) enter default

optional field information.
8.Select the tax authorities and sales tax classes that apply to the
charge.
9.Click Save to add the charge.

Related topics

Add Optional Fields to Records and
Transactions
Overview
Before you start

To add optional fields to miscellaneous charges, transactions, and
transaction details:
1.Open Order Entry > O/E Setup > Optional Fields.
Click here for help on all Optional Fields setup fields

.

2.Select a record/transaction type from the Optional Fields For list.
.

Click here for more information

3.Click in the optional field entry grid, and then press the Insert key on
your keyboard to start a new line.
4.Click the Finder (or press F5) in the Optional Field column, then
choose an existing optional field from the Finder list. (The description
will appear automatically.)
5.Click the Finder in the Default Value column, then choose the value
for the optional field selected in step 3.
6.Toggle in the Auto Insert column to:
Choose Yes if you want to allow the optional field (and its default
value) to appear in new records and transactions.
Choose No if you do not want the optional field to appear
automatically.
7.Click the Settings button to select the G/L accounts that this optional
field will be included with for G/L transactions and transactions sent to
other subledgers.
Click here for a list of G/L accounts for shipment, invoice, and credit/debit note transaction details.

Consider carefully the purpose of each optional field that you add.
For example, only send optional fields to General Ledger that are
used for financial analysis, and only to the accounts where they are
required.

8.Click the Close button to close the Settings form. Click the add button
on the O/E Optional Fields form, and then click Close.
Make sure that no one else is using the Order Entry data and that no
other Order Entry forms are open for the company before you save
changes.
After adding optional fields to O/E
Related topics

Allow Editing of Sales Statistics
Overview
Before you start

To change O/E processing options:
1.Open Order Entry > O/E Setup > Options.
.

Click here for help on all Options fields

2.Click the Processing tab.
3.Change the Allow Edit Of Statistics option.
4.Click the Save button to save any changes to processing options.
After changing statistics
Related topics

Edit Salesperson Commission Rates
Overview

Note: You edit salesperson's commission rates in Accounts Receivable.
To edit salesperson commission rates
1.Open Accounts Receivable > A/R Setup > Salespersons.
2.Select the salesperson that you want to edit.
3.On the Commission tab, select the Paid Commissions check box if
necessary.
You can turn the Commissions option on or off, or change any of the
commission rate information.
4.Select the number of commission rates in the drop-down box.
5.Click Save to record the changes.

Print Shipping Labels
Overview
Before you start

To print shipping labels:
1.Open Order Entry > O/E Forms > Shipping Labels.
2.Choose the type of label you want to use. Order Entry comes with two
label formats that you may be able to use:
OELABEL.RPT Shipping label: 1½" x 4" sheet labels for a laser
printer (14 labels on a page)
OELABELD.RPT Shipping label: 1½" x 3¾" tractor feed labels
3.Choose whether to print labels for a range of invoices, orders, or
shipments.
4.Specify the range of invoices, orders, or shipments.
5.Choose whether you want to reprint previously printed labels.
6.Choose whether you want to print labels for all shipments or invoices
or print labels only for those invoices, orders, or shipments that you
marked as requiring labels.
7.Click Print.
If you are printing to a printer, Order Entry displays the Print
Destination dialog box to let you confirm your printer selection and
change the number of copies to print. Click OK if the settings are
correct; otherwise, click Cancel or Setup.
If you are printing to a file, Order Entry displays the name of the file so
you can change it or cancel printing.
If you are printing to the screen (preview), Order Entry displays the
report. If you want, you can then export it to a file or send it to the
printer.
Related topics

Print Reports to a Printer
Sage ERP Accpac lets you print reports to a printer, to the screen, to a
file, or as an attachment to an e-mail message.
Note: You must be assigned to a security group that has been assigned
permission to change the print destination. (Otherwise, the only
destination available will be to a physical printer.)
If your printer is already set up, follow these instructions to change
the print destination back to Printer:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select Printer as the print destination.
3.Click OK.
If you have not yet selected a printer for Sage ERP Accpac, follow
these instructions to choose a default printer for printing all reports
from Sage ERP Accpac.
1.On the Sage Accpac Desktop menu, select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Microsoft Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page

Setup form.
Related topics

Print Customer Forms Using an E-mail Delivery
Method
Overview

Note: Sage Accpac ERP also lets you print any reports as an attachment
to an e-mail message. See Print Reports as an E-mail Attachment.
To automatically e-mail business forms to customers:
1.In the Accounts Receivable, open A/R Customers > Customers.
2.For each customer record:
a.

Specify the customer's e-mail address on the Address tab.

b.

On the Contact tab, specify the contact's e-mail address if you use
it.

c.

On the Processing tab, choose E-mail or Contact's E-mail as the
delivery method.

d.

Save the customer record.

3.If you use ship-to locations, open A/R Customers > Ship-To Locations.
4.For each ship-to record:
a.

Specify the ship-to location e-mail address on the Address tab.

b.

On the Contact tab, specify the contact's e-mail address if you use
it.

c.

Save the ship-to record.

5.Open Order Entry > O/E Setup > E-mail Messages.
6.Create the E-mail message that you want to accompany each
business form that you send to customers.
7.Each time you print a form in Order Entry, choose Customer as the
Delivery Method, and choose the e-mail message that you want to
use with the business form (if you use more than one).
When you print using a customer delivery method
Related topics

Select a Printer for Reports
Sage ERP Accpac lets you choose a default printer for all reports that
you print, and assign different printers to specific reports (such as
invoices or labels).
To change the default printer for all reports:
1.On the Sage Accpac Desktop menu, select File > Page Setup.
2.Click the Printer button.
3.From the drop-down list, choose the printer that you want to use.
The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4.Click the Properties button to change available settings for your
particular printer.
5.Click OK to close the Properties form.
6.Click OK again to return to the Page Setup form.
7.Click the Print Destination button and check that the print destination
is set to Printer.
If you are using a laser printer, you would normally select the Report
Paper Size and Report Orientation options on the Print Destination
form.
8.Click OK on the Print Destination form, and then click OK on the Page
Setup form.
To assign a specific report to a specific printer:
1.Open the report form which you want to assign to a printer.
2.From the menu on the report form, Select File > Print Setup.
3.Choose whether you want to choose the printer that is set as the
Windows default printer, or choose a specific printer for this report.
Note: By default, the specific printer is the one chosen as the printer
on the Page Setup form selected from the File menu on the Sage
ERP Accpac Desktop.

The printer list includes all printers that have been added to the
Printers and Faxes list in Windows.
4.Choose a paper source if you want to select a particular paper tray or
paper stock for this report.
5.Click OK Page Setup page.
To clear the assigned printer for this report
Prompt for printer each time you prnt
Related topics

Print Reports to the Screen
Sage ERP Accpac lets you print reports to a printer, to the screen, to a
file, or as an attachment to an e-mail message.
Note: You must be assigned to a security group that has been assigned
permission to change the print destination. (Otherwise, the only
destination available will be to a physical printer.)
To change the default print destination to Preview:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select Preview to view a report on the screen.
You can also print from the Preview window by clicking the Printer
button.
3.Click OK.
Additional information regarding print destinations
Related topics

Print Reports to a File
verview

O

To change the default print destination to File:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select File to save your report as a file in your usual print file folder.
3.Click OK.
When you print to a file, the report is assigned a unique name, for
example, CS1000.TXT.
Related topics

Print Reports as an E-mail Attachment
Sage ERP Accpac lets you print reports to a printer, to the screen, to a
file, or as an attachment to an e-mail message.
Note: This is not the same as using the e-mail delivery method for
customer forms such as order confirmation and invoices. Order Entry
also lets you send quotes, order confirmations, and invoices to customers
using the delivery method specified in A/R customer records.
Click here for information on using the e-mail delivery method.

To change the default print destination to E-mail:
1.From the Sage Accpac Desktop menu, select File > Print Destination.
2.Select E-mail to create a file that can be attached to an e-mail.
3.Select either Adobe Acrobat (PDF) or Rich Text Format (RTF) as the
file format for the e-mail attachment.
You can open PDF files with Adobe Acrobat Reader (available as a
free download from the Adobe Software Web site).
You can open RTF files with most Windows and Linux word
processing programs.
4.Click OK.
When you print with an e-mail destination
Related topics

Print Order Entry Reports
What types of reports does Order Entry have?
Before you start

To print Order Entry reports:
1.Open Order Entry > O/E Reports.
Or
Open Order Entry > O/E Forms.
2.Choose the report that you want to print.
3.Press F1 when the print form appears for detailed information on
report options.
4.To begin printing, click the Print button.
Related topics

Print Salesperson Commission Rates
Overview

You can print the Salesperson Commission Rates from the Accounts
Receivable program.
To print salesperson commission rates:
1.Open Accounts Receivable > A/R Setup Reports > Salespersons.
Or, choose File > Print from the Salesperson Commission Rates form.
2.Choose Salesperson Profile as the Report Type.
3.Specify the range of salespeople that you want to appear on the
report.
4.Select the option to Include Commission Rates.
5.Click the Print button.
Related topics

Save Personal Report Settings for Future
Printing
Sage ERP Accpac lets you save report settings as defaults for printing
Order Entry forms (such as invoices or labels) and for several Order
Entry reports, including the Transaction List, Order Action Report, Aged
Orders, Invoice Action, and Sales History reports.
To save current settings as defaults:
1.Open the Order Entry form or report for which you want to save
printing settings.
2.Choose each of the settings on the print form that you want as a
default setting.
3.Select Settings > Save Settings As Defaults from the report menu.
To clear saved settings:
1.Open the Order Entry form or report for which you want to reset
printing settings.
2.Select Settings > Clear Saved Settings from the report menu.
Related topics
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Changes in Order Entry 5.6
Order Entry version 5.6A included reporting enhancements, as well as
integrated features for handling serialized and lotted items, which
previously required separate Sage ERP Accpac programs.

Take Advantage of Fully Integrated Serialized
Inventory and Lot Tracking
Since version 5.6, serialized inventory and lot tracking features have
been installed and fully integrated with Sage ERP Accpac Inventory
Control. You require a license for Serialized Inventory and Lot Tracking to
turn on these features in Sage ERP Accpac programs, but you no longer
need to purchase and install Sage ERP Accpac Serialized Inventory and
Lot Tracking programs separately.
All the icons for managing serial numbers and lot numbers are
conveniently located in existing Inventory Control folders, where you
expect to find them, rather than in separate Serialized Inventory and Lot
Tracking folders.
We have also redesigned the forms you use to assign serial numbers
and lot numbers in transactions. It is now much simpler to assign these
numbers on orders, shipments, invoices, debit notes, and return credit
notes in Order Entry!
For more information, see Understanding Serialized Inventory and Lot Tracking.
Including Serial Numbers and Lot Numbers on Reports
The following Order Entry reports and forms now let you print serial
numbers and lot numbers:
Credit/Debit Notes
Invoices
Order Confirmations
Picking Slips
Posting Journals
Transaction List
Sales History report

Improved Reports
In addition to the improvements noted in the previous section, we have

enhanced the following reports:
Sales History Report
Salesperson Commissions Report
Invoice Action Report
Sales History Report
Sales Statistics Report

No Default Item Quantity for Debit Notes
Order Entry 5.6 no longer inserts a default item quantity for debit notes
that are created from invoices.

Upgrading from an Earlier Version?
If you are upgrading directly from version 5.4, see Changes in Order Entry 5.5.
If you are upgrading directly from version 5.3, see Changes in Order Entry 5.4.

What's New in Order Entry 5.5
Order Entry 5.5 let you:
Enter job-related orders, shipments, invoices, credit notes, and debit
notes in Order Entry, track projects in Project and Job Costing, and
generate invoices in Order Entry or in Project and Job Costing.
Use the start and end dates entered on Inventory Control price lists.
Enter different document dates and posting dates for transactions.
Drilldown to transactions that are on sales order and purchase order
when entering orders, shipments, invoices, and credit or debit notes.
Enter prepayments on shipments as well as on orders and invoices.
Check that duplicate orders are not being entered for customers
(based on the customer's purchase order number).
Calculate backordered quantities based on customer options.
Cost inventory items during posting but delay creating transactions
and audit information until you run Day End Processing.
Inquire on items that are expected to ship within a specified date
range.
Create order entry templates with blank tax groups.
Specify the source type codes for G/L transactions.
Hide, show, or allow users to edit the unit cost/extended cost fields in
credit/debit note entry.
Override the customer account set during order entry.
Send transaction entries to General Ledger from Credit/Debit Note
Entry.
Create single, unconsolidated A/R invoice details from job-related
invoice details and invoice details with optional fields.
Each of the unconsolidated A/R invoice lines will produce a G/L entry
with sales account, cost of goods sold account, and clearing account
details when posted in Accounts Receivable.

Create a single detail line for each kitting item listed on an invoice,
instead of showing one line for each component of each kitting item
when processing job-related invoice details or invoice details with
optional fields.
Post transactions faster.
Also note:
You now set up salespeople and add commission information in the
A/R Salespersons form, instead of setting up salespeople in A/R and
then adding commission information in Order Entry. The A/R
Salespersons report has also been changed to show commission
information.
The program ships with a different set of picking slips:
OEPICKORDER1, OEPICKORDER2, OEPICKSHIPMENT1, and
OEPICKSHIPMENT2. It no longer includes OEPICK01 and
OEPICK02.
If you are upgrading from version 5.3A, also see the topic Changes in Order Entry
5.4 to read about the features introduced in that version.
See the following topics for more details about version 5.5A features:
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

What's New in Order Entry 5.4
Order Entry 5.4 let you:
View shipment and invoice numbers on orders, order and invoice
numbers on shipments, and shipment numbers on invoices.
Drill down through each level of an order, from orders to shipments
and invoices, from shipments to orders and invoices, from invoices to
shipments, and credit/debit notes to invoices.
Drill down to invoices posted for specific item numbers using the
Transaction History Inquiry form in Inventory Control.
Inquire on sales orders by customer, based on order status.
Print an invoice action report to check whether orders have been
partially or fully invoiced to ensure they are invoiced in a timely
manner.
Copy orders from one customer to another using the Copy Orders
form.
Specify discounts for entire orders as well as for each order detail.
Check customers’ credit ratings based on:
The total outstanding balance in Accounts Receivable.
The total outstanding balance including pending transactions in
Accounts Receivable and Order Entry.
An outstanding balance that’s overdue by a set number of days.
Trigger a warning or error if a credit note has previously been posted
for an invoice.
Assign security rights to view item costs during order entry.
Specify item weight and weight unit of measure during order entry,
shipment entry, and invoice entry.
Allow, warn, reject, or require approval when item prices fall below a
specified cost or margin.
Prohibit the sale of non-sellable items from Inventory Control.

Use new inventory pricing features, including pricing by weight,
pricing by multiple units of measure, and pricing based on current cost
plus a specified percentage or amount.
Default the inventory location based on the customer’s ship-to
location, so goods are shipped from the nearest warehouse.
(Accounts Receivable now provides default locations for both the
customer record and the ship-to location.)
Automatically determine the appropriate inventory item by using the
customer item numbers that match your inventory. Customer item
numbers are set up in Inventory Control.
Use the lowest price available to a customer, regardless of the
contract price. (An option has been added to Inventory Control’s
Contract Pricing form that allows you to use the lowest price.)
Set the Picking Slip Printed status for only those orders for which a
picking slip was printed.
Specify a tax reporting currency and automatically calculate taxes in
source currency, functional currency, and tax reporting currency. (This
feature provides support for legislation in several tax jurisdictions.)
In a multicurrency environment, update Accounts Receivable with
source currency and functional currency amounts, thereby eliminate
any rounding differences between Accounts Receivable and Order
Entry.
Allow inquiry on multiple levels of bills of material in order, shipment,
and invoice entry.
Use the G/L Integration form to choose the information that you want
to transfer to General Ledger in the description, reference, and
comment fields of General Ledger transactions arising from Order
Entry transactions.
See the following topics for more details about version 5.4A features:
Enhanced Pricing Available in Order Entry
Enhancements for Entering Orders
Enhanced Online Customer, Pricing, and Credit Note Checks
G/L Integration Options
Optional Fields in Finders
Required Optional Fields without Default Values

Gathering Order Entry Data
After you activate your Sage ERP Accpac Order Entry data, you must
add the data from your company's present ordering system to Order
Entry.
First, gather all your current order entry records. These can be manual
records or printed listings and reports from other accounting software,
such as:
A list of the general ledger accounts used in your Order Entry system,
including the revenue account to which miscellaneous charges are
posted.
Lists of the codes and other information you will use to set up: shipvia codes, miscellaneous charges, templates.
Outstanding orders, including backorders, standing orders, future
orders, and quotes.
Historical sales statistics for orders (optional).
Samples of your order confirmation, picking slip, shipping label,
invoice, and credit note forms.
If you use a multicurrency order entry ledger, a list of the source
currencies in which you record transactions, and a list of current
exchange rates.
You may be able to enter much of the order entry data by reading it
directly from files created by another program. In Sage ERP Accpac
this is called importing.
See also
Steps for Setting Up Order Entry

Adding Order Entry Accounts
Add the revenue account to your general ledger to which amounts
generated by miscellaneous charges are credited when you post
invoices, and debited when you post credit notes.
All other general ledger accounts to which Order Entry data is posted are
specified in other Sage ERP Accpac programs:
In Accounts Receivable, you specify the Receivables Control and
Prepayment Liability accounts.
In Inventory Control, you specify the Sales, Returns, Cost Of Goods
Sold, Cost Variance (if using standard or most recent costing), and
Damaged Goods accounts for item categories, and the Shipment
Clearing and Inventory Control accounts for account sets.
In Tax Services, you specify the Tax Liability accounts.
For information about these accounts, refer to the online help for each
program (press F1 when a program form is open).
See also
Steps for Setting Up Order Entry

Choosing Order Entry Options
The options you choose on the O/E Options form determine how your
Order Entry system operates and the types of data that it stores and
displays. You can also use the form after setup to review your entries
and, as needed, change most of them.
The O/E Options form contains the tabs listed below. For information
about the options on a tab, click the name of the tab, then click the Field
List button in the online Help that appears.
Company
Processing
Documents

See also
O/E Options form — Overview
Choosing G/L Integration Options
Steps for setting up Order Entry

Adding Order Entry Setup Records
Before you can process orders, invoices, and credit notes in Order Entry,
you need to set up records for ship-via codes, miscellaneous charges,
and e-mail messages. You can also define templates to speed up and
simplify order entry, and add optional fields to be used in transactions.
Using the Options form, you set up processing and G/L integration for
transactions.
Choose icons from the Setup folder to set up:
E-mail messages
G/L integration
Optional fields
Options
Miscellaneous charges
Ship-via codes
Templates

Import Setup Records
You can also import setup records for Order Entry.
See also
Steps for Setting Up Order Entry

Entering Outstanding Orders
When you set up Order Entry, you should enter all outstanding orders
into the new system so you can track them effectively.
If you currently have a computerized order entry system, you may be
able to use Order Entry's import utilities to transfer records directly
into Sage ERP Accpac Order Entry.
If you are transferring orders from another Sage ERP Accpac Order
Entry database, you can export them from the other database, edit
them in a spreadsheet or other program to change codes, amounts,
and other information, then import them into the new Order Entry
system you are setting up.
For detailed information on importing and exporting, see the help for
System Manager.
After importing, you should print the Transaction Lists for orders and
invoices to verify the imported records.

You can also enter orders individually
As an alternative, you can enter outstanding orders directly in Order
Entry.
See also
Importing Orders and Invoices
Importing Returns and Credit Notes
Steps for Setting Up Order Entry

Entering Sales Statistics
Order Entry maintains sales statistics for the current year and for all the
previous years for which you retain data.

Entering current-year sales statistics
If you set up partway through a fiscal year, you need to enter sales statistics from
previous periods of the current year if you want to view these statistics
online or print reports which include them.

Entering previous-year sales statistics
You can also enter any sales statistics from previous years that you want
to view online or for which you want to print reports.
Once you are set up, Order Entry automatically updates statistical
information each time you run day-end processing.
See also
Accumulating sales statistics for reporting
Steps for Setting Up Order Entry

Designing Order Entry Forms
Sage ERP Accpac Order Entry includes sample formats you may be able
to use with your laser or ink-jet printer "as is" or adapt to print on the
forms you use for quotes, order confirmations, picking slips, shipping
labels, invoices, and credit notes.
You can use these forms as is, adapt them to suit your needs, or design and create
your own forms:
OECONF01.RPT — order confirmation for laser printers
OECONF02.RPT — order confirmation for pre-printed forms
OECONF03.RPT — order confirmation for internet orders
(used by iConnect Sales Orders Order Entry)
OEPICK01.RPT — picking slip for laser printers
OEPICK02.RPT — picking slip for pre-printed forms
OECRN01.RPT — credit note for laser printers
OECRN02.RPT — credit note for pre-printed forms
OEINV01.RPT — invoice for laser printers
OEINV02.RPT — invoice for pre-printed forms
OEINV03.RPT — invoice for internet orders
(used by iConnect Sales Orders Order Inquiry)
OEINV04.RPT — invoice for laser printers (non-datapiped)
OEINV05.RPT — invoice for pre-printed forms (non-datapiped)
OEQUOT01.RPT — quote for laser printers
OEQUOT02.RPT — quote for pre-printed forms.
There are two additional invoice formats, OEINV04 and OEINV05, that
are similar to OEINV01 and OEINV02, but they are not datapiped. To use
these non-datapiped forms, edit the OEINV01 and OEINV02 sections of
OERPT.INI.

Editable Fields

The fields you can include in Order Entry forms are listed in the online
document, Forms.wri, that is installed in the ACCPAC\DOCS\OE5
"xAENG directory when you install Order Entry."
You can also customize the information that appears on invoices: invoice
terms, comment/instructions, serial numbers, invoice prepayment
information, item/location information, customer, and salesperson
information.

Test Formats with Sample Data
Before you process transactions, you should test your formats by printing
the forms you use. The easiest way to test printing is to use the sample
data that comes with Order Entry.
To print test copies from your own data, first add orders, invoices, and
credit notes in the Order Entry form and the Returns/Credit Note Entry
form, then choose the various forms icons in the Forms folder.

Create Your Own Forms
If you want to customize forms using Crystal Reports, you must install
Crystal Reports.
See also
Steps for setting up Order Entry
Setting up multicurrency accounting

E-Mail Messages Field List
Description
E-mail Subject
Inactive
Last Maintained
Message ID
Message Type

G/L Integration Form Field List
Integration tab
Consolidate G/L Batches
Create G/L Transactions
Create G/L Transactions by
G/L Transactions Generated Through Day End Number
Transaction Type
Source Ledger
Source Type

Transactions tab
G/L Detail Comment
G/L Detail Description
G/L Detail Reference
G/L Entry Description

G/L Integration — Transactions Tab
Use this form to:
Select the information to appear in the Entry Description, Detail
Description, and Detail Reference and Comment fields in G/L
transactions arising from invoices and shipments.
Look up the last Day End Number for which you have created general
ledger batches.
Click the field list button or on of the links shown below for more
information on selecting G/L integration options.
Integration tab

Changing Settings
You can change any of your choices in the G/L Integration form at any
time. However, you should be aware that any changes you make will
apply only to general ledger transactions created after the change, and
will not affect existing general ledger batches.

Before using the G/L Integration form
Before changing any of the settings or other information in the G/L
Integration form, make sure you understand the impact the options have
on processing within Order Entry.
See also
Miscellaneous Charges
Ship-Via Codes
Steps for setting up Order Entry
Templates

Miscellaneous Charges Field List
Allow for Jobs
Amount
Authority and Authority Description
Currency (multicurrency ledgers)
Extended Cost
Misc. Charge Clearing Account
Misc. Charge Expense Account
Misc. Charge Revenue Account
Miscellaneous Charge Code and Description
Optional Fields
Sales Tax Class and Class Description

Optional Fields Form Field List
uto Insert

A
Default Value and Description
Optional Field and Description
Optional Fields For
Required
Settings... button
Value Set

Inserting Optional Fields on Orders
Note:
Optional fields must be assigned to the order form (using the Optional
Fields setup form) before you can insert them on orders.
Fields on the Optional Fields tab apply to the complete order.
Fields on the Optional Fields popup form for a single transaction detail
apply only to the detail.
You require Transaction Optional Fields security access to insert or
remove optional fields from O/E transactions.
To insert an optional field for an order
To insert an optional field for an order detail

If you use the same optional fields and values for invoices in Accounts
Receivable (with exactly the same values), the optional field information
from the Order Entry transaction appears with the transaction in Accounts
Receivable.

Inserting Optional Fields in Shipments
Note:
Optional fields must be assigned to the shipments form (using the
Optional Fields setup form) before you can insert them on shipments.
Fields on the Optional Fields tab apply to the complete shipment.
Fields on the Optional Fields popup form for a single transaction detail
apply only to the detail.
You require Transaction Optional Fields security access to insert or
remove optional fields from O/E transactions.
To insert an optional field on a shipment
To insert an optional field on a shipment detail

If you use the same optional fields in Accounts Receivable as in
Shipment Entry, the optional field information from the Order Entry
transaction appears with the transaction in Accounts Receivable.

Inserting Optional Fields on Invoices
Note:
Optional fields must be assigned to the invoice form (using the
Optional Fields setup form) before you can insert them on invoices.
Fields on the Optional Fields tab apply to the complete invoice
Fields on the Optional Fields popup form for a single transaction detail
apply only to the detail.
You require Transaction Optional Fields security access to insert or
remove optional fields from O/E transactions.
To insert an optional field for an invoice
To insert an optional field for an invoice detail

If you use the same optional fields in Accounts Receivable (with exactly
the same values), the optional field information from the Invoice Entry
transaction appears with the transaction in Accounts Receivable. If you
also assign the same field and value in General Ledger, the optional field
data will flow through to General Ledger.

Inserting Optional Fields on Credit/Debit Notes
Note:
Optional fields must be assigned to the credit/debit note form (using
the Optional Fields setup form) before you can insert them on credit
notes or debit notes.
Fields on the Optional Fields tab apply to the complete credit/debit
note.
Fields on the Optional Fields popup form for a single transaction detail
apply only to the detail.
You require Transaction Optional Fields security access to insert or
remove optional fields from O/E transactions.
To insert an optional field for a credit note or debit note
To insert an optional field on a credit note or debit note detail

If you use the same optional fields in Accounts Receivable as in
Credit/Debit Note Entry, the optional field information from the Order
Entry transaction appears with the transaction in Accounts Receivable.

Assigning Optional Fields in the Copy Orders Form
The optional fields and default optional field values defined for Orders in
Optional Fields setup are used when you create an order by copying
existing orders using the Copy Orders form.
The Orders setup optional fields that are flagged to be automatically
inserted and the appropriate default optional field values automatically
appear in Copy Orders.
If the optional fields defined for the customer match the optional fields
defined for Orders, the optional field values for the customer are
automatically defaulted.
If an optional field has been defined for Orders that does not exist for
the customer, the default optional field value specified for the Orders
optional field is defaulted.
Copy Orders details grid
If one or more Order details optional fields are set to Yes, the Optional
Fields indicator displays Yes. If optional fields have not been defined for
Order details or if none are automatically inserted, the field displays No.
The Optional Fields zoom form shows the optional fields set up for Order
details. Any optional fields codes specified on the original order appear
as default.

Adding and Deleting Optional Fields
You use the Optional Fields form in the O/E Setup folder to add or delete
optional fields.
You can add any optional fields for Order Entry that are defined in
Common Services for use in Sage ERP Accpac.
If you attempt to delete an optional field that is used in Order Entry, the
program displays an error message. You must first delete the optional
field from the records that use it, or post any transactions that include it.
Note: If security is turned on for your Sage ERP Accpac system, you
need Setup Maintenance authorization to add or delete optional fields.

Options Form Field List
Company tab
Contact Name
Fax Number
Telephone

Processing tab
Accumulate By
Allow Edit Of Statistics
Allow Non-Existent Customers
Apply Credit Note to Previously Credited Invoice
Calculate Backorder Quantities
Calculate Tax Reporting Amounts Automatically
Clear Expired Quotes
Commission By Sales/Margin
Credit Checks
Default Create Invoice Option To
Default Order Unit Of Measure
Default Order Weight Unit Of Measure
Default Posting Date
Default Quantity Committed
Default Quote Expiration Days
Default Rate Type
Default Template Code
Functional Currency
Include Other Pending Transactions in Credit Limit Check
Include Pending A/R Transactions in Credit Limit Check
Include Pending O/E Transactions in Credit Limit Check
Keep Sales History
Keep Sales Statistics
Keep Transaction History
Multicurrency
Period Type
Post A/R Batches During Posting/Day End or On Request Using...
Track Commissions

Documents tab
Aging Periods
Document Type
Length
Next Number
Prefix

Options Form — Company Tab
Use this tab to change the contact name, telephone number, and fax
number for the company's Order Entry administration.
Click the links below for help on using the corresponding tabs:
Processing

Documents

For an overview of the Options form, see Options form.
For information about integrating Order Entry with the General Ledger
program, see G/L Integration.
Company name and address
To change the company name and address, or to change the contact
name, telephone number, and fax number at the company level, use the
Company form in Common Services.
Contact name and telephone and fax numbers for Order Entry
To change the contact name, telephone number, and fax number for the
Order Entry administration, use the Company Options page of the
Options form in the Setup form.
Depending on the choice of the Format Phone Numbers option in the
Company Profile in Common Services, parentheses and hyphens may be
inserted.
See also
Miscellaneous Charges
Ship-Via Codes
Steps for setting up Order Entry
Templates

Options Form — Processing Tab
Use the Processing tab of the Options form to choose whether your
Order Entry system:
Calculates backorder quantities

automatically.

Displays the pricing unit or the stocking unit as the default order unit of
measure in Order Entry forms.
Saves transaction

and sales information for reporting.
.

Accumulates sales statistics

Allows editing of statistics.
Uses a default template for entering orders, invoices, and credit notes. (You
cannot specify the default code until you have added templates in the
Templates form).
Tracks commissions

on sales or margins.

Allows you to enter a default number of days for the expiration of quotes.
Allows you the option to clear expired quotes after a delay you specify
Allows you the option to choose to post to non-existent customers.
For an overview of the Options form, see Options form.
Click these buttons for more help:
Finder

or
Zoom

Drop-Down
Lists

Click the links below for help on using the corresponding tabs:
Company

Documents

Changing option selections
After setup, you can change your choices for all Processing options, with
the following exceptions and restrictions:
You cannot change your choice about using the Multicurrency option
in Order Entry. This choice is made for Order Entry in the Accounts

Receivable Options form, and you can change it only in Accounts
Receivable. (Note that you cannot turn off the Multicurrency option
once you have selected it and saved your changes to the Accounts
Receivable Options form.)
You can change the type of year (fiscal or calendar) and period by
which you accumulate item statistics (in the Enterprise and Corporate
Editions), but you should do so only at fiscal or calendar year end.
If you change either method part way through a year, the statistics
already accumulated will be incorrect or in the wrong period.
See also
G/L Integration
Miscellaneous Charges
Ship-Via Codes
Steps for setting up Order Entry
Templates

Options Form — Documents Tab
Use this tab to:
to assign to quotes, orders, invoices, and
credit notes if you use Order Entry to assign document numbers
automatically. You can change these prefixes and next numbers at
any time.
Specify the prefixes and next numbers

Apply standard aging periods for the Aged Orders report.
Click these buttons for more help:
Click these buttons for more help:

Finder

or

Drop-Down
Lists

Zoom

Click the links below for help on using the corresponding tabs:
Company

Processing

See also
G/L Integration
Miscellaneous Charges
Ship-Via Codes
Steps for setting up Order Entry
Templates

Adding Ship-Via Codes
You add ship-via codes to identify the shipping methods or carriers you
use to deliver goods to customers (for example, courier, air mail, parcel
post).
Ship-via codes are optional. If you do not add them to Order Entry and
specify them on orders, the Order/Invoice Entry form will display the shipvia description entered with A/R ship-to locations (if you specify a ship-to
location for the order).

To add a ship-via code
1.Choose Ship-Via Codes from the Setup form.
2.Type the code for the new record. If the Ship-Via Code field is not
clear, click the New icon next to the field, or choose New from the
Ship-Via menu, then type the code you want to use. (If you are
displaying an existing ship-via record, you can “copy” it to a new code
by typing the new code over the displayed code, making any changes
you need to the information, and adding the record.)
3.Type the name, address, telephone number, and fax number, and an
optional comment for the code.
4.Choose Add to add the record.
Click Ship-Via Codes form to return to the overview.

Deleting Ship-Via Codes
Make sure that no current orders list this ship-via code. If you post an
order or invoice with a code that no longer exists, Order Entry will post an
error message, and you will have to change the ship-via code on the
order before you can post it.

To delete a ship-via code
1.Type the ship-via code, or use the Finder to select the code you want
to delete.
2.Click the Delete button. If a message appears asking you to confirm
the deletion, choose Yes.
Click Ship-Via Codes form to return to the overview.

Editing Ship-Via Codes
You can change all the information in ship-via codes at any time, except
the identifying codes.

To edit a ship-via code
1.Type the ship-via code, or use the Finder to select the code you want
to change.
2.Make the changes you need.
3.Choose Save to record the changes.

Effects of changes
Changing the description of a ship-via code has no effect on current
orders. To change the description in an order, you have to edit the order
and choose the code again.
Click Ship-Via Codes form to return to the overview.

Templates Form Field List
Template Code and description

Order tab
Comment
Description
FOB Point
Location
On Hold
Order Type
Reference

Customer tab
Customer Type
Price List
Ship-Via Code
Tax Group
Terms
Territory

Setting Up Templates
You can speed up and simplify order entry by setting up templates.
Templates provide default settings which appear when you add a new
order or credit note.

Adding templates
You use the Templates form to add templates for your system. For each
template, you specify the order type and customer type. The other information in a
template is optional.

Selecting a default template
After setting up your templates, select one as your default template on
the Processing tab in the O/E Options form.

Multicurrency ledgers
The currency of the tax group assigned to a template determines the
currency of the template. You must use a template that matches the
currency of your customer.
Templates are printed on the Templates report. You can edit templates as
needed.
See also
Templates form
Steps for Setting Up Order Entry

Templates Form — Order Tab
Use this tab to:
Specify the order type for the template (Active, Future, Standing,
Quote).
See Types of orders.
Type an optional FOB (free-on-board) point for the template.
Assign a location code to the template.
Type an optional description, reference, and comment for the
template.
The information you type on the Order Information page appears on the
Order Information page in the Order/Invoice Entry form and the Credit
Note Information page in the Credit/Debit Note Entry form when you
select the template code for a new order.
Click these buttons for more help:
Finder

or
Zoom

Drop-Down
Lists

Click the link below for help using the Customer tab:
Customer

See also
Adding templates
Deleting templates
Editing templates
Miscellaneous Charges form
Options form — overview
Ship-Via Codes form
Steps for setting up Order Entry

Templates Form — Customer Tab
Use this tab to:
Specify a shipping method (ship-via code) for the template.
Assign the customer type.
Specify the default tax group.
Select a default price list and terms code.
Specify an optional territory code for the template.
Click these buttons for more help:
Finder

or
Zoom

Drop-Down
Lists

Click the link below for help using the Order tab:
Order

See also
Adding templates
Deleting templates
Editing templates
Miscellaneous Charges Form
Options form — overview
Ship-Via Codes form
Steps for setting up Order Entry

Adding Templates
Order Entry templates are optional. They supply default customer and
order information for new orders and new credit notes.

Before adding templates
Add the ship-via codes for the delivery methods and carriers you use.

To add a template
1.Choose Templates from the Setup folder.
2.If the Template Code field is not clear, click the New icon next to the
Template Code field, or choose New from the Template menu, then
type the code you want to use. (If you are displaying an existing
template, you can “copy” it to a new template code by typing the new
code over the displayed code, making any changes you need to the
information, and adding the record.)
3.Type a code for the template and an optional description.
4.Select the order type for the template and assign an optional FOB
point and location, type an optional description, reference, and
comment for the template.
5.Open the Customer tab and assign the customer type, as well as an
optional tax group, ship-via code, price list, territory code, and terms
code.
6.Click Add to add the template.

After adding templates
Open the O/E Options form and select one of the templates you have
added as the default template code. The entries in this template will
appear when you add a new order. You can change the entries as
needed.
Click Templates form to return to the overview.

Deleting Templates
Before deleting a template
Check that the template you are deleting is not the default template for
entering orders. If it is, use the O/E Options form to change the default
template code (or leave it blank).

To delete a template
1.In the Template Code field, type the code for the template you want to
delete, or use the Finder to select the template code.
2.Click the Delete button. If a message appears asking you to confirm
the deletion, choose Yes.
Click Templates form to return to the overview.

Editing Templates
You can change all the information in a template at any time, except the
identifying code.

To edit templates
1.In the Template Code field, type the code for the template you want to
change, or use the Finder to select the template code.
2.Make the changes you need.
3.Choose Save to record the changes.

Effects of changes
Changing the template has no effect on current orders. You will see the
changes the next time you select the template for a new order.
Click Templates form to return to the overview.

E-Mail Messages Report — Features
The E-Mail Messages report is a list of all the e-mail messages you have
set up for your Order Entry system. .

Information printed on the report
The report includes, for each e-mail message:
The message type.
The message ID and description.
The subject.
The body of the message.
The last maintained date.
The Inactive date, if applicable.
See also
Order Entry Reports
E-Mail Message Symbols

G/L Transactions Report — Features
The G/L Transactions report is a list of the general ledger transactions
created from all shipments posted in Order Entry since the last time you
created the general ledger batch.
To print this report, you must select On Request Using G/L Batch Icon for
the Create G/L Transactions option in the O/E Options form. If you create
transactions during day-end processing, you cannot print the G/L
Transactions report.
You can print detailed or summary versions of the report.
In multicurrency systems, you can print amounts either in the functional
currency or in the source (vendor) currencies in which you posted the
transactions in Purchase Orders.
For instructions on printing the report, see G/L Transactions Report — Printing.

Order Entry Menu Commands
The menu bar appears in all Order Entry forms immediately below the
form title. The menu bar lists the available menus for the form.
A menu contains a list of commands, or actions, you can carry out in the
form. All Order Entry forms have a File menu and a Help menu. The
Order/Invoice Entry form also has a Settings menu.
For information about Order Entry menu commands, select one of the
following menu names.
File menu
Help menu
Settings menu

(Order/Invoice entry form only)

Print
Use this command to print reports, lists, and forms.
If you choose this command from a non-report form, it opens the
corresponding report form so you can select report options, if applicable,
then print the report.
See also
Order Entry reports
When Print Destination is File
When Print Destination is Printer
When Print Destination is Preview
When Print Destination is E-mail
When Print Destination is Schedule
Reporting Order Entry data

Print Setup
Use this command to set up your printer. You can select the default
printer or specify another from the list of installed printer names.
For more information about printer options, refer to your Windows
documentation.
See also
Order Entry reports
Printing to a file
Printing to a printer
Printing to the screen
Printing to an e-mail
Printing according to a schedule
Reporting Order Entry data

Customize
Use the Customize command in the File menu of an open form to hide
fields for users assigned to a UI Profile ID for that form. When these
fields are hidden, data that would normally appear in these fields cannot
be printed.
For more information, see the Customize User Interfaces topic in the
System Manager help.

Import
Use this command to transfer (import) data from non-Sage ERP Accpac
programs to Order Entry.
For example, you could use a spreadsheet program to create
miscellaneous charges for orders, then import the miscellaneous charges
into Order Entry.
To import data, follow these general steps
1.Create the file you want to import. (You can create an import file
template by exporting a few records of the type you want to import.)
2.Open the appropriate Order Entry window for the type of data you
want to import. For example, to import orders, open the Orders and
Invoices window.
3.Choose the Import command from the File menu.
4.Specify the file name and file type in the form that appears next.
If you previously created a template for importing, choose the Load
Template button.
5.Choose the fields that you are importing. (You can save your choices
as a template for the next time you import records.)
Note that you cannot import serial or lot numbers for kit components.
See also
Export

Export
Use this command to transfer (export) data from Order Entry to non-Sage
Accpac programs.
For example, you could export sales history data from Order Entry for
use in a spreadsheet program or database program.
To export data, follow these general steps
1.Open the appropriate Order Entry form for the type of data you want
to export. For example, to export sales history, open the Sales History
form.
2.If necessary, create the records you wish to export.
3.Choose the Export command from the File menu.
4.In the form that appears, select the range of records you want to
export, and the type of information.
Note that you cannot import or export serial or lot numbers for kit
components.
5. Specify the file name and file type for the exported records.
See also
Import

Close
Use this command to close the current form.
Shortcut keys: Alt + F4
Tips
To save the sizes and positions of open forms, make sure that Save
Company Desktop Settings is selected in the Preferences dialog box
on the company desktop before you exit Sage ERP Accpac.
To save the width and position of columns in a form, select Save
Application Settings in the Preferences dialog box before you exit
Sage ERP Accpac.

Save
Use this command to save a new record or changes you have made to
an existing record.

Entering Order and Customer Information
For each order or invoice transaction, enter the following information on
the Order and Customer tabs:
Order tab:
Order Number — a number that is usually assigned by the program,
although you can enter a number of your choice.
— the number you use to identify the customer. Click the
credit check button to see if you should continue with the order.
Customer Number

— identifies the default template from the Options form; you
can select another template if you wish, or leave the field blank. For
more information, see Using Order Entry templates.
Template Code

PO Number — the number of the customer's purchase order, if
known.
Order Date — the date of the order. The date you enter for a future
order determines when the order will be activated by Day End
Processing.
Location — the code identifying the inventory location from which
you are shipping items to fill the order (taken from the customer
record). This location is the default location for the detail lines,
although you can select different codes for order detail lines.
Order Type

— select Active, Future, Standing, or Quote.

Multicurrency ledgers. If you use multicurrency accounting, you can
assign a standing order only to a customer with the same currency as
the standing order.
Quote Expiration Date — the date the quote expires, if you select
Quote as the order type. Order Entry automatically deletes the quote
when you run Day End Processing on the expiration date.
From Multiple Quotes. Choose if creating an order from more than
one quote, and then click the Zoom button to select the quotes. If you
use this option, you must select quotes before adding any detail lines
for the order.

Calc Tax — select this checkbox if you want the program to
automatically calculate tax on the order.
On Hold

— select this field if you need to put an order on hold.

— the code identifying the customer's shipping address.
Order Entry uses the address in the customer record unless a primary
ship-to address is identified in Accounts Receivable. If you select an
existing ship-to location code (defined in Accounts Receivable), Order
Entry displays the price list, territory, tax group, and sales split
information stored for the ship-to location.
Ship-To Location

Expected Ship Date

— the date on which you expect to ship the order.

Description — optional, the description is displayed as the
description for the invoice in Accounts Receivable.
Reference (optional).
Comment (for example, an announcement of a sale or special
instructions for the order; optional). You can include the comment on
printed order confirmations, picking slips, and invoices. For
instructions, see the online document, &rdquor;Customizing Printed
Forms”.
Customer tab:
Ship Via (identifies the carrier or delivery method; optional). The
program displays the ship-via description from the customer record or
ship-to location record (or if no ship-via is specified, from the ship-via
code in the order template).
Tracking Number — a waybill number for the whole order. You can
also enter separate tracking numbers for item details if the order
requires several shipments.
FOB Point (identifies the location at which the customer begins
paying freight charges on the order; optional).
Territory (identifies the customer's sales territory code; optional).
— a code identifying the discount level for the customer
(from the A/R customer record).
Customer Type

Price List (the code identifying the default price list from which prices

are displayed on detail lines). The price list comes from the A/R
customer record. You can select different price lists for individual
detail lines.
— the code identifying the customer's tax group (from the A/R
customer record).
Tax Group

— the code identifying the customer's payment terms for the
order or invoice.
Terms

See also
Entering item details
Entering miscellaneous charges

Entering Item Details
For each inventory item detail select or enter:
Line Type — an inventory item if entering item details. For information
on miscellaneous charges, see Entering miscellaneous charge details.
Item Number — of the item being ordered. The information in the
Inventory Control item record is displayed: order unit, pricing unit, and
unit price. The pricing unit and unit price are based on the customer's
price list.
Kit/BOM — if the item is a kit or assembly with more than one
possible kit or BOM number, you can choose the particular kit/BOM
for the detail line. (You can click the Components button with the line
highlighted to check the components for the particular kit or BOM
number.)
Description — supplied by Inventory Control from the item record.
Price List — from the customer record, but you can specify a different
price list. If you enter a non-stock item, the price list can be blank.
Location — the code entered on the Order tab, but you can select a
different location. If you enter a non-stock item, the location can be
blank.
Expected Ship Date — the date you expect to ship the item. The
default date is the expected ship date for the order.
Quantity Ordered

— the number of units ordered.

Order Unit of Measure

— the unit of measure for the quantity being ordered.

Order Weight Unit of Measure

— the unit of measure for the weight of the item

being ordered.
Price By — how the item is priced. You cannot edit this field. The item
can either by priced by quantity or by weight.
Pricing Unit of Measure — the unit of measure in which the item is
priced. You cannot edit this field. If the item does not exist on the price
list, Order Entry uses the stocking unit for the pricing unit.
Unit Price

— the suggested selling price for the item.

Price Approval — if you set up price checks in Inventory Control,
approval may be required for prices that vary by particular amounts or
percentages. This field shows all approvals.
Quantity Shipped

— the quantity shipped or to be shipped on an active

order.
Quantity Backordered

— the unshipped quantity, if you are not shipping the

entire order.
Unit Weight — from the item record in Inventory Control. If you are
pricing by weight, the unit weight and extended weight determine the
price. Otherwise, the weight is used only to determine the total order
weight for estimating shipping costs. You can edit the unit weight.
Extended Weight — the quantity shipped multiplied by the unit
weight entered for the item in Inventory Control (or entered here). If
you are pricing by weight, the extended weight determines the price.
— the price calculated by the program for the detail line
after you enter a quantity shipped.
Extended Price

Discount Percent/Amount — for the detail line. You can also enter a
discount for the order as a whole.
Discounted Extended Amount — the extended amount less the
discount.
Category — supplied by Inventory Control from the item record, but
you can specify a different category. The category determines the
item's general ledger accounts for sales, cost of goods sold, and cost
variance.
Unit Cost — editable if the costing method for the item is userspecified.
Costing Unit of Measure — displays the unit of measure if the
costing method for the item is user-specified.
Comments/Instructions

— that are specific to this item; optional.

Ship Via, Description and Tracking Number — the shipping carrier,
along with a tracking number (such as the waybill number).
Shipped to Date — for drilling down to previous shipment and invoice

transaction already added to this order.
Quantity Committed — in Inventory Control. This field holds goods
for the order and prevents over-committing of stock.
Manufacturers' Item Number — inserted automatically here if
entered in the item number field (for example, with bat code entry).
Manufacturers' item numbers are defined in Inventory Control.
Customer Item Number — inserted automatically here if entered in
the item number field. (Customer item numbers are defined in
Inventory Control.)
Non-Stock Clearing Account — the account which you credit when
you ship non-stock items to a customer.
Optional Fields — fields that you have added to order detail lines
using the Optional Fields form.
— the total value of items ordered, calculated by the
program at the bottom right of the form.
Order Subtotal

Editing the tax distribution
To verify the tax distribution for the current item, choose the Item/Taxes
button. You can change the tax class for the item, and specify whether
tax is included in the price before returning to the detail grid on the Order
tab.
If you are entering taxes manually (you did not select Calculate Tax for
the order or invoice), you can enter or change the tax base and the tax
amount.
For information about entering taxes manually, see Enter taxes manually.
For information about sales tax calculation, see Change tax information.
When you have finished adding an item line, the program recalculates
the order subtotal and displays it at the bottom of the form.

Entering Miscellaneous Charge Details
When you select a miscellaneous charge, you see the description and
amount defined for it. If you enter a different description for the charge
than you entered for it in the Miscellaneous Charges form, the new name
will appear on order confirmations, picking slips, invoices, and credit
notes. This feature allows you to be very specific in describing
miscellaneous charges to your customers.
Tip: When you apply charges to separate invoices — if you partially ship
orders and produce partial invoices — all miscellaneous charges on an
order will appear on the first partial invoice.
If you want to allocate a miscellaneous charge over several invoices, add
a portion of the charge as a new detail each time you are ready to
produce a partial invoice.

Editing the tax distribution
To verify the tax distribution for the current miscellaneous charge detail
line, choose the Distribution button on the Detail Information page. You
can change the tax class and specify whether tax is included in the
amount.
For information about sales tax calculation, see Calculating sales taxes.
When you have finished adding the miscellaneous charge line, the
program recalculates the order subtotal. The miscellaneous charge
amount is added to the order subtotal at the top of the form.
See also
Entering item details

Editing Sales Splits
The salespeople assigned to the customer account in Accounts
Receivable appear by default when you enter an order in the Order Entry
form (unless you select a ship-to location, in which case, it provides the
salespeople instead).
The first salesperson shown is the primary salesperson. (A number of
reports list only the primary salesperson, while others allow you to sort
information by primary salesperson.)
Order Entry uses the salesperson numbers to calculate commissions —
and to assign responsibility for orders and invoices.
You can assign the order to other salespeople on the Sales Split tab. You
can also change the percentage of the transaction total that is allocated
to each salesperson on an order. The Percent Split column must total
100 (or 0 — zero — if you do not assign salespeople to the transaction).
To edit sales splits
1.Using the Order Entry form, add or display the order for which you
want to edit sales splits.
2.Choose the Sales Split tab.
3.Add, edit, or delete sales splits, as follows:
To add a sales split, type the salesperson number on a new line,
then type the corresponding percentage allocation.
To change the salesperson number, type the new number over it
or select it from the Finder. If necessary, type a new percentage
allocation over the displayed rate.
To delete a sales split, highlight the line you want, then press the
Delete key.
4.Make sure all percentages add up to 100.
5.Click Post.
See also
Change an order

Change payment terms
Change tax information
Create a new order
Create and activate a quote
Edit currency exchange rates
Enter a prepayment

Enter a standing or future order
Entering optional field information
Importing orders and invoices
Invoice an order
Printing order confirmations and invoices

Edit Currency Exchange Rates on Orders
If you use multicurrency accounting, exchange rate information is
displayed on the Rates tab of the Order Entry form when you enter
orders for customers who do not use the functional currency.
Order Entry uses the order date on the Order tab as the default Order
Rate Date on the Rates tab. If you change the rate date, Order Entry
checks the rate tables for a date match, and updates the rate if
necessary. (See the System Manager help for more information on how
Sage ERP Accpac selects exchange rates.)
If you are producing an invoice, the Invoice Rate Date comes from the
invoice date on the Totals tab (unless you change it). If you change the
date, Order Entry checks the rate tables and changes the displayed
exchange rate if necessary.
You can change the order rate date or invoice rate date on the Rates tab.
You can also override the displayed exchange rates.
See also
Change an order
Change payment terms
Change tax information
Create a new order
Create and activate a quote
Edit sales splits
Enter a prepayment
Enter a standing or future order
Entering optional field information
Importing orders and invoices
Invoice an order
Printing order confirmations and invoices

Verifying Order Totals
Before posting an order, you can check the Totals tab to verify order
totals, and to check the customer tax classes and payment terms.
The Totals tab displays the following information for orders:
Comments for the order.
Subtotal of all items ordered.
Subtotal of all miscellaneous charges.
Detail and order discount amounts.
Tax on the order (price-included or excluded). For more information,
see Change tax information.
Net amount of the order.
Estimated weight.
Total of prepayments.
Terms discount available.
Outstanding order amount.
Number of lines on the order.
You can enter the following information in the Totals tab:
Any comments, using up to 250 characters, that you want to include
on printed order confirmations, picking slips, and invoices.
Any discount that applies to the order. You can also specify whether to
discount miscellaneous charges.
The number of labels that you want to print for the order. When you
print labels, you can print the number of labels specified for each
order. For example, to print labels for order confirmations only:
Specify 1 label on the Totals tab.
Choose the Require Shipping Labels option when you print order
confirmations.
Choose Print Only Labels Marked As Required when you print

order labels. Order Entry will print labels for the printed order
confirmations only.
See also
Posting orders
Verifying invoice totals

From Multiple Orders
This option lets you create a shipment based on several orders.
Note:
When you create a shipment from more than one order, all of the
shipment header information (including the fields on the Optional
Fields tab) will come from the first order that you select.
You cannot combine job-related and non-job-related orders in the
same shipment.
To create a shipment from a number of orders
1.Click the Zoom button ( ) beside the From Multiple Orders field, or
select the option, then press the F9 key.
2.In the Create Shipment From Orders form that opens, either type the
numbers in the Order Number column or use the Finder to select the
orders you wish to use one at a time.
3.When you have selected all the orders you are shipping, click the
Ship button to add the order details to the shipment transaction.
4.Click the Close button to close the form when you have finished.
Once you add details from multiple orders, the Order Number field
becomes unavailable and you cannot change the multiple orders option.

Verifying Invoice Totals
Use the Totals tab on the Invoice Entry form to verify totals (including
prepayment, tax, and discount information).
The invoice information that appears on the Totals tab includes:
A comment, (up to 250 characters), that can be included on the
invoice.
The date on which you shipped the order.
Invoice subtotal (the subtotal of all items and miscellaneous charges
on the order, shipment, or invoice).
Subtotals for inventory items and miscellaneous charges.
Discounts entered for item details.
Invoice discount percentage or fixed amount for the complete invoice.
This is a discount for a volume purchase, for example, and not an
early payment discount. If a discount is entered, it is prorated to all the
items on the invoice. If miscellaneous charges are discounted as well,
the discount is also prorated to the miscellaneous charges.
Whether invoice discounts also apply to miscellaneous charges (in
addition to invoice items).
Taxes, both included and excluded.
Any prepayment you entered with the invoice.
Any terms discounts available.
Discount information that applies to the invoice.
Amount due, calculated as follows:
Invoice subtotal (shipped items + misc.
charges)
- Invoice discount
(Tax (if it is not included in item prices or
+
charges)
+/- Prepayment (for this invoice)

-

Terms discount

Estimated weight for the total order or shipment (using the unit weight
for items entered in Inventory Control or on the order detail lines).
The total of prepayments you entered with the original order. This total
is displayed for information only. It does not affect the calculation of
the amount due. When you apply the prepayment, later, in Accounts
Receivable, the amount due on the invoice is reduced.
Number of detail lines on the invoice.
Number of labels for the invoice. This number controls the number of
labels that will print when you print shipping labels for a range of
invoices. See Shipping Labels.
If invoice item prices include taxes, Order Entry displays the tax amounts.
It does not affect the calculation of the invoice amount due.
If you need to edit the customer's tax classes, you can do so on the
Taxes tab. If you need to edit payment terms, use the Customer tab. For
instructions, see Change tax information and Change payment terms.
See also
Posting invoices
Verifying order totals
Verifying shipment totals

Setting Up Miscellaneous Charges
Miscellaneous charges are the charges added to invoices and credit
notes for costs other than for items purchased and returned. For
example, miscellaneous charges can include postage, shipping,
handling, and restocking charges.

Adding miscellaneous charges
Use the Miscellaneous Charges form to add miscellaneous charge
records for your system.
For each miscellaneous charge, you can enter the amount of the charge
and the general ledger revenue account to which the amount is posted.
The account can be the same as your sales revenue account, or you can
add a separate account for each miscellaneous charge or group of
charges. If you leave the amount blank, you can enter it separately on
orders, invoices, and credit notes.
When you select this option, the program displays several additional
fields for entering an extended cost, a miscellaneous charge expense
account, and a miscellaneous charge clearing account.

Multicurrency ledgers
If you use multicurrency accounting, you need to assign a currency to the
charge. To simplify data entry, you can use the same charge code for
each of the currencies.
For each miscellaneous charge, you also need to specify the tax
authorities that levy taxes on the charge, and the applicable tax classes.
Miscellaneous charges are printed on the Miscellaneous Charges report.
You can edit the charge records as needed.

Costing information for miscellaneous charges
Note that if you want to track costing information for miscellaneous
charges, you need to set them up as non-stock inventory items in
Inventory Control.

Using miscellaneous charges with Project and
Job Costing
To create miscellaneous charges for job-related orders, you must select
the Allow For Jobs option on the Miscellaneous Charges form, and then
specify:
An extended cost.
For each project in PJC, you can choose to use this cost by default or
use the contract cost.
A miscellaneous charge expense account.
A miscellaneous charge clearing account.
You can also choose by project in PJC whether to use the amount
specified in Order Entry for the miscellaneous charge or use a default
billing rate specified for the contract in PJC.
Miscellaneous charges can have two different functions on job-related
orders:
Let you add charges to customer orders for invoicing external charges
such as freight (UPS or FedEx).
Let you record internal non-material transactions such as equipment,
subcontractors, labor, etc.
See Journal Entries Generated by Posted Transactions too see how miscellaneous charges
appear in job-related transactions.
See also
Miscellaneous Charges form
Steps for Setting Up Order Entry
G/L Accounts Used by Order Entry

Journal Entries Generated for Posted Transactions
This topic describes the journal entries that are created for your general
ledger when you post invoice and receipt batches created in Accounts
Receivable by Order Entry and when you process billings in Project and
Job Costing.
It also describes the journal entries created for shipments posted in Order
Entry.
You view and print the Accounts Receivable G/L Transactions report for
all entries except shipments. Shipment transactions appear on the Order
Entry G/L Transactions report.
This page contains the following sections:
Shipments
Invoices
Number of detail lines on A/R invoices
Prepayments
Credit notes
Items returned to inventory
Damaged items
Price adjustment
Shipping and invoicing kitting items
Job-related transaction entries
Shipping and invoicing in Order Entry
Project invoicing in Project and Job Costing

Shipments
Shipments are assigned source code OE-SH on the Order Entry G/L
Transactions report.
Item quantities are removed from Inventory Control for posted shipments
(either during day end processing or when you use the Create G/L Batch
icon), as follows:
G/L Account
Debit
Credit
Shipment Clearing
Inventory Control
Return to Top

X
X

Invoices
Invoices are assigned source code OE-IN on the Accounts Receivable
G/L Transactions report.
When you post an invoice, the program generates the following entries:
G/L Account
Debit
Credit
Receivables Control

X

Cost of Goods Sold
(Item)

X

Shipment Clearing

X

Tax Liability

X

Sales

X

If an item's costing method is the standard method or the most recent
cost method, then the item's cost variance account is debited or credited
with the difference between the standard or most recent cost, and the
weighted average cost of the items shipped.
If you decrease the quantity shipped on an invoice, Order Entry creates
an entry to adjust Inventory Control (either when you run Day End
Processing or when you use the Create G/L Entries icon), as follows:
G/L Account
Debit
Credit
Inventory Control
Shipment Clearing

X
X

The source code that appears on the G/L Transactions report for this
entry is OE-IN.
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Number of detail lines on A/R invoices
The way that Order Entry creates detail lines in A/R invoices depends on
whether or not you use detail optional fields or Sage ERP Accpac Project
and Job Costing.
Without optional fields or Project and Job Costing
If you do not use optional fields in Order Entry invoice details and in
Accounts Receivable invoice details, and you are not posting job-related
transactions, the Order Entry program creates A/R invoices with separate
detail lines for sales, cost of goods sold, and shipment clearing entries
(as in earlier versions of Order Entry).
All A/R invoice details are consolidated by G/L account, so if you use only
one sales account, one cost of goods sold account, and one clearing
account, you will see only three lines on an invoice.
Acct
Sales
750.00
4111
Cost of
Goods Sold

Acct
5200

-500.00

Shipment
Clearing

Acct
5900

500.00

With optional fields or Project and Job Costing
If you use optional fields in Order Entry invoice details and in Accounts
Receivable invoice details, or if you are posting job-related transactions,
the Order Entry program now creates a single A/R invoice detail line for
each Order Entry invoice detail line.
Each A/R invoice detail includes the entries for the revenue, inventory
(shipment clearing), and cost of goods sold accounts, and there will be as
many invoice detail lines as there were on the original O/E invoice. A/R
invoice details are not consolidated.
Acct
Sales item 1
250.00
4111
Acct

Sales item 2

4111

250.00

Sales item 3

Acct
4111

250.00

Each of the unconsolidated A/R invoice lines will produce a G/L entry
with sales account, cost of goods sold account, and clearing account
details when posted in Accounts Receivable.
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Prepayments
Prepayments are assigned source code AR-PI on the G/L Transactions
report.
Prepayments are added directly to Accounts Receivable receipt batches
when you post an order, shipment, or invoice that has a prepayment.
Prepayments debit the general ledger prepayment liability account and
credit the customer's receivables control account.

Credit Notes
Credit notes are assigned source code OE-CN on the Accounts
Receivable G/L Transactions report.
Credit note transactions debit and credit general ledger accounts as
shown in the following tables.
If an item's costing method is the standard method or the most recent
cost method, then the item's cost variance account is debited or credited
with the difference between the standard or most recent cost and the
weighted average cost of the items shipped.
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Items returned to inventory
The following example records a credit note transaction for items
returned to inventory. The first transaction is posted directly to G/L from
Order Entry; the second one goes through Accounts Receivable.
G/L Account
Inventory Control

Debit
X

Credit/Debit Note
Clearing
G/L Account

Credit

X
Debit

Sales Returns

X

Credit/Debit Note
Clearing

X

Tax Liability

X

Credit

Receivables Control

X

Cost of Goods Sold

X
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Damaged items
The Damaged Goods account is debited rather than the Sales Returns
account.

G/L Account

Debit

Damaged Goods

X

Credit/Debit Note
Clearing

X*

Tax Liability

X

Credit

Receivables Control

X

Cost of Goods Sold

X*

* The Cr/Dr Note Clearing and the COGS entries will always be zero
for damaged goods.
This transaction will appear differently in the A/R Invoice form
depending on whether or not the transaction is job-related or uses
optional fields.
If the transaction is job-related or uses optional fields, the invoice will
list a single detail line for the damaged goods account.
If the transaction is not job-related and does not use optional fields,
the invoice will list three lines—one for damaged goods, one for cost
of goods sold, and one for Credit/Debit Note clearing—but only the
damaged goods line will have an amount.
Price adjustment
G/L Account

Debit

Sales

X

Tax Liability

X

Receivables Control

Credit

X
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Shipping and invoicing kitting items
As of Order Entry 5.5, A/R invoices created if you have Project and Job
Costing or if you added optional fields to invoice details will show only
one detail line for each kitting item listed on an invoice, instead of
showing one line for each component of each kitting item. Order Entry

handles the accounting for kitting items with the following G/L entries.
When you ship kitting items, Order Entry creates G/L entries for each of
the components in the kitting item:
G/L Account
Debit
Credit
Shipment Clearing,
component 1

X

Inventory Control
Shipment Clearing,
component 2

X
X

Inventory Control

X

When you invoice a kitting item, Order Entry creates the following G/L
entries to back out the components for the master item from the shipment
clearing account:
G/L Account
Debit
Credit
Shipment Clearing,
master item

X

Shipment Clearing,
component 1

X

Shipment Clearing,
component 2

X

The source code that appears on the G/L Transactions report for the
shipment entry is OE-SH. The source code that appears on the G/L
Transactions report for the invoice entry is OE-IN.
Note:If you do not use optional fields in Order Entry invoice details and in
Accounts Receivable invoice details, and if you do not use Project and
Job Costing, the Order Entry program creates shipment clearing lines for
each component to the A/R invoice and will not create the G/L account
entries shown above during invoicing.
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Job-related transaction entries

Job-related transactions can take two separate paths. You can invoice
orders through Project and Job Costing (by choosing the Project
Invoicing option) or you can create invoices in Order Entry.

Shipping and invoicing in Order Entry
The following example shows the shipping and invoicing transactions for
an order with one item and one miscellaneous charge. The
miscellaneous charge is considered internal, because it's a handling
charge and one of your employees is packaging the shipment. You can
enter both the revenue and cost for the miscellaneous charge or only the
revenue. Usually, you would enter the cost because you wanted to
associate both the cost and revenue to the job and have labor and
overhead calculated on the cost.
Item
Billing Ext.
No./
Unit
Type
Qty.
Cost
Billing
Misc.
Cost
Type
Amt.
Charge
Item

A1103/0

Misc.

HC

1

50.00

Billable

15.00

30.00

Shipment posting entry:
G/L Account

Debit

Shipment Clearing

50.00

Misc. Charges
Clearing

15.00

Credit

Inventory Control

50.00

Shipping Expense

15.00

Invoice posting entry:
G/L Account

Debit

Receivables Control

146.90

Cost of Goods Sold

71.50

Revenue

100.00

Credit

130.00

Overhead Allocated

3.25

Labor Burden

3.25

GST (Fed sales tax)

9.10

PST (Prov/State
sales tax)

7.80

Shipment Clearing

50.00

Misc. Charges
Clearing

15.00
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Project invoicing in Project and Job Costing
The following example shows an item being shipped from Order Entry
and invoiced through Project and Job Costing. It also show the entries for
an additional shipping cost (FedEx) coming through Accounts Payable
instead of through O/E.
The shipping cost is recorded in Accounts Payable, picked up by PJC
when you run the Billing Worksheet, and, finally, included on the invoice
created in Accounts Receivable.
Type

Item
No.

Item

A1103/0

Qty.

Unit
Cost

Billing
Cost
Type

Ext.
Billing
Amt.

1

50.00

Billable

100.00

Shipment posting entry:
G/L Account

Debit

Work In Progress

55.00

Credit

Inventory Control

50.00

Overhead Burden

2.50

Labor Burden

2.50

Accounts Payable invoice entry for FedEx charge:
G/L Account

Debit

Work In Progress

16.50

Work In Progress
(Prov/State s. tax)

.90

GST (Canadian Fed
sales tax)

1.05

Credit

A/P Invoice Posting

16.95

Overhead Allocated

.75

Labor Burden

.75

A/R invoice created from the billing worksheet:
G/L Account

Debit

Receivables Control

146.90

Billings

Credit
130.00

GST (Canadian Fed
sales tax)

9.10

PST (Prov/State
sales tax)

7.80

Revenue recognition:
G/L Account

Debit

Billings

130.00

Cost of Sales

72.40

Credit

Revenue (Sales)

130.00

Work In Progress

72.40

Return to Top

See also
Using Order Entry with Project and Job Costing
Setting Up Miscellaneous Charges
Entering Item Details
Entering Miscellaneous Charge Details
G/L Accounts Used by Order Entry
Invoice Entry form — overview
Order Entry form — overview
Shipment Entry form — overview
Using Order Entry templates

Using Order Entry Templates
Order Entry templates let you speed up and simplify order entry by
providing default settings which appear when you start a new order or
credit note.
You specify the following information for each template that you define.
Order information:
Order Type
FOB Point
On Hold
Location
Description
Reference
Comment
Customer information:
Ship-Via Code
Customer Type
Price List
Territory
Tax Group
Terms
You must specify the order type, customer type, and tax group in a
template. The other information is optional. Note that the information in a
number of the template fields can also come from other records. For
example, the customer type, location, price list, territory, and tax group
fields are in the customer and the ship-to location records.
Default templates. You can specify a default template on the Options
form so a standard set of default customer and order settings appears for
each new order or credit note you create. The default template provides
initial settings, but these are overridden by settings from the customer

record — and from another template if you choose another one.
The following sequence of steps illustrates template use:
1.Choose New to create a new order. The default template settings
appear for the new order.
2.Choose the customer number. The information in the customer record
replaces the information from the default template.
3.Choose a different template to override the customer information. All
the information from the new template replaces the current order
information.
You could again choose the customer number to replace the information
inserted in step 3 with the information from the customer record.
Credit note settings come from invoices. Most credit notes or returns
refer to invoices, and use the invoice information by default. You can
override the invoice information by choosing a different template (or by
choosing the default template again). However, if your credit note does
not reference an existing invoice, templates work the same way that they
do for orders.

Information Entered with Prepayments
With each prepayment, you enter:
Payment code (the codes that you set up in Accounts Receivable are
displayed).
Check or receipt number. If you do not enter a check or receipt
number, Order Entry assigns one when you save the prepayment,
using the following format: Accounts Receivable batch number - entry
number.
Receipt date (if it is not the batch date) and amount.
Rate type and exchange rate (in multicurrency ledgers when the
prepayment is not in the company's functional currency).
If you use Payment Processing, a processing code that specifies the
bank, currency, and merchant account that will be used when a credit
card transaction is processed.

Multicurrency Prepayments
If you use multicurrency accounting, you also specify the currency of the
prepayment. If you select an existing batch, the batch currency must
match the prepayment currency.
If you select another batch with a different currency after saving a
prepayment, the program clears the receipt amount. You must re-enter
the information.

Crediting Part of an Invoice
If you do not want to credit an entire invoice, or you need to alter the
numbers or amounts on lines to be credited, use the detail-entry grid on
the Order tab.
You can delete lines you do not want to credit, and add detail lines for
items or miscellaneous charges to the invoice being credited.

Using the New Contract Wizard
If you are creating a job-related quote in Order Entry, you can use the
New Contract wizard to create a new contract in Project and Job Costing
by copying an existing one.
The wizard copies the settings, projects, categories, and resources from
the existing contract to the new contract. The wizard also lets you choose
to use original or current estimates, actual revenues and costs, or no
amounts from the existing contract as the default estimate for the new
contract. You can also choose whether to use the same optional fields as
the existing contract or the program default optional fields.
Note: When you add job-related detail lines to a quote, the detail lines
must be applied to projects with an Estimate status. Quote amounts
appear as estimates in the new contract.
To use the New Contract Wizard:
1.Start a new order in the Order Entry form.
2.Choose Quote as the Order Type.
3.Click the Contracts button at the bottom of the Order Entry form.
The Contracts button appears after you choose Quote as the Order
Type.
4.Enter a new contract number (you can use the Contract Number tab
to help you do this), and specify the number of the contract that you
are copying to create this new contract.
5.Click the Contract Style tab, and choose whether you want to create a
basic contract or a standard contract.
6.Click the Optional Fields tab and choose whether you want to copy
the optional fields from the template contract, use the PJC default
optional fields, or use no optional fields for this contract.
7.Click the Finish button to create the contract.
See also
Using Order Entry with Project and Job Costing
Setting Up Project and Job Costing Integration
Setting Up Miscellaneous Charges
Transaction Processing

Misc. Charge Clearing Account (job-related
charges only)
Type the number of the general ledger clearing account to which the
expense amounts of miscellaneous charges are posted when you ship
goods, or select the code from the Finder if you use Sage ERP Accpac
General Ledger.
The miscellaneous charge clearing account is similar to the shipment
clearing account.
Order Entry debits the clearing account and credits the miscellaneous
charge expense account when you ship goods (and run Day End
Processing). It then credits the clearing account and debits cost of goods
sold when you post the invoice.

Setting Up Project and Job Costing Integration
If you use Order Entry and Project and Job Costing, you can enter jobrelated orders in Order Entry and track project costs in Project and Job
Costing.
Note the following points about setting up Order Entry with Project and
Job Costing:
You must create jobs in Project and Job Costing before you can enter
a job-related order in Order Entry.
You can enter a quote in Order Entry and create the contract details
on the fly using the New Contract Wizard.
The New Contract Wizard also lets you copy an existing contract to
make the new one. This means that you can create one or more
contracts in Project and Job Costing that act as templates for all the
new contracts created in Order Entry.
You specify on the Project tab of new contracts where the order gets
default prices for items and miscellaneous charges.
You can use the price list assigned to the customer, a price list
specified on the Project tab of the contract, or use prices set up in
Project and Job Costing's Contract Maintenance form.
You can default costs from Inventory Control or from contract
maintenance.
If you want to use miscellaneous charges for job-related orders, you
must choose the Use For Jobs option in the Miscellaneous Charges
form and fill in the several additional fields.
Depending on the type of contract, you can create invoices in Order
Entry and pass them to Accounts Receivable, or create invoices in
Project and Job Costing (called Project Invoicing).
One of the most important processing decisions regarding job-related
orders is how you are going to invoice orders and jobs, including how
you will manage additional charges — especially those billed by thirdparty companies. See Using Order Entry with Project and Job Costing for full discussions
of these issues.

The choice of Invoicing options depends on the project type and
accounting method. Click here to see project type chart.
If the invoice needs to be created in Project and Job Costing,
Order Entry will complete the order when you post the shipment,
and prevent you from invoicing in O/E.
If you delay invoicing in Order Entry, the transaction will be sent to
Project and Job Costing as unbilled, and you will have to create
the invoice in PJC or bill from Accounts Receivable.
See also
Journal Entries Generated by Posted Transactions
Setting Up Miscellaneous Charges
Setting Up Templates
Quotes
Using Order Entry with Project and Job Costing
G/L Accounts Used by Order Entry

Transaction Processing
This topic presents a brief overview of how posting, day-end processing,
and audit trails relate to transaction processing in Order Entry. The types
of transactions in Order Entry are orders, invoices, and credit notes.

Online posting
Order Entry uses online transaction processing rather than batch
processing. This means that each transaction is posted when you enter
it.

Posting updates quantities
When you post transactions, Order Entry immediately updates item
quantities in Inventory Control so you always know your inventory levels.
If you choose to cost inventory in I/C during posting, then posting also
updates accounting and statistical information. Otherwise, everything
else is done by Day End Processing.

Day End updates everything else
Unless you choose to cost inventory in I/C during posting, you must run
Day End Processing in Inventory Control to update Order Entry sales
statistics, sales commissions, and audit information, and to create a
batch of Accounts Receivable summary invoices and credit notes.
In addition, Day End Processing updates costing information, item and
sales statistics, and audit information in Inventory Control with the posted
transactions (unless you cost inventory during posting).
If necessary, you can run Day End Processing several times a day to
keep this information more current.

Transaction lists
You can print summary or detail listings of all orders, invoices, and credit
notes until the transactions are deleted from the Order Entry program.

Keeping transaction history

If you selected the Keep Transaction History option in the Order Entry
Options form, the program will keep this information until you remove it
using the Clear History form. You can print transaction lists, reprint
invoices and credit notes, and view transactions in the original transaction-entry
forms and in the Salesperson Inquiry form until you clear transaction
history.
If you do not keep transaction history, Order Entry will automatically
delete completed transactions when you run Day End Processing. Order
Entry considers the following transactions to be completed:
Orders with a Completed status.
Invoices and credit notes that you have printed.
This means that if you do not keep history, you cannot print a transaction
list for completed orders (or printed invoices and credit notes) after you
run Day End Processing.
Posting journals

You can print posting journals for invoices and credit notes after running
Day End Processing in Inventory Control.
You can keep posting journals until you remove the information using the
Clear History form. However, you cannot remove the information for a
particular day-end sequence until you have printed the posting journals.

Day End Processing
For information about day-end processing, see Day End Processing.

G/L Accounts Used by Order Entry
This topic describes the general ledger accounts used by the Order Entry
program and tells you where the account numbers are assigned.
This page contains the following sections:
Inventory Control account sets
Inventory Control categories
Miscellaneous charges
Project and Job Costing accounts

Inventory Control account sets
Inventory Control account. An asset account containing the total value
of the inventory on hand (at actual cost). The account increases when
you receive goods, and decreases when you ship goods.
The word "control" in the account name means that the account contains
only totals, whereas the information stored by Inventory Control contains
details on an item-by-item basis.
When you process all accounting entries correctly, the total cost of the
inventory in the Inventory Control system equals the totals in the
Inventory Control accounts in the general ledger.
Payables Clearing account. A suspense account to which Inventory
Control posts the "other side" of the accounting entries for inventory you
receive (and for previous receipts you return to suppliers).
Inventory Control normally generates credit entries to this account for
inventory you receive; therefore, the account can be thought of as the
accrued amount payable for goods received into inventory. Inventory
Control debits this account when you enter receipt returns.
As you post the related vendor invoices in Sage ERP Accpac Accounts
Payable, offsetting journal entries (debits) related to the inventory
purchased are generated against the Payables Clearing account to clear
the balance that is left in this account from posting the inventory receipt.
Adjustment Write-Off account. The account to which you post
inventory adjustments and write-offs. Entries to this account are normally
expenses (debits); therefore, the account number you specify should be
in the expenses or cost of goods sold section of your general ledger.
Assembly Cost Credit account. The account to which you post the
variable and fixed costs of assembling items. The program credits this
account with the variable and fixed cost of assembly. You may want to
create manual entries in the general ledger to redistribute the assembly
cost credit to accounts such as labor costs.
Non-stock Clearing account. The account which you credit when you
ship non-stock items, and debit when you enter shipment returns for non-

stock items.
You can use non-stock items to handle specially ordered items which you
do not stock in your inventory, and to handle service charges that appear
on invoices.
Transfer Clearing account. This account is used for the additional cost
amount in the Transfer form.
Shipment Clearing. Debited instead of Cost of Goods sold when
shipping goods from Order Entry.
The Shipment Clearing account is required because the shipment and
invoicing functions in Order Entry are separated. The COGS account is
debited when you invoice the shipment.
Disassembly Expense. Used if you specify an expense amount when
you disassemble items that were previously assembled in Inventory
Control.
Physical Inventory Adjustment. The expense account that balances
the change in inventory value when you adjust inventory quantities after
making a physical inventory count.
Credit/Debit Note Clearing. Debited instead of the I/C Control account
or the Damaged Goods account in Order Entry returns sent to Accounts
Receivable. The G/L transaction credits the clearing account instead of
COGS and A/R Control.
The Credit/Debit Note Clearing account is required because the inventory
return and credit note functions in Order Entry are separated, with one
side of the transaction going through the Accounts Receivable program.
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Inventory Control item categories
For each category that you add in Inventory Control, you specify general
ledger account numbers for the five following accounts (Sage ERP
Accpac Order Entry uses the Sales account, Returns account, and
Damaged Goods account — Inventory Control does not use them):
Sales. A revenue account which Order Entry credits with the revenue
from goods sold.
Returns. A revenue contra account which Order Entry debits to record
the reduction of revenue caused when previously sold goods are
returned or credit notes are issued.
Cost of Goods Sold. An expense account which Inventory Control
automatically debits with the cost of goods sold, and credits with the cost
of goods returned.
Cost Variance. An expense account in which Inventory Control records
the cost variance between the actual cost and either the standard cost
(for items using the standard costing method) or the most recent cost (for
items using the most recent costing method) of inventory items sold.
Damaged Goods. A revenue contra account that is debited instead of
Sales Returns whenever goods are returned as damaged in Order Entry.
Internal Usage. The default expense or asset account that is debited
when an item in this category is used internally. You can override this
account when you enter transactions.
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Miscellaneous charges
You specify the following accounts when you add miscellaneous charges
to Order Entry.
Miscellaneous Charge Revenue. The general ledger revenue account
to which amounts entered as miscellaneous charges are posted.
Miscellaneous Charge Expense. For job-related orders, Order Entry
credits the expense account and debits the miscellaneous charge
clearing account when you ship goods and run Day End Processing.
(When you post the invoice, it credits the clearing account and debits
cost of goods sold.)
Miscellaneous Charge Clearing. For job-related orders, the
miscellaneous charge clearing account is similar to the shipment clearing
account.
Order Entry debits the clearing account and credits the miscellaneous
charge expense account when you ship goods (and run Day End
Processing). It then credits the clearing account and debits cost of goods
sold when you post the invoice.
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Project and Job Costing accounts
If you are processing job-related orders with Project and Job Costing, the
following accounts can appear on the item detail lines, depending on
whether or not you are using project invoicing.
Order Entry will also send information to Accounts Receivable and
Project and Job Costing for the Overhead Allocated and Labor Burden
accounts. You specify those accounts on the Account tab for the category
in Contract Maintenance, but you cannot edit those accounts in Order
Entry.
Revenue/Billing Account (orders). If the sales order is job-related, and
you did not select Project Invoicing, you also specify the Revenue/Billings
account for each order detail.
The default account number comes from Project and Job Costing and is

used instead of the Sales Account specified for the item in the item
category record.
WIP Account (orders). If the sales order is job-related, and you selected
Project Invoicing, you also specify the Work In Progress account for each
order detail.
The account number specified in Project and Job Costing will appear by
default, but you can change it. (The level at which the WIP account is
specified in Project and Job Costing depends on the project type and
accounting method.)
COGS (Cost of Goods Sold) Account. If the order is job-related, and
you did not select Project Invoicing, the program displays the default cost
of goods sold account from Project and Job Costing for each order detail.
You can change the account number.
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See also
Using Order Entry with Project and Job Costing
Setting Up Miscellaneous Charges
Entering Item Details
Entering Miscellaneous Charge Details
Invoice Entry form — overview
Order Entry form — overview
Shipment Entry form — overview
Using Order Entry templates

Serial/Lot Number Allocation/Generation Form
Field List–
For information about fields and buttons on the Serial/Lot Number
Allocation form and on the Serial/Lot Number Generation form, click the
following links:
(display only)
Location (display only)
Stock Date (display only)
Item Number

Serials tab
(display only)

Allocated
Auto-Allocate From

(display only)

Generated
Next Serial Number
Serial Number column
Shipped column

(display only)
Remaining (display only)
Serial Nos. Required (display only)
Serials Shipped (display only)
Unit of Measure (display only)
Qty Shipped

Lots tab
(display only)

Allocated
Auto-Allocate From

(display only)

Generated
Lot Number column

(display only)
Lots Shipped (display only)
Lot Qty Required

Make [ ] Lots OR Each Lot Has [_]
Next Lot Number
Quantity column
Quantity Shipped column

(display only)
Remaining (display only)
Unit of Measure (display only)
Qty Shipped

Buttons

Add
Auto-Alloc

.

Auto-Gen
Clear All
Close
Ship All

Serial/Lot Numbers Allocation / Generation
Form — Serials Tab
Use the Serials tab on the Serial/Lot Numbers Allocation form to assign
serial numbers to serialized items when you enter orders, shipments, debit
notes, and credit notes.
For help on the fields that appear on the Serials tab, click the Field List
button at the top of this form.
For help on assigning serial numbers, click the link for the task you want
to perform, below:
To assign serial numbers to an order
To assign serial numbers to a shipment
To assign serial numbers to a debit note
To assign serial numbers to a credit note

Click the following links for more information about the Serial/Lot
Numbers Allocation / Generation Form:
Serial/Lot Numbers - Lots Tab
Serial/Lot Numbers Allocation / Generation Form

See also
Understanding Serialized Inventory and Lot Tracking

Serial/Lot Numbers Allocation/Generation
Form — Lots Tab
You use the Lots tab on the Serial/Lot Numbers Allocation form to assign
lot numbers to lotted items when you enter orders, shipments, debit notes,
and credit notes.
For help on the fields that appear on the Lots tab, click the Field List
button at the top of this form.
For help on assigning lot numbers, click the link for the task you want to
perform, below:
To assign lot numbers to an order
To assign lot numbers to a shipment
To assign lot numbers to a debit note
To assign lot numbers to a credit note

Click the following links for more information about the Serial/Lot
Numbers Allocation / Generation Form:
Serial/Lot Numbers - Serials Tab
Serial/Lot Numbers Allocation / Generation Form

See also
Understanding Serialized Inventory and Lot Tracking

Understanding Serialized Inventory and Lot
Tracking
If you have a license to use Serialized Inventory and Lot Tracking, you
can assign serial numbers or lot numbers to items when you enter orders,
shipments, invoices, debit notes, and credit notes in Order Entry.
You use the serial numbers and lot numbers to track items — from their
receipt in inventory to their sale and shipment to customers.

Managing Serialized and Lotted Inventory
Sage ERP Accpac Inventory Control maintains serial numbers and lot
numbers by item and location, and it determines how you process
serialized and lotted items in Order Entry.
Settings in the I/C item record determine whether a particular item is serialized or lotted

(or both).

Settings in the I/C item record also determine whether you must allocate serial numbers and lot numbers to all

, or if you can allocated fewer
serial numbers or lot quantities than the quantities in entries.
quantities in shipments, invoices, credit notes, and debit notes

Inventory Control options also determine whether you allocate serial
numbers and lot numbers for the quantity ordered or the quantity
shipped.
If you allocate serial numbers or lot numbers to an order quantity, Inventory Control reserves the numbers until

.

you ship the items

The default field for opening the allocation and generation forms is the
Qty. Shipped field. If you have Inventory Control Setup Maintenance
security authorization, you can change the options for serial numbers and/or lots. (For more
information on these options, see the help for the Inventory Control
Options form.)
You generate serial numbers and lot numbers for an inventory
location when you receive serialized or lotted items (in Inventory
Control or in Purchase Orders), and, if necessary, when you return the
items to Inventory Control (in Order Entry).
You allocate serial numbers and lot numbers from an inventory
location when you sell or ship serialized or lotted items (in Inventory
Control or in Order Entry), and, if necessary, when you return them to
the vendor (in Purchase Orders).

Allocating Serial Numbers and Lot Numbers in
Order Entry
When you enter quantities for a serialized or lotted item in Order Entry
transactions, the program prompts you to allocate serial numbers and lot
numbers, as follows:
The Serial/Lot Numbers Allocation form appears when you enter a
quantity on the Order Entry, Shipment Entry, and Invoice Entry forms,
and then press the Tab key or the Zoom ( ) button for the quantity
field. This form also appears when you enter a quantity for a debit
note in the Credit/Debit Note Entry form.
The Serial/Lot Numbers Generation form appears when you enter
a quantity for a credit note.
For more information about the allocation and generation forms, see
Serial/Lot Numbers Allocation / Generation Form.
For information about assigning lot numbers and serial numbers in Order
Entry, see:
Assign Lot Numbers or Serial Numbers to a Debit Note
Assign Lot Numbers or Serial Numbers to a Credit Note
Assign Lot Numbers or Serial Numbers to an O/E Invoice
Assign Lot Numbers or Serial Numbers to an Order
Assign Lot Numbers or Serial Numbers to an O/E Shipment

Transaction Records Generated for Inventory
Control Serial Numbers and Lot Numbers
Transaction records are generated for I/C Serial Numbers and I/C Lot
Numbers when you post serialized or lotted items for O/E shipments,
shipment adjustments, O/E invoice adjustments, O/E credit notes (for
type Items Returned To Unventory), and O/E debit notes (for type Items
Removed From Inventory).
For I/C Serial Numbers, the transaction cost is shown for each
transaction record.
For I/C Lot Numbers, the quantity and transaction cost are shown for
each transaction record.
The transaction cost and total cost are helpful when you are using
serialized or lotted items that use the serial costing or lot costing
methods. For all other costing methods (FIFO, LIFO, MRC, STD, AVG,
and USER specified costing), the transaction cost and total cost recorded
is irrelevant, since these methods cost the items at the item detail level,
rather than the serial or lot level.

Order Entry Field List
(also see credit checks)
Customer Name (display)
Last Invoice Number (display only)
Last Shipment Number (display only)
Number Of Shipments (display only)
Customer Number

Order Number
Buttons on the Order Entry form
Order tab — Header fields (top of form)
Order tab — Item details (lines on Order tab)
Order tab — Item quantities for the current line (with drilldown
Order tab — Buttons
Customer tab
Taxes tab
Retainage tab
Optional Fields tab
Sales Split tab
Rates tab
Totals tab

)

Order Entry — Order Tab
Use this tab to specify:
An optional template code to specify the default entries in order and
customer information fields.
The customer number.
The customer's purchase order number.
The order date.
The default location code for the order.
Whether the account is on hold.
The order type.
The particular quote, or quotes, on which the order is based.
Expected ship date.
Whether to calculate taxes automatically.
The ship-to location (from the Accounts Receivable customer record)
or a shipping address just for the order.
An optional shipping method or carrier.
An optional description, reference, and comment.
Order details.
Use the detail grid of the Order tab to:
Add item and miscellaneous-charge detail lines.
Edit or delete existing detail lines.
Specify ordered quantities.
Specify prices.
Specify shipped quantities.
Add optional fields.
Open a separate detail entry form that to change tax information for a
selected detail, and to view all the information for a detail without

having to scroll sideways (press F9).
At the bottom of the Order tab, the program displays quantities for the
location specified on a selected detail line and for all locations.
You can check expected arrival and shipping dates by clicking the
drilldown buttons to viewing the details for items on sales order, on
purchase order, and committed to orders.
You can also use the Location Finder on a selected detail line to display
quantities for other locations.
For information about another tab, click its name:
Customer

Taxes

Retainage

Sales Split

Rates

Totals

Optional Fields

Click these buttons for more help:

Finder

Drill Down

See also
Order Entry — Items/Taxes form
Order Entry form — overview
Printing Order Entry forms

or
Zoom

Drop-Down
Lists

Order Entry — Customer Tab
Use this tab to specify:
The shipping method for the order.
The tracking number if sending by courier or registered mail.
An optional FOB (free-on-board) location.
An optional territory code.
Whether the customer is eligible for discounts or special pricing (the
customer type).
The price list to use to select prices for item details.
The tax group for the order.
The customer account set.
The code that identifies the payment terms that will be used for
invoices from the order.
The due date and discount terms of the order or invoice.
Click these buttons for more help:

Finder

or
Zoom

Drop-Down
Lists

For information about another tab, click its name:
Order

Taxes

Retainage

Sales Split

Rates

Totals

See also
Customer Ship-To Address form
Order Entry — overview

Optional Fields

Order Entry — Taxes Tab
Use this tab to:
Choose to manually or automatically calculate taxes.
Choose automatic tax calculation for tax reporting (if you report taxes
in a different currency), or enter the tax reporting amounts manually.
Check the tax information that applies to the order for the customer.
Change the customer tax class for the order.
To change the tax status of an item, click the Item/Tax... button on the
Invoice tab
Enter the tax base and tax amount, if you are entering taxes manually.
Enter or edit the customer's tax exemption number.
Automatically prorate tax amounts for individual details on the order.
Click these buttons for more help:
Finder

Calculate
Taxes

New

Calculate
Tax Reporting

or

Drop-Down
Lists

Zoom
Distribute
Taxes

For information about a different tab, click its name:
Order

Customer

Retainage

Sales Split

Rates

Totals

Optional Fields

To manually enter item tax amounts:
1.Uncheck the Calculate Tax checkbox on the Order tab or on the Taxes
tab.
2.Highlight the detail line for which you want to change/edit tax
amounts.
3.Click the Item/Tax... button or press F9.
4.As required, change the tax class, tax base, tax amount, and tax
reporting amount (if reporting tax in another currency).

To manually enter and distribute document tax amounts:
1.Uncheck the Calculate Tax checkbox on the Order tab or on the Taxes
tab.
2.On the Taxes tab, change the customer tax class, tax base, tax
amount, and tax reporting amount (if reporting tax in another
currency), as required.
3.Click the Dist. Taxes button to distribute the amounts on the Taxes tab
to the individual document detail lines.
Note: If you entered tax amounts for individual detail lines, do not
redistribute the total. You will overwrite the entries that you made for
document details.
To manually enter tax reporting amounts (if reporting tax in another
currency):
1.Uncheck the Calculate Tax Reporting checkbox on the Taxes tab.
2.Enter the tax reporting amount.
3.Choose the Rates page, and click the Derive Rate button to select the
actual exchange rate for the tax reporting amount.
See also
Enter Taxes Manually
Order Entry — overview
Order Totals tab

Order Entry — Retainage Tab
When you select the Retainage option on the Order tab, a Retainage tab
appears that lets you specify how to process retainage for this order.
The program lets you choose the exchange rate to use for the retainage
invoice if you are using a multicurrency system, and the retainage terms.
You can only use retainage if the document is job-related.
The default entries for the retainage percentage and retention period
for each detail line come from the Customer Default fields in the
Contract Maintenance Project tab in Project and Job Costing. You can
change these entries for each detail line.
For information about another tab, click its name:
Order

Customer

Taxes

Sales Split

Rates

Totals

Optional Fields

Click the following buttons for more help:

Finder

New

See also
Order Entry — overview

or
Zoom

Drop-Down
Lists

Order Entry — Optional Fields Tab
This tab appears if you use the Sage ERP Accpac Transaction Analysis
and Optional Field Creator product and you assigned optional fields for
Credit/Debit Note Entry transactions.
Optional fields (and values) will appear by default in the grid on this tab if
Auto Insert was selected in O/E Optional Fields setup. If no optional fields
appear automatically, or if you want more optional fields, you can add them
manually.
Order Entry also supports optional fields at the detail level.
If you assign optional fields in Order Entry that are the same optional
fields assigned in the Accounts Receivable Invoice Entry form, the
information in the Order Entry fields is sent to Accounts Receivable.
For information about another tab, click its name:
Order

Customer

Taxes

Sales Split

Rates

Totals

Retainage

Click the following buttons for more help:

Finder

New

See also
Order Entry — overview

or
Zoom

Drop-Down
Lists

Order Entry — Sales Split Tab
Use this tab to allocate document totals to salespeople for commission
calculation.
Order Entry lets you assign portions of each transaction you enter in the
Order Entry form to each salesperson who is responsible for the
customer account or sale. If you track commissions for sales staff, Order
Entry uses this information to update the commission data when you post
invoices and run Day End Processing.
Default salespeople are assigned to customer records and to ship-to
locations in Accounts Receivable.
For information about a different tab, click its name:
Order

Customer

Taxes

Optional Fields

Rates

Totals

See also
Order Entry form — overview

Retainage

Order Entry — Rates Tab
Use this tab to:
Change the rate type, rate date, and exchange rate for converting the
order amount from the customer's currency to your functional (home)
currency.
If you are shipping goods, change the rate information for converting
the shipped amount from customer's currency.
If you are invoicing shipped goods, change the rate information for the
invoice.
Enter or derive the rate for converting tax amounts to the tax reporting
currency (if you report taxes in a different currency than you collect
them).
If Order Entry automatically calculates the tax amount in the tax
reporting currency, the program will use the Tax Reporting Currency
Exchange Rate on the Rates tab.
If you manually enter the tax amount in the tax reporting
currency, use the Derive Rate button on the Rates tab to calculate
the actual exchange rate for the tax reporting currency.
The Rates tab appears only if you use multicurrency accounting and you
are entering a document for a customer who does not use your
company’s functional currency (and the exchange is not between two
EMU member currencies).
For information about another tab, choose its tab:
Order

Customer

Taxes

Optional Fields

Sales Split

Totals

See also
Order Entry — overview

Retainage

Order Entry — Totals Tab
Use this tab to:
Enter a comment about the order.
Specify whether any discounts apply to miscellaneous charges.
Specify the number of labels you want to print for an order.
Create an invoice for shipped quantities.
Verify order totals and discounts before posting an order.
Check the total estimated weight of items ordered.
The order prepayment total on this tab enables you to easily determine if
there is an outstanding balance.
For information about a different tab, click its name:
Order

Customer

Taxes

Optional Fields

Sales Split

Rates

See also
Order Entry — Items/Taxes form
Order Entry — overview

Retainage

Importing and Exporting Orders and Invoices
Use the Import and Export commands on the File menu in the
Order/Invoice Entry form to import and export orders.
You cannot import invoices. However, Order Entry will create and post
invoices for imported orders that contain shipped quantities or
miscellaneous charges.
Kit components, serial numbers and lot numbers. You cannot import
or export serials numbers or lot numbers for kit components. (You can
automate the entry of serial numbers and lot numbers for kit components
using a macro.)
For more information on importing and exporting, see the help for System
Manager.
See also
Change an order
Change payment terms
Change tax information
Create a new order
Create and activate a quote
Edit sales splits
Enter a prepayment
Entering a standing or future order
Entering optional field information
Invoice an order
Printing order confirmations and invoices

Printing Order Confirmations, Receipts, and
Invoices
Printing order confirmations
Order Entry allows you to print order confirmations at two stages of order
processing:
You can print an order confirmation immediately after posting an order.
You can print order confirmations for a range of posted orders before they are cleared from
Order Entry.

Before you start
Create the format for the order confirmation. (You can use the forms
that come with Sage ERP Accpac ERP, or alter them using Crystal
Reports.)
Select the printing destination to which you will print.
Print a test copy of the order confirmation to check the alignment of
the forms in your printer.

Printing receipts
Order Entry allows you to print receipts to let you confirm your receipt of
a customer prepayment in the following ways:
You can print a receipt immediately after posting an order or an invoice that includes a
prepayment.
You can print one or more receipts using the A/R Receipts report in
Sage ERP Accpac Accounts Receivable.

Before you start
Create the format for the customer receipt. (You can use the forms
that come with Accounts Receivable, or alter them using Crystal
Reports.)

Printing invoices

Order Entry allows you to print invoices at two stages or order
processing:
You can print an invoice immediately after posting an invoice.
You can print a range of invoices before they are cleared from Order Entry.

Before you start
Create the format for the order confirmation. (You can use the forms
that come with Sage ERP Accpac ERP, or alter them using Crystal
Reports.)
Select the printing destination to which you will print.
Print a test copy of the invoice to check the alignment of your invoice
forms in your printer.
Related topics

Save/Add/Post Buttons
Use the Save or Add button to save the displayed record, code, or
transaction. If you have just entered a new record, the Save command is
replaced by Add.
Use the Post button to post the displayed order, invoice, return, credit
note, or adjustment, or to save changes you have made to an order.

Order Entry — Prepayments Form
Use this form to:
Enter a prepayment with an order.
Modify or delete the information for a prepayment you entered
previously, but have not yet posted with the order or invoice.
If you use Payment Processing, process or void a credit card
prepayment.
You can enter as many prepayments as you want for an order.
Prepayments made for orders do not reduce the amount of the next
invoice you create; instead, they are matched to invoices when they are
posted in Accounts Receivable (using the order number). The order
prepayment total is displayed on the invoice total tab, enabling you to
easily determine if there is an outstanding balance.
Job-Related payments
When you record job-related prepayments, click the Jobs button and then
click the distribute button on the Prepayment Details form to
automatically distribute amounts to details.
You can prorate payment amounts to individual details, or you can do a
"top-down" distribution, starting at the first job-related detail, or you can
edit the payment amounts yourself.
Note: The prepayment amount on a job-related order can exceed the
document total; however, you must ensure that the sum of the
prepayment amounts to individual details matches the prepayment total.
Credit card prepayments
If you use Payment Processing, you can use the Prepayments form to:
.

Process a credit card prepayment

.

Capture a pre-authorized credit card payment
Void a credit card prepayment

if it has not been settled in Sage Payment

Solutions.
To enable the Charge and Void buttons on this form, you must select a

payment code that uses the payment type SPS Credit Card before
adding the prepayment.
Tip: Click the Finder ( ) for the Payment Code field to see a list of
payment codes and associated payment types.
Before you start
Find out which Accounts Receivable receipt batch to use for the
prepayment.
For information about adding prepayments, see Enter a prepayment.
See also
Order Tab — Detail form
Order Entry — Totals tab

Order Entry — Items/Taxes Form
Use the Items/Taxes form to add, edit, and delete order detail lines, and
to change detail tax information.
Rather than presenting all the details for an order in columns, this form
displays information for a single detail so that you can see most of the
fields for a detail without having to scroll through the form.
Click these buttons for more help:
or
Finder

Drill Down

Shift +
Zoom

Drop-Down
Lists

To open or close the Items/Taxes form
1.Select a detail line on the Order tab, then either:
Press F9.
Click the Item/Tax... button.
2.Press F9 or click the Close button to return to the Order tab.
To add or edit details in the Items/Taxes form
1.To enter a new detail, click the New button beside the Line Number
field.
To edit an existing detail, type its line number or use the scroll bars to
display the line you want.
2.Enter the information or changes for the detail.
You can change a tax class to another tax class that is assigned to
the authority, and you can change the choice for the Tax Included
option.
If you are entering taxes manually (you did not select the Calculate
Tax option), you can also change the tax base and the tax amount.
3.Click Add or Save.
To delete details in the Items/Taxes form

1.To open an existing detail you want to delete, type its line number or
use the scroll bars to display the line you want.
2.Choose Delete.
To check tax amounts for an order or invoice and compare the totals on
the screen with the totals on the source document, click the Totals tab.
See also
Calculate Tax Option
Enter taxes manually
Order Entry Form — overview
Taxes tab

Customer Bill-To Address Form (Orders)
Use this popup form to:
Check or edit the billing information for an existing customer.
Type billing information for a new customer number you have
specified on an order but which you have not yet added to Accounts
Receivable.
To open the Customer Bill-To Address form, click the zoom button beside
the Customer Number field or, with the pointer in the Customer Number
field, press F9.
See also
Customer Ship-To Address form
Order Entry form — overview

Customer Ship-To Address Form
Use this popup form to:
Check or edit the shipping address for an existing customer.
Type the shipping address and other information for a new customer
number you have specified on an order but which you have not yet
added to Accounts Receivable.
To open the Customer Ship-To Address form, click the zoom button ( )
beside the Ship-To Location field, or press F9 while typing in the Ship-To
Location field.
See also
Customer Bill-To Address form
Order Entry form — overview

Order Entry — Pre-authorization Form
Use the O/E Pre-authorization form to:
Pre-authorize a credit card payment for an order.
Void a previously created credit card pre-authorization for which you
will not process a payment.
To open the O/E Pre-authorization form, click the Pre-authorize button on
the Order Entry form.

About Pre-authorizing Credit Card Payments
If you use Payment Processing, you can click the Pre-authorize button on
the Order Entry form to pre-authorize a credit card payment for an order.
You pre-authorize a credit card payment when you want to verify that
sufficient credit exists on a customer's credit card before processing a
sale. When you create a pre-authorization, the cardholder's credit limit is
reduced by the amount of the pre-authorization until the pre-authorization
is captured or expires.
The amount of a pre-authorization does not need to match the amount
captured in the final sale. The captured amount may be more (as when a
restaurant customer adds a tip) or less (as when a service station
customer swipes a credit card, and then purchases fuel that costs less
than the amount pre-authorized for a fill-up).
If you use multicurrency accounting, you can pre-authorize a credit card
payment only if the customer currency matches the currency specified for
an existing processing code. For example, if you want to pre-authorize a
credit card payment for a USD customer, USD must be specified as the
currency for an existing processing code.
Merchant service providers charge a fee for voiding a credit card preauthorization. However, this fee is lower than the fee that is charged if
you do not void or capture a pre-authorization and allow it to expire. For
this reason, we recommend that you void any pre-authorization that will
not be captured.
If a pre-authorization has expired, you may be able to force a payment for
the pre-authorized amount. You can force a payment only if the preauthorization has expired recently (typically within 30 days), and if you
used a saved credit card for the pre-authorization (that is, you did not
select the Enter A Card For One-Time Use option when processing the
pre-authorization).
For more information, see Pre-authorizing, Capturing, and Forcing Credit Card Transactions.
Note: Forced transactions may be subject to higher fees than regular
transactions.

If it is likely that more than seven days will pass before an order is
shipped, you should not pre-authorize a credit card payment for the
order. If you do, the pre-authorization may expire, in which case your
merchant service provider will charge a fee. (Credit card preauthorization expires after approximately seven days.)
Related topics

Printing Order Entry Forms
You can print the following forms from Order Entry:
Credit notes
Invoices
Order confirmations
Picking slips
Quotes
Receipts
Shipping labels

The Order Entry program includes sample formats for each type of form.
You can adapt the sample forms or use Crystal Reports to create your
own forms to suit your business.
You can print quotes, order confirmations, receipts (for prepayments),
and invoices (if created for shipped quantities) immediately after
posting orders.
You can print picking slips and invoices (if you created an invoice)
after posting shipments.
You can print receipts (for prepayments) and invoices immediately
after posting invoices.
You can also use the Order Entry form to print individual order
confirmations immediately after posting their corresponding orders, as
well as invoices you have just posted. After posting a credit note in the
Return/Credit Note Entry form, you can print it.
You can print all of the above forms except receipts from the Order Entry
Forms folder. You can print receipts from Accounts Receivable
Transaction Reports folder.
Note: You can print receipts after posting orders and invoices that
include prepayments, but the receipt forms come with Accounts
Receivable.
Order Entry adds receipts to Accounts Receivable receipt batches and

uses the Accounts Receivable Print Receipts program to print the
prepayment confirmations.

Credit/Debit Note Entry Field List
Customer Number and Description
Document Number
Document Type
History button
Distribute Taxes button
Components button
Items/Taxes button

Click the following headings for information about fields on each tab of
the Credit/Debit Note Entry form.
Credit Note/Debit Note tab — Header fields (top of form)
Credit Note/Debit Note tab — Item details (lines on Credit/Debit Note tab)
Customer tab
Taxes tab
Retainage tab
Optional Fields tab
Sales Split tab
Rates tab
Totals tab

Customer Bill-To Address Form (Credit/Debit
Notes)
Use this form to:
Check or edit the billing information for an existing customer.
Type billing information for a new customer number you have
specified on an Order Entry Transaction, but which you have not yet
added to Accounts Receivable.
To open the Customer Bill-To Address form, click the zoom button ( )
beside the Customer Number field, or press F9 while typing in the
Customer Number field.
See also
Order Entry form — overview
Printing Order Entry forms
Credit/Debit Note Entry form — overview

Edit Currency Exchange Rates on Credit Notes
The Rates tab appears only in a multicurrency ledger, if the customer does
not use the functional currency.
You enter exchange rate information in the Credit/Debit Note Entry form
only if you do not want to use the current exchange rate for the credit
note, or if no rate is entered for the credit note date.
Realized gains or losses. If the exchange rate of the return or credit
note differs from the rate of the invoice, you will realize an exchange gain
or loss on the transaction.
To edit the exchange rate for a credit note
1.Choose the Rates tab in the Credit/Debit Note Entry form.
2.Enter the Rate Type code (identifies the method used to convert
source-currency amounts on credit notes to functional-currency
equivalents).
3.Enter the Rate Date (to select the credit note exchange rate from the
currency rate table in Common Services).
4.If the rate you want is not displayed, enter the rate in the Credit Note
Exchange Rate field.

Enter a Credit for Damaged Goods
If you select this credit type for a detail line, you enter the number of
items damaged (as a positive amount) in the Quantity field.
Quantities on hand in Inventory Control are not updated by damaged
items and costs. Order Entry reverses only the sales transaction (by
debiting sales and crediting the receivables account).

Enter a Price Adjustment
If you select this credit type for a detail line, enter the amount of the
adjustment in the Price/Adjustment field.
If the adjustment is a price decrease, enter it as a positive amount. If it is
a price increase, enter it as a negative amount. The program multiplies
the adjustment by the quantity to determine the adjustment for the detail
line, which is displayed in the Extended Amount field.
Note that you can enter a detail line with a negative amount, but you
cannot post a credit note or a debit note with a negative total amount.

Importing Debit Notes and Credit Notes
Use the Import command on the File menu in the Credit/Debit Note Entry
form to import debit notes returns and credit notes.
You can import the same debit note or credit note any number of times.
The original credit information is retained until you delete it from the
program in which you created the import file.
Kit components, serial numbers and lot numbers. You cannot import
serials numbers or lot numbers for kit components. (You can automate
the entry of serial numbers and lot numbers for kit components using a
macro.)
Multicurrency ledgers. You cannot import multicurrency returns or credit
notes into a single-currency Order Entry system. If necessary, edit the
import file to remove the multicurrency field before importing.
For more information about importing, see the help for System Manager.

Post a Credit Note
Order Entry assigns the credit note number during posting, using the
prefix and starting number you entered on the Documents tab in the O/E
Options form.
Items returned to inventory. When you post a credit note for items
returned to inventory, the quantities on hand in Inventory Control are
immediately increased for the items on the credit note.
Day End Processing. If you keep sales statistics, the quantity sold,
sales amount, invoice amount, and item cost of sales are reduced when
you run Day End Processing in Inventory Control. The number of returns
and the returned amount are updated if you keep sales history.
When you post a credit note for an item that had serial numbers assigned
to it when invoiced, the returned numbers are reported on the Serial
Numbers List in Inventory Control.
Damaged items. If you post a credit note for damaged items, there is no
effect on the quantity on hand or on costs.
Damaged items update sales statistics and history after Day End
Processing, just as items returned to inventory do.
Price adjustments. If you post a credit note as a price adjustment, there
is no effect on the quantity on hand or on costs.
The item sales and invoice amounts are reduced when you run Day End
Processing, but the number of returns and the returned amounts are not.
Sales commissions. If your salespeople earn commissions, credit notes
posted against invoices reduce the commission earned accordingly. The
recalculation of commissions is done during Day End Processing.

Return Items to Inventory
If you select this credit type or debit type for a detail line, you enter the
number of items returned in the Quantity field. The program calculates
the extended amount (quantity returned multiplied by price).
If you selected an existing invoice number, the displayed cost is the cost
of the sold item. If the invoice number was blank or non-existent, the
program displays a unit cost for the item based on the item's costing
method. The costing method is one of the following:
Most recent cost
Standard cost
Average cost — for average, LIFO, and FIFO costing methods
You can edit the item fields that are not dimmed if you need to. For
example, you can edit the price or the extended amount.
Quantities on hand in Inventory Control are adjusted when you post the
credit note.

Credit/Debit Note Entry — Credit Note /Debit
Note Tab
The name of this tab is Credit or Debit, depending on the document type
you select.
Use this tab to:
Select the invoice that the credit/debit note adjusts.
Select an optional template code to specify the default entries for this
tab and the Customer tab.
Enter an optional description and reference for the transaction.
Specify price changes, returned quantities, or damaged goods for
particular detail lines from an invoice.
Enter new charges.
Alter the quantities or amounts for invoice detail lines.
Add new credit or debit lines for an invoice.
Add credit or debit details for invoices that no longer exist in your
Order Entry system.
Open a zoomed detail-entry form for detail entry instead of the spreadsheetstyle grid you see on the Credit/Debit Note tab (press F9 or click the
Item/Tax button).
Click these buttons for more help:
Finder

New

Drill Down

or
Drop-Down
Lists

Shift+
Zoom

Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:
Customer
Sales Split

Taxes

Retainage

Rates

Totals

Optional Fields

See also
Credit/Debit Note Entry - Overview
Printing Order Entry forms

Credit/Debit Note Entry — Customer Tab
Use this tab to specify:
The ship-via method for additional shipments.
The tracking number for shipments.
An optional territory code.
Whether the customer is eligible for discounts or special pricing (the
customer type).
The price list to use to select prices for item details.
The tax group for the return, credit note, or debit note.
The customer account set.
Click these buttons for more help:

Finder

Drop-Down
Lists

Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:
Credit Note/Debit Note

Taxes

Retainage

Sales Split

Rates

Totals

See also
Printing credit notes
Credit/Debit Note Entry — overview

Optional Fields

Credit/Debit Note Entry — Taxes Tab
Use this tab to:
Check the tax information that applies to the credit or debit note.
Change the customer tax class for the credit or debit note.
To change the tax status of an item, click the Item/Tax... button on the
Credit/Debit tab.
Enter or edit the customer's tax exemption number.
Choose automatic tax calculation, or enter the tax amounts manually.
Choose automatic tax calculation for tax reporting, or enter the tax
reporting amounts manually.
Automatically distribute manually-entered tax amounts.
Click these buttons for more help:
Finder

or

Drop-Down
Lists

Zoom
Calculate
Taxes

Distribute
Taxes

Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:
Credit Note/Debit Note

Customer

Taxes

Optional Fields

Sales Split

Rates

Retainage

To manually enter item tax amounts:
1.Uncheck the Calculate Tax checkbox on the Credit/Debit tab or on the
Taxes tab.
2.Highlight the detail line for which you want to change/edit tax
amounts.
3.Click the Item/Tax... button or press F9.
4.As required, change the tax class, tax base, tax amount, and tax
reporting amount (if reporting tax in another currency).
To manually enter and distribute document tax amounts:

1.Uncheck the Calculate Tax checkbox on the Credit/Debit tab or on the
Taxes tab.
2.On the Taxes tab, change the customer tax class, tax base, tax
amount, and tax reporting amount (if reporting tax in another
currency), as required.
3.Click the Dist. Taxes button to distribute the amounts on the Taxes tab
to the individual document detail lines.
Note: If you entered tax amounts for individual detail lines, do not
redistribute the total. You will overwrite the entries that you made for
document details.
To manually enter tax reporting amounts (if reporting tax in another
currency):
1.Uncheck the Calculate Tax Reporting checkbox on the Taxes tab.
2.Enter the tax reporting amount.
3.Choose the Rates page, and click the Derive Rate button to select the
actual exchange rate for the tax reporting amount.
See also
Credit/Debit Note Entry — Overview
Printing Order Entry forms

Credit/Debit Note Entry — Retainage Tab
When you select the Retainage option on the Credit/Debit Note tab, a
Retainage tab appears that lets you specify how to process retainage for
this credit/debit note.
The program displays the retainage percentage, retainage amount, and
the retainage exchange rate to use for the retainage credit/debit note if
you are using a multicurrency system.
You can only use retainage if the document is job-related.
The default entries for the retainage percentage and retention period
for each detail line come from the Customer Default fields in the
Contract Maintenance Project tab in Project and Job Costing. You can
change these entries for each detail line.
Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:

Credit Note/Debit Note

Customer

Taxes

Sales Split

Rates

Totals

Optional Fields

Click the following buttons for more help, and click the Field List button
at the top of this help topic for more information about fields on this
tab.
Finder

Drop-Down
Lists

See also
Printing credit notes
Credit/Debit Note Entry — overview

Credit/Debit Note Entry — Optional Fields
Tab
This tab appears if you use the Sage ERP Accpac Transaction Analysis
and Optional Field Creator product and you assigned optional fields for
Credit/Debit Note Entry transactions.
Optional fields (and values) will appear by default in the grid on this tab if
Auto Insert was selected in O/E Optional Fields setup. If no optional fields
appear automatically, or if you want more optional fields, you can add them
manually.
Order Entry also supports optional fields at the detail level.
Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:

Credit Note/Debit Note

Customer

Taxes

Sales Split

Rates

Totals

Retainage

Click the following buttons for more help, and click the Field List button
at the top of this help topic for more information about fields on this
tab.
Finder

Drop-Down
Lists

See also
Printing credit notes
Credit/Debit Note Entry — overview

Credit/Debit Note Entry — Sales Split Tab
Use this tab to allocate credit totals to salespeople for commission
calculation.
Order Entry lets you assign portions of each transaction you enter in the
Credit/Debit Note Entry form to each salesperson who is responsible for
the customer account or sale.
Default salespeople are assigned to customer records and to ship-to
locations in Accounts Receivable.
Click these buttons for more help:

Finder

Drop-Down
Lists

Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:

Credit Note/Debit Note

Customer

Taxes

Optional Fields

Rates

Totals

See also
Printing credit notes
Credit/Debit Note Entry form — overview

Retainage

Credit/Debit Note Entry — Rates Tab
Use this tab to:
Specify the rate type, rate date, and exchange rate for converting the
document amount from the customer's currency to your functional
(home) currency.
Enter or derive the rate for converting tax amounts to the tax reporting
currency (if you report taxes in a different currency than you collect
them).
If Order Entry automatically calculates the tax amount in the tax
reporting currency, the program will use the Tax Reporting Currency
Exchange Rate on the Rates tab.
If you manually enter the tax amount in the tax reporting
currency, use the Derive Rate button on the Rates tab to calculate
the actual exchange rate for the tax reporting currency.
This page appears only if you use multicurrency accounting and you are
entering a document for a customer who does not use your company’s
functional currency.
Click these buttons for more help:

Finder

Drop-Down
Lists

Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:

Credit Note/Debit Note

Customer

Taxes

Optional Fields

Sales Split

Totals

See also
Printing credit notes
Credit/Debit Note Entry form — overview

Retainage

Credit/Debit Note Entry — Totals Tab
Use this tab to:
Enter a comment about the items returned.
Enter a percentage or specific amount (positive or negative) to reduce
or increase the total amount credited (or debited) to the customer.
Verify the credit note or debit note amount and tax amounts.
Click the following links for information about the other tabs in the
Credit/Debit Note Entry form:

Credit Note/Debit Note

Customer

Taxes

Optional Fields

Sales Split

Rates

See also
Enter a credit for damaged goods
Enter a price adjustment
Printing credit notes and debit notes
Return items to inventory
Credit/Debit Note Entry — overview

Retainage

Shipment Entry Field List
Complete Status

(also see credit checks)

Customer Name
Customer Number
Invoice Number
Shipment Number

Buttons on the Shipment Entry form
Shipment tab — Header fields (top of form)
Shipment tab — Item details (lines on the Shipment tab)
Shipment tab — Item and location quantities for the current line
Shipment tab — Buttons
Customer tab
Taxes tab
Retainage tab
Optional Fields tab
Sales Split tab
Rates tab
Totals tab

Shipment Entry — Shipment Tab
Use this tab to specify:
The shipment number.
The order number (or numbers) you are shipping at this time.
The shipment date.
Whether to calculate taxes automatically.
The ship-to location (from the Accounts Receivable customer record)
or a shipping address just for the invoice.
An optional description and reference.
Use the detail grid on the Shipment tab to:
Specify shipped quantities, prices, discount information, and serial
numbers for a detail.
Add miscellaneous charges to existing orders.
Add item detail lines if shipping goods without entering orders first.
Enter a comment or special instructions for a detail.
Include the customer's item number.
Enter a ship-via method and tracking number for a detail, if you plan
to ship the items separately from the rest of the items.
Open the Items/Taxes form to enter tax and other information for a
detail. This form lets you view all the fields for a selected detail
without having to scroll through columns.
The Shipment tab also:
Displays quantities for the location specified on a selected detail line
and totals for all locations. (You can also use the Finder on a selected
detail line to display quantities for other locations.)
Lets you drill down to the order that you are shipping and to an
invoice that was created from the shipment (if posted).
For information about another tab, click its name:

Customer

Taxes

Retainage

Sales Split

Rates

Totals

Optional Fields

Click these buttons for more help:
Finder

or
Zoom

New

Drop-Down
Lists

See also
Shipment Entry form — overview
Printing Order Entry forms
Credit/Debit Note Entry form — overview

Drill Down

Shipment Entry — Customer Tab
Use this tab to specify:
The shipping method for the shipment.
The tracking number if sending by courier or registered mail.
An optional FOB (free-on-board) location.
An optional territory code.
Whether the customer is eligible for discounts or special pricing (the
customer type).
The price list to use to select prices for item details.
The tax group for the shipment.
The customer account set.
The code that identifies the payment terms that will be used for
invoices from the shipment.
Click these buttons for more help:

Finder

or
Zoom

Drop-Down
Lists

For information about another tab, click its name:
Shipment

Taxes

Retainage

Sales Split

Rates

Totals

See also
Customer Ship-To Address form
Shipment Entry — overview

Optional Fields

Shipment Entry — Taxes Tab
Use this tab to:
Choose to manually or automatically calculate taxes.
Choose automatic tax calculation for tax reporting (if you report taxes
in a different currency), or enter the tax reporting amounts manually.
Check the tax information that applies to the customer.
To change the tax status of an item, click the Item/Tax... button on the
Invoice tab.
Change the tax class for the shipment.
Enter the tax base and tax amount, if you are entering taxes manually.
Enter or edit the customer's tax registration number.
Automatically prorate/distribute tax amounts to individual details on
the shipment.
Click these buttons for more help:
or

Finder

Drop-Down
Lists

Zoom
Calculate
Taxes

Distribute
Taxes

For information about a different tab, click its name:
Shipment

Customer

Retainage

Sales Split

Rates

Totals

Optional Fields

To manually enter item tax amounts:
1.Uncheck the Calculate Tax checkbox on the Shipment tab or on the
Taxes tab.
2.Highlight the detail line for which you want to change/edit tax
amounts.
3.Click the Item/Tax... button or press F9.
4.As required, change the tax class, tax base, tax amount, and tax
reporting amount (if reporting tax in another currency).

To manually enter and distribute document tax amounts:
1.Uncheck the Calculate Tax checkbox on the Shipment tab or on the
Taxes tab.
2.On the Taxes tab, change the customer tax class, tax base, tax
amount, and tax reporting amount (if reporting tax in another
currency), as required.
3.Click the Dist. Taxes button to distribute the amounts on the Taxes tab
to the individual document detail lines.
Note: If you entered tax amounts for individual detail lines, do not
redistribute the total. You will overwrite the entries that you made for
document details.
To manually enter tax reporting amounts (if reporting tax in another
currency):
1.Uncheck the Calculate Tax Reporting checkbox on the Taxes tab.
2.Enter the tax reporting amount.
3.Choose the Rates page, and click the Derive Rate button to select the
actual exchange rate for the tax reporting amount.
See also
Enter Taxes Manually
Shipment Entry — overview

Shipment Entry — Retainage Tab
When you select the Retainage option on the Shipment tab, a Retainage
tab appears that lets you specify how to process retainage for this
shipment.
The program displays the retainage percentage, and retainage amount of
the shipment, and lets you choose the exchange rate to use if you are
running a multicurrency system, and the retainage terms to use for the
retainage invoice.
You can only use retainage if the document is job-related.
The default entries for the retainage percentage and retention period
for each detail line come from the Customer Default fields in the
Contract Maintenance Project tab in Project and Job Costing. You can
change these entries for each detail line.
For information about another tab, click its name:
Shipment

Customer

Taxes

Sales Split

Rates

Totals

Optional Fields

Click the following buttons for more help:

Finder

Drop-Down Lists

See also
Shipment Entry — overview

Shipment Entry -- Optional Fields Tab
This tab appears if you use the Sage ERP Accpac Transaction Analysis
and Optional Field Creator product and you assigned optional fields for
Shipment Entry transactions.
Optional fields (and values) will appear by default in the grid on this tab if
Auto Insert was selected in O/E Optional Fields setup. If no optional fields
appear automatically, or if you want more optional fields, you can add
themmanually.
Shipment Entry also supports optional fields at the detail level.
If you add the same optional fields to Order Entry shipments as those
used for invoices in Accounts Receivable, the information in the Order
Entry fields is sent to Accounts Receivable.
For information about another tab, click its name:
Shipment

Customer

Taxes

Sales Split

Rates

Totals

Retainage

Click the following buttons for more help:

Finder

or
Zoom

See also
Shipment Entry - Overview

Drop-Down
Lists

Shipment Entry — Sales Split Tab
Use this tab to:
Allocate document totals to salespeople for commission calculation.
Order Entry lets you assign portions of each transaction you enter in the
Shipment Entry form to each salesperson who is responsible for the
customer account or sale. If you track commissions for sales staff, Order
Entry uses this information to update the commission data when you post
invoices and run Day End Processing.
Default salespeople are assigned to customer records and to ship-to
locations in Accounts Receivable.

Creating a Shipment from Multiple Orders
Note that Invoice Entry uses only the sales split for the first order by
default when you create a shipment from multiple orders. Therefore, you
should always check the Sales Split tab when shipping multiple orders to
ensure that the sales allocation is correct. If the orders use different sales
splits, you must change the allocation for the shipment manually.
If the sale is split among more than five salespersons, you should not
create one shipment from the multiple orders.
For information about a different tab, click its name:
Shipment
Optional Fields

Customer

Taxes

Rates

Totals

See also
Shipment Entry form — overview

Retainage

Shipment Entry — Rates Tab
Use this tab to:
Change the rate type, rate date, and exchange rate for converting the
document amount from the customer's currency to your functional
(home) currency.
If you are invoicing shipped goods, change the rate information for the
invoice.
Enter or derive the rate for converting tax amounts to the tax reporting
currency (if you report taxes in a different currency than you collect
them).
If Order Entry automatically calculates the tax amount in the tax
reporting currency, the program will use the Tax Reporting Currency
Exchange Rate on the Rates tab.
If you manually enter the tax amount in the tax reporting
currency, use the Derive Rate button on the Rates tab to calculate
the actual exchange rate for the tax reporting currency.
The rates tab can show three groups of rates information — for the order,
for the shipment, and for the invoice (if you are creating an invoice). You
cannot edit the order rate information.
This tab appears only if:
You use multicurrency accounting.
You are entering a document for a customer who does not use your
company’s functional currency.
For information about another tab, choose its tab:
Shipment

Customer

Taxes

Optional Fields

Sales Split

Totals

See also
Shipment Entry — overview

Retainage

Shipment Entry — Totals Tab
Use this tab to:
Enter a comment about the shipment.
Automatically create an invoice for the shipped items when you post
the shipment.
Specify the number of labels you want to print for a shipment.
Verify totals and discounts before posting a shipment.
Specify whether shipment discounts apply to miscellaneous charges.
Check the total estimated weight of items ordered.
For information about a different tab, click its name:
Shipment

Customer

Taxes

Optional Fields

Sales Split

Rates

See also
Shipment Entry — overview

Retainage

Shipment Entry — Prepayments Form
Use this form to:
Enter a prepayment with a shipment.
Modify or delete the information for a prepayment you entered
previously, but have not yet posted with the shipment.
If you use Payment Processing, process or void a credit card
prepayment.
You can enter as many prepayments as you want for an order or a
shipment.
Prepayments made for orders and shipments do not reduce the amount
of the next invoice you create; instead, they are matched to invoices
when they are posted in Accounts Receivable (using the order number).
The order and shipment prepayment total is displayed on the invoice total
tab, enabling you to easily determine if there is an outstanding balance.
Job-Related payments
When you record job-related prepayments, click the Jobs button and then
click the distribute button on the Prepayment Details form to
automatically distribute amounts to details.
You can prorate payment amounts to individual details, or you can do a
"top-down" distribution, starting at the first job-related detail, or you can
edit the payment amounts yourself.
Note: The prepayment amount on a job-related order can exceed the
document total; however, you must ensure that the sum of the
prepayment amounts to individual details matches the prepayment total.
Credit card prepayments
If you use Payment Processing, you can use the Prepayments form to:
.

Process a credit card prepayment

.

Capture a pre-authorized credit card payment
Void a credit card prepayment

if it has not been settled in Sage Payment

Solutions.
To enable the Charge and Void buttons on this form, you must select a
payment code that uses the payment type SPS Credit Card before
adding the prepayment.
Tip: Click the Finder ( ) for the Payment Code field to see a list of
payment codes and associated payment types.
Before you start
Find out which Accounts Receivable receipt batch to use for the
prepayment.
For information about adding prepayments, see Enter a prepayment.
See also
Shipment Tab — Detail form
Shipment Entry — Totals tab

Entering Taxes Manually
Order Entry lets you specify on individual orders and invoices whether
taxes should be calculated automatically by Order Entry or entered
manually.
If you wish to enter tax amounts manually, do not select the Calculate Tax
option.
Note: When you enter taxes manually, you must specify, for each
authority within the tax group, both:
The total tax amount, and
The tax amount for each detail on the order or invoice.

Enter tax totals for each tax authority
You can enter the total tax amount for each authority and then enter the
tax for individual details, or you can enter the taxes for each detail first
and then enter the total amounts. Note that the total tax amounts must
equal the sum of the detail taxes entered for each authority.

To enter the total tax amount manually
1.From the O/E Transactions folder, choose Order Entry.
2.On the Order tab, clear the Calculate Tax option if it is selected.
3.Enter the order, including item details, as usual, but do not post it yet.
4.Click the Taxes tab.
5.Enter the tax base and total tax amounts for each tax authority.
Note that you can also enter total taxes manually on the Taxes tab of the
Shipment Entry form and the Invoice Entry form.

Enter taxes for individual items
You can use the Distribute (Dist.) Tax button in the Taxes tab to
automatically prorate and allocate to the document details the total tax
amount you have entered manually, or you can enter tax amounts
manually for each detail.

To distribute the tax amount manually
1.On the Order tab of the Order Entry form, on the Shipment tab of the
Shipment Entry form, or on the Invoice tab of the Invoice Entry form,
highlight the detail line for which you want to adjust the taxes.
2.Click the Item/Tax... button or press F9. Order Entry displays the
detail Items/Taxes form.
3.In the Tax Base and the Tax Amount columns, enter the tax base and
the tax amount that you have calculated for the detail.
4.Repeat steps 2 and 3 for each detail item on the document, ensuring
that the sum of the taxes for the details equals the total tax amount
you entered in the Customer Tax Distribution form.
5.Check the amounts carefully before posting.

Allocating taxes manually to partial shipments
If you partially ship and invoice an order for which taxes have been
entered manually, Order Entry displays a message asking whether you
want the program to recalculate taxes for you.
You must decide whether to recalculate taxes for the invoice and the
order as follows:
Choose No if you want to post the invoice without recalculating taxes
for the invoice and the order. The invoice will be posted with the full
tax amounts specified on the order.
Choose Yes if you want the program to recalculate taxes for the
invoice (for the items shipped) and for the order (for the items
remaining on order).
Choose Cancel if you want to cancel posting and return to the
transaction entry form to enter recalculated taxes manually.
For more information about sales tax calculation, see Calculating sales taxes.

Customer Bill-To Address Form (Shipments)
Use this popup form to:
Check or edit the billing information for an existing customer.
Type billing information for a new customer number you have
specified on an order but which you have not yet added to Accounts
Receivable.
To open the Customer Bill-To Address form, click the zoom button beside
the Customer Number field or, with the pointer in the Customer Number
field, press F9.
See also
Customer Ship-To Address form
Order/Invoice Entry form — overview

Ship-To Address Form
Use this popup form to:
Check or edit the shipping address for an existing customer.
Type the shipping address and other information for a new customer
number you have specified on an order for a customer who has not
been added to Accounts Receivable.
To open the Customer Ship-To Address form, click the zoom button
beside the Ship-To Location field, or press F9 while typing in the Ship-To
Location field.
See also
Customer Bill-To Address form
Order/Invoice Entry form — overview

Shipment Entry — Items/Taxes Form
Use the Items/Taxes form to edit detail lines and to change detail tax
information.
Rather than presenting all the details for an order in columns, this form
displays information for a single detail so that you can see all of the fields
for a detail without having to scroll through the form.
Click these buttons for more help:
Finder

New

Drill Down

or
Drop-Down
Lists

Shift +
Zoom

To open or close the Items/Taxes form
1.Select a detail line on the Shipment tab, then either:
Press F9.
Click the Item/Tax... button.
2.Press F9 or click the button to return to the Shipment tab.
To add or edit details in the Items/Taxes form
1.To start a new detail line, click in the Line Number field. To edit an
existing detail, type its line number or use the scroll bars to display the
line you want.
2.Type the information or changes for the detail.
You can change a tax class to another tax class that is assigned to
the authority, and you can change the choice for the Tax Included
option.
If you are entering taxes manually (you did not select the Calculate
Tax option), you can also change the tax base and the tax amount.
3.Click Add or Save.
To delete details in the Items/Taxes form

1.To open an existing detail you want to delete, type its line number or
use the scroll bars to display the line you want.
2.Choose Delete.
To check tax amounts for an order or invoice and compare the totals on
the screen with the totals on the source document, click the Totals tab.
See also
Calculate Tax Option
Enter taxes manually
Shipment Entry Form — overview

Invoice Entry Field List
Invoice Number
Customer Number
Customer Name
Buttons on the Invoice Entry form
Invoice tab — Header fields (top of form)
Invoice tab — Item details (lines on the Invoice tab)
Invoice tab — Item quantities for the current line (with drilldown
Customer tab
Taxes tab
Retainage tab
Optional Fields tab
Sales Split tab
Rates tab
Totals tab

)

Invoice Entry — Invoice Tab
Use this tab to specify:
The invoice number.
The shipment number (or numbers) you are billing on the current
invoice.
The invoice date.
Whether to calculate taxes automatically.
The ship-to location (from the Accounts Receivable customer record)
or a shipping address just for the invoice.
An optional description, reference, and comment.
Invoice details.
Use the detail grid on the Invoice tab to:
Specify shipped quantities, prices, discount information, and serial
numbers for a detail.
Enter a comment or special instructions about the detail.
Enter a ship-via method and tracking number for a detail, if you
shipped the items using a different method than for the rest of the
invoice.
Open a detail-entry (Items/Taxes) form that lets you enter tax
information for a detail. (This form lets you view all the fields for a
selected detail without having to scroll through columns.)
The Invoice tab also displays quantities for the location specified on a
selected detail line and for all locations. (You can also use the Finder
on a selected detail line to display quantities for other locations.)
For information about another tab, click its name:
Customer

Taxes Retainage Optional Fields

Sales Split Rates Totals

Click these buttons for more help:

Finder

or
Zoom

New

Drop-Down
Lists

See also
Detail form
Invoice Entry form — overview
Printing Order Entry forms
Credit/Debit Note Entry form — overview

Drill Down

Invoice Entry — Customer Tab
Use this tab to specify:
The shipping method from the shipment (editable on the invoice).
The tracking number if shipped by courier or registered mail.
An optional FOB (free-on-board) location.
An optional territory code.
Whether the customer is eligible for discounts or special pricing (the
customer type).
The price list to use to select prices for item details.
The tax group for the invoice.
The customer account set.
The code that identifies the payment terms for the invoice.
The invoice due date.
A discount date, discount percent, and discount amount (if any).
A payment schedule for customers who are making a series of payments
over time.
Click these buttons for more help:

Finder

or
Zoom

Drop-Down
Lists

For information about another tab, click its name:
Invoice

Taxes Retainage Optional Fields

Sales Split Rates Totals

See also
Customer Ship-To Address form
Invoice Entry — overview

Invoice Entry — Taxes Tab
Use this tab to:
Choose to manually or automatically calculate taxes.
Choose automatic tax calculation for tax reporting (if you report taxes
in a different currency), or enter the tax reporting amounts manually.
Check the tax information that applies to the order or invoice for the
customer.
Change the customer tax class for the invoice.
To change the tax status of an item, click the Item/Tax... button on the
Invoice tab.
Enter the tax base and tax amount, if you are entering taxes manually.
Enter or edit the customer's tax exemption number.
Automatically prorate tax amounts for individual details on the invoice.
Click these buttons for more help:
or

Finder

New

Zoom

Drop-Down
Lists

Calculate
Taxes

Distribute
Taxes

For information about a different tab, click its name:
Invoice

Customer Retainage Optional Fields

Sales Split Rates

Totals

To manually enter item tax amounts:
1.Uncheck the Calculate Tax checkbox on the Invoice tab or on the
Taxes tab.
2.Highlight the detail line for which you want to change/edit tax
amounts.
3.Click the Item/Tax... button or press F9.
4.As required, change the tax class, tax base, tax amount, and tax
reporting amount (if reporting tax in another currency).

To manually enter and distribute document tax amounts:
1.Uncheck the Calculate Tax checkbox on the Invoice tab or on the
Taxes tab.
2.On the Taxes tab, change the customer tax class, tax base, tax
amount, and tax reporting amount (if reporting tax in another
currency), as required.
3.Click the Dist. Taxes button to distribute the amounts on the Taxes tab
to the individual document detail lines.
Note: If you entered tax amounts for individual detail lines, do not
redistribute the total. You will overwrite the entries that you made for
document details.
To manually enter tax reporting amounts (if reporting tax in another
currency):
1.Uncheck the Calculate Tax Reporting checkbox on the Taxes tab.
2.Enter the tax reporting amount.
3.Choose the Rates page, and click the Derive Rate button to select the
actual exchange rate for the tax reporting amount.
See also
Customer Payment Schedule
Enter Taxes Manually
Invoice Entry — overview

Invoice Entry — Retainage Tab
When you select the Retainage option on the Invoice tab, a Retainage
tab appears that lets you specify how to process retainage for this
invoice.
The program displays the retainage percentage, retainage amount, the
retainage exchange rate to use if you are running a multicurrency
system, and the retainage terms to use for the retainage invoice.
You can only use retainage if the document is job-related.
The default entries for the retainage percentage and retention period
for each detail line come from the Customer Default fields in the
Contract Maintenance Project tab in Project and Job Costing. You can
change these entries for each detail line.
For information about another tab, click its name:
Invoice

Customer Taxes Optional Fields

Sales Split Rates

Totals

Click these buttons for more help:

Finder

or
Zoom

See also
Invoice Entry — overview

New

Drop-Down
Lists

Invoice Entry -- Optional Fields Tab
This tab appears if you use the Sage ERP Accpac Transaction Analysis
and Optional Field Creator product and you assigned optional fields for
Invoice Entry transactions.
Optional fields (and values) will appear by default in the grid on this tab if
Auto Insert was selected in O/E Optional Fields setup. If no optional fields
appear automatically, or if you want more optional fields, you can add them
manually.
Invoice Entry also supports optional fields at the detail level.
If you assigned optional fields in Order Entry that are exactly the same as
those used for invoices in Accounts Receivable, the information in the
Order Entry fields is sent to Accounts Receivable.
For information about another tab, click its name:
Invoice

Customer Taxes Retainage

Sales Split Rates

Totals

Click these buttons for more help:

Finder

or
Zoom

See also
Invoice Entry - Overview

New

Drop-Down
Lists

Invoice Entry — Sales Split Tab
Use this tab to:
Allocate document totals to salespeople for commission calculation.
Order Entry lets you assign portions of each transaction you enter in the
Invoice Entry form to each salesperson who is responsible for the
customer account or sale. If you track commissions for sales staff, Order
Entry uses this information to update the commission data when you post
invoices and run Day End Processing.
Default salespeople are assigned to customer records and to ship-to
locations in Accounts Receivable.

Creating an Invoice from Multiple Shipments
Note that sales commissions are calculated when you post an O/E
invoice.
Invoice Entry uses only the sales split for the first shipment by default
when you create an invoice from multiple shipments. Therefore, you
should check the Sales Split tab to ensure that the sales allocation is
correct. If the shipments used different sales splits, you must change the
allocation for the invoice manually.
If the sale is split among more than five salespersons, you should not
create one invoice for the multiple shipments.
For information about a different tab, click its name:
Invoice

Customer Taxes Retainage

Optional Fields Rates

Totals

See also
Order Entry form — overview

Invoice Entry — Rates Tab
Use this tab to:
Change the rate type, rate date, and exchange rate for converting the
document amount from the customer's currency to your functional
(home) currency.
Enter or derive the rate for converting tax amounts to the tax reporting
currency (if you report taxes in a different currency than you collect
them).
If Order Entry automatically calculates the tax amount in the tax
reporting currency, the program will use the Tax Reporting Currency
Exchange Rate on the Rates tab.
If you manually enter the tax amount in the tax reporting
currency, use the Derive Rate button on the Rates tab to calculate
the actual exchange rate for the tax reporting currency.
This tab appears only if you use multicurrency accounting and you are
entering a document for a customer who does not use your company’s
functional currency (and the exchange is not between two EMU member
currencies).
For information about another tab, choose its tab:
Invoice

Customer

Taxes Retainage

Optional Fields Sales Split Totals

See also
Invoice Entry — overview

Invoice Entry — Totals Tab
Use this tab to:
Enter a comment about the invoice.
Specify the number of labels you want to print for an invoice.
Verify invoice totals before posting an invoice.
Verify or change the invoice date.
The prepayment total on this tab enables you to easily determine if there
is an outstanding balance.
For information about a different tab, click its name:
Invoice

Customer

Taxes Retainage

Optional Fields Sales Split Rates

See also
Customer Payment Schedule form
Detail form
Invoice Entry — overview

Invoice Entry — Prepayments Popup Form
Use this form to:
Enter a prepayment with an invoice.
Modify or delete the information for a prepayment you entered
previously, but have not yet posted with the invoice.
If you use Payment Processing, process or void a credit card
prepayment.
You can enter a prepayment with an order, a shipment, or an invoice.
When you are creating an invoice, the prepayment you enter is
automatically applied to the invoice. (Prepayments added to orders are
applied to the order.)
Note:
Prepayments entered with invoices immediately reduce the amount
due on the invoices sent to customers, and are matched to invoices
posted to Accounts Receivable.
Prepayments entered with orders do not reduce the amount of the
next invoice you create; instead, they are matched to invoices when
they are posted in Accounts Receivable (using the order number).
You can enter only one prepayment for each invoice, but as many as you
want for a order.
The order prepayment total is displayed on the invoice total page,
enabling you to easily determine if there is an outstanding balance.
Job-Related payments
When you record job-related payments, click the Jobs button and then
click the distribute button on the Prepayment Details form to
automatically distribute amounts to details.
You can prorate payment amounts to individual details, or you can do a
"top-down" distribution, starting at the first job-related detail, or you can
edit the payment amounts yourself.
Note: The prepayment amount on a job-related order can exceed the

document total; however, you must ensure that the sum of the
prepayment amounts to individual details matches the prepayment total.
Credit card prepayments
If you use Payment Processing, you can use the Prepayments form to:
.

Process a credit card prepayment
Void a credit card prepayment

if it has not been settled in Sage Payment

Solutions.
To enable the Charge and Void buttons on this form, you must select a
payment code that uses the payment type SPS Credit Card before
adding the prepayment.
Tip: Click the Finder ( ) for the Payment Code field to see a list of
payment codes and associated payment types.
Before you start
Find out which Accounts Receivable receipt batch to use for the
prepayment. (You can also use the Finder to browse through the open
A/R batches.)
For information about adding prepayments, see Enter a prepayment.
See also
Customer Payment Schedule
Order Tab — Detail form
Order/Invoice Entry — Totals tab

Customer Bill-To Address Form (Invoices)
Use this popup form to:
Check or edit the billing information for an existing customer.
Type billing information for a new customer number you have
specified on an order but which you have not yet added to Accounts
Receivable.
To open the Customer Bill-To Address form, click the zoom button beside
the Customer Number field or, with the pointer in the Customer Number
field, press F9.
See also
Customer Ship-To Address form
Order/Invoice Entry form — overview

Invoice Entry — Customer Ship-To Address
Form
Use this popup form to:
Check or edit the shipping address for an existing customer.
Type the shipping address and other information for a new customer
number you have specified on an order but which you have not yet
added to Accounts Receivable.
To open the Customer Ship-To Address form, click the zoom button ( )
beside the Ship-To Location field, or press F9 while typing in the Ship-To
Location field.
See also
Customer Bill-To Address form
Invoice Entry form — overview

Invoice Entry — Items/Taxes Form
Use the Items/Taxes form to edit detail lines and to change detail tax
information.
Rather than presenting all the details for an order in columns, this form
displays information for a single detail so that you can see all of the fields
for a detail without having to scroll through the form.
Click these buttons for more help:
Finder

New

Drill Down

or
Shift +
Zoom

Drop-Down
Lists

To open or close the Items/Taxes form
1.Select a detail line on the Invoice tab, then either:
Press F9.
Click the Item/Tax... button.
2.Press F9 or click the button to return to the Invoice tab.
To edit details in the Items/Taxes form
1.To start a new detail line, click in the Line Number field. To edit an
existing detail, type its line number or use the scroll bars to display the
line you want.
2.

Enter any changes for the detail.

3.Click Add or Save.
To delete details in the Items/Taxes form
1.To open an existing detail you want to delete, type its line number or
use the scroll bars to display the line you want.
2.Choose Delete.
To check tax amounts for an order or invoice and compare the totals on

the screen with the totals on the source document, click the Totals tab.
See also
Assign Lot Numbers or Serial Numbers to an O/E Invoice
Calculate Tax Option
Enter taxes manually
Invoice Entry Form — overview
Taxes tab

Posting Invoices
After you have finished entering all the details for an invoice, you can
post it.
Note the dates that you enter on the Invoice tab:
Invoice Date — the invoice date is the date that will appear on the
invoice and which will be used for document aging. The invoice date also
appears on invoice transactions in Accounts Receivable.
Posting Date— this is the transaction date used by Day End Processing
in Inventory Control when it creates journal entries for the general ledger.
The posting date determines the fiscal year and period to which
transactions are posted in the G/L.
Fiscal year and period — this is a display-only field on data entry
screens. It shows the fiscal year and period is the period to which the
invoice transactions will be posted in Accounts Receivable — no matter
what date appears as the Invoice Date (and on the invoice).
The Invoice Date and the Posting Date do not have to match each other.
For example, by default, the fiscal period will match the Invoice Date, but,
if you are late invoicing an order, you might wish to post the transaction to
a previous fiscal period.
Day End Processing
If you cost inventory during day end processing, you must use the Day
End Processing form in Inventory Control to update Order Entry sales
statistics, sales commissions, and audit information, and to create
batches of Accounts Receivable invoices and credit notes. (You can post
A/R batches during day end processing, or later, using the Create Batch
icon in Order Entry.)
See also
Posting orders
Posting Shipments
Verifying invoice totals

Copy Orders Field List
From/To Customer Number
From/To Order Number
Tax Group
Order Type
Job Related
Project Invoicing
Price List

Copy Orders tab
Description
Expiration Date
On Hold
Order Date
Order Number
Order Type
Reference
Retainage

Buttons
Create
Kit Component

Detail grid
Contract, Project, Category, Cost Class (if job-related)
Copy Detail
Costing Unit of Measure
Description
Expected Ship Date
Extended Cost
Extended Price
Item Number
Line Number
Location
Kit/BOM
Misc. (Miscellaneous) Charge
Optional Fields
Order Unit of Measure
Order Weight Unit of Measure
Price Approval
Price By
Price List
Pricing Unit of Measure
Quantity B/O (Backordered)
Quantity Committed
Quantity Ordered
Retainage Percentage
Retention Period
Type
Unit Cost
Unit Price

Optional Fields tab

Optional Field and Description
Value Set
Value and Description

Current Orders Inquiry Field List
Customer Number
From/To Order Number
From/To Order Date
From/To Expected Ship Date
Order Type
Status

Detail display
Description (shipping)
Exp. (Expected) Ship Date
FOB Point
Location
On Hold
Order Date
Order Number
PO Number
Price List
Reference
Ship Via
Ship-To Location
Status
Tax Group
Terms
Territory
Type

Pending Shipments Inquiry Field List
From/To Expected Shipment Date
From/To Customer Number
From/To Item Number
From/To Location
Order Type

List of orders meeting selection criteria
Customer Number and Name
Exp. (Expected) Ship Date
Location
Order Date
Order Number
Order Type

List of item lines on orders
Expected Ship Date
Item Number and Description
Location
On PO
Order UOM
Qty Available
Qty Committed
Qty Ordered
Ship Via

PO details
Expected Arrival Date
Location
Order Number
PO Number
PO Type
Qty Ordered
Unit of Measure
Vendor Number and Name

Sales History Detail Form
You use the Sales History Detail form to:
View a list of documents posted in a particular year and period for a
specified item and customer.
Drill down to view a selected document in the original entry form.
Display the serial numbers or lot numbers allocated in a document
that included serialized or lotted items.
To display the Sales History Detail form:
On the Sales History form, double-click the line for
the item, year, and period, or select the line, and
then click the Details... button.
To drill down to view the document in the original
entry form:
On the Sales History Detail form, select the detail
line, and then click the Document... button.
To view the serial numbers or lot numbers allocated
to a serialized or lotted item:
On the Sales History Detail form, select the detail
line, and then click the Serial/Lot Numbers button.
Click the Field List button at the top right of this topic for help on the fields
that appear on the Sales History Detail form.
See also
Look Up Sales History for an Item or a Customer
Salesperson Inquiry form

Sales History Form Field List
Cost of Sales
Currency
Customer Number / Item Number
Customer Number and Name
Details...
From Year and Period/To Year and Period
Item Number and Description
Margin Percent
Quantity Sold
Return Amount
Returns Count
Sales Amount
Sales Count
Select By (Customer Number / Item Number)
Show As Functional Currency / Customer Currency

Keep Transaction History
Select this option if you want to be able to print completed order, invoice,
and credit note information on the Transaction List.
You must also select this option to be able to drill down from transactions
in General Ledger, Accounts Receivable, and Inventory Control to the
originating entry in Order Entry.
If you do not select this option, Day End Processing removes information
for fully shipped and invoiced orders and removes information for printed
invoices and credit notes so they will no longer appear on transaction
lists. (This option does not affect posting journals.)

Saving Sales Information for Reporting
The Keep Sales History option in Order Entry allows you to save sales
information so you can later print the information on reports.

Keep Sales History option
To save sales information, select the Keep Sales History option on the
Processing tab in the O/E Options form. You specify whether to save
sales data by fiscal year or calendar year, and select the period type. You
can report sales data on the Sales History report, sorted by customer
number, item number, or primary salesperson.
You can export transaction and sales history to other databases or to
spreadsheets for further analysis.

Turning the options on and off
You can turn the options to keep history on or off at any time. If you turn
them off after you have used them, Order Entry immediately stops saving
information, although it retains those records already collected until you
clear (delete) them using the Clear History form.
If you turn the options on again, there will be a gap in the collected
information corresponding to the period when the options were not used.

Clearing historical data
Historical data can take up a large amount of storage space on your
computer, so you should clear the data when you are finished using it.
For example, you might decide to clear data that is more than six months
old, or you might keep data for more than a year.

Saving Transaction Information for Reporting
The Keep Transaction History option in Order Entry allows you to save
information from posted orders, invoices, and credit notes, so that you
can print the information on reports after running Day End Processing. If
you do not use the option, you cannot print the information after running
Day End Processing.
If you keep transaction history, you can also drill down from transactions
in Accounts Receivable, Inventory Control, and General Ledger to view
originating transactions in Order Entry. If you turn off the Keep
Transaction History option, the system stops storing posted transactions
and you will no longer be able to drill down to Order Entry from other
Sage ERP Accpac programs to view them.
To save transaction information when you process transactions at day
end, select the Keep Transaction History option on the Processing tab in
the O/E Options form. You can print this information in summary or
detailed form on the Order List, the Invoice List, and the Credit Note List.

Sales Statistics Field List
Year
Period
Currency

Sales Grid
Number of Orders
Net Quantity Sold
Net Sales Amount
Net Invoice Amount
Cost of Sales
Total Sales Lost
Average Sales Lost
Margin Percent
Functional Currency/Customer Currency

Invoices and Credit/Debit Notes Grid
Number of Invoices and Credit/Debit Notes
Average Invoice and Credit/Debit Note
Largest Invoice and Credit/Debit Note
Customer With Largest Invoice and Credit/Debit Note
Smallest Invoice and Credit/Debit Note
Customer With Smallest Invoice and Credit/Debit Note
Invoice/Credit/Debit Note Currency

Accumulating Sales Statistics for Reporting
Order Entry can keep sales statistics from your posted orders, invoices,
and credit notes. You can review the statistics as far back as the oldest
year for which you keep this information by printing the Sales Statistics
report.
Keep Sales Statistics option
To save sales statistics for reporting, select the Keep Sales Statistics
option on the Processing tab in the O/E Options form. Order Entry keeps
the following statistics:
Order totals — number of orders, total sales lost, and average sales
lost.
Invoices — number of invoices, net quantity sold, net sales amount,
cost of sales, margin percent, net invoice amount, average amount,
and largest and smallest invoices, with associated customers.
Credit notes — number of credit notes, average amount, and largest
and smallest credit notes, with associated customers.
If you keep statistics, you must also decide:
. Use the Allow Edit Of Statistics option.

Whether to allow editing of statistics

. Use the Accumulate By and Period Type options.
(In the Small Business Edition, you can only accumulate statistics by
fiscal year and period.)
How you want to group statistics

If you do not save sales statistics, the Sales Statistics report shows only
zeroes.
Turning off statistics accumulation
You can turn the Keep Sales Statistics option on or off at any time. If you
turn off the option after you have used it, Order Entry immediately stops
saving statistics when you run day-end processing, although it retains
those already collected until you clear them using the Clear History form.
If you turn on the option again, there will be a gap in the collected
information corresponding to the period when the option was not used.

Keep Sales Statistics
Select this option if you want to save order, invoice, and credit note
statistics for reporting. If you select this option, other options appear for
you to specify whether you want to be able to edit statistics and how
statistics are accumulated.

Salesperson Inquiry Field List
Currency
Customer Number and Name
Document Date
Document Functional Amount (Func. Doc. Amount)
Document Number
Document Source Amount (Src. Doc. Amount)
Document Type
From/To Year and Period
Order Date
Order Number
Purchase Order Number
Primary Salesperson
Ship Date

Buttons
Detail button

Tasks Performed by Day End Processing
Day End Processing performs the following tasks:
Activates and posts future orders that have reached their order date,
and updates the quantities on sales order. When Day End Processing
is complete, you can print order confirmations and picking slips, enter
quantities shipped, and issue invoices for these orders.
Tip: If you usually run Day End Processing at the end of the work
day, future orders set to be activated on a certain day become active
only at the end of the day. To be sure a future order is ready to be
processed on the correct date, assign a date earlier than the desired
date for the order.
Removes quotes with expiration dates up to and including the session
date for day-end processing,and deletes expired quotes from the
system if you selected the option to Clear Expired Quotes and
specified a number of days on the O/E Options form.
Depending on whether you

:

cost inventory during posting or during Day End Processing

Calculates the unit cost for each item on an invoice, using the
item's costing method. (For more information, see the help for
Inventory Control.) The unit costs calculated are the default unit
costs for credit notes entered against the invoices.
Updates costing information for LIFO- and FIFO-costed items in
Inventory Control.
Updates Inventory Control with the costs of items returned as
negative shipments on invoices.
Updates statistics and history in both Order Entry and Inventory
Control.
Updates sales commissions if you selected the option to Track
Commissions and you entered salesperson commission rates in
Accounts Receivable or your item categories in Inventory Control
are commissionable.
Creates a batch of Accounts Receivable summary invoices and
credit notes from posted Order Entry transactions using the next

available Accounts Receivable batch number. For more
information about this batch, see Batches created in Accounts Receivable.
Creates the invoice and credit note posting journals in Order Entry for
the new day-end sequence number. These journals are the detailed
records of the general ledger entries that will be created when the
Accounts Receivable batches are posted.
See also
Day End Processing

Post A/R Batches
Specify when to post A/R batches generated from Order Entry Invoices,
credit notes and debit notes:
During Posting / During Day End Processing (depending on when you
create subledger transactions in Inventory Control)
Or
On Request Using Create Batch Icon
During Posting / During Day End Processing
This option lets you post Accounts Receivable invoice batches created by
Order Entry at the same time that you create subledger transactions in
Inventory Control — either when you post invoices or when you run day
end processing.
You choose when to create subledger transactions with the Create
Subledger Transactions And Audit Info. During option on the Costing tab
of the I/C Options form. The Create Subledger Transactions...During
option gives you two choices:
During Posting (appears only if you cost inventory during posting)
Or
Day End Processing
Note: These choices can have a large impact on the speed of processing
transactions in Order Entry and on the number of A/R batches that Order
Entry produces.
If you create subledger transactions during posting and you choose to
post A/R batches during posting, Order Entry will create and post an A/R
batch for each invoice it creates.
If you are processing a large volume of orders, you should create
subledger batches during day end processing or use the Create Batch
icon to post A/R batches.
On Request Using Create Batch Icon
This option lets you decide when to post Accounts Receivable invoice

batches created by Order Entry. Use the Create Batch form in Order
Entry and select the option to Post A/R Batches.
If you wish, you can also post the A/R batches created by Order Entry
using the Post Batch form in the Accounts Receivable program.
You can change your selection any time.

Periodic Processing — Overview
This topic outlines procedures you might follow as part of your daily,
weekly, bi-weekly, or monthly procedures, and tells you how to use Order
Entry to accomplish the tasks.

Daily or weekly processing tasks
If you have high order volumes, you can use the following forms at the
end of each day to complete order processing:
Day End Processing form in Sage ERP Accpac Inventory Control.
If performance is important, we suggest that you:
Choose the option in Inventory Control to cost inventory during
Day End Processing (instead of each time you post).
Choose the G/L Integration option in Order Entry to create G/L
transactions using the Create Batch icon.
Choose the option in Order Entry to post A/R batches using the
Create Batch icon. This option is on the Processing tab in The O/E
Options form.
Day End Processing will update item costs, update statistics, activate
future orders, delete quotes, and create G/L and A/R transactions (but
not add G/L transactions to batches or post A/R).
Create Batch form in Order Entry.
If you chose the above settings, the Create Batch process will create
the G/L batch and optionally post it (if you choose the option in the
G/L Integration form) and post the Accounts Receivable batches in
A/R.

At each period end, you should
1.Use the Order Entry form to create any new sales orders you wish to
process in the period.
2.Post other transactions that apply to the period.
Use the Shipment Entry, Invoice Entry, and Credit/Debit Note Entry

forms.
3.Print the Order Action, Invoice Action, and Aged Orders reports to
identify orders that require action.
Use the Order Action, Invoice Action, and Aged Orders forms from the
O/E Reports folder to print the reports.
4.Print the G/L Transactions report, then create general ledger
transactions (if you do not use the option to create general ledger
transactions during Day End Processing). Process the batches in
General Ledger, if you use it, or post them manually to your other
general ledger.
Choose the G/L Transactions icon from the O/E Reports form to print
the report. Choose the Create Batch form from the Periodic
Processing folder to create the general ledger transactions.
5.Clear the paid transactions, posting journals, and statistics that you no
longer need.
Choose the Clear History form from the Periodic Processing folder to
clear this information.

Options Report — Features
The Options report lists the information you entered and the options you
selected when you set up your Order Entry system, or when you changed
the information using the Options form.
For instructions on printing the report, see Options report — printing.

Information printed on the report
The report lists:
The company address, and the order entry contact person and
telephone number.
In multicurrency ledgers, the functional (home) currency and the
default exchange rate type.
Processing options specified on the Options form:
Whether you calculate backorder quantities.
Whether you keep transaction history.
Whether you allow non-existent customers.
Whether you default the quantity ordered as the quantity
committed.
The default unit of measure used for orders.
The default weight unit of measure used for orders.
The default template you use for entering new orders.
The default number of days before quotes expire.
Whether you create invoices for shipped goods by default.
Whether you warn before applying credit notes to previously
credited invoices.
Whether and how you accumulate sales history.
Whether and how you accumulate sales statistics.
Whether and how you track and calculate sales commissions.

What transactions you review for credit checks.
The size, prefix, and next number for quotes, orders, invoices,
shipments, and credit and debit notes.
The number of days in order aging periods.
See also
Order Entry reports
G/L Integration
Optional Fields

G/L Integration Report — Features
The G/L Integration report lists the G/L transaction and batch creation
options and other information you entered in the G/L Integration form to
specify how your Order Entry system sends transactions to General
Ledger.
For instructions on printing the report, see Printing the G/L Integration Report.

Information printed on the report
General ledger integration options.
Information transferred from source transactions to G/L transaction
fields.
See also
Order Entry Reports

Miscellaneous Charges Report — Features
The Miscellaneous Charges report lists the information entered to define
each of the charges you add to invoices and credit notes for costs other
than for items purchased and returned. For example, miscellaneous
charges can include postage, shipping, handling, and restocking charges.
For instructions on printing the report, see Miscellaneous Charges report — printing.

Information printed on the report
For each miscellaneous charge, the report lists the miscellaneous charge
code and description, currency code (if you have a multicurrency
system), amount of the charge, general ledger account code, tax
authority, and tax class.
You can also include optional field information and, if you use Project and
Job Costing, the extended cost and job-related expense and clearing
accounts for job-related miscellaneous charges.
See also
Order Entry reports

Ship-Via Codes Report — Features
This report lists the ship-via codes that are defined in Order Entry. Shipvia codes are specified on orders and invoices to identify the shipping
method or carrier you will use to deliver goods to customers (for example,
courier, air mail, parcel post).
For instructions on printing the report, see Ship-Via Codes report — printing.

Information printed on the report
Ship-via codes and descriptions.
Names, addresses, telephone numbers, and contacts for all listed
ship-via codes.
See also
Order Entry reports

Templates Report — Features
The Templates report lists the information entered to define the templates
that are used in your Order Entry system.
For instructions on printing the report, see Templates report — printing.

Information printed on the report
Template codes and descriptions.
The information entered and selections made to define the templates.
See also
Order Entry reports

Transaction List Report — Features
The Order, Invoice, Shipment, and Credit/Debit Note reports provide
detailed or summary listings of all current Order Entry transactions. For
instructions on printing the report, see Transaction List — printing.

Information printed on the report
Depending on the printing options you select, the report lists:
The information entered on the Order tab of the Order Entry form or
the Credit (Debit) Note tab of the Credit/Debit Note Entry form, and
the total amount. In multicurrency ledgers the total amount is in both
source currency and functional currency.
The address, phone number, and fax number for billing and shipping.
Details for each item on the order, invoice, shipment, or credit (debit),
including quantities ordered and shipped or returned, unit prices, and
total amounts outstanding.
The salesperson commission split for the order.
Any prepayments that were posted to an order or invoice.
The contract, project, and category to which the items or charges
were allocated.
Any allocated serial numbers or lot numbers (if you use Serialized
Inventory and Lot Tracking).
The report also includes grand totals for orders, shipments, invoices, or
credit/debit notes. The multicurrency version of the report includes
summary totals for each source currency.
See also
Order Entry reports

Sales History Report — Features
The Sales History report provides summarized or detailed sales
information, including sales totals by customer, inventory item, or primary
salesperson. Use the report as a sales journal, record of sales staff
performance by territory or location, and to indicate the strengths and
weaknesses in company sales.
For instructions on printing the report, see Sales History report — printing.

Information printed on the report
The detail report prints details of invoices, debit notes, and credit
notes, the sales, returns, and cost amounts for each invoice, debit
note, and credit note, and the gross margin percent for each sale and
return, as calculated by Day End Processing.
If you use Serialized Inventory and Lot Tracking (licensed separately),
you can include serial numbers and lot numbers on the report.
Multicurrency versions of the report can be printed in functional or
source (customer) currency.
See also
Order Entry reports

Order Action Report — Features
The Order Action report lists details of your current orders, and provides
options which allow you to produce a variety of versions of the report.
For instructions on printing the report, see Order Action report — printing.

Information printed on the report
Depending on the options you select, the report can list:
The item status you selected for the report.
The primary salesperson for each order.
Source-currency and functional-currency amounts (multicurrency
reports) and the exchange rate for converting source-currency
amounts to their functional-currency equivalents.
Total amount for all orders (in functional currency for multicurrency
ledgers).
The total amount outstanding for the order (in functional currency for
multicurrency ledgers).
The contract, project, and category (if you include job details).
The detail version of the report lists the order details for each item on the
order.
See also
Order Entry reports

Invoice Action Report — Features
This report lets you find out whether shipments have been partially or
fully invoiced and print the current amounts remaining to be invoiced.
This report ensures that all product shipped to customers is properly
invoiced in a timely manner.
For example, a salesperson can print a report by order number that lists
all orders with uninvoiced shipments.
The main choice of report is whether to choose shipments by order
number or shipment number — and the range of order numbers or
shipment numbers to include on the report.
If you select by shipment number, you choose the range of shipments
and, optionally, a range of customers or a range of salespeople.
If you select by order number, you choose the range of orders and,
optionally, a range of customers or a range of salespeople. However,
you can also choose the status of the orders printed, which involves
choosing from a variety of shipment statuses and invoicing statuses.
You can then select a range of customers or salespeople.
Note that this report does not apply to job-related orders that use project
invoicing. This is because after posting a shipment for a job-related order
that uses project invoicing, that document is marked completed, and can
never be invoiced in Order Entry.
For instructions on printing the report, see Invoice Action report — printing.

Information printed on the report
Depending on the options you select, the report can list:
Orders for a range of order or shipment numbers, also sorted for
ranges of customer numbers, salespeople, and order or shipment
dates.
Orders fully shipped, partially shipped, fully invoiced, partially
invoiced, or never invoiced.
The order number along with the customer number and name.
The primary salesperson for each order.
Each item on the order, with the shipment date and number, invoice
date and number, quantity ordered, quantity shipped, unit price and
discount, extended amount shipped, and shipped but not invoiced
amount.
The summary version of the report does not list the details for each
item on the order.
Invoiced shipments if you choose Fully Shipped, Fully Invoiced
orders.
Source- and functional-currency amounts.
Total amount for all orders (in functional currency for multicurrency
ledgers).
The total amount of all orders listed, and the total amount shipped but
not invoiced for all orders listed (in functional currency for
multicurrency ledgers).
The contract, project, and category information for details (if you use
the Project and Job Costing program).
See also
Order Entry reports

Sales Statistics Report — Features
The Sales Statistics report lists the order entry statistics you have
accumulated since you last cleared statistical data for the period you
specify. Use the report to help you understand and analyze the level of
processing in your Order Entry system.
For instructions on printing the report, see Sales Statistics report — printing.

Information printed on the report
The net sales amount (not including miscellaneous charges or taxes).
Total sales lost and average sales lost. Sales amounts lost occur
when items are ordered or backordered, then canceled, whether or
not quantities were shipped.
In multicurrency ledgers, the source-currency code and description,
and statistics for each source currency. You can print multicurrency
versions of the report in functional or source (customer) currency.
See also
Order Entry reports

Aged Orders Report — Features
The Aged Orders report is a list of all incomplete orders and their relative
ages in the system. The report allows you to quickly spot and act on
orders that have been outstanding for a long time.
For instructions on printing the report, see Aged Orders report — printing.

Information printed on the report
The Aged Order report compares the Aged As Of dates to the order
dates to determine the aging category to which each order belongs.
The report contains the following:
A subtotal for each of the four aging periods and, in the right-hand
column, the grand total of all aged orders.
Amount of orders for each period, expressed as a percentage of the
grand total. Shows where the bulk of aged orders occurs.
Currency information (multicurrency ledgers), including report
subtotals and a grand total for each currency.
See also
Order Entry reports

Salesperson Commissions Report — Features
This report lists the sales commissions earned since you last cleared
commission data for each salesperson for whom you track commissions.
(The program tracks commissions only if the option Paid Commissions is
selected in the salesperson record, in Accounts Receivable.)
For instructions on printing the report, see Salesperson Commissions report — printing.

Information printed on the report
The range of salesperson numbers selected for the report.
The commission earned, including the type of commission, based on
the sales amount or on the margin, as specified on the Processing
Options page of the Options form.
Category sales which include those where the commission rate is
determined by the category. All salespersons receive the commission
rate defined for the category.
The program uses the category commission rate, instead of the
salesperson commission rate, unless the category rate is 0 (zero)
percent.
Sales by salesperson including those where the program uses the
salesperson's commission rate to calculate the commission.
The salesperson can have up to five commission rates, which you
define in the Salespersons form in the Accounts Receivable program.
The program uses the commission rate for the sales range into which
the sales amount falls.
Rates totals for each salesperson a rate total for the report.
Report totals (not including miscellaneous charges or taxes).
In multicurrency ledgers, report amounts are printed in the functional
(home) currency.
See also
Order Entry reports

Posting Journals Report — Features
You can choose to print the following journal reports:
Shipments Posting Journal. Lists all shipments for the range of dayend numbers you specify, sorted by day end number, transaction
date, customer number, or shipment number. You can also choose the
paper size format (either Legal or A4).
Invoices Posting Journal. Lists all invoices issued to customers for
the range of day-end numbers you specify, sorted by day end number,
transaction date, customer number, or invoice number. You can also
choose the paper size format (either Legal or A4).
Credit/Debit Notes Posting Journal. Lists credit/debit notes issued
to customers for returned goods and other credits/debits, sorted by
day end number, transaction date, customer number, or by
credit/debit note number.
For each of the above reports, you can include sales splits, tax
summaries, and optional fields. You can also choose to reprint previously
printed journals.
For invoice posting journals, you can also include Accounts Receivable
audit information with invoice information to help you match postings in
Order Entry to Accounts Receivable transactions.
Multicurrency reports. The multicurrency version of the report lists the
customer's currency code for each invoice or credit, along with the
exchange rate, exchange rate type, and exchange rate date. The journal
prints amounts in both source and functional currencies.
The final pages of the report include totals for each source currency, and
a general ledger summary in both source and functional currencies.
For instructions on printing the report, see Posting journals — printing.

Information printed on the report
The details of each invoice. Transactions can be listed in order by day
end number, transaction date, invoice number, or customer number.
Debit and credit amounts distributed to general ledger accounts for

the invoice.
Note: An asterisk (*) beside an amount in the Invoice Amount column
shows that the unit price or extended price was overridden during
invoice, order, or credit note entry.
Tax summary.
Tax reporting information (if you report taxes in a different currency).
Invoice totals.
Salesperson summary.
Optional fields.
Job details (if you use the Project and Job Costing program).
Any allocated serial numbers or lot numbers (if you use Serialized
Inventory and Lot Tracking).
A General Ledger Distribution Summary, including the debit and credit
totals for each account listed on the journal.
See also
Order Entry reports

Order Confirmations — Features
Order confirmations list items on an order, acknowledging receipt of the
order and confirming the contents.
Order Entry comes with two order confirmation forms: one prints a
complete confirmation (including lines and borders) on a laser or ink-jet
printer, and the other prints order information on preprinted stock.
The sample Order Entry order confirmations list all the items and
miscellaneous charges on an order, together with any comments that
were entered either with detail lines or for the order itself. The sample
confirmations also include the name and address of both the company
and customer.
You can include other information on order confirmations, you can
change the report layout to suit your needs, or you can create your own
forms using Crystal Reports. For more information, refer to the online
document, Customizing Printed Forms with Crystal Reports.”“
Unit Price column may not match data entry screen
Note: The Unit Price column printed on order confirmations is calculated
by dividing the extended price by the quantity ordered — whether pricing
by quantity or by weight. When pricing by weight (and when the order unit
of measure is not the pricing unit of measure), the printed unit price may
not match the unit price on the transaction entry forms.
For instructions on printing confirmations, see Order confirmations — printing.
See also
Order Entry reports

Receipts — Features
For instructions on printing receipts, see Receipts — Printing.

Information printed on the receipt
Each receipt contains:
Header information, including your company information, the date the
receipt is printed, the document number, whether the payment was
made in cash or by check or credit card, the payer and the customer
name (if different from the payer), the customer address.
A signature line where you can acknowledge receipt of the customer
payment.
Detail information that shows information about the document(s)
being paid, including the amount applied to each document and any
discounts taken.
Totals that show the total amount paid and the total amount remaining
to be paid, in the customer currency and, if the payment was made in
a different currency, in the receipt currency, also.
If you use Customer as the print destination, for customers that use an email or fax delivery method, the program e-mails or faxes to each
customer a receipt confirmation along with a message you specify in the
Message ID field.
See also
Order Entry reports

Picking Slips — Features
Picking slips show the number of items that are currently on order
(usually the original amount minus any quantity shipped). Depending on
your choices, items are listed in order by picking sequence, item number,
or order line number.
You can also print multiple picking slips per order or shipment if your
order/shipment details include goods from different locations.
Sage ERP Accpac Order Entry includes sample forms you may be able
to use to print picking slips. You should set up and test these forms
before you begin entering transactions.
For instructions on printing the report, see Picking slips — printing.

Information printed on the report
The sample Order Entry picking slips list all the items and miscellaneous
charges on an order, together with any instructions that were entered
either with detail lines or for the order itself. The sample slips also include
the name and address of both the company and customer.
You can include other information on picking slips, depending on the
report files you use to print them.
Note: If you shipped goods from an order and printed the picking slip
after posting from the Order Entry form, the print status of the shipment
will be set to “Picking Slip Printed,” but the print status of the order will
not be changed.
To update the status for orders, post the order but do not print the picking
slip. Instead, go to the O/E Forms folder, choose Picking Slips, select the
form you want, and change the Select By field to Order Number. Print the
picking slip, and the status will be correctly updated.
See also
Order Entry reports

Credit/Debit Notes — Features
Order Entry provides two 8½" x 11" sample forms which list complete
details of the sales returns and credits you post to customer accounts.
One of the sample forms prints a complete credit (or debit) note form —
with headings and lines — on a laser or ink-jet printer, and the other
prints only the credit or debit note information (for preprinted stock).
You should set up and test the forms you want to use before you begin
entering transactions. See the online document, Customizing Printed
Forms with Crystal Reports, for instructions for adapting the forms to your
use or creating your own. ”“
Unit Price column may not match the data entry screen
Note: The Unit Price column printed on credit and debit notes is
calculated by dividing the extended price by the quantity shipped or
returned — whether pricing by quantity or by weight. When pricing by
weight (and when the order unit of measure is not the pricing unit of
measure), the printed unit price may not match the unit price on the
transaction entry forms.
For instructions on printing the report, see Credit/Debit notes — printing.
See also
Order Entry reports

Shipping Labels — Features
You can use Order Entry to print shipping labels which you can attach to
shipments sent from the warehouse or shipping department. The number
of labels printed for each order or invoice is the number specified for the
order or invoice on the Totals tab of the Order/Invoice Entry form.
Order Entry comes with two labels: one works with 1½" x 4" sheet labels
for a laser printer (report file OELABEL.RPT), and the other works with
1½" x 3¾" tractor feed labels (report file OELABELD.RPT).
You can change the shipping labels to suit your needs or create your own
labels using the Crystal Reports designer. You should set up and test
these forms before you begin entering transactions.
For instructions on printing labels, see Shipping labels — printing.
See also
Order Entry reports

Quotes — Features
Quotes list items on an order that was entered with Quote selected as the
order type, and provide a record of the quote for your customer and your
records.
Order Entry comes with two quote forms: one prints a complete quote
(including lines and borders) on a laser or ink-jet printer, and the other
prints quote information on preprinted stock.
The sample Order Entry quotes list all the items and miscellaneous
charges on an order, together with any comments that were entered
either with detail lines or for the order itself. The sample quotes also
include the name and address of both the company and customer.
You can include other information on quotes, you can change the report
layout to suit your needs, or you can create your own forms using Crystal
Reports or Crystal Info. For more information, refer to the online
document, Customizing Printed Forms with Crystal Reports (x:\Program
Files\ACCPAC\Docs\SM55AENG).”“
There is a default number of days for the expiration of quotes. When you
enter a quote, Order/Invoice Entry displays a default expiration date
based on the number of days specified.
Unit Price column may not match data entry screen
Note: The Unit Price column printed on invoices is calculated by dividing
the extended price by the quantity shipped or returned &emdash;
whether pricing by quantity or by weight. When pricing by weight (and
when the order unit of measure is not the pricing unit of measure), the
printed unit price may not match the unit price on the transaction entry
forms.
For instructions on printing confirmations, see Quotes — printing.
See also
Order Entry reports

Including Optional Field Information on Reports
Because several Order Entry reports let you select records by optional
fields, you can analyze your data in ways that are especially relevant to
your business. When you use optional fields as selection criteria, Order
Entry prints records that will display optional fields and values that fall
within the specified ranges.
You can include optional field information when printing the following
Order Entry reports:
Posting Journals Report.
Miscellaneous Charges Report.
Transaction List Reports.

Printing When Schedule is the Print Destination
You can choose the option to schedule a report to be printed from a
computer running Crystal Info Server software.
To schedule a report for printing choose Print Destination from the File
menu on the company desktop, choose Schedule, and then choose OK.
A dialog box appears when you choose to print:
1.Enter your Crystal Info user name and password.
2.Choose a server from the APS field (Automated Process Server).
3.Indicate the publishing format and enter the name of the file you are
scheduling for printing.
4.Choose the destination (either to a hard disk on another workstation
or to a computer running Crystal Info server.
5.Enter the date and time you’d like the report printed.
See also
Order Entry reports
Printing when File is the print destination
Printing when Printer is the print destination
Printing when Preview is the print destination
Printing when E-mail is the print destination

Calculating Sales Taxes
Order Entry calculates a sales tax amount automatically if:
The Calculate Tax option on the Order tab is selected. (The option is
selected by default.)
The customer is subject to tax. You enter the tax classes and tax
registration numbers for each customer in the Accounts Receivable
Customers form. However, you can change this information on the
Taxes tab of the Order/Invoice Entry form for individual orders.
The order contains taxable items or taxable miscellaneous charges.
Item tax classes are set up in Inventory Control, but you can change
the tax classes for an individual detail line by opening the zoomed
Detail form (select the detail line and press F9) while editing the
detail. You can also change the setting for whether tax is included in
or excluded from the price of the item.
You specify the tax rates for the tax authorities and classes in Tax
Services. Order Entry calculates sales tax using the rates defined for
the customer tax class and item tax classes for each authority that
can levy taxes on the customer.
See also
Change tax information

Prepayments Field List
Amount Due
Bank Code
Bank Currency (display only — multicurrency ledgers)
Bank Rate (multicurrency ledgers only)
Batch Date
Batch Number
Check/Receipt Number
Currency (multicurrency ledgers only)
Deposit Number
Deposit Slip Printed (display only)
Description
Discount Available (display only)
Jobs button
Order Total
Payment Code
Processing Code
Rate Date (multicurrency ledgers only)
Rate Type (multicurrency ledgers only)
Receipt Amount
Receipt Date
Shipment Total

Prepayments Field List
Amount Due
Bank Code
Bank Currency (display only — multicurrency ledgers)
Bank Rate (multicurrency ledgers only)
Batch Date
Batch Number
Check/Receipt Number
Currency (multicurrency ledgers only)
Deposit Number
Deposit Slip Printed (display only)
Description
Discount Available (display only)
Document Total (display only)
Jobs button
Payment Code
Processing Code
Rate Date (multicurrency ledgers only)
Rate Type (multicurrency ledgers only)
Receipt Amount
Receipt Date

Partial Invoices
You create a partial invoice when you ship and invoice only part of an
order. You can post as many invoices from a single order as you require,
until all the quantities are shipped.
When you post a partial invoice, all the miscellaneous charges currently
entered for the order (and not marked Completed) will be invoiced.
When you partly invoice an order, the program deducts the quantities
shipped from the quantities on order. The next time you recall the order,
the quantities on order will be the reduced amounts -- showing the
quantities outstanding.
To check the original quantity ordered for the item, select the item line
and review the amount in the Original Order field.

Credits on Invoices
If an order is still incomplete, and you do not want to create a credit note,
you can enter credit amounts on invoice detail lines for returned items or
to reverse miscellaneous charges.
To enter a credit for a returned item, enter a negative quantity in the
Quantity field before posting an invoice. The program computes the
extended price of the item as a negative amount. Credit amounts entered
on invoices are included with other invoice data on the Invoice List. They
do not appear on the Credit Note List.
The quantities on hand in Inventory Control are adjusted when you post
the invoice.
The costs of the returned items are adjusted when you run Day End
Processing in Inventory Control.
Although you can enter a detail line with a negative quantity shipped,
Order Entry does not allow you to post an order or invoice with a negative
total.

Invoices Over the Customer's Credit Limit
When you are about to post an invoice that will put a customer account
over its credit limit, Order Entry displays a warning message and the
following customer information:
Credit limit.
Outstanding Accounts Receivable balance.
Order amount.
Last invoice amount and date.
Last payment amount and date.
If you are using security, you or your supervisor must enter a user ID and
password which are authorized to approve credit before you can continue
invoicing.
If you are not authorized to override the credit limit, or if you want to put
the order on hold for later invoicing, select On Hold. If the order is on
hold, you can post the order but you cannot ship goods and produce an
invoice for it until you remove the on-hold designation.

Miscellaneous Charge Invoices
You can enter an invoice that contains only miscellaneous charges.
When you are ready to post, the program asks whether you want to
produce an invoice. If you are not ready to produce the invoice, choose
No to post the charge only as an order (which you can later recall to
produce an invoice).

Sales History Detail Form Field List
Category
Cost of Sales
Day End Number
Entry Number
Location
Order Date
Order Number
Quantity Sold
Return Amount
Sales Amount
Salesperson
Ship Date
Territory
Transaction Date
Transaction Number
Transaction Type
Year and Period

Choosing G/L Integration Options
Sage ERP Accpac Order Entry produces general ledger transactions for
all posted shipments.
If you use Sage ERP Accpac General Ledger, Order Entry creates
batches of transactions right in General Ledger, where you can edit and
post them. If you use another general ledger system, or if your Sage ERP
Accpac General Ledger system is at another location, Order Entry
creates batches you can import into your general ledger, or print, then
enter manually into your general ledger.
The Integration tab of the G/L Integration form provides options for
producing general ledger transactions in the form and at the time that
best suits your requirements.
It also displays the last day end number for which you created general
ledger transactions, as well as the day end number that will be assigned
when you next run Day End Processing.

Reporting General Ledger Data
You can print the G/L Transactions report, a listing of the general ledger
transactions created by Order Entry, whether or not you post batches in
General Ledger.

Specifying When and How to Create General
Ledger Transactions
Using the Integration tab of the G/L Integration form, you can:
Specify when to create general ledger transaction batches.
Specify whether to add transactions to existing general ledger batches or to create a new batch every time you
create general ledger transactions -- and optionally post the batch automatically.

Choose whether to create detailed general ledger transactions or to
consolidate them during day end processing of Order Entry batches.
Select the descriptions, reference and comments to include with each
unconsolidated general ledger transactions and transaction details.
Choosing Consolidation Options for General Ledger Transactions

Selecting

Descriptions, References, and Comments for General Ledger Transactions

See also
Choosing Order Entry Options

G/L Integration Options
Like other Sage ERP Accpac products, Order Entry lets you choose the
information that appears in description, reference and comment fields for
General Ledger transactions generated from O/E transactions. You
specify this information on the G/L Integration form, where you can also
choose to automatically post all General Ledger batches that are created
by Order Entry.
Order Entry now gives you far more choices for the information in the
description and reference fields of G/L transactions than you had
previously. When you upgrade to Order Entry 5.4, the program maintains
the same description and reference information that you chose
previously. You should review the choices you made previously to see if
you now want to change them.

Adding Salesperson Commission Rates
You maintain salesperson commission rates with the salesperson records
in Accounts Receivable.
To track commissions, you must:
In the Order Entry Options form, select the Track Commissions
option.
In Accounts Receivable, select the Paid Commissions option for each
salesperson who earns commissions.
In Inventory Control, select Allow Commissions for each inventory
category for which salespeople can earn commissions.
Note: Category commission rates will override salesperson commission
rates.
This also means that if you calculate commissions using rates added to
the inventory category (maintained in Inventory Control), you do not have
to enter rates with salesperson records in Accounts Receivable.
If you need to vary commission rates for items, you can change the
categories for items when you enter orders.
To add commission rates for salespersons in Accounts Receivable:
1.Choose Salespersons from the Accounts Receivable Setup folder.
2.Type the salesperson number, or select it with the Finder.
3.Choose the Paid Commissions option on the Commissions tab and
specify the number of commission rates you wish to enter.
4.Type the total sales amount up to which the rate applies.
5.Click Save to record your entries.

Integration with Project and Job Costing
If you have Order Entry and Project and Job Costing, you can enter jobrelated orders in the Order Entry program and track project costs in
Project and Job Costing.
Orders can list material details items from inventory used on the job and
they can list miscellaneous charges, which can be labor, subcontracting
charges, or charges such as shipping and handling.
Order Entry lets you handle the complete order processing cycle in Order
Entry, or create the order and shipment in Order Entry and manage the
billing and invoicing in the Project and Job Costing program (called
Project Invoicing).
For example:
Service providers normally invoice directly from Order Entry.
Companies with more lengthy or complex projects, such as
construction companies, normally use project invoicing, and will likely
process addition costs through the Accounts Payable program.
Posting the shipment in Order Entry completes the transactions for O/E.
The transaction is sent to Project and Job Costing, where it calculates the
extended billing amount and the cost portion of the order.
You can enter a quote in Order Entry and create the contract on the fly
using the New Contract Wizard.
The New Contract Wizard lets you copy an existing contract to make the
new one. This means that you can create one or more contracts in
Project and Job Costing that act as templates for all the new contracts
created in Order Entry.
See also
Changes in Order Entry 5.5
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions

Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

Start and End Dates on Price Lists
In Inventory Control, you can now set the period during which a price list
is in effect. This means that you can easily cut over from an old price list
to a new one on a particular date.
If you choose a price list in Order Entry before or after the effective dates,
the program will display a warning message and enter a 0.00 price.
The price list is always valid if the starting and ending dates are blank.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

Different Document Dates and Posting Dates
Like other Sage ERP Accpac subledgers, Order Entry now provides a
Posting Date field on transaction entry forms (in addition to the document
date) that lets you specify the date to use for the transaction when it’s
posted in General Ledger.
The ability to specify posting dates is particularly useful if you need to
post a document to a different year or period from the document date.
Note: The posting date determines the year and period to which a
document is posted. You no longer specify the Year/Period separately.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

Drilldown to Sales Orders and POs from
Transaction Entry
You can now drill down from item quantity information on transaction
entry forms in Order Entry to display sales order and purchase order
information.
This lets you see exactly what items are on order, where and when they
will arrive, etc. while you are entering new transactions.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

Enter Prepayments on Shipments
Order Entry now lets you enter prepayments on shipments, as well as on
orders and invoices.
As with orders, prepayments on shipments do not reduce the amount of
the next invoice you create; instead, they are matched to invoices when
they are posted in Accounts Receivable (using the order number).
The shipment prepayment total is displayed on the shipment total tab,
and is also displayed with the Order Prepayment amount on the invoice
total tab, helping you determine if there is an outstanding balance.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

Check for Duplicate Orders Based on Purchase
Order Numbers
Order Entry uses the settings in the Accounts Receivable customer
record to decide whether it checks for duplicate purchase order numbers
and what it does if it finds them.
Use the Check For Duplicate POs option on the Invoicing tab in the
customer record to select the behavior that you want:
Select None if you do not want Order Entry to check for duplicate
purchase order numbers.
If you want Order Entry to check for duplicates, select the type of
message you want to display — a warning or an error message that
blocks you from entering a document with the duplicate PO number.
Note: The program will check for duplicate POs on active orders, future
orders, and shipments) — not on quotes or standing orders.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

Calculate Backordered Quantities Based on
Customer Options
Order Entry also uses the settings in the Accounts Receivable customer
record to decide whether to place out-of-stock items on backorder.
If the customer allows backorders (which arise when you do not have the
quantity on hand to fully ship an order), select Allow Backorder Quantities
on the Invoicing tab in the Accounts Receivable customer record.
If you select this option for a customer, and you:
Use the option in Order Entry to calculate backorder quantities, Order
Entry automatically calculates the backorder quantity when you ship
an order for the customer.
Do not use Calculate Backorder Quantities, you can manually enter
the backorder amount in Order Entry.
Use the option in Order Entry to commit backordered quantities,
Order Entry also creates a commitment for the unfilled portion of the
order.
If you do not select this option for the customer in A/R, the quantity
backordered field in Order Entry will be disabled for this customer. Also,
Order Entry will not create a commitment for unfilled quantities on partial
shipments.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
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Create Unconsolidated Details on A/R Invoices
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Post Transactions Faster
New Picking Slips

Cost inventory during Posting / Create
Transactions and Audit Information during Day End
Processing
Version 5.4 of Order Entry let you cost inventory during posting or during
day end processing, so you could keep inventory costs up-to-date during
the day. If you chose to cost inventory during posting, the program
created transactions and audit information at the same time.
In version 5.5, we enhanced this option to let you cost items during
posting, but delay transaction and audit information creation until day
end. This way, you can get more information when you need it without
sacrificing performance.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
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Post Transactions Faster
New Picking Slips

Inquire on Pending Shipments
Order Entry’s Pending Shipments Inquiry lets you review items that are
expected to ship within a given time period (for example, from this
Monday to next Monday) and whether sufficient stock is available for the
shipments.
The inquiry ignores orders that are on hold, and you can limit the inquiry
to specific order types and to specific locations.
The inquiry also shows if open purchase orders exist for each item on
order, and allows you to zoom into existing POs to check the quantities
on order and the expected arrival dates.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
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Order Entry Templates with Blank Tax Groups
Previously, Order Entry required a tax group on templates. This is no
longer the case, so the same template can be used with customers in
different tax jurisdictions.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
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Definable Source Type Codes for G/L Transactions
As with other Sage ERP Accpac applications, you can now change the
two-letter source type codes used for the different transaction types sent
to the General Ledger.
You change source type codes on the G/L Integration form.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
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Post Transactions Faster
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Hide, Show/Allow Editing of Unit Cost/Extended
Cost Fields in Credit/Debit Note Entry
Order Entry provides a new Credit/Debit Note Costing security right to
control hiding and showing/editing of the unit cost/extended cost fields in
the Credit/Debit Note Entry form.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
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New Picking Slips

Override the Customer Account Set during Order
Entry
You can now override the customer account set when entering an order,
shipment, invoice, or credit/debit note. The account set must match the
customer's currency in a multicurrency system.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
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Send Credit/Debit Note Transactions to the
General Ledger
Order Entry now uses the Credit/Debit Note Clearing account added to
Inventory Control account sets when you enter and post credit and debit
note entries.
Items returned to inventory
The following example records a credit note transaction for items
returned to inventory. The first transaction is posted directly to G/L from
Order Entry; the second one goes through Accounts Receivable.
G/L Account
Inventory Control

Debit
X

Credit/Debit Note
Clearing
G/L Account

Credit

X

Debit

Sales Returns

X

Credit/Debit Note
Clearing

X

Tax Liability

X

Credit

Receivables Control

X

Cost of Goods Sold

X

Damaged items
The Damaged Goods account is debited rather than the Sales Returns
account.
G/L Account

Debit

Damaged Goods

X

Credit/Debit Note
Clearing

X*

Credit

Tax Liability

X

Receivables Control

X

Cost of Goods Sold

X*

* The Cr/Dr Note Clearing and the COGS entries will always be zero
for damaged goods.
This transaction will appear differently in the A/R Invoice form
depending on whether or not the transaction is job-related or uses
optional fields.
If the transaction is job-related or uses optional fields, the invoice will
list a single detail line for the damaged goods account.
If the transaction is not job-related and does not use optional fields,
the invoice will list three lines—one for damaged goods, one for cost
of goods sold, and one for Credit/Debit Note clearing—but only the
damaged goods line will have an amount.
Price adjustment
G/L Account

Debit

Sales

X

Tax Liability

X

Receivables Control

Credit

X

Debit notes generate opposite debit and credit entries.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices

Post Transactions Faster
New Picking Slips

Create Single, Unconsolidated Details on A/R
Invoices for Job-Related Invoice Details and
Invoice Details with Optional Fields
Order Entry creates detail lines differently for A/R invoices if you use
detail optional fields or if you use Project and Job Costing.
Without optional fields or Project and Job Costing
If you do not use optional fields in Order Entry invoice details and in
Accounts Receivable invoice details, and if you do not use Project and
Job Costing, the Order Entry program creates A/R invoices with separate
detail lines for sales, cost of goods sold, and shipment clearing entries
(as in earlier versions of Order Entry).
All A/R invoice details are consolidated by G/L account, so if you use only
one sales account, one cost of goods sold account, and one clearing
account, you will see only three lines on an invoice.
Sales

Acct
4111

750.00

Cost of
Goods Sold

Acct
5200

-500.00

Shipment
Clearing

Acct
5900

500.00

With optional fields or Project and Job Costing
If you use optional fields in Order Entry invoice details and in Accounts
Receivable invoice details, or if you use Project and Job Costing, the
Order Entry program now creates a single A/R invoice detail line for each
Order Entry invoice detail line.
Each A/R invoice detail includes the entries for the revenue, inventory
(shipment clearing), and cost of goods sold accounts, and there will be as
many invoice detail lines as there were on the original O/E invoice. A/R
invoice details are not consolidated.

Sales item 1

Acct
4111

250.00

Sales item 2

Acct
4111

250.00

Sales item 3

Acct
4111

250.00

Each of the unconsolidated A/R invoice lines will produce a G/L entry
with sales account, cost of goods sold account, and clearing account
details when posted in Accounts Receivable.
See also
Journal Entries Generated by Posted Transactions
G/L Accounts Used by Order Entry
Cost of kitting items in job-related orders
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster
New Picking Slips

Create a Single Line for Kitting Items on A/R
Invoices
A/R invoices created if you have Project and Job Costing or if you added
optional fields to invoice details show only one detail line for each kitting
item listed on an invoice, instead of showing one line for each component
of each kitting item. Order Entry handles the accounting for kitting items
with the following G/L entries.
When you ship kitting items, Order Entry creates G/L entries for each of
the components in the kitting item:
G/L Account
Debit
Credit
Shipment Clearing,
component 1

X

Inventory Control
Shipment Clearing,
component 2

X
X

Inventory Control

X

When you invoice a kitting item, Order Entry creates the following G/L
entries to back out the components for the master item from the shipment
clearing account:
G/L Account
Debit
Credit
Shipment Clearing,
master item

X

Shipment Clearing,
component 1

X

Shipment Clearing,
component 2

X

The source code that appears on the G/L Transactions report for the
shipment entry is OE-SH. The source code that appears on the G/L
Transactions report for the invoice entry is OE-IN.
Note:If you do not use optional fields in Order Entry invoice details and in
Accounts Receivable invoice details, and if you do not use Project and

Job Costing, the Order Entry program will still add shipment clearing lines
for each component to the A/R invoice and will not create these G/L
account entries during shipping and invoicing.
See also
Journal Entries Generated by Posted Transactions
G/L Accounts Used by Order Entry
Cost of kitting items in job-related orders
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
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New Picking Slips

Post Transactions Faster
We have spent considerable effort improving Order Entry's performance.
Even though Order Entry now includes several new features that affect
performance (such as integration with Project and Job Costing), the net
result is faster processing and quicker reports.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Order Entry Templates with Blank Tax Groups
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
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Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
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New Picking Slips
The picking slips report form lets you print picking slips for a range of
orders or for a range of shipments, depending on which method best
suites your order processing system. To make the print program more
efficient, Order Entry ships with four new picking slips that are designed
for the two different types of ranges.
If you are selecting one or more orders for picking, you can choose one
of the following reports:
OEPICKORDER1 A picking slip for laser printers (plain paper
version).
OEPICKORDER2 A picking slip (for preprinted forms).
If you are selecting one or more shipments for picking, you can choose
one of the following reports:
OEPICKSHIPMENT1 A picking slip for laser printers (plain paper
version).
OEPICKSHIPMENT2 A picking slip (for preprinted forms).
Order Entry selects the report file that you last used by default.
See also
Changes in Order Entry 5.5
Integration with Project and Job Costing
Start and End Dates on Price Lists
Different Document Dates and Posting Dates
Drilldown to Sales Orders and POs from Transaction Entry
Enter Prepayments on Shipments
Check for Duplicate Orders Based on Purchase Order Numbers
Calculate Backordered Quantities Based on Customer Options
Cost inventory during Posting / Create Transactions and Audit Information during Day End Processing
Inquire on Pending Shipments
Definable Source Type Codes for G/L Transactions
Hide, Show/Allow Editing of Unit Cost/Extended Cost Fields in Credit/Debit Note Entry
Override the Customer Account Set during Order Entry
Send Credit/Debit Note Transactions to the General Ledger
Create Unconsolidated Details on A/R Invoices
Create a Single Line for Kitting Items on A/R Invoices
Post Transactions Faster

Enhanced Pricing Available in Order Entry
Pricing for items in Order Entry is handled in Inventory Control. The item
pricing features in version 5.4 of Inventory Control let you:
Specify whether the discount price of the item is based on weight or
on quantity.
If you specify weight for an item, Order Entry can use volume discount
amounts or percentages that are determined by item weight. The
weights are calculated in Order Entry by multiplying the unit weight of
an item times the quantity ordered, and converting the weight to
default units.
The weight unit of measure for orders is the Default Weight Unit of
Measure set in the I/C Options form in Inventory Control.
Note: Pricing by weight is available only in Sage ERP Accpac 500.
Price items by a single or multiple units of measure.
You can enter a base price for a single unit of measure or for multiple
units of measure. You can also enter sale prices for single or multiple
units of measure.
This means that the unit of measure is now used in Order Entry to
determine prices. (Previously, the way to do this was through volume
discounts or by creating a kit for the different unit of measure.)
Price items using a cost plus a percentage or a fixed amount.
For more information on pricing features, see the Inventory Control help.

Enhancements for Entering Orders
Order Entry has several new features that enhance the order entry
process. You can:
Enter the item numbers that your customers use on the Order Entry
form, as well as use your own item numbers and manufacturer’s item
numbers (such as bar codes). Customer item numbers remove
ambiguities on orders, and large customers will often use their own
item numbers when ordering goods. Customer item number are
defined in Inventory Control.
Automatically use the lowest price available to a customer, regardless
of the contract price.
You can choose whether to use the contract price or the lowest price
by changing the option in Inventory Control’s Contract Pricing form.
Make sure that you don’t sell items in inventory that aren’t for sale —
such as goods used for building projects or in bills of material.
You can uncheck the Sellable checkbox in the Items form in Inventory
Control if you do not want to sell the item through Order Entry.
Use new inventory pricing features, including pricing by weight,
pricing by multiple units of measure, and pricing based on current cost
plus a specified percentage or amount.
Pricing options are selected for each item in the Item Pricing form in
Inventory Control.
Default the inventory location based on the customer’s ship-to
location, so goods are shipped from the nearest warehouse. (Note
that if you price by cost, prices can also vary by location.)
You add the default locations for both the customer record and the
ship-to location in Accounts Receivable.
Let you view the components of multilevel bills of material (as well as
single level BOMs and kit components). Order Entry lets you click the
components button to pop up the list of components.

Enhanced Online Customer, Pricing, and Credit
Note Checks
Order Entry provides more online checking for customer credit ratings,
allowing you to also include pending (unposted) amounts in Accounts
Receivable, Order Entry, and other third-party applications. You change
the credit check settings for pending transactions on the Processing tab
of the A/R Options form.
You can set the credit limit balance for transactions in the individual
customer records in A/R, and you can also set an overdue amount and
number of days overdue in the A/R customer record.
You can have Order Entry check that item prices stay above a specified
cost or margin, and have the program post a warning message or an
error message or require approval before allowing the price to vary more
than a specified amount. (Price checks are set on the Price Check tab of
the Price List Codes form in Inventory Control.)
Order Entry can also trigger a warning or error condition if a credit note
has previously been posted for an invoice. You can set Order Entries
control over credit notes on the Processing tab of the O/E Options form.

Optional Fields in Finders
Optional fields now appear in Finders for Order Entry records, so you can
search for and select records using the entries in optional fields.

Required Optional Fields without Default Values
In version 5.3 of Sage ERP Accpac, you had to specify a default value for
any optional fields that were required in transaction forms or records.
This is no longer the case. Note, however, that you must make an entry
for all required fields before you can save records or post transactions.

Choosing Company Options
You keep and update most company information using the Company
Profile form in the Common Services folder. However, you can store the
name of an order entry contact person or position, and enter the
telephone and fax numbers you use in your Order Entry department on
the Company tab of the O/E Options form.
This page also displays the name and address entered for the company
in Common Services. To change the company name and address, use
the Company Profile form in Common Services.
The O/E Options form contains the tabs listed below. For information
about the options on a tab, click the name of the tab, then click the Field
List button in the online Help that appears.
Processing
Documents

See also
Choosing Order Entry Options

Choosing Document Options
Document Numbers
Each quote, order, shipment, invoice, and credit note in Order Entry must
have a unique number. You can specify quote, order, shipment, invoice,
and credit note numbers when you enter transactions, or you can use the
numbers generated automatically by the program.
You define the formats of document numbers assigned by Order Entry by
specifying the length of the number, the prefix you want to use, and the
number of the next document on the Documents tab in the O/E Options
form. The next number is increased by 1 each time you post a new
document.
Use your present numbering scheme
Maximum lengths of document numbers
Entering your own document numbers with transactions

Order Entry lets you:
Validate data input for optional fields
Transfer optional field information to Accounts Receivable

See also
Choosing Order Entry Options

Entering Ship-Via Codes
Ship-via codes identify the shipping methods or carriers you use to
deliver goods to customers (for example, courier, air mail, parcel post).
Use the Ship-Via Codes form to add ship-via records for your system. For each
shipping method, enter the name and address of the carrier and any
pertinent comments.
You can select one of the ship-via codes when you enter an order. Order
Entry then displays the ship-via description with the order information. If
you do not select a ship-via code, you can still type the shipping method
in the ship-via description field on the Customer tab of the Order Entry,
Shipment Entry, and Invoice Entry forms.
Also, if you choose a ship-to location for a customer when entering an
order (defined for the customer in Accounts Receivable), the program
displays the ship-via information entered for that location in the
description field.
If you use a default ship-via code in a customer record, or if you
designate a primary ship-to location for a customer in Accounts
Receivable, Order Entry displays the ship-via code from the customer
record or the ship-to location by default when you enter an order for that
customer.
Ship-via records are printed on the Ship-Via Codes report. You can edit
ship-via records as needed.
See also
Ship-Via Codes form
Steps for Setting Up Order Entry

Calculating Backorder Quantities Automatically
Order Entry can automatically calculate a backorder — the difference
between the quantity ordered and the quantity shipped — when you enter
an item on an order or invoice. The resulting figure is displayed in the
Quantity Backordered field in the Order Entry, Shipment Entry, and
Invoice Entry forms.
Any amount ordered but not shipped is considered to be a backorder,
whether you have the stock ready to send, or are out of it and waiting for
new stock to arrive.
If an order is entered with the Calculate Backorder Quantity option turned
off, the backorder quantities will not be calculated on the order and will be
zero if you don't manually enter them. Thus, when you click the Ship All
button in Shipment Entry, you will get no result since the shipment
quantity is determined based on the backorder quantity.

Selecting the option
To have the program automatically calculate and display the backorder
quantity when you enter an item on an order, select the Calculate
Backorder Quantities option on the Processing tab on the O/E Options
form.
If you do not select this option, the program displays zeroes in the
Quantity Backordered field, whether or not the quantity ordered is larger
than the quantity shipped.
In either case, you can change the entry in the Backordered field. The
option merely determines what appears initially in the field.

Reporting backordered quantities
The program reports backordered quantities on the Order List. You can
see the value of orders which have not been filled on the Order Action
and Aged Orders reports.
When you reduce amounts in the Backordered field without reducing the
amount ordered, or cancel an order that has quantities entered in the
Backordered field, the amounts are reported as lost sales on the Sales
Statistics report when the entire order is complete.
If you are unable to ship all items on an order, but do not wish the
unshipped quantities reported as lost sales, you can edit the item lines to
reduce the quantities ordered to match the quantities shipped.

Specifying the Default Order Unit of Measure
The O/E Setup form lets you specify the order unit of measure that
appears by default in Order Entry forms.
You can select either the stocking unit or the pricing unit as the default
order unit of measure. (Stocking units and pricing units are defined for
individual items in Inventory Control, and they may be different. For
example, you may use "dozen" as the stocking unit for an item, but
"each" as the pricing unit.)
The Order Unit Of Measure appears in the Order Entry, Shipment Entry,
Invoice Entry, and Credit/Debit Note Entry forms. You can accept the
Order Unit Of Measure displayed by default in these forms, or you can
choose a different one using the Finder.

Editing Sales Statistics
If you select the Allow Edit Of Statistics option in the O/E Options form,
you can:
Enter or revise year-to-date or previous-year data for orders, invoices,
and credit notes. (You might want to do this if you set up your Order
Entry system part way through a fiscal year.)
Edit statistics from posted transactions. Normally, you do not need to
revise statistics because they are updated automatically and
accurately each time you run day-end processing.
You can turn the Allow Edit Of Statistics option on or off at any time.

Using a Default Template
Data entry templates allow you to speed up and simplify the order entry
process by providing default settings which appear when you start a new
order or credit note.
You can use one of the templates you set up as the default template for
all new orders and credit notes. The default template should contain the
settings you use most frequently for orders and credit notes. For more
information about templates, see Setting up templates.

Choosing Commission Options
Order Entry can calculate commissions earned by salespersons using
the data from invoices and credit notes. You can print this information on
the Salesperson Commissions report.
Choose from options as follows if you want to calculate sales:
Specify whether to track commissions by sales or margin. If you
choose sales, Order Entry calculates commissions as a percentage of
the sales amount. If you choose margin, the calculation is based on
the margin amount. You make this choice on the Processing tab in the
O/E Options form in Order Entry.
Use the rates set for the item categories in Inventory Control or
use the commission rates set for the salespeople in Accounts
Receivable. This is not a choice on the Options form. Order Entry
uses the rate specified in the item category record in Inventory
Control unless the rate is 0.00 — in which case, it will use the
salesperson's rates defined in Accounts Receivable.

Setting up commissions
You must set up your system as follows to calculate commissions on
sales of inventory items:
Select the Track Commissions option on the Processing tab of the
O/E Options form. You must also specify the method for calculating
commissions (Sales or Margin).
In Accounts Receivable, select the Paid Commissions option on the
Salespersons form for each salesperson who is paid commissions.
Select the Allow Commissions option for each item category that
accrues commission (in the Categories form in Inventory Control).
See the Inventory Control help for instructions for entering
commission rates for categories.
Assign commission percentages to the item categories in Inventory
Control and/or to the salesperson (in the Salesperson form) in
Accounts Receivable.

Assigning commission rates to categories
Each item category in Inventory Control can have a single commission
rate. If you want to use a different rate, you can change the category for
any item when you add it to an order.

Assigning salesperson commission rates
If you use the commission rate structure defined in Accounts Receivable,
you can use up to five rates for each salesperson, with each rate
applying to a different range of sales amounts (such as to the first
$5,000, the next $5,000, and so on).
See also
Calculating commissions

Quote Expiration Date
This field appears if you select Quote as the order type. Type the date on
which the quote expires. Order Entry displays a default expiration date
based on the number of days you specified on the O/E Options form.
Note: If you do not change the quote to an order before the expiration
date, Order Entry automatically removes the quote when you run Day
End Processing. If you selected the option to Clear Expired Quotes and
specified a number of days on the O/E Options form, Order Entry deletes
the expired quote from the system the next time you run Day End
Processing after the specified delay. If you do not select this option,
expired quotes will not be deleted.

Clear Expired Quotes
Select this option if you want to specify a number of days after which
expired quotes will be deleted from the system. Order Entry deletes
expired quotes from the system when you run Day End Processing.
If you do not select this option, expired quotes will not be deleted.

Allow Non-Existent Customers
If you select this option, you can post orders for customers for whom you
have not set up a record in Accounts Receivable.
Note: Selecting this option will not enable you to ship an order for a nonexistent customer if you have activated Sage ERP Accpac integration
with SageCRM and the order is linked to a SageCRM opportunity. Before
you can ship an order that is linked to a SageCRM opportunity, you must
open SageCRM and promote the customer to Accounts Receivable.
If you do not select the option, Order Entry prevents you from entering an
order, a shipment, or an invoice for a customer for whom no record exists
in Accounts Receivable.
Regardless of your choice, you will not be able to post an invoice in
Accounts Receivable until you add the customer to your Accounts
Receivable system.
Note: We suggest that you do not use this option in a multicurrency
system, especially if the reporting currencies for customer tax groups do
not match your customers' currencies.

Aging of Orders
Order Entry supplies default aging periods for grouping outstanding
orders on the Aged Orders report.
Orders are aged into four periods, a current period and three aging
periods. For example, you can set the aging periods to 7, 14, and 21
days to see how many orders are filled within one, two, three, or more
weeks of the current period.

Changing the default settings
To change the default aging settings, type over the numbers on the
Processing tab on the O/E Options form.
When you are ready to print the Aged Orders report, you can change the
periods without changing the default settings. The program compares the
Aged As Of date on the report to the order date, to determine the aging
category to which the order belongs.

Order Types
The type of order you are entering determines how the order is
processed.
. An active order is an order that you expect to fill in a normal
period of time. An active order may also contain items on backorder, or
be on hold. If the order is not on hold, you can post and print an invoice
for shipped goods.
Active Orders

. A future order is an order to be filled on the future date you
specify. When you run Day End Processing on that date, the order is
automatically activated and posted.
Future Orders

. A standing order is an order that is filled regularly for the
same customer, or for different customers.
Standing Orders

. A quote is an order with an expiration date. When you run Day End
Processing on that date, the quote is removed from the system. If a quote
is accepted by the customer before the expiration date, you can change
the order type to Active to save you re-entering the order details.
Quotes

Optional Entries for Templates
In a template, you can choose whether to enter a default FOB point,
location, description, reference, comment, ship-via code, price list,
territory, and terms. You can change any of these entries for individual
orders.
FOB point — An FOB (free on board) point is the location at which
the customer begins paying freight charges on the order. The order is
shipped as far as the FOB point at no cost to the customer.
Location — Location identifies the warehouse or other place from
which inventory items are usually shipped to fill the order. Location
codes are defined in Inventory Control.
Description, Reference, and Comment — The information you type
in these fields applies to the entire order. You can print this
information on order confirmations, picking slips, and invoices.
Price list — Price lists allow you to vary your basic item prices. For
example, you can set up price lists that calculate sale prices, give
volume discounts, or assign different regional prices for items. Price
list codes are defined in Inventory Control.
Tax group — Tax groups are always overridden by the tax group
specified in the customer record. This tax group will only be used for
an order or shipment if you have not yet added the customer record.
See also
Setting Up Templates

E-mail Message Symbols
You can use the following symbols (variable names) in e-mail messages
that you create to send with e-mailed documents. When you e-mail a
quote, order, invoice, or credit note, the program substitutes the
information from your database for each customer.
Order Confirmation (OE1200)
$CUSTOMER_NUMBER
$CUSTOMER_NAME
$CUSTOMER_CONTACT
$COMPANY_NAME
$COMPANY_CONTACT
$COMPANY_PHONE
$COMPANY_FAX
$ORDER_NUMBER
$ORDER_DATE
$ORDER_AMOUNT
$ORDER_DESCRIPTION
$ORDER_REFERENCE
$PO_NUMBER
$EXPECTED_SHIP_DATE
$SHIP_VIA_DESCRIPTION
$SHIP_VIA
Invoices (OE1400)
$CUSTOMER_NUMBER
$CUSTOMER_NAME
$CUSTOMER_CONTACT
$COMPANY_NAME
$COMPANY_CONTACT
$COMPANY_PHONE
$COMPANY_FAX
$ORDER_NUMBER
$INVOICE_NUMBER
$ORDER_DATE
$INVOICE_DATE
$INVOICE_AMOUNT

$DESCRIPTION
$REFERENCE
$PO_NUMBER
$ACTUAL_SHIP_DATE
$SHIP_VIA_DESCRIPTION
$SHIP_VIA
Credit Notes (OE1700)
$CUSTOMER_NUMBER
$CUSTOMER_NAME
$CUSTOMER_CONTACT
$COMPANY_NAME
$COMPANY_CONTACT
$COMPANY_PHONE
$COMPANY_FAX
$INVOICE_NUMBER
$CREDIT_NOTE_NUMBER
$INVOICE_DATE
$CREDIT_NOTE_DATE
$CREDIT_NOTE_AMOUNT
$DESCRIPTION
$REFERENCE
$PO_NUMBER
$ACTUAL_RETURN_DATE
Quotes (OE2000)
$CUSTOMER_NUMBER
$CUSTOMER_NAME
$CUSTOMER_CONTACT
$COMPANY_NAME
$COMPANY_CONTACT
$COMPANY_PHONE
$COMPANY_FAX
$ORDER_NUMBER
$ORDER_DATE
$EXPIRATION_DATE
$ORDER_AMOUNT
$ORDER_DESCRIPTION

$ORDER_REFERENCE
$PO_NUMBER
$EXPECTED_SHIP_DATE
$SHIP_VIA_DESCRIPTION
$SHIP_VIA

Customer Number
If you select a customer number from Accounts Receivable, Order Entry
displays the customer type, price list, territory, tax group, terms, and
salesperson split from the customer record. In multicurrency ledgers, it
also displays the customer's currency.
On-hold customer. If the customer account is on hold in Accounts
Receivable, a message warns you that the order will be placed on hold.
You need to remove the hold in Accounts Receivable before you can ship
goods and produce the invoice in Order Entry.
Inactive customer or account set. If the customer account or account
set is inactive, you cannot enter an order for the customer.
Adding a customer
If you want to add a new customer, you can do it in one of two ways:
Adding a new customer record in Accounts Receivable. You can
type the customer number and click the New button, then enter the
customer information “on the fly” in Accounts Receivable before
returning to Order Entry to finish entering the order.
Adding only a customer number and name in Order Entry. You
can also type a customer number and name in Order Entry, and enter
the remaining customer information later in Accounts Receivable.

Posting Orders
After you have finished entering all the details for an order, you post the
order.

Exceeding a Credit Limit
If the order will put the customer account over its credit limit, the program
displays a warning message and the following customer information:
Credit limit
Outstanding Accounts Receivable balance
Order amount
Last invoice amount and date
Last payment amount and date

Approving Credit
If you are using security, someone authorized to approve credit must
enter their user ID and password before you can continue invoicing.
If you are not authorized to override the credit limit, or if you want to put
the order on hold for later invoicing, select On Hold. If the order is on
hold, you can post the order, but you cannot produce an invoice for it until
you remove the On Hold designation.

Posting Orders To Non-existent Customers
If this option is turned on, Order Entry allows you to post orders and
invoices to non-existent customers.
If the option is turned off, Order Entry prohibits the entry of the order or
invoice.

Posting an Order without Creating an Invoice
The quantity ordered and the quantity backordered are updated for
each item. (The quantity ordered but unshipped appears as the
Backordered quantity if you select the Calculate Backorder Quantities

option.)
The quantity on sales order (in Inventory Control) is increased for
each item on the order.
You can print an order confirmation and picking slips, as described in
the next section. (You can print the order confirmation immediately
after posting the order.)

Posting an Order and Creating an Invoice
The quantity on hand (in Inventory Control) is reduced for each item
that is shipped from the order.
The status of a line item is changed to Completed in the Order Entry
form if the ordered quantity has been:
Fully shipped and invoiced, or
Partially shipped and invoiced, and you have set the backorder
quantity to zero. The amount shown on order becomes a lost sale.
The quantity ordered, the quantity backordered, and the quantity
shipped to date are updated for the order (if you display it on the
Order Entry form or print it on the Order List). Order Entry calculates
the backordered quantity only if you select the Calculate Backorder
Quantities option.
You can print an invoice immediately after posting the order.

Additional Tasks During Posting or Day End
Processing
Depending on when you cost inventory in I/C, posting may also:
Update item costs in Inventory Control.
Update sales statistics.
Create audit records or general ledger transactions.
If you cost inventory at day end, you must run Day End Processing in Inventory
Control to do the above tasks.
See also

Posting invoices
Posting Shipments
Verifying order totals

Verifying Shipment Totals
Use the Totals tab on the Shipment Entry form to verify totals (including
prepayment, tax, and discount information).
The shipment information that appears on the Totals tab includes:
Estimated weight for the total order or shipment (using the unit weight
for items in Inventory Control).
Number of detail lines on the shipment.
Subtotals of all items and miscellaneous charges on the order,
shipment, or invoice.
Amount due, calculated as follows:
Shipment subtotal (shipped items + misc. charges)
-

Shipment discount

+

(Tax (if it is not included in item prices or charges)

If item prices include taxes, Order Entry displays the tax amounts. It
does not affect the calculation of the total.
If you need to edit the customer's tax classes, you can do so on the
Taxes tab. If you need to edit payment terms, use the Customer tab.
For instructions, see Change tax information and Change payment terms.
You can enter the following information on the Totals tab:
Indicate whether to create an invoice when you post the shipment. If
you select the option, you can enter an invoice number, or, if you use
automatic numbering, the program assigns the next sequential invoice
number when you post the invoice.
Number of shipping labels for the shipment. This number controls the
number of labels you can print when you print shipping labels for a range of
shipments. For example, if you need five labels to ship the ordered
items, specify “5” in this field.
Whether shipping discounts also apply to miscellaneous charges (in
addition to shipped items).

Shpping discount percentage or fixed amount. This is a discount for a
volume purchase, for example, and not an early payment discount. If
you enter a discount, it is prorated to all the items on the shipment. If
you discount miscellaneous charges as well, the discount is also
prorated for the miscellaneous charges.
Any comment, using up to 250 characters, that you wish to include on
the shipment.
See also
Posting invoices
Verifying order totals
Verifying invoice Totals

Quotes
Quotes do not affect quantities on sales orders until you make them
active.
Changing quotes to orders. When you enter a quote, you enter the
date on which the quote expires. Order Entry displays a default expiration
date based on the number of days you specified on the O/E Options
form.
To change the quote to an order, call up the quote by its order number,
change the order type to Active, edit the detail information as required,
check tax statuses and order totals, and then post the order.
Note: If you do not change the quote to an order before the expiration
date, Order Entry automatically removes the quote when you run Day
End Processing. If you selected the option to Clear Expired Quotes and
specified a number of days on the O/E Options form, Order Entry deletes
the expired quote from the system the next time you run Day End
Processing after the specified delay. If you do not select the option to
Clear Expired Quotes, expired quotes will not be deleted.
Reusing quotes. To reuse a quote that you have previously converted to
an order, add a new order for the customer using the Create Order From
Multiple Quotes option.

Allow Serial and Lot Number Allocation for
Quantity Ordered
Before you start

To display the Serial/Lot Numbers Allocation and Generation forms
from the Qty Ordered field:
1.Open Inventory Control > I/C Setup > Options.
2.On the Serials tab, select Use The Qty Ordered Field In OE For The
Allocation Of Serial Numbers.
3.On the Lots tab, select Use The Qty Ordered Field In OE For The
Allocation Of Lot Numbers.
4.Click Save.
Related topics

Ship All button
Click the Ship All button to ship all of the quantities listed as backordered.
Note that the Ship All button uses the Backorder Quantities to determine
the number to enter in the Quantity Shipped fields. This means that the
Ship All button will not work properly if you do not enter backordered
amounts or use the option to calculate backordered quantities
automatically.

Discount Percentage
You can specify a separate discount percentage or amount for each
detail on an order, shipment, invoice, credit note, or debit note.
If you override the discount percentage in the amount field, Order Entry
displays an asterisk beside the field in the popup detail entry form to
show that the amount was overridden.
You can still enter a discount for the whole document, if you like. Order
Entry displays the discount amount for the transaction details, as well as
the discount for the whole document, on the Totals tab summary.

Shipment Number
Order Entry displays the shipment number for each detail, indicating the
source of the detail, if you are invoicing more than one shipment.
You can click the drilldown button to view all the details for the shipment.

Item/Taxes Form Field List (Order)
Amount (Misc. Charge)
Backordered quantity (B/O)
Category
Comments/Instructions
Completed
Customer Item Number
Description
Discount %
Discount Amount
Discounted Ext. Amount
Expected Ship Date
Extended Weight

(display only)

(display only)

Extended Price
Item Number
Line Type (item or miscellaneous charge)
Location
Miscellaneous Charge Code
Optional Fields

(display only)
Order Total (display only)
Original Order

Price Approval
Price By
Price List
Pricing UOM
Quantity Committed
Quantity Ordered
Quantity Shipped
Shipped To Date ( drill down)
Ship Via
Tracking Number
Unit Cost
Unit Order of Measure (UOM)
Unit Price
Unit Weight
UOM (unit of measure)
Weight UOM (unit of measure)

Tax grid
Tax Authority and Description
Tax Amount
Tax Base
Tax Class and Class Description
Tax Included

Calculate Tax
Order Entry lets you specify on individual orders and invoices whether
taxes should be calculated automatically by Order Entry or entered
manually.
If you want the program to calculate tax automatically for the
order/invoice, select the Calculate Tax option.
If you want to enter tax amounts manually, do not select this option.
If the order is job-related and you select the Project Invoicing option, you
cannot enter taxes manually. The Calculate Tax option is automatically
selected, and you cannot change it.

Customer Bill-To Address Field List (Orders)
Click the following links for information about fields in this form.
Address
Bill-To Name
Contact
Customer Number (display only)
E-mail/Contact E-mail
Phone Number and Fax Number

Customer Ship-To Address Field List
Address
Contact Information
Customer Number (display only)
Phone Number, Fax Number, and E-mail Address
Ship-To Location (display only)
Ship-To Name

Pre-authorization Form Field List
Click the following links for information about fields on this form.
Amount Due
Bank Code
Currency
Order Total
Payment Code
Pre-authorization Amount
Processing Code

Customer Bill-To Address Field List (Credit/Debit
Notes)
Click the following links for information about fields in this form.
Address
Bill-To Name
Contact Information
Customer Number (display only)
Phone Number, Fax Number, and E-mail Address

Credit/Debit Notes Items/Taxes Form
You can use this form to enter information for individual details on the
credit note or debit note. The form displays all the information for a detail
in separate window, so that you don't have to use the scroll bar.
The Items/Taxes form also lets you change tax classes and tax statuses
for a detail, if the authority permits it.
To open or close the Items/Taxes form, select a detail on the Credit
Note tab, then press F9 or click the Item/Tax button.
Click these buttons for more help:

Finder

New

Drill Down

or
Shift+
Zoom

Drop-Down
Lists

To add or edit details on the Items/Taxes form
1.To start a new detail line, click the New button next to the Line
Number field. To open an existing detail for editing, type its line
number or use the navigation buttons beside the Line Number field to
display the line you want.
2.Type the information or changes for the detail, then click Add or Save.
To delete details on the Items/Taxes form
1.To open an existing detail you want to delete, type its line number or
use the navigation buttons beside the Line Number field to display the
detail you want to edit.
2.Click Delete.
See also
Credit/Debit Note Entry — overview

Zoom or
Click the Zoom button ( ) or press F9 to open a detail form associated
with particular data entry fields, such as customer bill-to and ship-to
addresses, and item serial numbers or shipping instructions.
The detail form that opens allows you to view or edit existing details or
add new details. You then click the F9 key to close the detail form.
When you're in a detail form that also has a Zoom button beside a field,
you must press Shift + F9 to see another detail form specifically for that
field; if you simply press F9 again, the detail form closes. (This function is
referred to as Detail Zoom; you again press Shift + F9 to close the
second detail form.)

History button
Click the History button in the Order Entry, Shipment Entry, Credit
Note/Debit Note Entry, and Invoice Entry forms to check the sales history
for an item or a customer while entering an order or invoice.

Qty. (Quantity) Shipped
This is the quantity of goods that you are shipping for this detail line.
If you calculate backorders automatically, the program will change the
backordered quantity when you enter a quantity shipped.
If you click the Ship All button, the program will entered the backordered
quantity in this field.
You can change the quantity shipped until you have fully invoiced the
shipped quantities for the shipment detail.
If you use Serialized Inventory and Lot Tracking, when you enter a
quantity shipped for a serialized or lotted item, and then leave the Qty.
Shipped field, the Serial/Lot Numbers Allocation form appears. You use
the form to allocate or edit serial numbers and/or lot numbers for the item
detail. You must fully allocate serial and lot numbers before you can save
the detail.

Prepayments Field List
Amount Due
Bank Code
Bank Currency (display only — multicurrency ledgers)
Bank Rate (multicurrency ledgers only)
Batch Date
Batch Number
Check/Receipt Number
Currency (multicurrency ledgers only)
Deposit Number
Deposit Slip Printed (display only)
Description
Discount Available (display only)
Jobs button
Order Total
Payment Code
Processing Code
Rate Date (multicurrency ledgers only)
Rate Type (multicurrency ledgers only)
Receipt Amount
Receipt Date
Shipment Total

Customer Bill-To Address Field List (Shipments)
Click the following links for information about fields in this form.
Address
Bill-To Name
Contact
Customer Number (display only)
E-mail/Contact E-mail
Phone Number and Fax Number

Customer Ship-To Address Field List
Address
Contact Information
Customer Number (display only)
Phone Number, Fax Number, and E-mail
Ship-To Location (display only)
Ship-To Name

Item/Taxes Form Field List (Shipment)
Amount (Misc. Charge)
B/O (Quantity Backordered)
Category
Comments/Instructions
Completes Order (detail)
Customer Item No.
Description
Disc. Amt. (Discount Amount)
Discount %
Discounted Ext. Amount
Exp. Ship Date
Extended Price
Extended Weight
Item Number
Line Type (item or miscellaneous charge)
Location
Optional Fields
Order Number
Price Approval ( - beside Unit Price)
Price List
Qty. B/O (Quantity Backordered)
Qty. Committed
Qty. On Order
Qty. Shipped
Ship Date
Ship Via
Shipped To Date
Tracking No.
Unit Cost
Unit Order of Measure (UOM)
Unit Price
Unit Weight
UOM (Unit Order of Measure)
Weight UOM (unit of measure)

Tax grid
You can change the tax class for individual details, and you can enter the
tax base and tax amounts if you do not select the Calculate Tax option on
the Shipment tab.
Tax Authority
Tax Amount
Tax Base
Tax Class and Class Description
Tax Included

Item location status for the current detail
This region displays item quantities for the current line item — for the
selected shipping location and for all locations.
Quantity Available Stocking UOM

Quantity On Hand
Quantity On Purchase Order
Quantity On Sales Order

Calculate Tax
Order Entry lets you specify on individual shipments whether taxes
should be calculated automatically by Order Entry or entered manually.
If you want the program to calculate tax automatically for the invoice,
select the Calculate Tax option.
If you do not select the Calculate Tax check box:
You can enter tax amounts for the tax authorities listed for the
shipment.
Order Entry displays a Distribute Taxes button.
Click the Distribute Taxes button to prorate the tax that you enter
manually on the Taxes tab to the document details.
Note: You cannot prorate a tax amount to an authority that uses an
exempt tax class.
If the shipment is job-related and you select the Project Invoicing option,
all tax calculation is automatic. You cannot change the Calculate Tax
option.

Shipped to Date
The quantity shipped from the shipment document appears as the default
in this field (found in the Item/Tax form).
You cannot change the quantity shipped on the invoice.

Calculate Tax Reporting
The Calculate Tax Reporting checkbox appears only if a tax authority for
the transaction has a tax reporting currency that is different from the
source or functional currency.
Select this option if you want the program to automatically calculate tax
reporting amounts for the invoice.
You can edit the tax reporting amount if you leave the option unselected.
The default for this checkbox is set by the Calculate Tax Reporting
Amounts Automatically option in the O/E Options form.
Sage ERP Accpac calculates the amount in the tax reporting currency by
applying the exchange rate between the source currency and the tax
reporting currency.

Value Set
The Value Set column shows whether a blank optional field currently has
a value. (By looking at the field, you cannot know otherwise whether the
field has a default value which is blank, or no value at all.)
The Value Set field will change from No to Yes if you make an entry in the
Value field.

Customer Payment Schedule
Payment terms can be as simple as a due date and a discount date and
rate, or they can include payment schedules to allow for several
installment payments.
Payment schedules appear on the Customer tab of the Invoice Entry
form when you use a terms code that has been set up to use a multiple
payment schedule.
All payment terms are defined in Accounts Receivable, but you can
change the terms for an order or an invoice on the Customer tab of the
Invoice Entry form.

Customer Bill-To Address Field List (Invoices)
Click the following links for information about fields in this form.
Address
Bill-To Name
Contact Information
Customer Number (display only)
E-mail/Contact E-mail
Phone Number and Fax Number

Customer Ship-To Address Field List
Address
Contact Information
Customer Number (display only)
Phone Number, Fax Number, and E-mail Address
Ship-To Location (display only)
Ship-To Name

Item/Taxes Form Field List (Invoice)
Amount (Misc. Charge)
Category
Comments/Instructions
Customer Item No.
Description
Disc. Amt. (Discount Amount)
Discountable
Discount %
Discounted Ext. Amount
Ext. (Extended) Price
Ext. (Extended) Weight

(display only)

(display only)

Item Number
Line Number
Line Type (item or miscellaneous charge)
Location
Miscellaneous Charge
Optional Fields
Price Approval ( beside Unit Price)
Price By
Price List
Pricing UOM
Qty. Available
Qty. B/O (Quantity Backordered)
Qty. Committed
Qty. Invoiced
Qty. on Hand
Qty. on Purchase Order
Qty. on Sales Order
Qty. on Order (customer order)
Ship Date
Shipment No.
Shipped To Date
Ship Via
Tracking Number
Unit Order of Measure (UOM)
Unit Price
Unit Weight
Weight UOM

Tax grid
Tax Authority
Tax Amount
Tax Base
Tax Class and Class Description
Tax Included

Calculate Tax
Order Entry lets you specify on individual invoices whether taxes should
be calculated automatically by Order Entry or entered manually.
If want the program to calculate tax automatically for the invoice, select
the Calculate Tax option.
If you want to enter tax amounts manually, do not select this option.

Posting Shipments
After you have finished entering all the details for a shipment, you can
post it.
Note the following:
Posting updates quantities — when you post a shipment in Order
Entry, the quantities on sales order and on hand in Inventory Control are
immediately reduced for the items on the shipment.
Depending on the costing options that you choose in the Inventory
Control program, posting may also update inventory costing information.
Posting, however, does not immediately update accounting or statistical
information.
Shipment date — the shipment date is the date on which you ship the
order. You enter it in the Shipment Date field on the Shipment tab. The
shipment date is used to calculate the average days between shipments
on the Item Status report in Inventory Control.
Posting Date — the posting date is the transaction date used by Day
End Processing in Inventory Control when it creates journal entries for
the general ledger. The posting date determines the fiscal year and
period to which transactions are posted in the G/L.
See also
Posting orders
Posting invoices
Verifying invoice totals

Invoice or Credit/Debit Note Currency (customer
and functional)
Displays the value of the invoice, credit note, or debit note in the
customer's currency and the company's functional currency.

Periods for Accumulating Sales History and
Sales Statistics
If you keep sales history and statistics, you must decide how you want to
group the data. In Order Entry, you can accumulate data:
By fiscal year or by calendar year.
Using almost any reporting period.
Note: In the Small Business Edition, you can only accumulate statistics
by fiscal year and period.
Fiscal year or calendar year — Use the Accumulate By option to
specify the dates to include in each period. You can choose whether to
use calendar dates or fiscal year dates. If you keep sales statistics by
calendar year, the first period begins with January 1. If you keep statistics
by fiscal year, the first period begins on the first date in your company's
fiscal year.
Period length — Use the Period Type option to choose the periods by
which sales history and statistics are totaled and reported. You can
display statistical totals by seven-day periods, weekly, bi-weekly, fourweek periods, monthly, bi-monthly (two months at a time), quarterly,
semi-annually, or the periods in your company's fiscal calendar.
Weekly periods run from Sunday to Saturday. This means that the first
and last periods in a year will likely be short ones (because your year
may not start at the beginning of the week).
Changing the method of reporting history and statistics — You can
change the type of year and period by which Order Entry reports sales
history and sales statistics, but such changes can distort the figures in
past periods.
If you need to change the type of year or period by which Order Entry
reports sales history or statistics, you will find it easier to do so after yearend. However, if you do change the reporting period during the year, you
can edit the statistics for the earlier periods in the year to correct
distortions.

Batches Created in Accounts Receivable
The Accounts Receivable batch of invoices and credit notes created from
posted Order Entry transactions contain summary details only.
To print the batch, use the Accounts Receivable Invoice Batch Listing
form. The batch date is the Posting or Day End Processing date, the
batch description is O/E Invoices/Credit Notes, the batch type is
Imported, the batch status is Ready To Post, and the detail type is
Summary.
If you selected the Accounts Receivable option to Allow Edit Of Imported
Batches, you can open and edit the batch (other than customer number,
document type, and document number) before you post it.
Order Entry also provides an option to automatically Post A/R Batches during
posting or Day End Processing (depending on when you cost inventory in
I/C) or when you choose, using the Create Batch icon in Order Entry.
(You can also post the batch in the Accounts Receivable program.)
When you post the invoice batch, Accounts Receivable makes sure there
are no duplicate invoice or credit note numbers. If duplicate numbers
exist, they are placed in an error batch.

Add customers before posting
You can add orders and credit notes for customers in Order Entry, before
you add the customer records to Accounts Receivable. Note, however,
that you cannot post the invoices in Accounts Receivable until you add
the customers.
Also, if you add these customers later, make sure you use the same
customer number that you used on the order or credit note.

Year and Period
When you view sales history for a customer number, these fields display
the year (fiscal or calendar) and period in which the customer purchased
items from your company. (Information is displayed by the type of year
and period you specify on the Options form for the Keep Sales History
option.)
When you view sales history for an item number, these fields display the
year and period in which customers purchased the item.

Calculating Commissions
Order Entry calculates commission amounts on invoices and credit notes
during Day End Processing, and adds them to the commissions already
accumulated for salespeople.
To calculate the commission, Order Entry checks:
That the salesperson earns commissions.
That the item is commissionable.
Whether the item's category has a rate. If not, Order Entry uses the
salesperson's rates.
Whether the commission is paid on the sales amount or the margin.
Commissions are earned on invoiced sales amounts or on margin
amounts. If commissions are calculated on margin, the program uses
cost figures in Inventory Control to determine the commission earned.
Commission periods. Order Entry accumulates commission information
until you clear the Salesperson Commission Report. In other words, the
commission period is the length of time between clearing reports. The
last report you print before clearing data (using the Clear History form)
contains the commission amounts due salespeople for the period.
Turning off commission tracking. You can turn the Track Commissions
option on or off at any time. If you turn off the option after you have used
it, Order Entry immediately stops calculating sales commissions,
although it retains those already collected until you clear them using the
Clear History form.
If you turn on the option again, there will be a gap in the collected
information corresponding to the period when the option was not used.
See also
Choosing commission options

Qty. B/O (Quantity Backordered)
In the zoomed form, this field is called “B/O.”
Enter the quantity backordered (if the program does not automatically
calculate the quantity and you are not shipping the entire order) or leave
the field showing zero, if you do not use backorder quantities.
If you select the Calculate Backorder Quantities option, the program
automatically calculates the Backordered amount (if the customer record
in Accounts Receivable allows backordered quantities).
Each time you enter a shipped amount, the backordered quantity is
reduced. When the backordered amount is zero, the item is considered to
be fully shipped. To cancel unshipped quantities of an order, change the
Backordered entry to zero.

Category
The program displays the category assigned to the item record in
Inventory Control. You can select a different category for the detail line
from the list displayed by the Finder.

Comments/Instructions
You can print comments and instructions on order confirmations, picking
slips, invoices, and credit notes.

To add comments to an order
1.Click the Totals tab
2.Enter comments in the Comment field
3.Click Post to save.

To add comments or instructions to a detail on
the detail-entry grid
1.On the Order tab, click the detail line.
2.Click the zoom button ( ) in the Comments column header to open
the Comments/Instructions popup form (or (or click in the column, and
then press Control + Shift F9).
3.Select Comment or Instruction in the Type field.
4.Type the comment or instruction, using up to 250 characters per line.
Press Tab or Enter to start new lines.

To add comments or instructions to a detail
using the Items/Taxes form
1.With the detail selected in the Items/Taxes form, click the zoom button
( ) in the Comments/Instructions field.
2.Select Comment or Instruction in the Type field.
3.Type the comment or instruction, using up to 250 characters per line.
Press Tab or Enter to start new lines.

Description (item or charge)
The program displays the description from the item price list or
miscellaneous-charge record for the item number or miscellaneous
charge code you specified. This description appears on printed order
confirmations, picking slips, and invoices.
You can type a new description for an individual order, if you wish.
In a multicurrency system, the program will display the description from
the item record if the price list does not include a price in the customer’s
currency.

Discount Amount
You can specify a discount percentage or amount for each detail on an
order, shipment, invoice, credit note, or debit note.
If you override the discount percentage in the amount field, Order Entry
displays an asterisk beside the field in the popup detail entry form to
show that the amount was overridden.
You can still enter a discount for the whole document, if you like. Order
Entry displays the discount amount for the transaction details, as well as
the discount for the whole document, on the Totals tab summary.

Disc. Ext Price (display only)
This field displays the amount for the detail after the discount is applied.

Expected Ship Date (item)
If necessary, type the date you expect to ship the items ordered on the
detail line.
The program displays the date you typed in the Expected Ship Date field
on the first tab of the Order Entry, Shipment Entry, or Copy Orders form
(depending on the type of document you are entering).

Extended Weight
The quantity shipped multiplied by the unit weight entered for the item in
Inventory Control.
You can edit the item weight and the extended on the order, if necessary.
You may want to use the extended weight for determining the postage,
shipping, or other charges.
Order Entry converts the extended weight for each line to the order
weight UOM, and puts the estimated weight for the entire order on the
Totals tab.

Extended Price
Type the extended price for the detail line, if you wish. The program
automatically calculates the extended price when you enter an order
quantity. To calculate the extended price, the program divides the unit
price by the pricing unit of measure conversion factor, and then multiplies
the result by the order unit of measure conversion factor and the quantity
ordered.
If you override the extended price calculated by the program, an asterisk
appears beside it in the “zoomed” detail entry form and also appears
beside the item on the Invoice List.
If you change the extended price, the program does not recalculate the
unit price.

Location (for item)
If necessary, type the code for the physical location from which you will
ship the items ordered on the detail line, or use the Finder to select the
location. (The program displays an error message if you specify a logical
inventory location instead of a physical location. Logical locations are
used mainly for transferring goods between physical locations in the
Inventory Control program.)
The program displays the location code specified in the order header as
the default, but you can change the location for individual details.
You can use the Location Finder on a selected detail line to display
quantities for other locations.
Note: You cannot change the location for a serialized or lotted item after
you enter a quantity in the Quantity Ordered field.

Misc. (Miscellaneous) Charge Code
Type the code for the miscellaneous charge or choose it from the Finder.
Once you add the detail line, you cannot change its miscellaneouscharge code.

Original Order (display only)
Displays the quantity specified when the detail line was first entered and
posted. This number does not change even if you change the ordered
quantity for the detail.

Order Total
To calculate the total value of a detail line, the program divides the unit
price by the pricing unit of measure conversion factor, then multiplies the
result by the order unit of measure conversion factor and the quantity
ordered.
The total value of a detail line is not the value of the quantity shipped.
The cost of the shipment (which will appear on the invoice) is calculated
in the Extended Price column.

Quantity Committed
Order Entry lets you specify an inventory quantity that is committed to a
particular order. When it is time to ship the order, the quantity is
guaranteed to be available, unless you allow negative inventory
quantities.
If a quantity is already committed to an order, you can ship another order
for the same items only if there is a sufficient quantity in inventory in
addition to the committed quantity.

Quantity Ordered
For each item detail, type the number of units of the item the customer is
ordering.
Make sure the number of units is consistent with the unit of measure you
chose for the detail.
If the item is serialized or lotted and if Inventory Control allows you to
allocate serial numbers or lot numbers to order quantities, a separate
Serial/Lot Numbers Allocation form appears after you enter the quantity
ordered and leave the field. You use the form to allocate serial numbers
or lot numbers for the quantity of items ordered.

Qty. (Quantity) Shipped
If applicable, type the quantity shipped or to be shipped on an active
order.
If the item is serialized or lotted and you did not allocate serial numbers
or lot numbers to the quantity ordered, a separate Serial/Lot Numbers
Allocation form appears after you enter the quantity shipped and leave
the field. You use the form to allocate serial numbers or lot numbers for
the quantity of items ordered.
If Inventory Control uses the option to allocate serial or lot numbers using
the Qty. Ordered field, you can ship only the serial and lot numbers
already allocated from the Qty. Ordered field. (In this case, the Serial/Lot
Numbers Allocation form does not let you allocate numbers using the
Qty. Shipped field.)

Shipped To Date (drill down)
The field displays the number of item units that have been posted for the
detail line.
Click the drilldown button to display shipment and invoice information for
the detail line, and to drill down to the shipment and invoice transactions.

Ship Via (detail)
Order Entry lets you specify a separate ship via method for each detail on
an order, shipment, or invoice.
This feature lets you group on one picking slip items that will be shipped
together.

Tracking Number (detail)
Order entry lets you enter a separate tracking number (waybill number)
for each detail, so that you can keep track of shipments that use different
carriers or that were shipped at different times.

Order UOM (unit of measure)
This is the unit of measure in which you are shipping item quantities for
the detail. The program displays the default order unit of measure
specified on the Processing tab on the Options form.
The default order unit of measure may be either the stocking unit or the
pricing unit. Stocking units and pricing units are defined for individual
items in Inventory Control, and they may be different. For example, you
may use "dozen" as the stocking unit for an item, but "each" as the
pricing unit.
In Sage ERP Accpac 500, you can define multiple pricing units of order. If
the Order UOM does not match a defined pricing UOM, Order Entry uses
the default pricing unit of measure set in the Item Pricing form in
Inventory Control.
You can change the Order Unit Of Measure by typing the name or
choosing it from the Finder. You must specify a unit of measure that is
assigned to the item record in Inventory Control.
Make sure the number of units you specify for the detail is expressed in
the unit of measure you choose.
Job-Related Orders and Shipments
If you are entering job-related orders or shipments where:
The Default Order UOM = Pricing Unit (set in the O/E Options form).
and
The Default Billing Rate = Billing Rate (set for the project in the
Project and Job Costing program).
Order Entry defaults the unit of measure from the current price list, and
then re-calculates the unit price based on the billing rate specified in PJC
Contract Maintenance.
Note that you can use different units of measure in the Inventory Control
Price List and in Contract Maintenance.

Unit Price
You can change this field only if you have Unit Price Override security
authorization.
If necessary, type the price for the item, per pricing unit.
The program displays the lowest price for which the customer is eligible.
It can be the base price, a sale price for a specified time period, or the
price for the customer's price level or quantity purchased, based on a
discount or markup. If the lowest price is a negative amount, it is
displayed as zeroes.
No price is displayed if the item is not on the price list you specified for
the detail.
If you set up contract pricing for a customer in Inventory Control, Order
Entry uses that information to calculate prices for items affected by the
customer’s pricing contract, and it displays the contract price by default in
the Unit Price Finder.
If you do not set up contract pricing for a customer, Order Entry
calculates prices based on the customer type and the price lists you set
up in Inventory Control.
You can use the Finder to select another price from the item price list in
Inventory Control. You can also override the unit price.
Also note that the Finder for the Unit Price field is not available if the price
list that you selected is not currently in effect. (In other words, the Finder
does not appear if the document date is not between the Price List Starts
date and the Price List Ends date specified in the I/C Item Pricing form for
the item, currency, and price list code.)
If the price list is not in effect, the Unit Price field displays 0.000000 by
default.

Order Weight Unit of Measure
This is the unit of measure for weighing this item on the order.
Depending on your settings in O/E Options, the program displays either
the item weight unit (from the item record) or the pricing weight unit (from
the price list).
Note:
If the item is not priced by weight, the program will display the item
weight unit from the item record.
If the item is priced by weight, and it has base prices for multiple
UOMs, the program will display the default unit of measure from the
price list if your Default Order Weight UOM in O/E Options is the
Pricing Weight Unit.
You can change the weight unit of measure for the detail line, if
necessary.
The weight UOM for the complete order is determined by the default
weight unit of measure set in Inventory Control's Options form.

Tax Amount
If you selected the option, Calculate Tax, the program displays the
amount of tax that is due for each authority.
For each authority, Order Entry calculates a sales tax amount if:
The customer is subject to tax.
The order contains taxable items or taxable miscellaneous charges.
Tax rates are specified for the tax authorities and classes in Tax
Services.
If you are entering taxes manually, enter the total tax amount you
calculated for each tax authority. Ensure that the amounts you enter
agree with the sum of the tax amounts for the details, for each tax
authority.

Tax Base
If you selected the Calculate Tax option, the program displays the total
amount of the order or invoice. Any invoice or early-payment discounts
are not deducted from this total.
If you are entering taxes manually, enter the total order or invoice amount
in this field.

Amount (Miscellaneous Charge)
Enter or accept the amount of the miscellaneous charge. This field
appears only for a miscellaneous charge.

Qty. B/O (Quantity Backordered)
If you did not ship the entire order and you use backorder quantities, the
program displays the quantity backordered in this field.
(If you use backordered quantities, the Quantity Shipped plus the
Quantity Backordered usually matches the Quantity On Order.)

Comments/Instructions
Use this field to enter comments and instructions. These
comments/instructions will be included as the default comment on the
invoice you create for the shipment.
To add comments to a shipment
1.Click the Totals tab
2.Enter comments in the Comment field
3.Click Post to save.
To add comments or instructions to a detail on the detail-entry grid
1.On the Shipment tab, select (highlight) the detail line.
2.Click the zoom button ( ) in the Comments/Instructions column
header to open the Comments/Instructions popup form (or click in the
column, and then press Control + Shift F9).
3.In the Type field, select Comment or Instruction.
4.Type the comment or instruction, using up to 250 characters per line.
Press Tab or Enter to start new lines.
To add comments or instructions to a detail in the Items/Taxes form
With the detail selected in the Items/Taxes form, click the zoom button ( )
in the Comments/Instructions field.

Completes Order
This field automatically changes from "No" to "Yes" when you completely
ship the number of items for the detail line, or change the number of
backordered items to 0 for the line.

Discount Amount
You can use this field to enter a discount for the detail.
The program then calculates the discount percentage and the discounted
extended price.
If you override the discount percentage in the amount field, Order Entry
displays an asterisk beside the field in the popup detail entry form to
show that the amount was overridden.
You can still enter a discount for the whole document, if you like. Order
Entry displays the discount amount for the transaction details, as well as
the discount for the whole document, on the Totals tab summary.

Discount %
The program displays the discount percentage specified for the shipment,
if any.
You can change the displayed rate. If the terms code does not use
discounts, you can enter a discount percentage for the individual order or
invoice, if necessary.

Discounted Extended Amount
This is the amount for the quantity/weight of units for this line on this
shipment after subtracting any discount for the line.

Expected Ship Date (item)
The program displays the expected shipment date for the shipment
document, but you can change the date for individual detail lines.

Line Type / Type Of Detail (item or miscellaneous
charge)
Choose Item to add a detail line for an inventory item or non-stock item
that is assigned an item number in Inventory Control.
Choose Miscellaneous to add a detail line for a miscellaneous charge
defined in Order Entry.
Click your choice, type its first letter, or use the Spacebar to toggle
between the choices.

Optional Fields
Click the Zoom button to edit an optional field that was assigned to this
Transaction Type in the Order Entry Optional Fields setup form.
If an optional field is required, you cannot save the transaction unless the
field has a default value — or until you fill in the field yourself.
Click the zoom button to review Optional Field entries if the Optional Field
column shows "Yes" or the checkbox is selected (in the zoomed Item/Tax
detail form).
To add optional item fields to the popup form that were not automatically
inserted, use the Insert key to add a new line to the grid, and then use
the Finder to add the optional field.
Optional fields must be assigned to the transactions forms using the O/E
Optional Fields form before you can add them to individual transactions.

Order Number
Order Entry displays the order number for each detail, indicating the
source of the detail.
You can click the drilldown button to display the complete order.

Price Approval
Price checks are set in Inventory Control price lists for particular items,
price lists, and Sage ERP Accpac user IDs.
The Price Approval field will display "Yes" if price checks are in effect,
and the price you enter is outside the boundaries allowed.
If "Yes" appears in the Price Approval column, you must:
Click the Zoom button (column heading in the grid) to display the
Price Approval popup.
Enter the ID of the person approving the price override (and
password, if security is set).
Note: The Price Approval field does not appear if you are using the
Item/Taxes zoomed form. Instead, an error message may appear when
you try to save the item detail, stating that the price requires approval.
Also note that price approval is available only in Sage ERP Accpac 500.
Click the Zoom button
Approval popup.

beside the Unit Price field to display the Price

Quantity On Order (display only)
The number of item units on the original order document appears in this
field.

Unit Cost
You enter the unit cost for a detail only if the item uses the User-Specified
costing method in Inventory Control.
Additional Unit Cost Notes:
The unit cost for each inventory item appears in Order Entry forms if you
have the proper security rights.
The Order Entry form shows the estimated cost of each item in the order.
When items are costed during posting or day end processing (depending
on the Inventory Control costing option), the actual cost is updated in the
Shipment Entry form and Invoice Entry form.
Note: The Order Entry form retains the estimated cost and is not
updated.
The following table lists the various inventory costing methods and the
methods used to cost items on orders, shipments and invoices.
Item Costing
Method
FIFO
LIFO
Moving Average
Most Recent
Standard
User Specified
Serial Costing
Lot Costing

Before
Costing
Moving
Average
Moving
Average
Moving
Average
Cost Most
Recent
Standard Cost
User Specified
Moving
Average
Moving
Average

After Costing
FIFO
LIFO
Moving Average
Cost Moving
Average
Moving Average
User Specified
Serial Cost
Lot Cost

For serial costing and lot costing, if the serial numbers and lot numbers
allocated in a transaction have different costs, the average cost of the
serials or lots are shown in the Unit Cost field. (For more detailed
information, see the Inventory Control help on Serial/Lot Costing
Methods.)
For kitting items, the unit cost is displayed as the sum of all of the
components’ costs.

Order UOM (unit of measure)
This is the unit of measure that was used for the order detail line, and it is
usually the UOM for the shipment. However, you can use a shipment unit
of measure that's different from the order UOM.
Note: If the shipment UOM is different from the order UOM, the quantity
backordered may not be calculated properly and may result in overshipment or under-shipment.
Make sure the number of units you specify for the detail is expressed in
the unit of measure you choose.
If you are directly shipping goods without creating an order first ...
The default order unit of measure may be either the stocking unit or the
pricing unit. Stocking units and pricing units are defined for individual
items in Inventory Control, and they may be different. For example, you
may use "dozen" as the stocking unit for an item, but "each" as the
pricing unit.
You can change the Order Unit Of Measure by typing the name or
choosing it from the Finder. You must specify a unit of measure that is
assigned to the item record in Inventory Control.
Make sure the number of units you specify for the detail is expressed in
the unit of measure you choose.
Note: In Sage ERP Accpac 500, you can define multiple pricing units of
order. If the Order UOM does not match a defined pricing UOM, Order
Entry will use the default pricing unit of measure set in the Item Pricing
form in Inventory Control.

Unit Price
You can change this field only if you have Unit Price Override security
authorization.
If necessary, type the price for the item, per pricing unit.
The program displays the lowest price for which the customer is eligible.
It can be the base price, a sale price for a specified time period, or the
price for the customer's price level or quantity purchased, based on a
discount or markup. If the lowest price is a negative amount, it is
displayed as zeroes.
No price is displayed if the item is not on the price list you specified for
the detail.
If you set up contract pricing for a customer in Inventory Control, Order
Entry uses that information to calculate prices for items affected by the
customer’s pricing contract, and it displays the contract price by default in
the Unit Price Finder.
If you do not set up contract pricing for a customer, Order Entry
calculates prices based on the customer type and the price lists you set
up in Inventory Control.
You can use the Finder to select another price from the item price list in
Inventory Control. You can also override the unit price.
Also note that the Finder for the Unit Price field is not available if the price
list that you selected is not currently in effect. (In other words, the Finder
does not appear if the document date is not between the Price List Starts
date and the Price List Ends date specified in the I/C Item Pricing form for
the item, currency, and price list code.)
If the price list is not in effect, the Unit Price field displays 0.000000 by
default.

Unit Weight
This is the weight of a single item for this detail line expressed in the
Order Weight Unit of Measure. You can multiply this weight by the
quantity ordered to get the extended weight.

UOM (Unit Order of Measure, display only)
These display-only fields on the Shipment or Invoice tabs of the
Shipment Entry and Invoice Entry forms show the stocking unit order of
measure for the item on a selected detail line.
The stocking Unit Order Of Measure is given for each of the following:
The location specified in the selected detail line.
All locations.

Shipment Weight Unit of Measure
This is the unit of measure for weighing this item on the shipment.
Depending on your settings in O/E Options, the program displays either
the item weight unit (from the item record) or the pricing weight unit (from
the price list).
You can change the weight unit of measure for the detail line, if
necessary.
The weight UOM for the complete order is determined by the default
weight unit of measure set in Inventory Controls Options form.

Tax Amount
If you selected the option, Calculate Tax, the program displays the
amount of tax that is due for each authority.
For each authority, Order Entry calculates a sales tax amount if:
The customer is subject to tax.
The order contains taxable items or taxable miscellaneous charges.
Tax rates are specified for the tax authorities and classes in Tax
Services.
If you do not select the Calculate Tax option (checkbox), the Distribute
Taxes button becomes available, and you can enter tax amounts for the
tax authorities listed for the shipment.
Click the Distribute Taxes button to prorate the tax you enter manually to
the document details. Note that you cannot prorate a tax amount to an
authority that uses an exempt tax class.
Note: If you are entering taxes manually, ensure that the amounts you
enter in the tax amount fields agree with the sum of the tax amounts for
the details, for each tax authority.

Tax Base
If you selected the option, Calculate Tax, the program displays the net
amount of the shipment (after a shipment discount, if any).
If you are entering taxes manually, enter the total invoice amount in this
field.

Qty. (Quantity) Available
These display-only fields on the Invoice tab of the Invoice Entry form
show, for the selected detail line, item quantities available for sale to your
customers.
Item quantities are given in stocking units for:
The location specified in the selected detail line.
All locations.
The Quantity Available is determined by the quantity on hand less the
quantity committed, as maintained in Inventory Control.

Qty. (Quantity) on Hand
These display-only fields on the Invoice tab of the Invoice Entry form
show, for a selected detail line, item quantities on hand as maintained in
Inventory Control.
Item quantities are given in stocking units for:
The location specified in the selected detail line.
All locations.
Together the Quantity On Sales Order and the Quantity On Hand fields
determine the quantity available for sale to your customers.

Qty. (Quantity) on Purchase Order
These display-only fields on the Invoice tab of the Invoice Entry form
show, for a selected detail line, item quantities on purchase order as
maintained in Inventory Control.
Click the drilldown button to see the purchase order details (such as
the expected arrival date and order date).
Item quantities are given in stocking units for:
The location specified in the selected detail line.
All locations.

Qty. (Quantity) on Sales Order
These display-only fields on the Invoice tab of the Invoice Entry form
show, for a selected detail line, item quantities on sales order as
maintained in Inventory Control.
Click the drilldown button to see the purchase order details (such as
the customer and the expected ship date).
Item quantities are given in stocking units for:
The location specified in the selected detail line.
All locations.
The Quantity on Sales Order is the total backordered quantity for the
particular item.
The Quantity On Hand minus the Quantity Committed determines the
quantity available for sale to your customers.

Unit Weight
This is the weight of a single item for this detail line expressed in the
Invoice Weight Unit of Measure. You can multiply this weight by the
quantity ordered to get the extended weight.
You can edit the unit weight and the extended weight on the invoice.
The estimated weight on the Totals tab is in the default weight unit of
measure specified in the I/C Options form.

Invoice Weight Unit of Measure
This is the unit of measure for weighing this item on the invoice.
The default unit should be the weight UOM specified on the shipment.
You can change the weight unit of measure for the detail line, if
necessary.
The weight UOM for the complete invoice is determined by the default
weight unit of measure set in Inventory Controls Options form.

